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Maps 3.32.1 Release Notes
This document specifies changes made to the Thermo Scientific™ Maps 3.32.1 software
application.

New Features

Phenom: Manual selection of colors for EDS

Maps can now assign predefined colors with EDS elements.

See Phenom Tile Set Tab for more information.

Phenom: EDS parameters in tile set templates

Maps now includes EDS parameters in tile set templates.

See Tile Set Templates for more information.

TEM: Support for TEM 3.23 and TEM 2.23

Maps now supports TEM server versions 3.18–3.23 for Titan and 2.18–2.23 for Talos.

Known Issues
See Known issues for known issues introduced with this version of Maps software.

Bug Fixes
The following bugs were fixed in this release of the Maps software.

Bug ID Description

MAPS-10481 Maps EDS colors for Phenom are now being taken from the same registry
in which Phenom UI stores them. Therefore, colors in both MAPS and
Phenommatch one another.

MAPS-10655 The Phenommetadata is now retrieved and saved in Maps. This
information is available under the Show Metadata button on snapshots and
stitched tile sets.
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Bug ID Description

MAPS-11408 Now when you export a stitched tile set, the scale bar option is available in
the context menu.

MAPS-11434 If you import an image into Maps and the file name does not include the
image resolution, an error message now appears to indicate that the file
name must include the image resolution.

MAPS-12291 All EDS fields are now displayed regardless of their checkbox status (that
is, activated/deactivated). To change a checkbox status, click the
checkbox of the desired EDS field.

MAPS-12654 Temporary files are now deleted correctly during time-intensive runs,
which prevents crashes in the Maps software application.

MAPS-12980 The naming convention has been updated to align with the labeling of tiles
in Maps. Tiles on Phenom are now labeled in the same manner.

MAPS-12995 The interface between Maps and ChemiSEM has been extended, so that
both Regular and Object-based segmentation types are properly
recognized. Selecting Regular segmentation in Maps now works as
expected.
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Overview
This document describes the Maps 3.32.1 application software used on SEM/SDB and TEM
systems.

Topics in this section include:

Introduction to Maps

Terminology

System Requirements

Data Storage Requirements

Project Directory

Package options
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Introduction to Maps
The Maps software application provides users with the ability to focus on areas of interest within
a sample region by organizing the sample into tiles and then navigating, selecting, and
overlapping tiles so they can be viewed and analyzed in a higher level of detail than previously
available.

The application will:

l Create a grid of a sample to enable efficient navigation and previews of selected tiles.
l Acquire tiled images in an automated fashion from multiple sample locations, with correlation
between multiple layers.

l Find stitching information between tiles in an automated or semi-automated fashion using
cross-correlation.

l Stitch and blend tiles into larger images with the capability to export them into common
industry formats for viewing.

l Provide the capability to interactively display and investigate images constructed from
multiple locations and layers of the sample.

l Process powerful workflows to do alignments or array tomography.
l Use the mineralogy workflow to collect and analyze EDS and mineralogy data from
geological samples.

Maps complements the Correlative Workflow features that enable you to move samples
between light microscopes and electron microscopes with the help of automated alignment on
supported sample holders and a suite of powerful correlation tools.

Maps provides a solution for correlative microscopy by facilitating workflows that involve optical
microscopy, SEM, and TEM. Both automated and manual alignments are used for correlation of
the data to truly understand the sample

Note: When upgrading from version 1 or 2 of Maps to version 3, a new license key is
required.

Maps 3.32.1 User Guide

6 | Original Instructions

Limited Rights

PN 1551059 Revision A | 11-Mar-2025

Overview



Terminology
Common terms used in Maps and Array Tomography are defined below.

Maps Terms

Tomography Terms

Maps Terms

Common Maps terms are listed below.

Alignment

In Maps, adjusts project data to the current stage position.

Blending

The Maps software will create a smooth transition between images during stitching.

Correlation

In Maps context, correlation is used for two things: 1. finding back areas of interest that show up
in different modalities, and 2. for visually overlaying data sets that correspond to the same area
on the sample.

EM

Electron microscopy

FIB

Focused Ion Beam

Holder Calibration

This procedure is used to adjust the expected fiducial positions for automated holder alignment
on individual systems. It must be performed the first time alignment is run on a supported holder.
See the Automated Holder Alignment section on Calibration.

Image Registration

The computational process Maps uses to determine the position of a single tile within the greater
tile set. The Image Registration process is run during tile set acquisition.
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LM

Low Magnification mode on TEM.

Maps Offline Viewer

A version of Maps that has read-only capabilities for Maps projects.

MIP

Maximum intensity projection. Collapses a Z-Stack of images into a single image using the
highest intensity pixels from the stack.

Nav-Cam

Navigation Camera

SDB

Small DualBeam; a family of microscopes that have both scanning electron and ion columns.

Segmentation

In the context of images, segmentation is the process of assigning a label to specified pixels in
an image such that pixels with the same label share certain visual characteristics, such as color.

SEM

Scanning Electron Microscope

Stitching

The computational task of combining a set of individual images to form a single image.

STEM

Scanning Transmission Electron Microscopy. STEMmode exists on SEMs, SDBs and TEMs
(depending on the exact configuration).

TEM

Transmission Electron Microscope

Maps 3.32.1 User Guide
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TIA

On TEM, the instrument user interface consists of two parts: TEM User Interface for instrument
control and TEM Imaging and Analysis for acquisition and analysis.

Tile Acquisition

The automated task of acquiring, aligning, and registering tiled images, as defined by the user.

Tile Grid

The empty grid that defines where and how a set of tiles will be acquired.

Tile Set

The output of a tile grid once acquisition is run, or the set of actual tiled images.

xT Software

Platform software for the SEM/SDB microscopes.

xT UI

xT software user interface

Z-Stack

A sequence of images through the z-axis, used to build a 3D volume.

Z-Stack Browser

The Maps UI component that allows you to view and select image planes from a z-stack.

Tomography Terms

Common Array Tomography terms are listed below.

Classic Ribbons

(Array Tomography) Sample sections are attached to each other and the ribbon is always
slightly bent. The angle between each section is constant, for the most part.
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Serial Section Array

The layer group that contains tile set arrays and section outlines. The purpose of the group is to
easily contain most of the array tomography data about a sample in one section of the Layer
tree.

Tape Ribbons

Sample sections are regularly spaced and the angle between each slice varies slightly.

Tile Set Array

A collection of tile sets that all share the same acquisition parameters, but can differ in location
and rotation.

Workflow

A series of steps that are necessary to complete a task.

System Requirements
l 3 GB of physical RAM
l 4.5 GB of memory paging allocated in Windows®
l Dual-core processor
l For Microscope Operation, microscope system software (xT, TEM Server, or LA) must be
running before launching Maps
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Data Storage Requirements
You can select a default location for project data. We suggest that you place the Project Data
Directory on the D drive or a supplemental data storage device such as a network drive, external
USB drive, or additional internal hard drive.

l You may need additional internal or external storage capacity to acquire large tile sets.
l Acquisition speed might be reduced when saving project data to USB or network locations.

The table below indicates the number of tile sets you can acquire at various image resolutions
and dimensions, provided that the Project Data Directory is configured to save to a standard
empty 350 GB drive partition.

Note: For multiple channel acquisitions, the storage requirements increase
incrementally with the number of channels.

Resolution Tile Set Size

5x5 10x10 50x50 100x100

512 15 MB 100 MB 1.25 GB 5 GB

1 K 55 MB 200 MB 5 GB 20 GB

2 K 200 MB 700 MB 20 GB 75 GB

4 K 750 MB 2 GB 75 GB 250 GB

8 K 4 GB 10 GB 250 GB 1.00 TB

Color Key:

Red < 1 Tile Set

Orange 1 to 2 Tile Sets

Yellow 2 to 5 Tile Sets

Da t a S t o r a g e Req u i r emen t s f o r S i n g l e Ch a n n e l Ima g e
A c q u i s i t i o n
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Resolution Tile Set Size

Green > 4 Tile Sets

Da t a S t o r a g e Req u i r emen t s f o r S i n g l e Ch a n n e l Ima g e
A c q u i s i t i o n ( C o n t i n u e d )

Project Directory
At the root directory, you will see the following:

The LayersData folder contains a directory structure that mimics the Layer tree in Maps, so you
can manually locate the image files.

Launch Maps from a New File in the Project Directory

Double-click Project.mapsxml to launch Maps and automatically open the project from the
directory in which this mapsxml file exists.

Maps 3.32.1 User Guide

12 | Original Instructions

Limited Rights

PN 1551059 Revision A | 11-Mar-2025

Overview



Package options
The table below lists all the package options available to you with the Maps software. To view
your installed licenses and their expiration date(s), click the Help menu, and then click About.
The expiration date(s) are determined by your product license key(s).

Contact your Thermo Fisher representative for licensing information.
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Option Description

Analytics for
TEM

Licensed to run the Analytics plug-in and acquire EDS data through a first-
party device interface (FDI). See TEM Analytics for more information.

Analytics for
SEM

Licensed to run the Analytics plug-in and acquire EDS data through a
software application interface on a SEM/SDB microscope. See SEM
Analytics for more information.

Annotations Licensed to create annotations in the project.

Array
Tomography

Licensed to enable the Array Tomography workflow. See Array
Tomography Workflow for more information.

Big Snapshot Licensed to acquire high resolution square images (4k and 8k) on
supported xT microscopes.

Color
Correlation

Licensed to allow correlation features including segmentation and color
maps.

External Image
Import

Licensed to allow importing of images from any source such as other
microscopes, cameras, CAD exports, etc.

Maps Offline
Viewer

Installations of Maps Offline Viewer are licensed only for viewing datasets
that have been generated by the full version of Maps.

Maps Min Licensed to set up and acquire mineral EDS data with automated mineral
classification post processing. See Maps Min for more information.

Phenom Licensed to use the Maps application software on Phenom desktop SEM
systems.

Project Editing Licensed to edit projects. Without this projects are opened read-only.

Stage
Correlation

Licensed to allow 1–3 point alignment.

Stitching Licensed to allow stitching of acquired tile sets.

TEM Online Licensed to run on TEM family of microscopes, such as Titan, Talos, etc.

Map s Pa c k a g e Op t i o n s

Maps 3.32.1 User Guide
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Option Description

xT Online Licensed to run on the xT family of SEM and SDB microscopes, such as
Helios NanoLab™, Quanta™, Versa, and so on.

Map s Pa c k a g e Op t i o n s (C o n t i n u e d )
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Maps User Interface
This section describes the Maps software user interface.

Topics include:

Default Shortcut Keys

Viewer Shortcut Keys

Main Screen

Menus

Toolbar

Layer/Holder Definition Control

Layer Tree Tabs

Layer Control

Job Control

Viewer

Rotation Control in the Viewer

Micron Bar

Maps 3.32.1 User Guide
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Default Shortcut Keys
This topic lists default shortcut keys in Maps.

Keys Description

F1 Opens the current Maps help system.

F2 Saves the screenshot with an automatically incremented file name. Same
as selecting File > Save Screenshot.

Space View all objects (zoom out).

Ctrl+Shift+C Centers the view on the current layer, same as Center View on Selection
and Center View.

Ctrl+G Shows/hides grid lines for the current layer, same as Show Grid Lines (Tile
Set right-click menu selection).

Ctrl+H Hides all graphic elements in the viewer, leaving only the images. Same as
selecting Options > Hide Annotations.

Ctrl+L Opens the Log Viewer. Same as selecting Help > Open Logs.

Ctrl+O Opens the project folder. Same as selecting File > Open Project Folder.

Arrows Moves selected tile set in small increments.

Shift + arrow Moves selected tile set in finer increments.

Ctrl + click or
drag

Selects tiles.

Shift + click Selects tiles by row.

Sho r t c u t K e y s
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Viewer Shortcut Keys
There are three profiles defined for Viewer’s shortcut keys (Application settings).

Default Profile

Classic Maps Profile

Avizo Profile

Default Profile

Keys Description

Ctrl + mouse wheel +/- Zooms in and out.

Mouse wheel Zooms in and out slowly.

Shift + Ctrl + left-click and
drag

Zooms the image to the selected region.

Left-click and drag Pan (move)

Shift + left-click and drag Rotates the viewer without moving the stage.

Alt + left-click and drag Draw a feature of interest rectangle with a number of available
options.

Left-click Selects an object.

Ctrl + left-click Selects multi objects.

Escape Deselects all objects.

Shift + left-click Selects tiles by row.

L + left-click and drag Draw a line measurement tool.

A + left-click and drag Draw an angle measurement tool.

V i ewe r De f a u l t P r o f i l e S h o r t c u t K e y s
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Classic Maps Profile

Keys Description

Ctrl + mouse wheel Zooms in and out.

Shift + mouse wheel Zooms in and out slowly.

Shift + Ctrl + left-click and
drag

Zooms the image to the selected region.

Shift + left-click and drag Pan (move)

Shift + right-click and drag Rotates the viewer without moving the stage.

Left-click and drag Draw a feature of interest rectangle with a number of available
options.

Left-click Selects an object.

Ctrl + left-click Selects multi objects.

L + left-click and drag Draw a line measurement tool.

A + left-click and drag Draw an angle measurement tool.

V i ewe r C l a s s i c Map s P r o f i l e S h o r t c u t K e y s

Avizo Profile

This profile defines the input as in Avizo® software.

Keys Description

Ctrl + middle-click and
drag

Zooms in and out.

Mouse wheel Zooms in and out slowly.

V i ewe r C l a s s i c Map s P r o f i l e S h o r t c u t K e y s
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Keys Description

Shift + Ctrl + left-click and
drag

Zooms the image to the selected region.

Middle-click and drag Pan (move)

Left-click and drag Rotates the viewer without moving the stage.

Ctrl + Left-click and drag Draw a feature of interest rectangle with a number of available
options.

P + Left-click Selects an object.

Ctrl + left-click Selects multiple objects.

L + left-click and drag Draw a line measurement tool.

A + left-click and drag Draw an angle measurement tool.

V i ewe r C l a s s i c Map s P r o f i l e S h o r t c u t K e y s (C o n t i n u e d )
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Main Screen
This topic shows and explains the Main screen of the user interface.

Maps User Interface, Control Panel

1. Menus

2. Toolbar

3. Layer Control

4. Overview Viewer

5. Tile Set Tab

6. Visualization Tab

7. Viewer

8. Micron Bar

Show or hide main controls

Click the last icon on the left side of the tool bar to hide the main controls. Click the icon again to
show the main controls.
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Microscope connection states

The bottom of the main screen contains two status icons that indicate the connection states
between the Maps application and the microscope.

Green connection states include:

l Solid Green: If the status icon is solid green, then the connection is active and you can use
the Maps application online.

l Spinning Green: If the status icon is green with a spinning wheel, then the connection is
currently occupied with a task. To use the Maps application online, wait until the status icon
becomes solid green.

Red connection states include:

l Spinning Red: If the status icon is red with a spinning wheel, then the connection is currently
unavailable and the Maps application is attempting to secure the online connection.

l Solid Red: If the status icon is solid red, then the connection could not be established and
the Maps application is no longer attempting to connect to the microscope. Click the status
icon to initiate a new online connection.

Menus
This section describes options listed in Maps software menus.
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Topics include:

File menu

View menu

Phenommenu

Options menu

Help menu

Tomography menu

File menu

This section describes options listed in the File menu.

Menu
Selection Description

New Project Displays the New Project window.

See New Project for full instructions.

F i l e Men u Ove r v i ew
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Menu
Selection Description

Open Project Displays the Project History window showing all previous projects.

See Open a Project for more information.

Import Project Displays the Import Project window. Browse to a Source directory and select
a project, rename it if appropriate, and then click Import. The imported
project name will appear in the Project History list. This can be used for
passing projects between computers.

See Import a Project for full instructions.

Project
Properties

Displays the Project Properties window for selecting the Project Path,
Sample Holder, and a project description. See Project properties for more
information.

Open Project
Folder

(Ctrl+O)

Displays the project folder. This can also be accessed by selecting Open
Folder in the Project Properties window.

Import Grid Creates a blank tile set that matches the settings of a previously exported
tile set. An exported tile set is saved as a .gridx file.

F i l e Men u Ove r v i ew (Co n t i n u e d )
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Menu
Selection Description

Import
Images

Opens a standard open file dialog that enables the user to import a image
file into the current Maps project.

Save
Screenshot
As

Displays a standard Windows Save As dialog box for saving a screen
capture of the Maps viewer. Used for selecting a file name and a file type for
saved viewer screenshots.

Save
Screenshot

(F2)

Saves the screenshot with an automatically incremented file name. Briefly
displays a dialog box with the saved (automatically incremented) file name.

Quit Closes the Maps software.

F i l e Men u Ove r v i ew (Co n t i n u e d )
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Project properties

View the attributes of the current project and modify the selected sample holder and project
description here.
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Interface
Item Description

Project Name Displays the name given to the project.

Project Path Displays the folder and location of the selected project.

Disk Space
Usage

Displays the amount of disk space used by the project.

Total Number
of Images

Displays the number of tiles and imported images for the project.

Project
Description

Displays the description of the current project.

Sample
Holder

Displays a dropdown list of possible sample holders that support automated
alignment on SEM/SDB microscopes.

Make a selection and then click Apply to see the holder outline displayed on
the main screen. See Sample Holders for more information.

OK Applies the selections and closes the window.

Apply Applies the selection only.

P r o j e c t P r o p e r t i e s O v e r v i ew
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Interface
Item Description

Cancel Cancels any changes to the Project Properties and closes the window.

P r o j e c t P r o p e r t i e s O v e r v i ew (Co n t i n u e d )

View menu

This section describes options listed in the View menu.

All selections

Menu
Selection Description

Hide All
Annotations

(Ctrl+H)

Hides all graphic elements in the viewer, leaving only the images.

Show Layer
Name
Annotations

Displays an additional annotation of the tile set names to help identify data
during viewing. This option is activated by default and persists when you
restart Maps. To deactivate this feature, click the Show Layer Name
Annotations menu item to clear the check mark associated with it.

V i ew Menu , A l l S e l e c t i o n s O v e r v i ew
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Menu
Selection Description

Show
Annotations on
Top

When activated, this menu option displays annotations on top of the image
data. Annotations include areas of interest; sites of interest; and line and
angle measurements.

Note: This option persists when you restart Maps.

Animate Pan &
Zoom

Allows a smoother transition of panning and zooming. Note that this is a
slower process and takes more memory. This option is activated by default
and persists when you restart Maps. To deactivate this feature, click the
Show Layer Name Annotations menu item to clear the check mark
associated with it.

l Pan: To make a sweeping movement
l Zoom: To simulate movement rapidly away from or toward a subject
using a zoom lens

The “Center View on Sample,” “Center View on Selection,” and “Go to
Microscope FOV” viewer functions animate pan and zoom by default.

Presentation
Mode

This option is available when you have two monitors. When activated, a
second full screen view of the project data displays on the other screen.
This is useful for demos and presentations.

V i ew Menu , A l l S e l e c t i o n s O v e r v i ew (Co n t i n u e d )

Phenommenu

The Phenom menu is only available for Maps software on Phenom desktop SEM systems.
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Menu Selection Description

Phenom instrument Opens the Phenom instrument dialog. The dialog shows details of
the connected Phenommicroscope. You can also use the dialog to
disconnect from the microscope. See Phenom Connectivity for more
information.

Phen om Menu Ove r v i ew
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Options menu

This section describes options listed in the Options menu.

System views

The common selections are described in the table below. For system-specific menu selections
outlined in purple, click the following links.

l SEM/SDB Options Menu
l TEM Options Menu

Options Menu, Specific Selections by System

SEM/SDB View

TEM View
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Menu
Selection Description

Application
Settings

Displays the Application Settings window for changing defaults for all new
projects.

Default Project Data Directory: Displays the default path with a browse
button to allow you to choose a different path.

Stage cursor color: Click the eyedropper to select a new stage cursor
color.

Measurements default color: Click the eyedropper to select a new color
for line and angle measurements.

Op t i o n s Menu , A l l S e l e c t i o n s O v e r v i ew
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Menu
Selection Description

Site/area of interest default color: Click the eyedropper to select a new
default color for sites of interest and areas of interest.

Display 360° Scan Rotation:

l When selected, displays 360° scan rotation.
l When not selected, displays –180° to 180° scan rotation.

Viewer Profile: Displays a list of viewing choices.

Choices include:

l Default: See Default Profile for detailed inputs.
l Avizo: The inputs defined for the viewer are based on Avizo/Amira®
software. See Avizo Profile for detailed inputs.

l Classic Maps: The inputs defined for the viewer are based on the
previous Maps version (v2.5). See Classic Maps Profile for detailed
inputs.

Op t i o n s Menu , A l l S e l e c t i o n s O v e r v i ew (Co n t i n u e d )
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Menu
Selection Description

Viewer Fonts:

Note: Changes to Viewer Font values affect the viewer scale
bar and layer name annotations. These changes are applied to
newly created annotations or measurements. Existing
annotations and measurements displayed within the Maps
project are not impacted by these font changes.

The first field displays a list of available fonts for the annotation and
measurement tool description. Select a font from the dropdown menu to
designate is as the default font.

The second field displays a list of font sizes for the annotation and
measurement tool description. Select a font size from the dropdown menu
to designate it as the default font size.

l Bold: Click the B button to designate bold as the default font weight for
the annotation and measurement tool description fonts.

l Italic: Click the I button to designate italic as the default typeface for the
annotation and measurement tool description fonts.

Op t i o n s Menu , A l l S e l e c t i o n s O v e r v i ew (Co n t i n u e d )
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Menu
Selection Description

Default Holder: Displays a list of possible sample holders. Select a holder
to be used as a default for all new Maps projects.

Histogram white tail: Trims a percentage of histogram pixels to eliminate
noise.

Histogram black tail: Trims a percentage of histogram pixels to eliminate
noise.

Screen Saver: Select the checkbox to display a screen saver when the
application is busy for the specified number of minutes.

Improvement Program: Shows the client ID for tracking your anonymous
usage data that the Maps application sends back to the Maps team. The
"Allow usage logging" setting is activated by default. To opt out of the
improvement program, select the slider and move it to the left to deactivate
the setting (a dark grey slider is deactivated).

Tile Set
Templates

Displays the Tile Set Templates window. See Tile Set Templates for a full
explanation of templates.

Tasks related to tile set templates include:

l Default templates
l Create custom templates
l Edit custom templates
l Import and export tile set templates

Op t i o n s Menu , A l l S e l e c t i o n s O v e r v i ew (Co n t i n u e d )
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Menu
Selection Description

Microscope
Settings

These are system-specific.

l SEM/SDB Options Menu
l TEM Options Menu

Snapshot
Settings

These are system-specific.

l SEM/SDB Options Menu
l TEM Options Menu

XPS Settings These are system-specific. See TEM Options Menu.

Cryo Settings These are system-specific. See SEM/SDB Options Menu.

Amira-Avizo2D
Settings

See Amira-Avizo2D Connectivity.

Op t i o n s Menu , A l l S e l e c t i o n s O v e r v i ew (Co n t i n u e d )

Help menu

This section describes options listed in the Help menu.
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Menu Selection Description

Help (press F1) Displays an interactive help system that
contains release notes, installation
information, and user guide topics. PDF
versions of the content are accessible from
within the help system.

Generate Bug Report Generates a bug report and opens the folder
with the generated bug report.

Open Bug Report
Folder

Displays the folder where the generated bug
reports are stored.

Open Maps Min Help
Desk

Opens the Maps Min Help Desk for online
support (see Maps Min). You can
request/renew a license or report bugs
through the help desk.

Open Application
Logs

(press Ctrl+L)

Displays the Log Viewer dialog.

About Opens the About screen, which displays
information about the software versions and a
list of your installed license options with
expiration dates. For descriptions of the
license options, see Package options.

License Terms Displays the accepted end-user license
agreement (EULA).

He l p Menu Ove r v i ew
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Tomography menu

When Maps is installed with the Thermo Scientific™ Tomography 5 Software application, the
Tomography menu is available.

Tomography menu

Click Tomography to view the menu items, which include Import Presets and Import Batch
Positions.

Menu Selection Description

Import Presets Imports Tomography microscope presets. The presets are stored as
Maps templates to be used later for acquisitions and autofunctions.

(Beta) Import Batch
Positions

Imports batch positions from Tomography with relevant Exposure,
Tracking, Focus, and Condition areas.

Tomog r a p h y Menu Ove r v i ew

Tomography menu with Maps Data Exchange Service

Note: If you also have the Maps Data Exchange Service installed with the
Tomography application, then the Tomography menu contains different options than
if the service is not installed. For information on how to install the Maps Data
Exchange Service, refer to the latest Maps Software Installation Guide.

Click Tomography to view the menu items, which include Import Presets, Synchronize With
Tomography, and Send To Tomography.
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Menu Selection Description

Import Presets Imports Tomography microscope presets. The presets are stored as
Maps templates to be used later for acquisitions and autofunctions.

(Beta) Synchronize
With Tomography

Toggles the automatic synchronization of data with Tomography
between ON and OFF.

When synchronization is active, the following data are automatically
exchanged between Maps and Tomography:

l Annotations are sent to Tomography, including areas of interest,
sites of interest, and lamella sites.

l Batch positions are imported from Tomography, including
exposure, tracking, focus, and condition areas.

(Beta) Send To
Tomography

Sends all annotations of given type to Tomography when live
synchronization is turned OFF.

Select the annotation type from the submenu:
l Send All Lamellae
l Send All Areas of Interest
l Send All Sites of Interest

Tomog r a p h y Menu w i t h Map s Da t a E x c h a n g e Se r v i c e O v e r v i ew

Limited Rights

PN 1551059 Revision A | 11-Mar-2025

Maps 3.32.1 User Guide

39 | Original Instructions

Maps User Interface



Toolbar
The common toolbar selections are described in the following table.

For system-specific selections, see:

l SEM/SDB Toolbar, Right Side
l Phenom Toolbar, Right Side

Topics in this section include:

Left Side, All Systems

Secondary Menu

Toolbar Descriptions
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Left Side, All Systems

The left side toolbar appears as below on all systems.

Toolbar, Left Side, All Systems

Secondary Menu

If the window is resized too small to display all tools, some of them are stored in a secondary
menu. Click the down arrow to access them.

Toolbar Descriptions

Tool Description

Move & Resize
Tool

Moves or resizes the tile grid with click and drag.

Too l b a r D e s c r i p t i o n s
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Tool Description

Measurement
Tool

Draws a line and displays the length as a callout.

Angle
Measurement
Tool

Draws a line and a third point; displays the angle as a callout.

Zoom to
Selection

Zooms the field of view to the selected area.

Add Tile Set Adds a tile set over a selected area in the viewer.

Add Circular
Tile Set

Adds a circular tile set over a selected area in the viewer.

Add Freehand
Tile Set

Adds a freehand drawn tile set over a selected area in the viewer.

Stamp Tile Set Stamp a new tile set using the active template.

Too l b a r D e s c r i p t i o n s (C o n t i n u e d )
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Tool Description

Add Area of
Interest

Displays the New Annotation dialog box for adding the drawn selected
area of interest (AOI).

The new AOI becomes a new Annotation layer in the Layer control.

Save Image to
File

Saves an image to file. See “Save Image to File” on page 69.

Stitch Selection Stitches a subset of tiles, as selected by the rectangle. See “Stitching” on
page 99.

Center View on
Sample

Zooms out to the full sample view. By default, this view animates the pan
and zoom function to orient you within the sample space. To deactivate
the animation functionality, see the "Animate Pan & Zoom” under View
menu.

Center View on
Selection

(Ctrl+Shift+C)

Unavailable until a project is open.

Pans and zooms the viewer so that the currently selected layer item is
centered. By default, this view animates the pan and zoom function to
orient you within the sample space. To deactivate the animation
functionality, see the "Animate Pan & Zoom” under View menu.

Go to
Microscope
FOV

Pans and zooms the view to match the microscope (electron beam) field
of view (FOV). By default, this view animates the pan and zoom function
to orient you within the sample space. To deactivate the animation
functionality, see the "Animate Pan & Zoom” under View menu.

Too l b a r D e s c r i p t i o n s (C o n t i n u e d )
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Tool Description

Save
Screenshot (F2)

Briefly displays a dialog box with the saved (automatically incremented)
file name. Also available from File > Save Screenshot.

Copy
Screenshot to
Clipboard

Copies the current image display to the system clipboard. You can then
paste the image into other applications using paste commands.

Global
Alignment

Performs a 1-, 2-, or 3-point alignment to align all previously acquired data
to the stage. It is useful if the sample was removed from the tool and you
want to continue with it. See Coarse Alignment (1-, 2-, or 3-Point).

Align to Holder

(SEM/SDB only)

Performs an Automated Holder Alignment; requires a specific holder
hardware.

If no sample holder has been selected for the project, a dialog box
appears to prompt you to select a holder.

Too l b a r D e s c r i p t i o n s (C o n t i n u e d )

Layer/Holder Definition Control
This feature is only available on SEM/SDB systems (see Holder Tab).

Layer Tree Tabs
This section describes the tabs within the layer tree depending on the selected item such as a
specific tile set, line, or angle. For example, the image below shows the Tile Set (20) and its
associated tabs.
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Topics include:

Image Tab

Tile Set Tab

Annotation Tab

Measurement Tab

Font Format Tab

Visualization Tab

Overview Viewer
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Image Tab

The Image tab appears in the left panel when you select an image layer in the layer tree view.
This tab displays properties of images, including imported images and stitched layers.

Control Description

Name Displays the name of the current image.
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Control Description

Planes Controls the image planes. Use the slider to change the current plane index
and to show the plane in the main viewer.

You can also click the left and right arrows to navigate one plane at a time.

Note: The control is activated only for images with multiple planes.

Note: If the image plane depth in the current image is available,
then the Depth control is displayed instead of the Plane control (see
Optional controls).

Current
Plane

Displays the current plane index.

Time
Frames

Controls the image time frames. Use the slider to change the current frame
index and to show the frame in the main viewer.

You can also click the left and right arrows to navigate one time frame at a
time.

Note: The control is activated only for images with multiple frames.

Current
Time
Frame

Displays the current frame index.

Pixels Displays the resolution of the current image.

Pixel Size Displays the physical size of a single pixel within the current image.
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Control Description

Physical
Size

Displays the physical size of the current image.

Show
metadata

Opens a screen to display the metadata of a selected item in the layer tree
(see Metadata Viewer). If there is not any metadata associated with the
selected item, then this button is deactivated.

Optional controls

If the image plane depth in the current image is available, then the Depth control is displayed
instead of the Plane control.

Control Description

Depth Controls the plane depth of the current image. Use the slider to change the
depth, to change the plane, and to show the plane in the main viewer.

You can also click the left and right arrows to navigate one depth plane at a
time.

Plane Displays the current plane index and its depth.
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Metadata Viewer

This topic describes the Metadata Viewer, which displays the information associated with the
selected item from the layer tree such as images, tiles, and tile sets. For example, the metadata
for a stitched image contains the original microscope information.

Note: For Maps 3.32.1, the Metadata Viewer functionality only supports stitched
images from SEM tile sets.

UI Item Description

Title Displays the name of the layer tree item associated with the metadata. The
screen title is located in the upper-left corner of the viewer.

Metadata
tabs

Displays the metadata of the element and is organized by the type of content.
These tabs are located in the upper-left corner of the viewer.

Copy to
clipboard

Copies the tab content to the clipboard, so that you can paste it to another text
editor if needed. This button is located in the upper-right corner of the viewer.

Maps 3.32.1 User Guide

50 | Original Instructions

Limited Rights

PN 1551059 Revision A | 11-Mar-2025

Maps User Interface



Tile Set Tab

When you create a new tile set, the parameters for basic tile acquisition are populated with
defaults.

The selections are system specific:

l SEM/SDB Tile Set Tab
l TEMmode: TEM Tile Set Tab
l STEMmode: STEM Tile Set Tab
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Annotation Tab

This Annotation tab contains the properties for the annotations within the main viewer. This tab
appears in the left panel when you select either a site of interest or an area of interest.

Site of interest

Property Description

Name Displays annotation name.

Notes Displays annotation notes. Click in this field to add or edit these notes.

Color Displays color of annotation. Click the color picker (that is, the eyedropper
icon) to change the color.

Ellipse Appears if the annotation is displayed with an ellipse form within the main
viewer. Select this checkbox to change the value.

Stage X Displays position of stage for X axis.

Stage Y Displays position of stage for Y axis.
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Property Description

Source
System

Displays name of source system.

Drive To Click button to drive microscope field of view to annotation location.

Area of interest

If the annotation is an area of interest, then the opacity property is shown in addition to the
properties described in the previous table.

Property Description

Fill Opacity Sets the level of opaqueness for the entire annotation. Click and move the
slider to the right to increase the level of opaqueness, or click and move the
slider to the left to decrease the level of opaqueness. The less opaque, the
more transparent the annotation becomes. Transparent annotations are
useful when overlaying a layer over another layer.
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Measurement Tab

The Measurement tab appears in the left panel when you select a line or angle measurement
layer. This tab displays properties of measurements.

Property Description

Name Displays measurement name.

Notes Displays measurement notes. Click in this field to add or edit these notes.

Color Displays color of measurement. Click the color picker (that is, the eyedropper
icon) to change the color.

Fill Opacity Sets the level of opaqueness for the entire measurement. Click and move the
slider to the right to increase the level of opaqueness, or click and move the
slider to the left to decrease the level of opaqueness. The less opaque, the
more transparent the measurement becomes. Transparent measurements
are useful when overlaying a layer over another layer.

Font Format Tab

Use the controls under the Font Format tab to set layer font properties as rendered within main
viewer. This tab appears only when you select a site of interest or when you select a line or
angle measurement layer.
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Property Description

Font Family Displays a list of available fonts. Select a font from the dropdown menu to
be displayed within the main viewer.

Font Size Displays a list of font sizes. Select a font size from the dropdown menu to
be displayed within the main viewer.

Bold Click the B button to display the font weight as bold within the main
viewer.

Italic Click the I button to display the font style as italics within the main viewer.

Font Viewer Provides a rendering of the selected font format properties. This viewer is
located to the right of the other four properties.

Visualization Tab

The Visualization tab (formerly called "Results" tab) contains the correlation controls, which you
can use to apply simple coloring to the tile set images when acquired. Some correlation controls
appear unavailable if they are not applicable to the system type.
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Correlation controls

Control Description

Opacity Sets the measure of opaqueness for the entire image. The less opaque,
the more transparent it becomes. Transparent images are useful when
overlaying on image over another.

Additive Opacity Sets the control the opacity between fluorescence and regular channels.
This is useful for the Analytics tile sets as they contain many non-
overlapping channels. The Additive Opacity option is the default for EDS
tile sets. Increasing the additive opacity makes fluorescence channels
more visible.

Stitching
Channel

Sets the channel used for stitching.

Show histogram Shows/hides the histogram panel. See Histogram.

Co r r e l a t i o n Con t r o l s O v e r v i ew
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Control Description

Quantification
Modes

EDS channels acquired with Velox can have up to four different
quantification modes. Click one of the activated buttons (shown in white)
to select a quantification mode, which is used to visualize the elements. A
deactivated button (shown in grey) indicates that the quantification mode
was not calculated and is not available.

The elements display data in each quantification mode as follows:

l int: the counts according to the raw integrated spectrum
l net: the counts according to the background corrected and fitted
model

l wt%: the weight fractions
l at%: the atomic fractions

Co r r e l a t i o n Con t r o l s O v e r v i ew (Co n t i n u e d )
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Control Description

Channels with
Opacity slider
and
Gamma
adjuster

Click the dropdown menu for each channel to view and select the options
described below.

l Channel name: Located at the top of the screen. This text field
displays the channel name.

l Delete Channel: For a multichannel image layer, the delete channel
option is available and appears as a trash can icon. Click the trash can
icon to delete the channel. This function is not available for a single
channel image layer and when using the Offline Viewer.

l Color picker: Located next to the delete channel option. Click this
button to select a unique color to display in the histogram. The color
picker is set to white by default.

l Opacity slider: Adjusts opacity for this channel only.
l Gamma: Displays the gamma curve adjustment.
l Reset: Resets the Gamma slider to the default.
l Saturation: Select this check box to highlight saturated pixels.
l Additive: Select this check box to designate this channel to use
additive color mixing. Additive color mixing is used for channels such
as fluorescence, cathodoluminescence, and EDS. Black is considered
transparent and colors are added with other channels/images behind
it. All channels marked additive are painted together (for example, red
and green combine to display yellow).

l Add Color: Launches Segmentation. Displays an additional histogram
every time you click the button.

l Metadata: Click the dropdown menu to view the channel metadata.

Co r r e l a t i o n Con t r o l s O v e r v i ew (Co n t i n u e d )
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Histogram

Displays a histogram for the selected channel. Click a different channel name to select its
histogram and associated color.

Selected Channel Histogram
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Interface Item Description

Selected channel
name

Displays the selected layer item (a tile set or image) from the Layer
control.

Hide Hides the histogram.

Zoom Expands the histogram area of images with less than 255 colors.

Semi-log When selected, changes the histogram intensity display to logarithmic.

Invert Inverts the intensity of the image, e.g., black to white.

Auto When selected, continuously adjusts the min and max for the histogram
display.

Current max
position

Displays the current max slider position.

Max slider Any data above the max line is white. Gray levels display between the
max and min sliders.

Histogram data Displays the histogram data for the selected channel.

Min slider Any data below the min line is black. Gray levels display between the
max and min sliders.

Current min
position

Displays the current min slider position.

Se l e c t e d Cha n n e l H i s t o g r am Ove r v i ew
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Overview Viewer

The Overview viewer, located in the Overview tab, shows a lower-zoom view of your data,
allowing you to see where the main Viewer field of view (FOV) is in relation to the whole project.
See Viewer for more information about the main Viewer.

The yellow crosshair shows where the current FOV in the main Viewer is in relation to the entire
data set. Double-click in the Overview viewer to move the FOV of the main Viewer.
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There are two toolbar buttons:

Button Description

Center view on sample. Click to snap the Overview viewer FOV over all the
sample data in the project. This action moves the FOV to the center of the
sample and adjusts the zoom, so that it is visible.

Center view on selection. Click to snap the Overview viewer FOV to the currently
selected data in the Layer tree. This action moves the FOV to the Layer tree and
adjusts that zoom, so that it is visible.

There is one unique context menu selection:

Menu Selection Description

Drive Stage Here Moves and centers the stage to the selected tile (see the green cross in
the center of the grid).

Layer Control
Use the controls to view existing layer items and create, delete, reorder, select, hide, and show
layers.

Topics include:

Layer Icons

Change Layer Order

Progress of Running Layer Tasks

Annotation Context Menu

Layer Context Menu

Tile Set Context Menu

Image Context Menu

Nav-Cam Context Menu
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Multiple Layer Context Menu

l When a check box is not selected, that layer item is not shown in the viewer.
l Double-click an item in the Layer control to center it in the viewer.

Control Description

Add Layer Adds another Layer to the tree. When you have multiple layers, the selected
layer will be green and the non-selected layers will be yellow.

Add Tiles You can only create a tile set if a microscope is connected.

See Define a Tile Set for more information about adding tiles.

Template Displays the name of the active template for the connected microscope. In the
example above, it is Default Template. See Tile Set Templates for more
information about templates.

Layer Displays a list of existing tile sets, annotations (areas of interest), imported
images (aligned and unaligned), sample holder, and fiducials for each layer.

See Layer Icons for icon descriptions.

L a y e r Co n t r o l O v e r v i ew

Layer Icons

Each created layer item has a unique icon.
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Layer Control Icons

Icon Indicates the layer contains

Complete tile set registration and acquisition.

Annotations (text callouts).

Annotations are directly created in the layer selected at the time of creation.

Line measurement.

Angle measurements.

An imported image that is not yet aligned.

An imported image was aligned and stitched into this layer.

A holder outline.

Fiducial information.

L a y e r I c o n s
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Change Layer Order

Context Menu

Layers can be moved in the layer tree to change their position, depending on their Permissions.

Right-click on a layer in the layer tree (or click the ellipsis icon next to a layer) to access the
context menu for moving the layer forward or backward.

Menu Selection Description

Bring to Front Moves the layer to the front or top-most layer.

Bring Forward Moves the layer forward one layer.

Send Back Moves the layer backward one layer.

Send to Back Moves the layer to the back or bottom-most layer.

L a y e r O r d e r C o n t e x t Men u Op t i o n s

Move layers

Layers can be moved in the layer tree to change their position, depending on their Permissions.
If allowed, you can click and move a layer up or down in the layer tree (or move multiple selected
layers by pressing Ctrl+left-click before moving them). If a layer is locked, then it cannot be
moved within the layer tree.

The mouse changes when dragging a layer to show what action is available:

l When dragging a layer, the cursor changes to a cursor with a rectangle below.

l When the dragged layer cannot be placed in a location, the mouse changes to a no-entry
icon.
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l When a layer is a valid drop location, the target group highlights with a rectangle :

l When dropping a layer between another layer, a divider appears:

Permissions

The table below shows if a parent layer can accept a child layer. When working with multiple
layer selections, these permissions are applied to each layer selection.

Parent Layer

Layer
Group Annotation

Tile
Layer

Image
Layer

Child
Layer

Layer Group Yes No No No

Annotation Yes Yes Yes Yes

Tile Layer Yes No No No

Image Layer Yes Yes Yes Yes

L a y e r O r d e r P e rm i s s i o n s
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Progress of Running Layer Tasks
l Acquisition progress is reported in the Job Control.

l Registration progress is reported by hovering the mouse over the tile set symbol.

l When both Registration and Acquisition have completed, the green Tile Set icon appears.

Annotation Context Menu

Right-click on an annotation in the layer tree to access a context menu for centering and rotating
the view, driving to, and deleting.

All of these menu commands, except Drive To and Save Image to File..., are common to most
all other layer item context menus.
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Menu
Selection Description

Center View Centers the view on the annotation.

Center and
Rotate View

Pans, zooms, and digitally rotates the viewer so that the
selected annotation is centered and displayed at its natural
point of rotation.

Drive To Drives the stage to the annotation. This menu selection is
available only while Maps is running from the Microscope PC
and thus connected to the microscope.

Save Image
to File...

Saves an image from the region outlined by the annotation
(see Save image to file under Viewer). This menu selection is
only available for an area of interest annotation (see Area of
interest under Annotation Tab).

Delete Deletes the annotation.

Anno t a t i o n Con t e x t Men u Ove r v i ew

Layer Context Menu

Right-click on any Layer selection to access a context menu.
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l For descriptions of common selections to all systems, see Annotation Context Menu.

l For descriptions of Layer-specific selections, see the table below.

Menu
Selection Description

Copy Layer Copies all tile sets in the layer to a new layer.

Import Grid... Displays a standard Open window for browsing to a saved tile
grid file.

Import
Images...

Displays a standard Open window for browsing to a saved
image file from another source, such as an optical
microscope.

These images, once aligned to the stage, can provide a
navigation guide for you to find areas of interest, like the Nav-
Cam does.

See Import Images from Other Sources.

Export To
Project...

Exports to a new or existing project.

Alignment Displays alignment choices. See Magnification Alignment.

Submenu selections include:

l Align: Aligns a single tile set or image. Similar to Global
Alignment, but for a single item. See Coarse Alignment
(1-, 2-, or 3-Point).

l Fine Alignment: Use Fine Alignment to fine-tune the
alignment of layers and tile sets visually. The Fine
Alignment controls only display after clicking Next after a
1-, 2-, or 3-point alignment. See Fine Alignment for
descriptions of the controls.

l Clear Alignment: Clears any tile set alignment that has
been applied.

L a y e r Co n t e x t Men u Ove r v i ew
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Tile Set Context Menu

Right-click on any tile set to access the context menu.

l For descriptions of common selections to all systems, see Annotation Context Menu.

l For descriptions of tile set-specific selections, see the table below.

Maps 3.32.1 User Guide

70 | Original Instructions

Limited Rights

PN 1551059 Revision A | 11-Mar-2025

Maps User Interface



Menu
Selection Description

Show Grid
Lines

(Ctrl+G)

Toggles to show/hide the tile grid lines onscreen.

Save and Set
As Default
Template

After editing the defaults, saves the edits as the new default template. See
Default templates for further instructions.

Save As
Template

Displays a submenu New Template, that allows saving the current tile
layers template as a new template or overriding a previous template. See
Create custom templates for further instructions.

Copy Grid Creates a grid above the one that is copied, and incrementally numbers
the name. In this example, EMTileSet 5 is a copy of EMTileSet 4.

Export Grid... Displays a standard Save As window for browsing to a folder in which to
save the exported grid.

Grids are saved in the *.gridx format.

Export to
Project...

Copies the selected tile sets into a new or existing Maps project.

Alignment Displays a submenu of alignment choices. See Layer Context Menu for
descriptions.

Drive To Drives to the selected tile set.

Square Up Rotates the stage to match the orientation of the tile set.

T i l e S e t C o n t e x t Men u Ove r v i ew
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Menu
Selection Description

Use For
Magnification
And Scan
Rotation
Alignment

When selected, uses the offsets calculated in the acquired tile set to
correct for misalignment between the scan axes and the stage axes by
applying a small magnification and scan rotation. This will allow better
acquisition and alignment of future tile sets. To activate this menu
selection, all tiles must be successfully registered (that is, no tiles outlined
in red). You can use a tile set of any size, but it is recommended that you
use a tile set of at least (9) tiles.

Apply Settings
to Microscope

Applies all defined tile set settings to the microscope.

Apply
Microscope
Settings to Grid

Applies all microscope settings to the tile set.

Check
Magnification
and Rotation
Error

Displays the calculated error of the microscope magnification and field-of-
view rotation based on the tile registration results. To activate this menu
selection, all tiles must be successfully registered (that is, no tiles outlined
in red). You can use a tile set of any size, but it is recommended that you
use a tile set of at least (9) tiles.

Post
processing

The following menu selections are related to post-processing functions.

Stitch Stitches the entire tile set.

T i l e S e t C o n t e x t Men u Ove r v i ew (Co n t i n u e d )
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Menu
Selection Description

Tile
Registration

Launch registration on tile set. See -.

Split Channels Divides the individual channels of a tile set into separate tile sets.

Note: This operation is permanent and cannot be undone.

Create
MIP Layer

Collapses the Z-Stack into a single image using the highest intensity pixels
from the stack. This menu selection is enabled for tile layers with more
than one plane.

Mark as done Sets the selected tile set that has started acquisition, but is not yet done.
This option deactivates all the remaining non-acquired tiles and
designates the acquisition job status as complete.

Reset
Acquisition

Clears all acquired image data in the selected tile set and unlocks the
parameter fields in the Basic tab for editing.

Open Z-Stack
(SEM/SDB
only)

Opens the Z-Stack Browser to view the focus stack of the tiles. See Z-
Stack Browser Controls.

T i l e S e t C o n t e x t Men u Ove r v i ew (Co n t i n u e d )

Z-Stack Browser Controls

The Z-Stack Browser allows you to select and view individual image planes in the Z-Stack.

After acquiring a Z-Stack tile set, right-click on a single tile in the tile set and then click Open Z-
Stack in the menu that appears.
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The Z-Stack Browser appears on the right-side of the interface.

Z-Stack Browser Open with Controls on the Right

Z-Stack Browser Controls
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Interface
Item Description

Channel
Selector

Selects the channel to be displayed in the multi-channel Z-Stack. The
pulldown list contains the same choices as in the Microscope controls.

Histogram Displays the same histogram as in the Microscope controls. See Histogram.

Close Closes the Z-Stack Browser.

Plane
Selector

Selects the plane from the Z-Stack to be displayed with the channel selection.
Move the slider or use the mouse scroll wheel to step through the planes.

Current
Plane
Control:

Z -S t a c k B r ow s e r Co n t r o l s O v e r v i ew
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Interface
Item Description

Select for
Display

Selects the plane to be displayed in the main viewer after you close the Z-
Stack Browser.

Note: Only one plane can be displayed in the main viewer.

Select for
Stitching

Selects the current plane to be used for the registration step for stitching.
Choosing a plane with more image content is best.

Reset Returns to the default gamma setting.

Go To Sets the microscopes current focus to the value in the Z-Stack viewer control.

Gamma
Control

Adjusts the gamma for the live image.

Tile Set
View

Displays the selected tile (with a thick green outline) from the main viewer and
its neighboring tiles.

You can use the mouse wheel to zoom in and out.

Z -S t a c k B r ow s e r Co n t r o l s O v e r v i ew (Co n t i n u e d )
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Tile Registration

The tile registration feature allows you to re-run the registration on a previously acquired tile set.

Note: The tile set must have at least two acquired tiles.

Note: Tile registration is only allowed for tile sets with positive Overlap X and Overlap
Y properties.

1. Right-click the layer and then click Tile Registration.

2. If the tile set has more than one channel defined, then you must Select a channel for which
perform registration.

3. Select a stitching profile with which the processing will use during registration.

4. Click Queue Job.

5. A registration job processes the tile set.

Image Context Menu

Images are directly stored in the selected layer. Right-click on an image to access its context
menu.

Note: This menu is only available on SEM/SDB.
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l For descriptions of common selections to all systems, see Annotation Context Menu.

l For descriptions of image-specific selections, see the table below.

Menu Selection Description

Export to Project... Copies the data to a new or existing project.

Save Image to File... Saves the image to disk as a TIFF image.

I m a g e Con t e x t Men u Ove r v i ew

Nav-Cam Context Menu

The Nav-Cam image is stored in the selected layer. Right-click on a Nav-Cam entry to access a
context menu.

Note: This menu is only available on SEM/SDB.
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This only applies to SEM/SDB systems (see SEM Nav-Cam Context Menu).

Multiple Layer Context Menu

This menu is only available when multiple layers are selected.

Note: This menu is only available on SEM/SDB.
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Menu
Selection Description

Merge
Channels

Merges the selected image layers together by combining all their channels
together and creates one resulting image layer. This requires all selected
layers to be image layers and have the same resolution, the same number of
z planes, and the same time frames.

This only applies to SEM/SDB systems (see SEM Nav-Cam Context Menu).
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Job Control
This topic describes the Job Control.

Summary toolbar

The summary toolbar is always visible in the user interface by default. Once a job is queued, the
Run button becomes available in the summary toolbar.

When a job is running, the summary toolbar displays the status of the current job.

l Progress Bar: This indicates the progress of an individual job (tile set acquisition, post
processing, etc.).

l Remaining Time: This indicates the time required to complete all selected jobs.

Limited Rights

PN 1551059 Revision A | 11-Mar-2025

Maps 3.32.1 User Guide

81 | Original Instructions

Maps User Interface



Job Control panel

Use the Job Control panel to manage all of your queued jobs, including microscope acquisition
jobs and data processing jobs. This panel contains an Acquisition tab for your microscope
acquisition jobs and a Processing tab for your data processing jobs. Click the up arrow next to
Job Control on the summary toolbar to open the Job Control panel.

Note: To close the Job Control panel, click the user interface anywhere outside the
control panel.

Microscope acquisition jobs

The Acquisition tab displays the current status and progress of the queued jobs related to
microscope acquisition. Refer to the Acquisition Tab Overview table below for descriptions of
each control within the Job Control panel.

Run queued microscope acquisition jobs

Click Run in the summary toolbar to begin job execution for the microscope acquisition jobs.
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Stop running microscope acquisition jobs

Click Stop in the summary toolbar at any time during job execution to stop running the
microscope acquisition jobs.
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Control Description

Deselect All Deselects all jobs for processing.

Select All Selects all jobs for processing.

Show
completed
jobs

Displays completed jobs.

Acq u i s i t i o n T a b Ove r v i ew
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Control Description

Job list items Each job row lists:
l Job name
l Job progression
l Time estimation if job has not started. If estimation is not provided by job,
'--:--:--' is displayed instead.

l Time remaining for job in progress. The value calculation is based on
previous progress and appears after the job is started and the estimation
is ready.

Jobs are listed in the order they will be processed. Select the check box to
the right of a job to add it to the processing queue. For non-running jobs, you
can click and drag the job rows to reorder them. You can also use the
Context Menu to reorder them.

Estimation
disk space

Displays estimation disk space needed to complete all selected jobs and the
available disk space. The field turns red if there is not enough space for the
jobs.

Estimation
time

Displays total estimation time needed to complete all selected jobs. The field
displays '--:--:--' if there is no estimation provided by selected jobs.

Post
acquisition

Post-acquisition actions are listed in this section. If selected, actions are
performed after acquisition.
For system-specific action, see:

TEM Post-Acquisition Actions
SEM/SDB Post-Acquisition Actions 

Post
processing

Post-processing actions are listed in this section. If selected, actions are
performed after processing.

Stitch Tile
Sets When
Done

Automatically adds a stitching job to the end of the Processing queue for
each completed acquisition job.

Acq u i s i t i o n T a b Ove r v i ew (Co n t i n u e d )
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Data processing jobs

The Processing tab displays the current status and progress of the queued jobs related to data
processing such as stitching, registration, or maximum intensity projection creation. Since these
jobs do not require the use of the microscope, they can run in parallel to the microscope
acquisition jobs. The Processing tab has the same functionality as the Acquisition tab described
in the Acquisition Tab Overview table, however, the Processing tab contains its own run and
stop buttons.

Run data processing jobs

Click RUN PROCESSING in the summary toolbar to begin job execution for the data
processing jobs.
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Stop running data processing jobs

Click STOP PROCESSING in the summary toolbar at any time during job execution to stop
running the data processing jobs.

Control Description

RUN PROCESSING Starts execution of the data processing job. This button is
available if any data processing jobs are queued, but the queue
is not running.

STOP PROCESSING Stops the execution of the data processing jobs. This button is
available only if the queue is running.

P r o c e s s i n g T a b Ove r v i ew
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Control Description

Spinner icon The spinner icon is located next to the Run button in the
summary toolbar. This icon appears and animates while the
data processing queue is running to indicate that background
work is active. You can click the spinner icon to open the
Processing tab whenever this tab is closed and the spinner icon
is present within the summary toolbar.

P r o c e s s i n g T a b Ove r v i ew (Co n t i n u e d )

Context Menu

For non-running jobs, you can right-click on any job row to open the context menu and change
the processing order.

l Bring To Front: Moves the selected job to the front of the queue. The job is processed as the
first one.

l Bring Forward: Moves the selected job forward in the queue.
l Send Back: Moves the selected job backward in the queue.
l Send To Back: Moves the selected job to the back of the queue. The job is processed as the
last one.

Job processing issues

When a job processes, you might encounter the following error and warning messages to
indicate that there are processing issues.
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l Error: This message indicates that the job execution is blocked, but it is not preventing
other jobs from running.

l Warning: This message indicates that job execution needs attention, but it is not blocked.

You can also view the error and warning messages in the summary toolbar next to the job
status.
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Messages are displayed according to the following strategy:

l Errors have priority over warnings.
l If more than one error (or warning) occurs during the same job, then the most recent job
processing issue is displayed first.

l A job processing issue related to an unscheduled job is not displayed.
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Viewer
This topic describes the Viewer in the Maps user interface.

Topics in this section include:

Tile Set Grid Color Key

Alt +Left-Click and Drag Selected Area

Save image to file

Viewer tile context menu

This example shows a 4 x 4 tile set grid.

l Double yellow lines indicate the overlap between tiles.

l The purple FOV (field of view) rectangle displays the HFW (horizontal field width).

Note: The coloring and labels of the FOV rectangle may change depending on
the context.

l The scale bar (not shown) in the bottom right corner shows the distance (for example, in
microns) in relation to the current magnification of the displayed image.

l The Delete key works in Maps for any selected item. You will receive a Confirmation
request.
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Tile Set Grid Color Key
l Yellow = Unacquired tiles. Visually indicates the tile overlap.
l Grey = Tiles that have been disabled; they will not be acquired
l Lime Green = Acquired tiles that are awaiting registration
l No outline = Acquired tiles that have been successfully registered
l Red = Acquired; but these tiles failed registration and will require manual alignment (see
Manual Alignment)

l Bright Red = Edges of groups of red tiles are highlighted with a brighter red, to show where
the actual break in the connection is. Often, fixing a bright red connection (via Manual
Alignment) will allow previously red tiles to become successful.

Alt +Left-Click and Drag Selected Area

Alt+left-click and drag a rectangle in the viewer to create a selected area. A menu appears with
selections for that area.

Maps 3.32.1 User Guide

92 | Original Instructions

Limited Rights

PN 1551059 Revision A | 11-Mar-2025

Maps User Interface



Menu
Selection Description

Zoom to
selection

Zooms the field of view to the selected area.

Add tiles Places a new tile set in the selected area, using the Active Template.

Add area of
interest

Places a new Annotation layer in the Layer control.

An area of interested is used to highlight regions of the sample. It can be
named, notes captured, color selected, and it can also be an ellipse.

Save image
to file

Saves an image to file (see Save image to filebelow).

V i ewe r S e l e c t e d A r e a Ov e r v i ew
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Menu
Selection Description

Stitch
selection

Stitches a subset of tiles, as defined by the rectangle area of interest (see
Stitching below). This menu selection is deactivated and not available if a tile
set is not selected.

V i ewe r S e l e c t e d A r e a Ov e r v i ew (Co n t i n u e d )

Save image to file

When you use Alt+left-click and drag to create a new tile set, the menu selection Save image to
file appears.
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1. Click Save image to file. The Save Selection Options screen appears.

2. Either enter a desired resolution into the Image Size or Pixel Size field, or click the Use full
resolution button to set the exported image width to the native pixel size.

Note: Full resolution exports for large selections of high-resolution data are not
available for all image types.

3. Select the Add scale bar check box to place the viewer scale bar on the exported image.

4. Click the browse button (...) to display the browser window.

5. File type options include TIFF Image and Tiled TIFF Image. Select a file type, file name, and
location and then click OK.

6. There are limitations for the TIFF file type. If TIFF is desired, but the resolution of the
selected area is too large for TIFF export, a warning appears. Click Shrink for Tiff and the
exported image width in pixels is automatically reduced to the maximum resolution for TIFF
export.
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7. To save large resolution images, use the Tiled TIFF format.

Note: Not all image processing software supports the Tiled TIFF format. We
recommend that you use the TIFF format to ensure compatibility with external
image processing packages.

8. The Save Selection Options window is still open. Click OK to close it.
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Viewer tile context menu

Right-click on a tile within the tile grid to access a context menu. Alternatively, you can select the
small menu button on the side of the selected tile to have the tile-specific menu appear.

The menu items outlined in purple below are system-specific; whereas, all other menu items are
common to SEM/SDB and TEM systems. See the Common Viewer Tile Context Menu Overview
table for descriptions of the common menu items, which includes common items in the main
menu and associated submenus. For system-specific menu selections outlined in purple, click
the following links.

l SEM/SDB Viewer Tile Context Menu
l TEM Viewer Tile Context Menu
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Viewer Tile Context Menu for SEM/SDB

Viewer Tile Context Menu for TEM
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Menu
Selection Description

Drive Stage
Here

Moves and centers the stage to the selected tile (see the green cross).

Snapshot
Here

Acquires a snapshot image centered on this stage location at the current
horizontal field width.

Add Tiles
Here

Adds a new Tile Grid centered on the clicked location.

Add Site of
Interest

Displays a New Annotation dialog box for creating the Site of Interest (SOI).
An SOI is a specific stage location used to mark sample features.

Z: Stage Z and T: Alpha Tilt can optionally be stored to be recalled later.

The new SOI is created is the currently selected layer group.

Note: This is different from the New Annotation dialog box for
creating an Area of Interest, which marks an area of the stage.

Clear Digital
Rotation

Resets the digital rotation to 0 degrees if rotation had previously been
applied. This only changes the displayed rotation of the images and does not
rotate the microscope stage.

Tile Set
submenu

Tile Set Displays the name of the selected tile set. Examples include: Tile Set, Tile
Set (2), and Tile Set (3).

Open Z-
stack

Opens the Z-Stack Browser to view the focus stack of the tiles. See Z-Stack
Browser Controls.

Stitch Initiates stitching for this tile set. See Stitching.

Common V i ewe r T i l e C o n t e x t Men u Ove r v i ew
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Menu
Selection Description

Snap to
stage
position

Moves the clicked position on the tile layer to the current stage position.

Preview
Corners

This item is only available in the Tile Set submenu before acquisition. After
running Preview Corners, preview images appear in the corners of the tile
set.

Common V i ewe r T i l e C o n t e x t Men u Ove r v i ew (Co n t i n u e d )
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Menu
Selection Description

Preview
Edges

This item is only available in the Tile Set submenu before acquisition. After
running Preview Edges, preview images appear in center of each edge of the
tile set.

Tile X, Y Displays the row (X) and column (Y) number for the selected tile.

Tile
submenu
selections

Tile Displays the name of the selected tile. Examples include: Tile 1,1 and Tile
1,3.

Open tile
image folder

If activated, opens File Explorer to the directory that contains the tile image
data.

Open source
image

If activated, opens the tile’s source image file with the default image viewer
(Windows Picture Viewer).

Open
analytics
data folder

If activated, opens the tile's analytics data folder that contains the metadata
files from Velox.

Common V i ewe r T i l e C o n t e x t Men u Ove r v i ew (Co n t i n u e d )
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Rotation Control in the Viewer
Grab the lollipop-looking control with the mouse to easily rotate tile layers (not for TEM) and
annotation layers.

Micron Bar
The micron (scale) bar scales to the magnification.
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Basic Operations
This section describes the basic process flow for Maps.

Topics include:

Launch the application

Application Window

Create a Project

Setting Options

Define a Tile Set

Tile Set Templates

Acquire a Tile Set

Import Images from Other Sources

Stage Navigation

Stitching
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Launch the application

Click the desktop icon , or use the Windows Start menu to launch the Maps application.

When the End User License Agreement dialog opens, do the following:

1. Read the entire end user license agreement by using the vertical scroll bar as you read.

2. When finished reading the end user license agreement, click I have read the EULA Terms
and Conditions.

3. If you are authorized to accept the license agreement terms and conditions, then click I
confirm that I am authorized on behalf of the licensee of the software to and hereby
accept the EULA Terms and Conditions.

4. If you do not want the Maps application to anonymously track usage and send the data back
to the Maps team, then deselect the Allow usage tracking checkbox.

5. If you agree with the end user license agreement terms and conditions, then click I Accept to
proceed with the Maps application. If, however, you do not agree with the end user license
agreement terms and conditions, then click I Decline to close the End User License
Agreement dialog.
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Application Window
The application window appears with the Project History window open.

Select a display mode from the icons below the New button:

l Thumb View: Displays thumbnail images of project data.

l List View: Displays a list of project data.
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New Project

If this is your first project, then the list/thumb view will be empty and the Open Project button will
be unavailable. Click Newand proceed to Create a Project.

Import a Project

To import a project that was created on another system and does not appear in the project list,
click Import Project. The project opens and its name is added to the project history list. See
Import a Project.

Open a Project

To open an existing project, highlight a project name in the list and click Open Project and then
proceed to Open a Project.

Yellow Exclamation Mark in Project List

This symbol appears if the project path is not found for that data, due to a disconnected network
drive, USB drive, or other drive.

Refresh

Updates the status of any disconnected projects that have been reconnected properly.

Quit Maps/Cancel
l If you have not opened a project yet, then you can directly quit Maps by clicking Quit Maps.
l If a project is already opened, then this button is replaced by a Cancel button that allows you
to close the Project History window.
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Create a Project
Create a new project, import a project, or open an existing project using File menu selections or
Project History buttons.

New Project
1. To create a new project, click File > New Project.

Alternatively, click File > Open Project and then click New within the Project History
window.
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2. When the New Project screen appears, enter the new into the Project Name field, enter a
brief description into the Project Description field, select a holder from the Sample Holder
dropdown menu, and then click Create.

3. The default data directory is used unless you browse to a new location.

4. The new project name appears in the title of the Layer control panel and the Layer control
shows a default Layer.
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5. The purple rectangle represents the current field of view on the sample and the purple + is
the current stage position.
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6. The white outline shows the stage boundaries, which can be circular or rectangular shaped
depending on the instrument.
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Open a Project

To select an existing project, select File > Open Project .

The Project History window appears, showing all existing projects. See the list of options below
to locate, open, and search for a project.
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Note: The padlock located near the project title indicates that the current project
cannot be opened because it is being used by the current instance or another Maps
instance. The exclamation icon and a gray project title in italics indicates that the
current project is not available (on a removable device).

l To open an existing project, double-click the thumbnail of the desired project and then click
OPEN.

l To open the selected project in a new Maps Offline Viewer instance, double-click the
thumbnail of the desired project and then click OPEN IN OFFLINE VIEWER.

l To search for an existing project, enter a project name or project description into the search
bar and then click the Search icon.
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l Click the down arrow menu of the selected project to view two submenus: Open Project
Folder and Remove Project...

l Click REFRESH to refresh the status of the project list (for example, Project not found).

l Click the List View icon to switch to a list view of projects.

l Right-click a project name in the list view to access the submenu for opening a project folder
and removing a project.
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Import a Project

Importing a project is useful for passing projects between computers. Once imported, you can
select it as an existing project.

1. To import (save) an existing project, select File > Import Project.

Alternatively, click File > Import Project and then click Import within the Project History
window.
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2. Browse to a Source directory. Name the project to be exported and then click Import.

3. The imported project opens and the file name is added to the project history list.
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Unsupported Project version of Converting From Maps 1.1 or 2.0
Software

Only projects of Maps version 2.5 or higher can be imported.The import process is only one-
way. Older software projects must be converted. When a project is imported from Maps v1.1 and
2.0, a warning is displayed telling the user that the import is one-way and the project will no
longer be compatible with v1.1 and 2.0.

If you atttempt to import older projects, following dialog will be displayed:

You are prompted to browse to a default location for storing project data.

We recommend that you do not use the C: drive, but you can use a supplemental data storage
device such as a network drive, external USB drive, or additional internal hard drive.
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Setting Options
Select new project defaults from the Options menu.

Application Settings

TileSet Templates

Default Autofunctions Templates (TEM Only)

Microscope Settings

Snapshot Settings (SEM/SDB Only)

SnapShot Settings (TEM Only)

Animate Pan & Zoom

Nav-Cam Alignment (SEM/SDB Only)

Running the Automated Holder Alignment (SEM/SDB Only)

Application Settings

Click Options > Application Settings to display a window for setting defaults. See Options menu
for descriptions of the controls.

TileSet Templates

Click Options > TileSet Templates to display a dialog that shows a collection of templates and
their respective settings. These settings are system specific:

l SEM/SDB Tile Set Tab
l TEM Tile Set Tab

Default Autofunctions Templates (TEM Only)

Click Options > Default Autofunctions Templates to display a dialog that shows a collection of
templates and their respective settings. These settings are system and mode specific:

l TEM Default Autofunction Templates

Microscope Settings

Click Options > Microscope Settings to display the Microscope Settings window.
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These are settings system-specific:

l SEM/SDB Options Menu
l TEM Options Menu

Snapshot Settings (SEM/SDB Only)

Click Options > Snapshot Settings to display the Microscope Settings window. See SEM/SDB
Options Menu.

SnapShot Settings (TEM Only)

Click Options > Snapshot Settings to display the Snapshot Settings Window. See TEM
Options Menu.

Animate Pan & Zoom

Click Options > Animate Pan & Zoom to allow a smoother transition of panning and zooming.

l Pan: To make a sweeping movement
l Zoom: To simulate movement rapidly away from or toward a subject using a zoom lens

Note: This is a slower process and takes more memory.

Nav-Cam Alignment (SEM/SDB Only)

See SEM Nav-Cam Alignment

Running the Automated Holder Alignment (SEM/SDB Only)

See Automated Holder Alignment.

Maps 3.32.1 User Guide

118 | Original Instructions

Limited Rights

PN 1551059 Revision A | 11-Mar-2025

Basic Operations



Define a Tile Set
This section describes how to define tile sets. Refer to Tile Set Templates to learn how to
change default template settings.

Topics include:

Methods

Define a Circular Tile Set

Define a Freehand Tile Set

Stamp a Tile Set

Manually Adjust Tile Sets

Tile Set Display with Grid

Configure Tiling Parameters

Methods

Define the tile set for your project using one of the three methods below:
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l Click the Add Tiles button on the Layer control.

l Press Alt+click and drag a rectangle in the Viewer, and then click Add Tiles in the menu.

l Click the Add Tile Set button in the tool bar, then click and drag an area in the viewer.

Maps creates a layer in the Layer control, depending on the type of microscope connected. You
cannot create a tile set when not connected to a microscope.

The new name is added to the list of tile sets beneath Layer in the Layer control. The Tile Set tab
displays default parameters, and a grid (green square) is centered on the stage location.
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Define a Circular Tile Set

Click the Add Circular Tile Set icon on the tool bar, then click and drag an area in the viewer to
create the tile set.

Example

Define a Freehand Tile Set

Click the Add Freehand Tile Set icon on the tool bar, then click and drag an area in the viewer to
create the tile set.
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Example

Stamp a Tile Set

Go to the toolbar and click Stamp Tile Set to enter the stamp tile set mode. While in this mode,
Maps creates a new tile set after each time you single-click in the Viewer. Maps creates tile sets
using the active template, and it draws a tile set outline on the cursor location if it can determine
the tile set size. To quit the stamp mode, either press Esc, right-click in the Viewer or select
another tool from the toolbar.
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Manually Adjust Tile Sets

Once a tile set is created, you can adjust the size of the tile set with the drag handles in the
viewer.

When a tile set is selected, its outline turns green and drag handles appear as small circles in
the corners and on the sides of the tile set border.

Click and drag within the tile set region to reposition it. This can be performed on multiple tile
sets at once by pressing Ctrl+left-clicking each tile set to multiselect them.

Click and drag the handles to perform resizing actions on the tile set. While dragging, you will
see the adjustment result in a light blue border as shown below.
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The screenshots below show resizing in process. The original border is green. The new border
is light blue. The purple arrows show the direction that the border is dragged.

To rotate the tile set, click and drag on the small rotation control located on the side of the tile
set. This can be performed on multiple tile sets at once by pressing Ctrl+left-clicking each tile
set to multiselect them. This control is only visible for tile sets on systems that support rotation.
See Rotation Control in the Viewer.

Maps 3.32.1 User Guide

124 | Original Instructions

Limited Rights

PN 1551059 Revision A | 11-Mar-2025

Basic Operations



Tile Set Display with Grid

Two views are shown below. They look different in STEM Mode.

SEM/SDB View

TEM View
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Configure Tiling Parameters
l Change the default tiling parameters to customize the grid for the data you will be acquiring.
l Modify the imaging parameters and resize the grid for the level of detail and size you need.

Tile Set Templates
Tile set templates are a set of pre-defined microscope settings designed to make your workflow
more efficient. You can use the factory template, or create custom templates to match your use
cases.

Template terms

Here is some terminology to help you understand tile set templates.

Template: A set of tile set settings that are applied to a newly-created tile set to help create
defined tile sets more efficiently.

Custom template: A template created by a user.

Active template: The template that will be used when creating a tile set. To change the active
template , click the Template list and then click the template you want to use. The example
below shows a TEM with the factory template and one custom template.

You can see your more details about your templates under Settings > Tile Set Templates.

Default template: A template that will be set as the active template when the Maps software is
launched. The default template is initially set to the factory template until changed. Any template
can be set as the default template in the ! window.

Factory template: A pre-defined, immutable template that comes with the Maps Software.
There is one factory template per microscope mode.
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Templates on SEM

On a SEM tool, a tile set template will have the properties shown below saved and applied when
used. This screen capture shows three templates: two factory templates and one custom
template. The factory template is set as the default template.

SEM Tile Set Templates screen
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Templates on Phenom

On a Phenom tool, a tile set template will have the properties shown below saved and applied
when used. This screen capture shows two templates: one factory template and one custom
template. The factory template is set as the default template.

Phenom Tile Set Templates screen
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Templates on TEM

On a TEM, only the settings shown in the Tile Set Templates screen are saved in Factory
Template (TEM).

TEM Tile Set Templates screen
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On a TEM, custom templates are also read-only after you set them up. You are prompted to
define the settings you want when creating the template.

Tasks associated with tile set templates include:

Default templates

Depending on what type of system you are using, you can either update settings in the Default
Template or choose a custom template to be the new default.
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Save new Default Template settings

This procedure works on all tool types. It overrides the Default Template settings.

1. Create a tile set with the settings you want in the new default tile set template. See Define a
Tile Set.

2. Right-click on the tile set and then click Save and Set As Default Template.

Change Default Template

You can only directly edit the Default Template in SEM) but not in TEM. However, you can
change the settings that Maps software uses to define default tile set templates.

Follow the steps from below.

Select a new default template
1. Create a tile set with the settings you want in the new default tile set template. See Define a

Tile Set.

2. Open the Tile Set Templates window. On the Options menu, click Tile Set Templates.

3. Click the template you want to be the new default and then click Set As Default.

The (Default) label is displayed next to the new default template.

4. Click OK.

Create custom templates

Custom templates are collections of settings that you define and can reuse when you create tile
sets.
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1. Create a tile set with the settings you want in the custom tile set template. See Define a Tile
Set.

2. Right-click the tile set. In the context menu, hover the mouse over Save as Template and
then click New Template.

3. On the New Tile Set Template window, type the Name of the new template.

4. Type the Tile Set Name. This becomes the default name of each new tile set created based
on this template.

5. (SEM only) Update fields in the Properties section to the values you want in the custom
template.

6. (SEM only) For the Tile HFW, Resolution, Dwell, and Frames fields, clear the check box if
you always want Maps software to use the value from the microscope settings for that field.

7. Click OK. Maps software saves a new template based on the tile set settings.

8. To use the new template, click the Template list and then click the template you want to use.

Edit custom templates

After you Create custom templates, you can change or edit the settings to match your needs.
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Edit a custom template (TEM)

You cannot directly edit custom templates on TEM microscopes, but you can override them.

1. Create a tile set with the settings you want in the custom tile set template. See Define a Tile
Set.

2. Right-click the tile set. In the context menu, hover your mouse over Save as Template and
then click the name of the template you want to update.

Maps software updates the tile set template settings. All new templates created with that
template use the new settings.

Edit a custom template (SEM)
1. Open the Tile Set Templates window. On the Options menu, click Tile Set Templates.

2. Click the template you want to edit.

3. Update fields in the Properties section to the values you want in the template.

l If you clear the check box next to the Tile HFW, Resolution, Dwell, or Frames fields, then
Maps software always uses the value from the microscope settings for that field.

l Click Reset to reset the template to the default settings.

4. When you are done editing settings, click OK.
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Delete custom templates

You cannot delete the template marked as (Default).

1. Open the Tile Set Templates window. On the Options menu, click Tile Set Templates.

2. Click the template that you want to delete.

3. Click the trash can icon.

Maps software deletes the template.

Import and export tile set templates

Maps software allows you to export tile set templates developed on one tool and import them
onto another.

Import tile set templates

This procedure replaces all current templates with the imported set, including the default. You
cannot recover the tile set templates replaced by the import process.

1. Obtain an XML file containing tile set templates and save it on your local machine. See
Export tile set templates for instructions.

2. Open the Tile Set Templates window. On the Options menu, click Tile Set Templates.

3. Click Import.

4. Navigate to the XML file that contains your templates and then click Open.

Maps software replaces your current custom templates and the settings in the Default
Template with the templates in the imported file.

Export tile set templates

You can export tile set templates from a Maps software installation on one tool to another. Once
exported, you can import the templates on another tool using Import tile set templates.

1. Open the Tile Set Templates window. On the Options menu, click Tile Set Templates.

2. Click Export all.

3. Navigate to the place you want to save the XML file that contains your templates and then
click Save.
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Acquire a Tile Set
When ready to begin acquisition, click Start Execution located in the status bar next to No Job.

Tile images are registered for stitching as they are acquired and displayed in the grid. The tile
sets are colored as they are registered to give immediate feedback on the stitching confidence.
See Tile Set Grid Color Key.
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Preconditions

Microscope preconditions must be met to proceed with tile set acquisition. For example, if the
microscope is not enabled or an acquisition parameter is invalid, then a validation error appears
in relation to the tile layer and you cannot start acquisition.
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Re-Adjust Acquired Tile Sets

When a tileset is acquired, you can adjust the size of the tile set with the drag handles in the
viewer. See Manually Adjust Tile Sets for instructions.

When you resize an acquired tile set in such a way that some acquired tiles will be deleted
(smaller in either dimension), you are asked to confirm the action:

l Click Delete to delete acquired tiles.
l Click Cancel to cancel the resize operation.
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Import Images from Other Sources
You can import an external image for navigation purposes to find the area of interest.

1. Right-click on a Layer in the Layer control and then click Import Images... on the context
menu that appears.

2. In the standard Open window that appears, browse to a saved image and then click Open.
Most standard image formats are supported, including BMP, JPG, GIF, PNG, and TIFF. Various
microscopy, scientific, and biological image data formats are also supported including LIF,
MRC, RAW, and LEI as well as DICOM data with DICOMDIR, DIC, DCM, and other DICOM
standard formats.

In the importing dialog that appears, you can cancel an image import or send the import to the
background.

Sending the import to the background allows you to use Maps while the import is running. When
the import is in the background, other image imports are unavailable.
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You can track the background import with the status bar import control. Click the control to
reopen the importing dialog.

The imported image is displayed to the right of the main viewer while the alignment workflow is
in progress. See Manual Alignment.
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If you imported an image with known stage position (like Nav-Cam images, SEM/SDB images),
then you are finished. Otherwise continue to the next step.

3. Align the two images with a simple one-, two-, or three-point alignment procedure: Move the
alignment points on the imported image to match the feature on the tile set image and then click
Next. See Coarse Alignment (1-, 2-, or 3-Point) for detailed information.

After clicking Finish, the viewer is restored to full size and the newly imported image is displayed
aligned to the stage. The imported image name is added to the Layers panel.
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Stage Navigation
To move the stage to a location, do the following: 

1. Double-click anywhere within the stage boundaries as shown by the white circle or square.

2. In the Overview Viewer, right-click anywhere within the stage boundaries as shown by the
white circle or square and click Drive Stage Here.
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Stitching
After a tile set with at least one tile has been acquired, the Stitch action is made available.

Initiate Stitching

Manual Alignment

Stitching Job Options

Stitching Profile Best Practices

Initiate Stitching

Stitch single tile set

Select the acquired tile set in the Layer control, and then do one of the following:

l Click Stitch in the tile set context menu.

The manual UI appears so that you can confirm the tile alignments.
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l Or, left-click and drag a rectangle around the tile sets to be stitched and then click Stitch
Selection in the stitch context menu.

Stitch selection stitches all tiles inside the rectangle for the selected tile set. Tiles that are
partially inside the rectangle are included as well. See Alt +Left-Click and Drag Selected Area.

Stitch multiple tile sets

Select the acquired tile sets in the Layer control, and then click Stitch in tile set context menu.
Note that the manual UI alignment of tiles is skipped, and the acquired tile sets will be stitched
using the default stitching options (see Stitching Job Options).

Manual Alignment

Follow the guided instructions to confirm or edit the alignment of the tiles.

Stitching Manual Alignment Histogram

Displays the histogram for the Stitching Channel.
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Stitching Manual Alignment Histogram

Interface Item Description

Channel name For SEM/SDB only: Displays the channel name, which is the detector
name.

Apply Applies changes to the histogram.

Auto When selected, continuously adjusts the min and max for the histogram
display.

Semi-log When selected, changes the histogram intensity display to logarithmic.

Current Max
position

Displays the current max slider position.

Histogram data Displays the histogram data for the selected channel.

Current Min
position

Displays the current min slider position.
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Overlap Transparency

Overlap Transparency options are available for assigning a color for the Center Tile and its
Neighbor Tiles.

Transparency is useful for seeing through the layers to line up the tiles in manual tile alignment.

Two Views

Manual stitching makes use of two views.

l The Tile Alignment View is the larger view:
l This view displays the currently selected tile and it's top, bottom, left and right neighbors.
The positions of the neighboring tiles are based on their individual registrations to the
center tile. This is not the same as the final position when stitched, which will be a result of
the optimization of all tile-to-tile registrations of the tile set.

l When manual alignment is first initiated, the first tile that failed alignment is selected and
displayed here.

l The view can be panned and zoomed in the same way as the other views. The center tile
is fixed, but you can click left-mouse+drag to move its surrounding tiles.

l The Project View is the smaller version of the standard viewer in the bottom right.
l This is a miniaturized version of the standard Maps project view.
l It can be panned, zoomed, and each tile can be selected with the mouse. When a tile is
selected, it appears as the center tile in the Tile Alignment View, and it can then be
manually aligned to it’s neighbors.
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Manual Alignment with Transparency Off

Manual Alignment with Transparency On
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Stitching Alignment Status Color Key

Each tile outline is colored to indicate stitching alignment status.

l Green: The automatic tile alignment succeeded.
l Orange: One side of the tile alignment failed, but another succeeded. These tiles do not
require manual alignment.

l Red: The tile failed to align with either neighbor, which means that there is not enough valid
registration for a tile or one of its neighboring tiles to be properly positioned in the larger
picture. Often multiple tiles can be red, but only one tile needs to be manually connected to
the green tiles to achieve alignment for all. After realignment, the outline turns blue.

Realign Failed Tiles

Use the Next and Previous buttons to jump through the list of failed tiles.

Confirm and Stitch

When manual alignment is finished, click Confirm and Stitch to begin stitching. You will be
prompted to confirm and click Yes.
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Stitching Job Options

After you click Yes to the Confirmation prompt, the Stitching Job Options screen appears.

Some options are not available for all tile sets.

Interface Item Description

Crop Image Crops the outer edges of the image to make it rectangular. Otherwise, it
will potentially have jagged edges where the tiles have been shifted.

Blend Tiles Blends the overlapped regions of the tiles together to make it appear as
one continuous image. In some rare cases, you may not want to blend
the tiles.

Always Use
Calculated
Positions

Maps uses calculated relative positions between tiles even if they are
outlined in red (that is, neighbor tiles in which Maps was not able to find a
relative position with a high enough score).

S t i t c h i n g J o b Op t i o n s O v e r v i ew

Maps 3.32.1 User Guide

148 | Original Instructions

Limited Rights

PN 1551059 Revision A | 11-Mar-2025

Basic Operations



Interface Item Description

Tile-to-Tile
Contrast
Normalization
(Experimental)

Removes differences in brightness and contrast between tiles in the
stitched tile set. The example shows the standard output in the left image
and the normalized stitched output in the right image.

Stitch to Project Stitches the tile set into the project for display in the Viewer. The stitched
output appears as a new layer in the Layer control.

When you select this option, the field for Destination file name is not
available.

Selecting Stitch to Project will not export the stitched output. The
stitched image will only appear in the Maps project. For data export, use
the Stitch to File feature.

Stitch to File Stitches the tile set into an image and exports the file to the specified
folder location. The output file is formatted as either RAW or TIFF in the
Destination File name field and then stored in the folder. The default
folder location is the current project’s data folder and the default
file format is TIFF. When stitching to the TIFF image format, the image
size limit is adjusted based on the following image bit depth:

l 8-bit grayscale: 2 gigapixel, or about 46,340 pixels square
l 16-bit grayscale: 1 gigapixel, or about 32,767 pixels square

Destination File
Name

Specifies the path and file name for the stitched project.

S t i t c h i n g J o b Op t i o n s O v e r v i ew (Co n t i n u e d )
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Interface Item Description

Specify output
image width

Determines the resolution of the stitched image. Enter the desired
stitched output width in the pixels field. When not selected, stitches to full
resolution.

Add scale bar When selected, a scale bar is burned into the final image. This option is
not available for RAW image format.

Set as Default Current settings are stored and used as default values for all stitching
jobs once you click Set as Default. You can edit the default stitching
settings under Main menu > Options > Settings > Stitching.

OK Click OK to accept the default stitching job options and begin the
stitching process.

Cancel Closes the window.
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Stitching settings

To edit the default settings for stitching jobs, navigate to the Stitching tab located under Main
menu > Options > Settings > Stitching.
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Settings Item Description

Stitching Profile Displays a list of stitching profiles.

Choices include:

l Default: The settings in this profile are intended for stitching a broad
range of samples. In general, it is recommended that you start with
this profile.

l Natural Structures: This profile is intended for life science or geology
samples. The main difference between this profile and the default
profile is that this profile has more tolerance in its assessment of
alignment validity. Use this profile if the default settings mark too
many tiles as invalid while the alignment is okay.

l Repetitive Structures: This profile is intended for stitching of
electronic devices, wafers, or repetitive structures. These settings
force the algorithm to be more sensitive to edges and the algorithm
uses a different method of assessing alignment validity (that is, since
repetitive structures may mislead the image recognition algorithms).

l No Stitching: The profile will not attempt to align the images. This
option prevents any kind of stitching. Use this option to save CPU
resources when stitching is not desired, or if stitching will be done by
another application.

See Stitching Profile Best Practices.

Align stitched
data to stage

For data stitched to project, the final image is aligned to the stage for
more accurate measurements and navigation.

Crop stitched
image

See Crop Image in the above table.

S t i t c h i n g Se t t i n g s O v e r v i ew
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Settings Item Description

Blend stitched
tiles

See Blend Tiles in the above table.

Tile-to-Tile
Contrast
Normalization
(Experimental)

See Tile-to-Tile Contrast Normalization (Experimental) in the above
table.

Always Use
Calculated
Positions

See Always Use Calculated Positions in the above table.

Stitch to Project See Stitch to Project in the above table.

Stitch to File See Stitch to File in the above table.

Specify output
image width

See Specify output image width in the above table.

Add scale bar See Add scale bar in the above table.

S t i t c h i n g Se t t i n g s O v e r v i ew (Co n t i n u e d )

Troubleshoot: Contrast gradients in stitched images

Sometimes uneven illumination results in contrast gradients in stitched images. Individual tiles
might appear even, but the stitched image shows contrast gradients (shadow squares). The
image below is an example of this issue.
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Solutions

l To remove the illumination gradients, use the Tile-to-Tile Contrast Normalization
(Experimental) option.

l To resolve this issue on the TEM system, contact your Thermo Fisher Scientific application
engineer and request the procedure.

Stitching Profile Best Practices
l Start with the Default profile and only change it if the default settings are not working well
enough.

l Before starting a large job, to do a few small runs (e.g., 4 x 4 tiles) and visually inspect the
result to find out what the best profile and acquisition settings are. Then use the same
acquisition setting on the small runs as on the large run.

l If neither profile gives satisfactory results, try to improve the image quality via the acquisition
settings; high quality image data has better chance to be successfully stitched. On SEM,
consider using larger dwell times as higher image quality may reveal small features that
facilitate image recognition

l If the image data is highly repetitive or very sparse, use a tile size such that there are enough
distinct features present in each tile.
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l When the success rate of the alignment is not sufficient, try to look at it from an image
recognition point-of-view: the algorithm looks at the pixel data in the overlapping border
regions; if there are not enough distinct features in that area, the alignment is very difficult.
Also think about ambiguity. For example, if the overlapping area only contains a horizontal
line, the vertical alignment is trivial but horizontally any position is a valid solution. The tile
size, overlap, or the image resolution may need to be increased in order to get data that
aligns well.

l On SEM/SDB, recommended overlap for systems with a mechanical stage (for example,
Quanta FEG):

l HFW > 50 µm overlap: 10%
l HFW 20–50 µm overlap: 15%
l HFW < 20 µm overlap: 20%

If stitching is still unsuccessful, consider increasing the overlap even more.

l On TEM, recommended overlap:
l Low Magnification: 20%
l Magnification 3000x–50000x: 10%–15%
l Magnification > 50000: 15%–20%

Note: The amount of required overlap is strongly related to how well the system is
aligned.

Limited Rights

PN 1551059 Revision A | 11-Mar-2025

Maps 3.32.1 User Guide

155 | Original Instructions

Basic Operations



SEM/SDB
This section describes user interface elements and procedures that are specific to the SEM/SDB
(Small DualBeam) systems.

Topics include:

SEM User Interface Elements

SEM Analytics

Cryo

Maps Min

Maps XPS

Rotational Alignment

SEM and SDB Scan Rotation

Stage Rotation

Set sample tilt

SEM Nav-Cam Alignment
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SEM User Interface Elements

SEMMicroscope Menu

The Microscope menu only appears for SEM/SDB systems.

Menu
Selection Description

Take
Snapshot

Acquires a SEM image at the current stage position and HFW and places it
on the Maps viewer as a snapshot. The HFW can be changed from the
SEM/SDB Tile Set Tab.

Import from
NavCam...

Not available while under vacuum if the door mounted Nav-Cam is installed..
Acquires and imports a Nav-Cam image, if the Nav-Cam is available. This
top down image of the stage can be used for point and click navigation of the
sample. See SEM Nav-Cam Alignment.

Get Image
from XTUI...

Imports a SEM image or ColorSEM image (as a single color image), currently
displayed in the xT UI without reacquiring the image and places it on the
Maps Viewer as a snapshot.

Set Sample
Tilt

Unlinks the stage and stores the current sample tilt to the current tilt of the
microscope. When the sample tilt is set, there will be a check mark next to
this option and the stage tilt that was set. See Set sample tilt for instructions.

Note: Setting sample tilt makes the linked focus unavailable.

Map s M i c r o s c o p e Menu Ove r v i ew

Limited Rights

PN 1551059 Revision A | 11-Mar-2025

Maps 3.32.1 User Guide

157 | Original Instructions

SEM/SDB



Menu
Selection Description

Restore Last
Sample Tilt

After you make the Set Sample Tilt unavailable, this menu option appears.
Click Restore Last Sample Tilt to restore the last sample tilt value.

Map s M i c r o s c o p e Menu Ove r v i ew (Co n t i n u e d )
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SEM/SDB Options Menu
l For descriptions of common selections to all systems, see Options menu.

l For descriptions of SEM/SDB-specific selections outlined in purple, see the table below.
Note that microscope settings are system specific.
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Menu
Selection Description

Microscope
Settings

Application times:

l Display critical acquisition time warning: Select this check box to
enable Maps to present the critical time warning as a dialog window that
must be dismissed before proceeding. If this option is disabled, then the
warning is displayed on the Layer Definition control, but it does not
require acknowledgment.

l Critical tile acquisition time [mm:ss]: Maps displays a warning
whenever the acquisition parameters selected for a tile set, result in a
per-tile acquisition duration larger than this threshold.

Op t i o n s Menu , SEM /SDB Ove r v i ew
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Menu
Selection Description

Microscope
Settings
(continued)

Optics Settings:

l Use Degauss when changing focus: Select the check box to
automatically Degauss when changing focus during queued
acquisitions.

l Optics settle delay [ms]: Allows setting a delay (in milliseconds) before
acquisition to allow the column optics to settle. Without a delay, some
image distortion can occur.

Stage Settings:

l Stage settle delay [ms]: Allows setting a delay (in milliseconds) before
acquisition to allow the stage movement to settle. Without a delay, some
image distortion can occur.

Electron Beam Settings:
l Beam wake up time [s]: Required wait time between commanding the
beam to turn on and starting image acquisition. This period of time
ensures that the beam has enough time to provide an acceptable signal.
If this wait time is too short, then the first tile might have a weak signal
and appear black.

Magnification and Scan Rotation Alignment:

l Magnification correction (Electron): Corrects the magnification factor
for the current beam. If the correction is in use and has a value other
than zero (that is, a positive or negative value), then the Clear button
becomes available to clear the alignment value.

l Scan rotation correction (Electron): Corrects the scan rotation
alignment for the current beam. If the alignment is in use and has a value
other than zero (that is, a positive or negative value), then the Clear
button becomes available to clear the alignment value.

Nav-Cam Settings:

l Clear Nav-Cam Alignment: Clears the saved default Nav-Cam
alignment that is applied to all acquired Nav-Cam images. See SEM
Nav-Cam Alignment.

l Door-mounted: Select this check box if the system’s Nav-Cam is
mounted to the exterior of the chamber door. Do not select the check box
if there is a Nav-Cam inside the microscope's vacuum chamber.

Op t i o n s Menu , SEM /SDB Ove r v i ew (Co n t i n u e d )
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Menu
Selection Description

Snapshot
Settings

(Not available
for SEM
Offline)

Displays the Snapshot Settings window and the scan settings that will be
used to acquire preview images and snapshots.

Do Not
Change
BeamMode

When this option is selected, it prevents the Maps application from switching
the SEM into or out of UHR (immersion) mode. Setting this option to
Disabled, allows a queued tile set to automatically activate UHR mode for
image acquisition without manual user interaction in the xT UI. In most
cases, leave this option set to its default value of Enabled.

Warning: The Do Not Change BeamMode feature exists to block
the ability of Maps to perform an action with a risk of hardware
damage. The SEM should never be put into UHRmode while a
magnetic sample is loaded in the chamber, since this could
damage equipment inside the microscope. Only make this
feature unavailable if you are certain the sample is non-magnetic
and you are operating in a use case that requires Maps to
change lens modes without user intervention.

Op t i o n s Menu , SEM /SDB Ove r v i ew (Co n t i n u e d )
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Menu
Selection Description

Prefer Scan
Rotation

If there is viewer rotation when creating a new tile set, the rotation will either
be applied as stage rotation or scan rotation.

l When selected: Uses scan rotation.
l When not selected: Uses stage rotation.

Op t i o n s Menu , SEM /SDB Ove r v i ew (Co n t i n u e d )

SEM/SDB Toolbar, Right Side

See Left Side, All Systems for common selections on all systems.

Tool Bar, Right Side, SEM/SDB

Tool Description

Electron Beam
(SEM)

(Online version
only)

Selects the Electron beam for imaging.

Ion Beam (FIB)

(Online version
only)

Selects the Ion beam for imaging.

Too l b a r D e s c r i p t i o n s , SEM /SDB
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Tool Description

Import from
Nav-Cam

Not available while under vacuum if the door mounted Nav-
Cam is installed. Acquires and imports a Nav-Cam image, if
the Nav-Cam is available. This top down image of the stage
can be used for point and click navigation of the sample. See
Nav-Cam Alignment (SEM/SDB Only).

Take Snapshot Acquires a SEM image at the current stage position and
horizontal field width (HFW), and then places it in the Maps
viewer as a snapshot image. The HFW can be changed from
the Tile right-click menu selection: Snapshot Settings. See
Options menu.

Import
Fluorescence
Data

Opens dialog where fluorescence data from optical
microscope can be selected and imported to the current
Maps project.
Note: Requires Cryo features to be activated within the
Settings.

Start Workflow Opens workflow selection dialog, from where specific
alignment workflow can be started.

Too l b a r D e s c r i p t i o n s , SEM /SDB (Con t i n u e d )
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SEM/SDB Tile Set Tab

This topic describes options in the Tile Set tab for SEM systems.

Basic Tab

Control Description

Name Displays the name of the current tile set.

Acquisition Type Specifies the beam to be used for
imaging. Choices are: Electron or Ion.

Tiles X, Y Sets the number of tiles in the X and Y
directions.

T i l e S e t T a b , B a s i c T a b Ove r v i ew
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Control Description

Tile HFW Specifies the horizontal field width
(HFW) for each tile.

Total HFW Shows the total HFW for all tiles.

Resolution Specifies the image resolution. Choices
are specific to each system type.

Pixel Size Displays the physical size of a single
pixel at the current acquisition settings.
This is based on Tile HFW and
Resolution.

Dwell Specifies the amount of time the beam
dwells on each pixel when images are
acquired.

Frames Sets the number of image frames.

Image acquisition time Displays the estimated time required to
acquire a single image in the tile set.

Estimated acquisition
time

Displays the estimated remaining time
required to acquire the whole tile set.

Elapsed acquisition time Displays the actual elapsed acquisition
time.

From Microscope Applies the current microscope setting.

To Microscope Applies these settings to the
microscope.

T i l e S e t T a b , B a s i c T a b Ove r v i ew (Co n t i n u e d )

Autofunction Tab

Note: The list of available autofunctions under the Autofunction tab may differ
according to your Maps configuration and connected microscope.
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Autofunction Description

Contrast
Brightness

Optimizes the contrast and brightness of the image

Focus Focuses the electron beam to produce a sharp image (see Focus
Mode and Set interpolated focus)

Lens Alignment Performs the lens alignment procedure

Focus After Lens
Alignment

Performs another focus after lens alignment

Stigmator
Centering

Performs the stigmator centering procedure

Stigmator Compensates for any astigmatism

Focus After
Stigmator

Performs another focus after stigmation
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Autofunction Description

Final Contrast
Brightness

Performs one last contrast and brightness optimization

Final Focus Performs on last focus optimization

Set autofunctions

1. Select the autofunctions to use during acquisition.

2. If needed, click Configuration to set up a selected autofunction and then click the play button
to perform a test run of the selected autofunction.

3. In the Mode combo box, select the mode in which the autofunction should be performed.
Available modes include the following:

l None - The autofunction is not used.

l Every tile - The autofunction is run locally at every tile.

l First tile - The autofunction is run once at the first tile before the acquisition.

l Custom tile list... - The autofunction is run over specified list of tiles. Select this option to
create a new list.
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Create a custom tile list

Click Custom tile list option and the selection workflow panel opens and displays instructions to
guide you. In the viewer, select tiles where the autofunction should be performed and name the
new list. You can use the Select Nth tile option in the right panel to quickly select tiles at the
selected Nth internal. You can finish the selection with closing the workflow panel or with leaving
the autofunction tab. The new list is inserted to the mode combo box and can be re-used by
other autofunctions in this tile set. Use the edit button if you need to further edit any tile
selection.
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Advanced Autofunction Settings

Hover your mouse cursor icon over any field name for more information.
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Focus Mode

Select the Focus Mode to automatically focus before acquisition.

l AutoFocus: AutoFocus mode runs the auto focus routine at each tile before acquisition. This
can result in better focus per tile, but adds considerably more time to the acquisition.

l LegacyAutoFocus: Runs the default autofocus algorithm provided by the microscope
platform.

Focus Tab

Select the Focus Strategy to focus the electron beam to produce a sharp image.

l None: The application does not touch the focus at all. You are free to change the focus using
the xT UI during the run.

l Fixed: Uses the same focus for every tile.
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l Interpolated: Select three focus points on the sample. The focus plane is then defined by
these points. Each tile’s focus is set based on where it is located in this plane.

Set interpolated focus

1. Navigate to the first location.

2. Manually focus the image.

3. When image is in focus, click Set. The focus is retained for Point 1 and the Set checkbox is
selected.

4. Repeat steps 1–3 for Point 2 (Set) and then for Point 3 (Set). Once all three Set checkboxes
are selected, the tiles are ready to be acquired.

Note: These points are used to define a focus plane, so that all tiles use a focus as
defined by this plane. Choosing points that are at opposite ends of the sample is
important to get the best results.

Clear (unset) a focus point

To clear a focus point, simply toggle Set.

Focus Stack

Focus stacking is a technique that allows you to acquire a stack of images on differing focal
planes. The focus stack control has two states.
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State 1

The first state is used to set up an explicit top and bottom working distance for the focus stack.

Next to the Top Focus Plane and the Bottom Focus Plane field, there is a Set button that grabs
the current working distance from the XT platform position. You can change the number of
planes to acquire in the Number of Planes text box. The Stack Depth is calculated from the
setup values and the spacing between each image plane in the Plane Spacing field.

State 2

The second state of the focus stack control is the relative focus setup. This is the automatic state
of control if you are using a Fixed, Interpolated, or Auto Focus autofunction. In this state, the
focal planes are relative to focus values set from the fixed, interpolated, or auto focus.
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In the second state, you can set the Number of Planes and the Total Stack Depth. After setting
the planes and stack depth, you can see the relative top and bottom planes change. A small
notification appears at the bottom of the control pane that notifies what the focus stack is based
upon.

Control Description

Focus Stack Perform the focus stack acquisition.

Top Focus Plane The working distance for the top plane of the focus stack.

Bottom Focus Plane The working distance for the bottom plane of the focus stack.

Number of Planes The number of focus planes acquired in the focus stack.

Total Stack Depth The physical depth of the total focus stack.

Plane Spacing The physical spacing between each focus plane in the focus stack.

Fo c u s T a b Ove r v i ew
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Advanced Tab

Use the controls on this tab to set advanced tile acquisition properties for each tile set.
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Control Description

Line
Integration

Specifies the number of times each raster line is scanned and integrated to
combat certain types of drift.

Scan
Interlacing

Specifies the number of times each frame is interlaced to combat certain
types of drift.

Overlap X, Y Displays the percentage of overlap between tiles in the tile set, as well as the
pixels.

Stage X Sets the X stage location of the center of the tile grid.

Stage Y Sets the Y stage location of the center of the tile grid.

Scan
Rotation

Allows manual adjustment of scan rotation for a tile set. Either enter a value
in the edit box here or rotate the tile set in the viewer to update the scan
rotation value.

High Voltage Selects value of the high voltage setting.

Beam
Current

Selects value of the total amount of electron or ion current striking the
sample.

BeamMode Selects the electron beam lens mode.

Drift
Corrected

If selected the correction of the image drift is used when the number of
Frames is higher than 1.

16-bit image When selected, saves image as 16-bit (65K grayscale levels), else image is
saved as 8-bit (256 grayscale levels).

Stage R Sets the stage rotation where the tiles are acquired. Existing tile sets rotate
with the stage. New tile grids are created at the current rotation. Select the
check box to enable the text field to change the default rotation.

Stage T Sets the stage tilt where the tiles are acquired. Select the check box to
enable the text field to change the default tilt.

T i l e S e t T a b , A d v a n c e d T a b Ove r v i ew
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Control Description

Stage Z Sets the stage height (Z) to be stored and used for acquisition. This allows
multiple tile sets to be acquired at different heights, that is sometimes
necessary for using different detectors. If left unselected, the stage height is
not changed.

Order Determines the order in which the contained tiles are acquired. Options are:

l Raster: Left to right, then top to bottom.
l Serpentine: Alternating left to right pattern per row, running top to bottom.
l Spiral In: Iterating over tiles in a clockwise pattern starting with the outer
most tiles moving inward.

l Spiral Out: Iterating over tiles in a clockwise pattern starting with the
inner most tiles moving outward.

Maximum
Run Time

Sets the maximum time spent acquiring data for this tile set. The tile set will
run until this time limit has been reached, or if all the tiles have been
acquired. The time limit entered is only used by this tile set and the
countdown starts when this tile set starts collecting images.

Display (1-4) Select multiple displays to acquire images from multiple display channels.

Store
Detector

Selects the method for acquiring detector settings. You can set up different
tile sets with different detectors and line them up for acquisition. When
selected, a label displays the current setting.

Stitching
Display

Select the display used for stitching. Choose the display with the most detail
of the sample for best results.

T i l e S e t T a b , A d v a n c e d T a b Ove r v i ew (Co n t i n u e d )

SEM Tile Set Context Menu

Right-click on any tile set to access the context menu.
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l For descriptions of common selections to all systems, see Tile Set Context Menu.
l For descriptions of SEM/SDB-specific selections, see the two items outlined above as well
as the table below.

Menu
Selection Description

Square Up Rotates the stage to match the orientation of the tile set.

Use for
Magnification
And Scan
Rotation
Alignment

When selected, uses the offsets calculated in the acquired tile set to
correct for misalignment between the scan axes and the stage axes by
applying a small magnification and scan rotation. This will allow better
acquisition and alignment of future tile sets.

T i l e S e t R i g h t - C l i c k Men u Ove r v i ew

SEM Nav-Cam Context Menu

The Nav-Cam image is stored in the selected layer. Right-click on a Nav-Cam entry to access a
context menu.
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l For descriptions of common selections to all systems, see Annotation Context Menu.
l For descriptions of SEM/SDB-specific selections, see the table below.

Menu Selection Description

Persist Nav-Cam Alignment Keeps the current Nav-Cam alignment.

Nav -Cam R i g h t - C l i c k Men u Ove r v i ew

SEM/SDB Viewer Tile Context Menu

Right-click on a tile within the tile grid to access a context menu.
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l For common selections, see SEM/SDB Viewer Tile Context Menu.
l For SEM/SDB-specific selections, see the four items outlined above as well as the table
below.

Menu
Selection Description

Rotational
Alignment

Allows rotation of the stage to Place Point 1, Place Point 2, or Cancel.
See Rotational Alignment.

V i ewe r T i l e C o n t e x t Men u , SEM /SDB Ove r v i ew
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Menu
Selection Description

Snapshot Here
with HFW

Acquires a preview SEM image at the selected stage coordinate and
current HFW. Submenu choices:

This is the same functionality as using the Take Snapshot Image tool
box button. See Tool Bar, Right Side, SEM/SDB.

Acquire/Queue
for re-acquisition

Displays whether or not the tile has already been acquired as defined
below. You can toggle between the two tile acquisition states as needed;
however, only the selected acquisition state appears in the menu.

l Acquire: This acquisition state displays if the tile has not been
acquired. If you select the check box for this menu item, then Maps
queues the selected tile to be acquired.

l Queue for re-acquisition: This acquisition state displays if the tile
has already been acquired. If you select the check box for this menu
item, then Maps queues the selected tile to be re-acquired and
replaces the original image.

Preview Tile(s) Acquires preview images for all selected tiles. Any tiles without pertinent
image data can be disabled from image acquisition.

V i ewe r T i l e C o n t e x t Men u , SEM /SDB Ove r v i ew (Co n t i n u e d )
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Menu
Selection Description

Sub-tile Displays a submenu for selecting the number of sub-tiles to be in a mini
grid within an individual tile, using the selected number of images.

The sub-tile names are automatically added to the Layers control
(TileSet: (3,4)).

V i ewe r T i l e C o n t e x t Men u , SEM /SDB Ove r v i ew (Co n t i n u e d )

SEM/SDB Post-Acquisition Actions 

This section describes the post-acquisition actions for SEM/SBD microscopes.

Control Description

Turn Off BeamWhen
Done
(Not available for SEM
Offline)

Turns off the beam after all jobs are completed.

Po s t - A c q u i s i t i o n A c t i o n s
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Control Description

Retract Detectors when
Done
(Not available for SEM
Offline)

Retracts any insertable detectors after all jobs are completed

Sleep When Done
(Not available for SEM
Offline)

Puts the system into Sleep mode after all jobs are completed.

Pump to HiVac When
Done

Returns the microscope to HiVac mode after completing a
LowVac acquisition.

Po s t - A c q u i s i t i o n A c t i o n s (C o n t i n u e d )

SEM Analytics
With the Analytics plug-in application, the Maps software can acquire EDS data through a
software application interface on a SEM/SDB microscope. EDS is an analytical technique that
enables you to collect information about chemical composition and elemental analysis. This
section describes how you can use Maps to collect this information in large area mapping
scenarios.

Note: This plug-in is not to be confused with the Maps Min that can also acquire EDS
data on SEMmicroscopes.

Preparation for SEM Analytics

Preconditions

To run Analytics, your system must include the following components:

l EDS detector
l SEM platform with ChemiSEM support and license
l Valid Maps license with XT Online and Analytics options
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To verify that your Maps license includes the necessary options, on the Help menu, click About.

Indication that Analytics is available

If all of the preconditions are satisfied, you can observe the following in the status bar:

l Analytics button is visible
l The color indicator on the button is green

Maps 3.32.1 User Guide

184 | Original Instructions

Limited Rights

PN 1551059 Revision A | 11-Mar-2025

SEM/SDB



Analytics Workflow for SEM

Proceed with the workflow in the following order:

1. Define a Tile Set: Use the normal procedure to define a tile set, and then navigate to the tile
set section and click the Analytics tab.

2. Configure Analytics for EDS Acquisition: Once you have defined the tile set, you must
configure the parameters on the Analytics tab before you acquire the EDS tile set.

3. Acquire EDS Tile Set: When you acquire the EDS tile set, you can observe the status of the
EDS acquisition and EDS count data during acquisition.

4. View Results of EDS Acquisition: Once an Analytics tile set has finished EDS acquisition,
you can view the results in the layer tree, Visualization tab, and main Viewer.

5. Reprocess EDS Tile Set: You can reprocess the spectrum data that is saved within the tile
set for a different selection of chemical elements and EDS maps.

6. Stitch EDS Tile Set: You can stitch EDS tile set in the same way as any other tile set.

Configure Analytics for EDS Acquisition

Note: If the Analytics tab is not visible, one or more Analytics preconditions is not
satisfied. Refer to Preparation for SEM Analytics for more information.

Follow the steps below to configure the parameters on the Analytics tab.

1. Click the Analytics tab, and then select the Perform EDS Acquisition checkbox to activate
the tile set for EDS acquisition.
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2. Configure the EDS acquisition parameters.

a. Observe the Resolution of the EDS maps. Note that EDS resolution is the same as the
selected tile set resolution up to the maximum supported EDS resolution, which is 512 x 442
or 768 x 512 based on the aspect ratio of the tile set resolution.

b. Enter the Dwell time and number of Frames to achieve satisfactory EDS counts during
acquisition. Note that Acquisition Time and Frame Time are automatically computed.

c. Locate and adjust the EDS Pixel Size parameter if necessary. Note that any changes to
EDS Pixel Size parameter affect the HFW of the tile set. Adjust the Tile HFW parameter to
match the specified EDS pixel size.
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3. Locate the Elements parameter under the Analysis Parameters section of the Analytics tab.
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4. Click the ellipsis icon to open the Element Selector.

a. Select the individual elements that you want to identify during EDS acquisition by selecting
them with a mouse click.

b. Optional: Associate a specific color with each selected element by right-clicking the element
and selecting the desired color from color picker. The selected color is used for the EDS map
generated for given element. If a color is not associated with the element, the color is
automatically selected from the system palette to match the color that you typically see in the
xT UI.
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5. The acquired X-ray spectrum is processed and displayed as a color map for each selected
element. There are two types of EDS maps that are currently supported: Count Maps and
Quant Maps. To select the EDS maps associate with your specific type, do the following:

a. For Count Maps, select one or more EDS maps to be generated after acquisition by
selecting the corresponding checkbox. If you do not select any maps, then you must activate
EDS reprocessing on the tile set so that processing can occur at a later point.

b. For Quant Maps, specify the quantification parameters to be used for processing of the EDS
spectrum:

l Quantification Type: available values include Atomic Percentage and Weight
Percentage.

l Segmentation Type: available values include Object-based and Regular.

c. For each selected type of map, observe the estimated disk size necessary for storing the
maps after acquisition. If you anticipate that the estimated disk size will be exceded, consider
deselecting some elements if they are not critical for the experiment.

6. Observe that the Normalize Maps checkbox is selected by default. This option allows you to
normalize the intensity of EDS maps across the entire tile set. See Reprocess EDS Tile Set for
more details.

7. Select the Enable EDS Reprocessing checkbox to include EDS reprocessing data in the tile
set after acquisition. This allows you to reprocess the spectrum data later for a different selection
of chemical elements and EDS maps. If the data is not saved, reprocessing will not be available
for this tile set.

Note: If you select this option, the disk size estimate is displayed next to the
checkbox. Note that the exact size is not available before acquisition, so the estimate
is refreshed during EDS acquisition based on the measured data.
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Acquire EDS Tile Set

Follow the steps below to acquire the EDS tile set.

1. Follow the standard tile set acquisition procedure described in Acquire a Tile Set.

2. Observe status of the EDS acquisition in the following:

l Progress bar and remaining time in the Acquisition job queue

l Status notifications in the status bar

l Remaining time in the status bar
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3. Click the Analytics button on the status bar. A dialog will then open for you to view data about
incoming counts, tile counts, and tile set counts during the EDS acquisition.
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View Results of EDS Acquisition

Once EDS tile set has finished acquisition and processing, you can view the results in the layer
tree, Visualization tab, Analytics dialog, and main Viewer (see Layer Tree Tabs).

View results in the layer tree

In the layer tree, the tile set has a collection of layers within it that corresponds to each
processed element and SEM image. The inner layers are represented as color channels, and
are organized within Quant Maps and Count Maps groups.

1. Expand the group by clicking on the small arrow next to the group name. The layer group is
expanded to show the list of corresponding element channels.

2. Select the checkbox on the left side of the layer to toggle visibility of the element channel or
group of channels.

3. Click the colored circle on the right to change the color of the element channel.
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View results in the Visualization tab

The Visualization tab of the tile set shows the list of color channels that corresponds to each
processed element and SEM image. The channels are organized within Quant Maps and Count
Maps groups.

1. Expand the group by clicking in the group header. The group is expanded to show the list of
corresponding element channels.

2. Expand the individual element channels by clicking in the channel header. In the expanded
control, you can modify the visualization properties of the channel.
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3. Select the checkbox on the left side of the group or channel to toggle visibility of the element
channel or group of channels.

4. Click the colored circle on the right to change the color of the element channel or group of
channels.

View results in main Viewer

The overall result of the EDS acquisition is displayed in the main viewer by blending the color
maps that correspond to each processed element and SEM image. You can control what maps
are included in the blended result by toggling visibility of the element channels in the layer tree
or the Visualization tab.
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View quantification data and summary of counts in Analytics dialog

The following additional information is collected during EDS acquisition:

l Summary of incoming counts
l Quantification Data: This is included if you have selected the Quant Maps analysis on the
Analytics tab.

You can observe this additional information by following the steps below:

1. Go to the status bar and click Analytics to open the Analytics dialog.

2. Select one of the tiles within the acquired EDS tile set in the main Viewer.

3. When the Analytics dialog opens, notice the name of the selected tile set and tile coordinates
in the header of the Analytics dialog.

4. View the quantification data measured on the selected tile in the Quantification Data panel.
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5. The elements are ordered by maximum concentration on the tile set, and for each element
you can view the following: 
l Element: This displays the name and color of the element.
l Intensity gradient: The range of intensities within the Quant Maps on the selected tile set.
l White marker on the intensity gradient: This marks the highest intensity that is associated
with maximum element concentration on the selected tile.

l Maximum concentration in At% or Wt%: This percentage is the maximum concentration for
a given element measured on the selected tile. This percentage also indicates that there is
at least one pixel on some part of the selected tile with that concentration level. Note that
the unit of measurement (At% or Wt%) depends upon the selected Quantification Type on
the Analytics tab.

6. View the summary of detected counts in the EDS Counts panel of the dialog.

Reprocess EDS Tile Set

The reprocessing functionality allows you to reprocess the spectrum data that are saved within
the tile set for a different selection of chemical elements and EDS maps.

Note: EDS reprocessing must be activated for the tile set in order for this functionality
to be available. Refer to Configure Analytics for EDS Acquisition for more
information.

You can include multiple changes, as described in the sections below, within the same
reprocessing operation:

l Change the selection of elements, EDS maps, or normalization option.
l Observe that warning is displayed on the Analytics tab and the Reprocess button after each
individual change: "EDS parameters have been changed. Reprocess the tile set to reflect the
changes."

l Continue adjusting EDS parameters until you complete all intended changes.
l Click the Reprocess button to reprocess the tile set and have all changes applied to the tile
set within the same EDS reprocessing job.
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Change selection of elements

1. Locate the Elements parameter and click the ellipsis icon to open the Element Selector.

2. Observe the elements that are currently selected for EDS processing.

3. Choose new elements that you want to include in EDS reprocessing by selecting them with a
left mouse click. Remove elements that you no longer want to include in EDS reprocessing by
clicking the selected element with a left mouse click again.
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4. Optional: Change the colors that are associated with each selected element by right-clicking
on the element and choosing the desired color from color picker. You can also remove color that
was previously associated with the element by clicking the Reset button in the color picker.

Change selection and parameters of EDS maps

1. Select or deselect Count Maps and Quant Maps checkboxes to include or exclude given
type of EDS maps from EDS reprocessing.

2. For Quant Maps, you can also change Quantification Type and Segmentation Type that
should be used for EDS reprocessing.
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Normalize EDS maps

Select the Normalize Maps option to have the intensity of the EDS maps normalized across the
whole tile set during EDS reprocessing.

The following occurs during the normalization process:

l The highest concentration of each element over the entire tile set is determined.
l The intesity maps are adjusted across all tiles to make the intensity ranges for given element
relative to the global maximum concentration.

l Visually, this process ensures that the intensity values for a given element are consistent
and comparable across different tiles.

Keep or remove EDS reprocessing data

Deselect the Enable EDS Reprocessing checkbox if you no longer want to include EDS
reprocessing data in the tile set. This will save storage space necessary for the project, but you
will no longer be able to reprocess the tile set. If you deselect the option, final reprocessing will
be performed after which the EDS reprocessing data will be removed.
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Reprocess the tile set

1. Reprocess the tile set by clicking Reprocess at the bottom of the Analytics tab.

2. Observe the status of the reprocessing job in the Processing job queue.
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Stitch EDS Tile Set

You can stitch an EDS tile set in the same way as any other tile set. Intensity maps for the
selected elements are stitched during the process as well and available in the stitched result.
SEM electron image is used as the default stitching channel, and it is used to align tiles based
on the overlaps.

View structure of the stitched EDS layer

In the layer tree, the stitched EDS layer has the same structure as the original EDS tile set. The
stitched EDS layer contains a collection of layers that correspond to each processed element
and SEM image. The inner layers are represented as color channels, and these inner layers are
organized within Quant Maps and Count Maps groups.

1. Expand the group by clicking on the small arrow next to the group name. The layer group is
expanded to show the list of corresponding element channels.

2. Select the checkbox on the left side of the layer to toggle visibility of the element channel or
group of channels.

3. Click the colored circle on the right to change the color of the element channel.
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View quantification data in Analytics dialog

The stitched EDS layer also contains quantification data, if the following conditions are satisfied:

l The original tile set has Quant Maps analysis selected
l The original tile set is normalized

You can observe the quantification data by following the steps below.

1. Go to the status bar and click Analytics to open the Analytics dialog.

2. Select the stitched EDS layer in the layer tree, or select it in the main Viewer.

3. When the Analytics dialog opens, the name of your selected layer is displayed in the header
and the normalized quantification data is displayed in the Quantification Data panel.

The elements are ordered by maximum concentration in the Quantification Data panel, and
for each element you can view the following:
l Element: This displays the name and color of the element.
l Intensity gradient: The range of intensities within the Quant Maps.
l White marker on the intensity gradient: This marks the highest intensity that is associated
with the maximum element concentration in the stitched layer.

l Maximum concentration in At% or Wt%: This percentage is the maximum concentration for
a given element measured on the stitched layer. This percentage also indicates that there
is at least one pixel on some part of the sample with that concentration level. Note that the
unit of measurement (At% or Wt%) depends upon the selected Quantification Type on the
Analytics tab.
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Cryo
The Maps Cryo workflow is a collection of controls to help create a list of sites that support the
cryo lamella TEM prep workflow.

In the Cryo workflow, you can target a collection of cells on a frozen sample grid by adding a
cryo lamella site at each cell of interest.

The Maps Cryo workflow consists of the following tasks:

1. (optional) Import and view fluorescence data.

2. Set sample tilt to make the cryo sample perpendicular to electron beam for imaging.

This procedure is required for the Cryo workflow because the cryo samples are on holders
that are tilted. To image the sample correctly with the Maps software, the sample must be
perpendicular to the electron beam at all times.

3. Add lamella sites.

4. Calculate the eucentric position of lamella sites.

5. Determine cryo milling position.

6. Perform GIS deposition. When you have a collection of lamella sites fully setup and ready for
milling, you must then perform a GIS deposition on the sample to prepare the sample for
milling.

GIS deposition is performed after setting up the sites because it is hard to see cells of
interest with a layer of a deposited substance covering them.

After you complete the workflow, you can analyze the milled-in-place lamellae in a TEM.
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Configure Cryo settings

The Cryo settings allow you to activate the Cryo features and then select from the options
described below.

Turn on Cryo features
1. Navigate to the Cryo Settings tab. On the Options menu, click Settings and then click the

Cryo tab.

2. Click Enable Cryo to activate the Cryo features. The Maps application alerts you if a system
restart is required to proceed. When the Maps software is in Cryo mode, then all the Cryo
controls are available.
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Choose a directory to watch

This option can speed up attaching files to selected lamella sites within Maps software. You can
set this to the directory where xT saves images. When files are added to that directory and a
lamella site is selected in the Maps software, you are prompted to attach the files to the selected
lamella site timeline. See Cryo lamella timeline for more about the timeline.

1. Navigate to the Cryo Settings tab. On the Options menu, click Settings and then click the
Cryo tab.

2. Select Watch Directory and then browse to a folder to choose a directory for Maps software
to watch for new files.

Choose a lamella site color
1. Navigate to the Cryo Settings tab. On the Options menu, click Settings and then click the

Cryo tab.

2. Click the eye dropper to choose the initial color used for a lamella site in the viewer when it is
created.

Choose a default import directory for fluorescence data

The Leica Microsystems' Application Suite X (LAS X) software can export fluorescence data
specifically for importation into the Maps software. The fluorescence data is a collection of
images and a special XML file with "{CLEM_Positions_TFS}" in its name within the same
directory. If you use this feature, then you can choose a default directory for Maps software to
look for Leica fluorescence data import files.

1. Navigate to the Cryo Settings tab. On the Options menu, click Settings and then click the
Cryo tab.

2. In the Default Fluorescence Import Directory field, browse to and select the directory where
your fluorescence data is stored. This directory is used as the starting directory when you
Import and view fluorescence data.
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Choose a default import file type for fluorescence data

The open file dialog defaults to a file filter for the selected fluorescence data type. Select the
data type that will be imported most often.

Options include:

l iFLM: Integrated fluorescence light microscope, available on some Thermo Fisher Scientific
systems.

l Leica: Fluorescence data from the Leica Microsystems' LAS X software.

Import and view fluorescence data

You can import fluorescence data and then view it within the Optical Data Browser.

Import procedure

When the Maps Cryo features are turned on, a command for importing fluorescence data is
added to the Maps toolbar.

Prerequisites:
l Requires Cryo features to be activated within the Settings.
l Have fluorescence data available.

1. Click the Import Fluorescence Data icon within the Maps toolbar.

2. Select an image to import, and then Click Open.

3. The Maps software imports the fluorescence data.
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View fluorescence data

When you select multilayer fluorescence data, hover your mouse cursor over the slider and
move your mouse scroll wheel up/down to browse through the image layers displayed in the
Optical Data Browser. Alternatively, you can use the Page Up and Page Down keys on your
keyboard to browse through the image layers. When the slider has focus, use the Arrow keys on
the keyboard to change the value by 1 and use the Page Up and Page Down keys to change the
value by 10%.

Maps displays the actual position of the image planes in microns and adds tick marks in the
browser's main viewer to display individual image planes for more accurate navigation. If Z
coordinates are available within the imported file, then you can view the minimum and maximum
depth values at each end of the Depth control slider. If Z coordinates are not available in the
imported file, then a plane number value appears for the Plane control.
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Import and view Arctis data

You can import and view Arctis data in the Maps software application on TEM systems. The
Arctis data include fluorescence images and information about milled lamellae.

Note: This Cryo functionalilty is specific to TEM systems and is not available on SEM
systems.

Import procedure

When the Maps Cryo features are turned on, a command for importing Arctis data is added to
the Maps toolbar.

Prerequisites:
l Requires Cryo features to be activated within the Settings.
l Have Arctis data available.

1. Click the Import Arctis Data icon within the Maps toolbar.

2. Select Arctis data to import, and then Click Open.

3. The Maps software imports the Arctis data.
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View individual lamella sites

You can view individual lamella sites by expanding the corresponding lamella group in the layer
tree. You will find electron images, optical images, and a lamella annotation within the group.
When selecting the lamella annotation, you can see information about the milling angle, lamella
thickness, and rating.
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Add lamella sites

There are two ways to add lamella sites in Maps software. One way is to find a spot on images in
the Maps software using the viewer. The other is to drive to the spot within xT and create the site
based on the current microscope field of view position.

Prerequisites:
l Requires Cryo features to be activated within the Settings.

Add a lamella site in Maps software

This is the preferred/recommended method when you already have data in Maps and can find
the desired site in the viewer.

1. In the Maps viewer, navigate to the location where you want to make a lamella site.

2. In the Maps viewer, right-click where you want to create a new lamella site and then click Add
Lamella Site Here.
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Maps software creates a new lamella site at that location and adds it to the active layer.

Add a lamella site using the current stage position.

Use this method when you do not have enough data in the Maps software to see the desired site
from within the viewer. This method uses xT to find and navigate to the site of interest.

1. In xT, find and drive to the site of interest and center it in the field of view (FOV).

2. In the Maps viewer, right-click anywhere and then click Add Lamella Site On FOV Position.
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Maps software creates a new lamella site in the center of the current microscope field of view
and adds it to the active layer.

Calculate the eucentric position

Maps software can help you determine the eucentric position of a lamella site for the Cryo
workflow. Eucentric position refers to a position where the sample can be tilted, and the area of
interest does not move out of the field of view or go out of focus.

Prerequisites:
l Requires Cryo features to be activated within the Settings.
l At least one lamella site has been created.
l Stage tilt set for current sample. See Set sample tilt for instructions.

This procedure can be performed only for lamella sites in the Cryo workflow. If you have
calculated the eucentric position and you want to change it, then you can refine it using the same
procedure.
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To calculate or refine the eucentric position

1. Click the lamella site in the Layer tree to select it.

2. In the Lamella Site pane, next to Eucentric Position, click Calculate.

If the eucentric position has already been calculated for this site, then click Refine Eucentric
Position.

3. Maps software prompts you to center the feature under the electron beam in xT. When
finished, return to Maps software and click OK.
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4. To calculate or refine the eucentric position of the site, perform a series of stage tilts, and re-
center the feature at each tilt position.

a. On the dropdown list, click the tilt increment you want to use to tilt the stage. You can
change the tilt step at any point while you are calculating. Starting with smaller tilt steps
might make this task easier.

b. Use the arrow buttons on either side of the dropdown list to tilt the stage up or down by the
selected tilt step.

c. Once the stage is done tilting, recenter your feature in xT.

d. Click Calculate Eucentric Position.

Repeat the previous step as needed to increase the accuracy of the eucentric position. If the
eucentric position is calculated correctly, then the feature stays centered in xT view window
as you change the stage tilt.
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5. Once you see the feature stays in the center of the display in xT between tilts of at least +/-10
degrees, you can close the Eucentric Position dialog.

The eucentric position is now calculated and stored within the lamella site in Maps software.

Determine cryo milling position

The milling position is the stage tilt and position to be used when milling the lamella. You must
determine this position before you can Perform GIS deposition.

Prerequisites:
l Requires Cryo features to be activated within the Settings.
l At least one lamella site has been created and the eucentric position has been calculated.

The yellow warning symbol indicates that the milling position needs attention.
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To determine the milling position:

1. Select the desired lamella site.

2. Click Drive To for Eucentric Position.

3. In xT, change the stage tilt to the angle at which you want to mill a lamella.

4. In Maps software, click Store Angle to finish setting up the milling position. Maps software
stores the angle. The lamella site is now fully setup.
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5. The green check mark symbol confirms that you have successfully determined the milling
position.

Perform GIS deposition

While creating sites, the sample tilt is set and the stage is unlinked. xT requires the stage to be
linked when performing deposition. To make sure you do not accidentally perform any unlinked
moves with the Maps software during deposition, you must lock the Maps user interface until
you are done with deposition in xT.

Prerequisites:
l Requires Cryo features to be activated within the Settings.
l At least one lamella site must be fully setup and ready for milling.
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1. On the Microscope menu click GIS Deposition.

Note: This command only locks out the Maps user interface. It does not actually
perform any deposition.

2. Using the xT software, perform a GIS deposition.

3. When deposition is finished, return to the Maps software and click OK to resume using the
Maps software.

After deposition, the sample is ready to perform lamella milling in a TEM.

Cryo menu items

When Maps software is in Cryo mode, new commands are available on the Microscope menu.

Note: GIS Deposition is the only unique menu item for Cryo mode. The other
commands are documented here because they are required for the Cryo workflow in
Maps software.
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Menu item Description

Set Sample
Tilt

Unlinks the stage and stores the current sample tilt to the current tilt of the
microscope. When the sample tilt is set, there is a check mark next to this
option and the stage tilt that was set. See Set sample tilt for instructions.

Restore Last
Sample Tilt

Restores the previous sample tilt that was set. This command is only visible
when the sample tilt is not set.

GIS
Deposition

Sets up the Maps software for GIS deposition. See Perform GIS deposition
for instructions.

Cryo lamella site toolbar

The cryo lamella site toolbar provides acces to controls and actions relevant to the Cryo
workflow. It is displayed only when the Cryo features are turned on as described in Configure
Cryo settings.

Toolbar item Description

Dropdown menu containing layer types that can be
used in this toolbar.

List of fully set up lamella sites. Changing the lamella
selection changes the selected site in the layer tree.
Use the arrow buttons on either side of the list to select
the next or previous lamella site in the collection.

Drives to the selected lamella site eucentric position.
See Cryo lamella sites for more information about
lamella sites.
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Toolbar item Description

Drive to the selected lamella site mapping position.
See Cryo lamella sites for more information about
lamella sites.

Starts the process to calculate the eucentric position.
See Calculate the eucentric position for instructions.

Cryo lamella timeline

The timeline is a collection of notes, files, and actions that have happened or been attached to a
selected lamella site. By default, the timeline automatically tracks property changes as text
notes. This control can help you identify what has happened during the setup of the selected
lamella site.

Add a note to the timeline

You can add simple text notes to lamella sites. The text appears on the timeline.
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1. Click the site to which you want to add a simple text note.

2. Click Add Note.

3. Type a text note in the dialog and then click OK.

Add a file to the timeline

You can attach files to lamella sites. The file is copied into the Maps project, so it is still available
if you move the Maps project to another directory. In Cryo Settings, you can Choose a directory
to watch.

1. Click the site to which you want to add a file.

2. Click Add FiIe.

3. Browse to the file you want to attach, click it, and then click Open.

Cryo lamella sites

A cryo lamella site is a special annotation layer defined on a SEM tool to mark a specific location
on a cryo sample where you want to mill a lamella. This layer contains special functionality and
positioning. Each lamella site is used to mark cells of interest and to determine the angle at
which to mill the lamella.

Lamella sites have the following properties in Maps software.
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Lamella site status

The status symbol indicates the setup state of the lamella. This status symbol is displayed in the
layer tree.

User
interface
item Description

The grey status symbol means the lamella site is in the initial state. It has
been created, but nothing else has been done to it.

The orange status symbol means the eucentric position has been calculated
and stored for the lamella site.

The green status symbol means the milling position and angle have been
stored. The site is ready to be used for deposition and milling.

Lamella site properties

The following properties are displayed when you click on a lamella site.

Property Description

Name of the lamella site.

Color of the lamella site. Click this to change the color of the
lamella site shown in the viewer.

Lamella site positions

Positions listed in the Lamella Site property pane. A position has a yellow exclamation mark

when it is not set up and green check once it is set up. You must set up a lamella site before
you can Perform GIS deposition.

Depending on the lamella site status, there are a different options per position. Notice the
change in the buttons and the status indicators. A lamella site is considered fully setup when all

three positions have a green check next to them.
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Initial Eucentric position calculated Setup complete

Mapping Position

The mapping position is the XYZ position where the lamella was initially added. See Add lamella
sites for instructions.

l Drive To – Centers the Maps viewer on that position.
l Update – Changes the mapping position to the current microscope field of view location.

Initial setup

Eucentric Position

The eucentric position is the location where the stage can be tilted through a range of angles
and the cell of interest the lamella site is marking does not move in X, Y, or Z in the field of view.
It is not initially set up and must be calculated manually. See Calculate the eucentric position for
instructions.
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l Calculate – Click if the position has not been calculated.
l Drive To – Centers the Maps viewer on that position.
l Update – Changes the mapping position to the current microscope field of view location.
l Refine Eucentric Position – Click to re-calculate the position.

Eucentric position calculated

Milling Position

The milling position is the stage tilt and position to use when milling the lamella. See Determine
cryo milling position for instructions.

l Drive To – Centers the Maps viewer on that position.
l Update – Changes the milling position to the current microscope field of view location.
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Setup complete
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Maps Min
Maps Min includes a workflow spanning multiple software applications to collect and analyze
EDS and mineralogy data from geological samples. Software includes Thermo Scientific Maps,
Thermo Scientific™ Nanomin (called "Nanomin" within this user guide), and Bruker ESPRIT.
Hardware includes the Support PC and the Microscope PC.

Get started

To get started in Maps Min, see Configure Mineralogy Acquisition.

Online support

Go to the Help menu and click Open Help Desk to access online support from within the Maps
application. Alternatively, click https://thermofisher-
asg.atlassian.net/servicedesk/customer/portal/16 to gain access outside of Maps. Click Report
Maps Min Bug for mineralogy issues.
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Configure Mineralogy Acquisition

Before you proceed with the Maps Min workflow, you must first configure the Maps software for
mineralogy acquisition on the Microscope PC with the Nanomin software and Bruker ESPRIT
software on the Support PC.

Prerequisites:
l Set up the Support PC according to the installation instructions.
l There must be a shared folder on the Support PC that the Microscope PC can access.

Note: This task needs to be performed only once.

Procedure

On Support PC

Note: Only one user can be logged in at any given time on the Support PC. If you
need to switch users, then first log off from your user account before another user
logs into the Support PC.
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1. Confirm that the required services are running.
a. Thermo Scientific Nanomin Service

b. Thermo Scientific Bruker Service x64 and Thermo Scientific Bruker Service x86 (two blue
icons appear in the task tray).

2. Perform the Energy Calibration procedure to ensure that the Bruker EDS detector is properly
calibrated.

On Microscope PC
1. Launch the Maps application.

2. When prompted for a default Maps project directory, select a location that is local on the
Microscope PC.

3. When the project history window appears, click New to create a new project.

4. Go to the Menu bar, and click Options > Settings > Mineralogy.

5. Go to the Bruker Detector Type dropdown menu, and then select the detector that is installed
on your microscope system.
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6. Go to the Mineralogy section >> Data Export >> Final Data Directory field, and click the
ellipsis [. . . ] to search for the shared folder location on the Support PC. Select this folder
location to designate it as the location where the final mineralogy data will be saved to and
processed from during the mineralogy workflow.

Note: At this time, you may also specify a Staging directory location. Go to the
Mineralogy section >> Data Export >> Staging Directory field and enter a non-
network location on the Microscope PC. The staging directory location must NOT
be a network location since Maps will store files in this location during acquisition
to improve reliability of the transfer to the Final Data Directory.

7. Click OK to save the settings.
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8. Wait for a solid, green status icon to appear in the status bar. This status icon indicates that
Maps is connected and ready for Bruker acquisitions.

9. Continue to Mineralogy Workflow now that the configuration is complete.

Energy Calibration

Correct calibration of the energy-channel (or gain) is a required for reliable qualitative and
quantitative analysis results.

Prerequisites:
l The Bruker ESPRIT application must be installed.
l Dead time value is bellow 10%. If it is too high, decrease the spot size on the microscope.

Note: It is important to check the calibration on a weekly basis and adjust it if
necessary to compensate for spectrometer drift.

Note: Calibration must always be performed after switching on the signal processing
unit. This action is not required when using the standby mode, but it is highly
recommended.

Procedure

Refer to the ESPRIT v2.2 user interface shown below for an overview of the procedure before
you begin. The user interface slightly differs depending on the version of your ESPRIT software
package.

1. Click EDS, and then click the Spectrometer tab to select the spectrometer workspace.

Note: Since system factor calibration is accessible through the calibration buttons
in every workspace that includes spectra acquisition, do not confuse energy
calibration with system factor calibration.
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2. Move the calibration sample into the analysis position and set the beam current (spot size) to
produce an intermediate count rate. Any element in the mid-energy range (that is, elements
Mn–Zn) in a given sample can be used, provided that it is contained in a reasonable
concentration. It is recommended that you use single element standards, such as pure
copper, to avoid peak misidentification, increase speed, and improve accuracy.

3. Under the Settings to calibrate panel:

a. Pulse throughput: Select the check boxes of all the pulse throughput settings. The list of
available speeds in this option is dependent on the license.

b. Energy range: Select 20kV for the energy range to be calibrated for the spectrometer.

c. Detector segments: Select all detectors that are physically present on the system.

4. Under the periodic table, click the element of interest and then click K-α. It is recommended
to use K-α lines whenever possible.

5. Under the Calibration panel, click Precise which is sufficient in most use cases, and then
click Start.

6. When prompted to save the new calibration data, click Yes. Note that the storage of
calibration data is not user specific, so changes in calibration affect all users of the
spectrometer.
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ESPRIT v2.2 software package
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Mineralogy Workflow

The Maps Min workflow explains how to use of Maps in tandem with Nanomin to acquire EDS
data from a sample. It also explains how to generate a Microsoft®Office Excel® report with the
acquired data and how to publish the data to the web-based Maps Min Reporting application.
You can use the Maps Min Reporting application to filter, combine, and view the data online as
desired. You can also export reports as Excel files similar to the Nanomin application.

Note: The Maps Min workflow is only available on SEM systems and requires an
active Mineralogy license. See Package options for information about licenses.

Prerequisites:
l The Maps software is configured for mineralogy acquisition on the Microscope PC (see
Configure Mineralogy Acquisition).

l The Nanomin software is configured on the Support PC (see Configure Mineralogy
Acquisition).

l The Maps Min Reporting application is installed on the Support PC.
l You have loaded your sample and aligned your holder in Maps.

Note: You can repeat this workflow for each mineralogy sample if needed.

Set up mineralogy tile set
1. Complete the procedure in Set Up Mineralogy Tile Set.

2. Repeat this task for as many tile sets as needed.

3. (Optional) Use the Mineralogy Measurement Template to quickly create multiple tile sets at
once for repeated work.

Acquire mineralogy data
1. Start the Job Queue.

2. Wait for acquisition and processing to finish.

Open mineralogy data
1. Complete the procedure in Open Mineralogy Data.

2. Diagnose the data.
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Export mineralogy report
1. Complete the procedure in Export Mineralogy Report.

2. Analyze data in report.

Publish mineralogy data
1. Complete the procedure in Publish Mineralogy Data.

2. Analyze data in Maps Min Reporting.
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Set Up Mineralogy Tile Set

This procedure explains how to set up a tile set in Maps, which performs a mineralogy
EDS acquisition with the Bruker ESPRIT software and detector.

Prerequisites:
l Maps must be configured for mineralogy acquisition (see Configure Mineralogy
Acquisition).

l xT software must be installed and running on the Microscope PC.

Note: If you have Mineralogy tile set templates that you created with an earlier
version of Maps 3.28, then you will need to recreate them.

Note: Repeat this procedure for every data sample of interest to capture EDS
information. Refer to Mineralogy Acquisition Properties for more information about
each acquisition parameter.
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Procedure
1. Create a tile set with one of the toolbar controls (see Toolbar).

2. Select the new tile set.

3. Click the Mineralogy Acquisition tab, and then select the EDS Acquisition check box to
designate the tile set for mineralogy acquisition.

4. Click the ... to select the desired elements to acquire EDS data. 

5. In the Select Elements window, click on the elements you want to select, and then click OK.
If you do not want to view elements during acquisition, then only click OK and continue to the
next step.
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6. Complete the Define Background BSE procedure.

7. Click the New button next to the Segmentation Settings dropdown menu to open the
Segmentation Wizard. Use this wizard to set up the segmentation settings for acquisition
and post processing. The wizard also helps you to define the background BSE.

8. Optional: In the Recipe dropdown menu, select which recipe you want to process the tile set
with post acquisition in Nanomin.

9. Optional: To stop acquisition after a specific number of acquired particles, select the Particle
Count Termination check box and enter a positive value in the dedicated field.

10. Optional: To acquire only a sub-set of particles based on the size metric:
a. Click Particle Size Metric, and then select one of the available values from the dropdown
menu.

b. Enter the minimum and/or maximum particle size value in the dedicated fields. If needed,
you can deactivate each field by deselecting the associated check box.

11. Optional: To perform Bright Phase Search acquisition, select the Use BSE Search Ranges
check box and follow the Optional: Bright Phase Search Acquisition Workflow procedure.

Note: When you activate Use BSE Search Ranges, the BSE image that Maps
sends to Nanomin for processing is the uncalibrated image.
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12. Select an Acquisition mode:
l Grid: This mode performs a simple serial scan to collect X-rays.

After you select Grid mode from the dropdown menu, enter the X-Ray Spacing value to
determine the distance between each location to collect X-rays. This is essentially the
pixel size for the resulting EDS image.

l Centroid (beta): This mode performs some image processing on the BSE electron image
to detect grains and attempts to perform a single X-ray scan on each grain to improve
acquisition performance.

After you select Centroid (beta) mode from the dropdown menu, enter a Grain Size value
to determine the grains of interest. Maps ignores any grains that are smaller than the Grain
Size value; therefore, increasing the Grain Size value improves acquisition time, but may
result in missing measurements on grains. The Process Edge Particles check box is
deselected by default since there are known issues with edge particles while in Centroid
mode. If you keep the default, then the particles that fall on acquisition tile edges are
ignored during Nanomin processing.

Caution: The Centroid mode is still in beta and may have varying results. It is
recommended that you only use a resolution of 512x442 for tile sets.
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13. Enter the EDS Dwell time. This is the time spent collecting X-rays per EDS pixel. The default
is 8 ms. Longer dwell times result in more acquired X-rays and higher quality results.

14. Optional: Fill out the Tags fields based on the sample associated with the tile set. These tags
are used for sample tracking and generating reports. For more information on what the tags
represent, see Mineralogy Acquisition Properties.

15. Optional: Repeat this procedure to create additional tile sets if needed.

16. Return to the Mineralogy Workflow to continue.
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Optional: Bright Phase Search Acquisition Workflow

The Bright Phase Search Acquisition workflow obtains mining data for particles containing bright
phase, which results in faster acquisition and results within the web-based Maps Min Reporting
application.

Workflow overview

The Bright Phase workflow utilizes user-defined standards to calibrate the incoming
BSE images. The workflow then compares the BSE pixel values against another set of user-
defined mineral search ranges to acquire EDS on particles of interest at a different resolution
and dwell time. The goal of this workflow is to minimize data size and reduce acquisition time
when only a subset of minerals is of interest.

Prerequisites:
l The Maps software is configured for mineralogy acquisition on the Microscope PC (see
Configure Mineralogy Acquisition).

l The Nanomin software is configured on the Support PC (see Configure Mineralogy
Acquisition).

l You have loaded your sample and aligned your holder in Maps.
l The xT software is installed and running on the Microscope PC.
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Procedure

1. Set up standard sample locations with the Mineralogy Standards Workflow. You are required
to have standard sample locations set up to continue with this procedure.

Note: To ensure that the data are accurate, these standard sample locations must be
from a sample holder that is currently loaded.

2. Begin the Set Up Mineralogy Tile Set procedure. Before you select an acquisition mode,
select the Use BSE Search Ranges check box to opt for Bright Phase Search acquisition.

3. Click the Mineralogy Acquisition tab and set the acquisition settings for Target and Non-
Target. The Target settings are acquisition scan settings for particles that contain pixels within
defined BSE search ranges, and the Non-Target settings are acquisition scan settings for all
remaining particles.

Note: Skipping Non-Target particles is not currently supported. As a workaround, you
can lower the EDS Dwell Time to 1 ms to speed up acquisition of Non-Target
particles.
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4. Click Add Search Range to add a new BSE search range.

5. When the Add New Search Range window appears. Click one of the target phases in the
dropdown menu (or type a target phase in the Search box), and then click Add.
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6. Your selected target phase will be added under Search Ranges. It will be populated with a
search range based on the phase's average atomic weight. You can change the upper and
lower threshold values of the search range by adjusting the left and right sliders bordering the
histogram. Alternatively, you can click the up and down arrows of the two text boxes to change
the upper and lower threshold values. The upper and lower threshold values range from zero to
one hundred percent (that is, 0%–100%).

7. (Optional): Repeat this procedure to create an additional search range if needed.

8. Return to Set Up Mineralogy Tile Set to select an acquisition mode and continue setting up
the mineralogy tile set.

Optional: validate procedure

Once tile set acquisition is complete, validate that the particles were successfully acquired with
the Target settings.

1. Select the stitched result layer, and click the Visualization tab.
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2. Deselect all channels except the calibrated channel. As shown in the example below, the
calibrated channel displays "(Calibrated)"at the end of the channel name.

3. Expand the Calibrated channel, and then click Add Color.

4. Review the BSE search range setup in the Bright Phase procedure above, and convert the
upper and lower threshold values into 16-bit values (that is, pixels). For example, the 84%–94%
range for gold would be converted to 55,049 and 61,603 pixels, respectively.
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5. In the solid color pane, move the upper and lower threshold values to match the converted
values that you calculated in the previous step. These updated threshold values define your
BSE search range.
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6. View the acquired image to locate the red pixels, which represent your BSE search range.
This means that if a particle contains red pixels, then the particle was acquired with the Target
scan settings.

Note: If none of the particles in the acquired image contain red pixels, then it is
recommended that you acquire another tile set with a different BSE search range
values.
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Mineralogy Standards Workflow

The Mineralogy Standards workflow explains how to set up standard sample positions used
within the Optional: Bright Phase Search Acquisition Workflow.

1. Click the Start Workflow icon located on the right side of the Toolbar.

2. In the Select Workflow window, click Mineralogy Standards Setup, and then click Begin.
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3. The Workflow: Mineralogy Standards Setup window appears on the right side of the main
screen.

4. Use the xT interface to drive the stage to a standard location on the sample holder.

5. Select the standard location from the Standard 1 dropdown menu.

6. Click Save Current Stage Position.

7. Repeat steps 4–6 to set up Standard 2 and Standard 3.

8. Click the check mark icon located in the lower right corner of the workflow window to save
the standard positions.
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Segmentation Wizard

This procedure explains how to use the Segmentation Wizard, which you use to set the
segmentation settings. Maps uses these settings during acquisition and classification to find
particles and grains.

Prerequisites:
l Maps must be configured for mineralogy acquisition (see Configure Mineralogy
Acquisition).

l xT software must be installed and running on the Microscope PC.

Note: Repeat this procedure for every data sample of interest to capture EDS
information. Refer to Mineralogy Acquisition Properties for more information about
each acquisition parameter.

Procedure

1. Create a tile set with one of the toolbar controls (see Toolbar).

2. Select the new tile set.

3. Click the Mineralogy Acquisition tab, and then select the EDS Acquisition check box to
designate the tile set for mineralogy acquisition.

4. Click the New button next to the Segmentation Settings dropdown menu to start the
Segmentation Wizard. The Segmentation Wizard automatically starts the workflow, which
includes defining the BSE background threshold, setting up the particle segmentation,
setting up the grain segmentation, and saving your new segmentation settings.
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5. Define the BSE background threshold. This step determines the areas of the image that will
not have any X-rays collected. Once a desired region is excluded from X-ray collection,
move to the next step in the workflow.
a. Click Drive To Tile Set to move the stage to the center of the current tile set.

b. Click Acquire Snapshot to acquire an image. When prompted to apply tile set settings to
the microscope, click Yes. This step is required to ensure that the image captured mimics
the image that will be acquired by the tile set.

Maps 3.32.1 User Guide

250 | Original Instructions

Limited Rights

PN 1551059 Revision A | 11-Mar-2025

SEM/SDB



c. Once Maps acquires the image, the image appears in the main panel of the workflow and
a threshold histogram appears in the right panel.
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d. Adjust the slider control for the threshold histogram to designate the areas of the image to
be excluded from the collected X-rays. Continue adjusting the slider control until all the
designated areas are highlighted in red.

e. Once a desired region is excluded from X-ray collection, move to the next step in the
workflow.
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6. Set up the particle segmentation. In this step, you to test the particle segmentation with the
BSE image taken in the previous step to ensure that the segmentation settings perform as
desired.
a. Click the Strength slider control to determine how aggressive you want the particle

splitting. When you increase the strength, the number of found particles increases.

b. Click Run Particle Splitter to test the particle segmentation. Found particles appear in
color, so you can identify them. Click Show/Hide Particles to toggle the visibility of the
particles on and off so that you can compare them with the BSE image.

c. When you are satisfied with your particle results, move to the next step in the workflow.
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7. Set up the grain segmentation. In this step, you test the grain segmentation results from
within the found particles of the particle segmentation. Note that this step is only available
when the acquisition mode is set to Centroid (beta).

a. Adjust the Grain size slider control to determine how granular you want the segmentation.
Each grain appears in color, so you can identify them. Click Show/Hide Particles to
toggle the visibility of the grains on and off so that you can compare them with the BSE
image.

b. When satisfied with the grain results, move to the next step in the workflow.
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8. Click Save to save your new segmentation settings, so that you can reuse them with other
tile sets. This step completes the segmentation workflow.
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Mineralogy Measurement Template

The Maps Min software enables you to quickly set up multiple mineralogy tile sets at once with a
customized CSV template file specific to your use case. Although a customized CSV template
file is optional, it is recommended that you create one and import it into Maps.

A CSV file is a comma-separated values text file, which allows you to save data in a tabular
format. Each line of data in the CSV file is a record, and each record consists of one or more
fields separated by commas. In this instance, Microsoft Office Excel automatically opens the
provided CVS file template and organizes the data. Each row in the Excel spreadsheet
represents one mineralogy tile set record, and the columns contain the tile set properties
associated with each mineralogy tile set record. Note that each mineralogy tile set record
contains 2–10 tile set properties.

Create custom CSV template file

1. Navigate to the Support Files folder in the Mineralogy Installer.

2. Locate the file entitled MineralogyMeasurementTemplate.csv and copy/paste it to the
desktop.

3. Double-click the desktop file copy to open the file as a standard Excel spreadsheet.

4. To create the first tile set record, refer to the table below and do the following in the first row
of the spreadsheet.

a. Enter a value into the Hole Position column.

b. Enter a value into the Template column.

c. (Optional): Enter values into the other columns as desired.

5. To create more tile set records, repeat steps 4a–4c for each additional row.

6. Click File, select Save As, rename the file, and then click Save.

7. Continue to Import custom CSV template file.
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Column
Header

Data
Type

Required
Field Notes

Hole Position Integer Yes This field represents which hole in the
holder that you designate for the tile set
creation (for example, 1 = hole 1, 2 = hole
2, 3 = hole 3, etc.).

Mineralogy
Project Name

String No Use this field to designate a parent
directory name for the acquisition results.
This can help organize your sample data
on disk.

Replicate String

Sample Code String No Use this field to name the created tile set.

Sample
Description

String No

Sample Name String No

Sample Weight Double No

Size Fraction String No

Size Fraction
Weight %

Double No

Survey Name String No

Survey
Description

String No

Template String Yes This field represents the name of the tile
set template within Maps. The tile set
template must exist prior to importing your
custom CVS template file into Maps.
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Import custom CSV template file

After you have created your custom CSV template file, you can then import it into the Maps.

Procedure
1. Confirm that a project is open and that Maps has a Bruker connection.

a. View the Maps status bar located at the bottom of the main screen. A green status icon
next to the Bruker label indicates that Maps is connected to the Bruker label, and a green
status icon next to the Nanomin label indicates that maps is connected to the Nanomin
Service (refer to the Main Screen for more information on the microscope connection
states).

b. If the green status icon is not present, then go to On Microscope PC and configure the
Maps software for mineralogy acquisition on the Microscope PC with Nanomin.

2. Click File, and then select Import Mineralogy Measurement Template.

3. When Maps prompts you, select your custom CSV template file from the desktop to import it
into Maps. Maps uses this template to create a tile set for each mineralogy tile set record in
the file.

4. Return to the Mineralogy Workflow to continue.
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Open Mineralogy Data

This procedure explains how to open and view acquired mineralogy data in Nanomin.

Prerequisites:
l Nanomin must be installed and licensed.
l You must have access to a Maps project that has acquired mineralogy data.

Note: This task can be performed anytime and repeated as needed.

Procedure
1. Launch the Nanomin application.

2. Click File from the toolbar, and then click Open Maps Tile Set from the dropdown menu to
open the directory dialog.

3. Locate the Maps project file that contains the mineralogy tile set to open. If there is more than
one mineralogy tile set within the selected Maps project, then Nanomin prompts you to select
a mineralogy tile set to open.
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4. Double-click the desired mineralogy tile set to open it.

l If Nanomin has not yet classified the mineralogy tile set, then Nanomin prompts you to
select a recipe to process the tile set. Select a recipe to continue.

l If Nanomin has classified the mineralogy tile set, then classification automatically runs.

5. The mineralogy tile set opens and appears in the viewer. You can then view the mineral and
elemental layers for the tile set.

6. Continue to Export Mineralogy Report.

Export Mineralogy Report

Nanomin can generate a mineralogy report containing a list of calculated results from one or
more Maps Min tile sets. Follow the steps below to export a mineralogy report that can be read in
Microsoft Office Excel.

Prerequisites:
l The Nanomin application must be installed.
l You must have a Maps Min tile set acquired and classified by Nanomin.

Procedure
1. Launch the Nanomin application.

2. Click Data from the toolbar, and then click Export Reports to Excel from the dropdown
menu to open the directory dialog.
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3. Locate the Maps project that contains the tile sets to be included in your report and then
double-click it.

4. Click the check boxes of the tile sets to designate their data for export.

5. Click Export.

6. When prompted, enter a file name, select a file location, and then click Save.

7. The report automatically opens after the file is saved. See Mineralogy Report Data for more
information.

Publish Mineralogy Data

Nanomin can publish one or more Maps Min tile sets data to use with the web-based Maps Min
Reporting application. Follow the steps below to publish data to the Maps Min Reporting server.

Prerequisites:
l The Nanomin application must be installed.
l You must have at least a Maps Min tile set acquired and classified by Nanomin.
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Procedure
1. Launch the Nanomin application.

2. Click Data from the toolbar, and then click Publish Multiple Measurements from the
dropdown menu to open the directory dialog.

3. When prompted, enter the URL address of the Maps Min Reporting server and then click
Next.

4. When the Reporting Server Selection screens opens, enter the reporting PC name.

5. Locate the Maps project that contains the tile sets that you want to publish to the reporting
server, and then double-click the project.
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6. Select the checkboxes in the Publish column to designate the desired tile set data for
publishing, and then click Publish.

7. Verify and edit the selected dataset's information, and then click Publish.

8. The data are automatically published to the Maps Min Reporting server.
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References

The Maps Min workflow includes supporting information as listed below.

Topics include:

Define Background BSE
Mineralogy Acquisition Properties
Mineralogy Report Data
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Define Background BSE

The Background BSE is a percentage that represents the darkest percent of pixels in the BSE
image. Properly defining the Background BSE ensures that X-rays in any of these dark pixel
locations are excluded from the acquisition, which optimizes EDS acquisition time.

Prerequisites:
l Maps Min must be configured (see Configure Mineralogy Acquisition).
l A Maps tile set must be created and selected (see Set Up Mineralogy Tile Set).
l The Mineralogy Acquisition tab must be selected in the tile set's property pane and the
EDS Acquisition check box must be selected.

Procedure

1. Click the gear icon next to the Background BSE parameter.

2. Follow the beginning of the Segmentation Wizard procedure to define the background BSE.

3. Once you define the background BSE and move to the next step in the workflow, Maps
closes the workflow and updates the Background BSE in the setup tab.
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Mineralogy Acquisition Properties

There is a collection of acquisition properties for you to complete within Mineralogy Acquisition
>> Mining Tag for each mineralogy tile set. Refer to the three tables below for property names
and descriptions.

Table 1 – Acquisition Parameters

Property Description

Acquisition Mode Determines the image processing mode used for collecting X-
rays.
Choices include:
l Grid: This mode performs a simple serial scan to collect X-
rays. When this mode is selected, you must provide an X-
Ray Spacing value. This value is the distance between X-
ray scan locations.

l Centroid (beta): This mode performs some image
processing on the BSE electron image to detect grains and
attempts to perform a single X-ray scan on each grain to
improve acquisition performance. When selecting this
mode, you must provide a Grain Size value to determine the
minimum grain size when performing the image processing.

Note: Centroid acquisition may have some
known issues.

Background BSE Percentage that represents the darkest pixels in the BSE
image. Maps software does not acquire X-rays in any of these
dark pixel locations. The reason for this functionality is to
optimize acquisition time by not measuring resin or dark
materials that are not of interest.
See Define Background BSE for details.

EDS Acquisition Determines if the tile set performs an EDS acquisition. Select
the check box to activate.

Maps 3.32.1 User Guide

266 | Original Instructions

Limited Rights

PN 1551059 Revision A | 11-Mar-2025

SEM/SDB



Property Description

EDS Dwell Time spent collecting X-rays per EDS pixel. The default is 8 ms.
Longer dwell times result in more X-rays being acquired and
higher quality results.

Elements The selection of elements displayed in Maps. Each selected
element is its own channel in the tile set result.

Table 2 – Mining Tags

Property Description

Mineralogy Project Name This is a label that represents the name of the project
containing a collection of mineralogy surveys. The mineralogy
project name typically includes the customer name, date,
and/or business case.

Survey Name This is a collection of related sample measurements, which
normally represents a set of samples taken from a plant or ore
body at a particular time.

Sample Name This represents a single instance of sample material being
taken from a particular location. For example, the concentration
stream of a flotation cell. This entity represents the raw and
unsized material. This may optionally be further subdivided into
multiple size fraction ranges if you have mechanically
separated this material for analysis.

Sample Weight (kg) This represents the weight of a single instance of sample
material being taken from a particular location. The default
value is 100 kg.

Size Fraction (µm) This is a label that represents the size range of particles for this
sample, assuming that the original sample has been sorted into
size ranges. For samples that are not sorted, leave this field
blank (null in the database) indicating that the sample is not
sized.
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Property Description

Size Fraction Weight % If the original sample is split into size fractions, this field
indicates the proportion of total sample mass that exists within
the current size range. This is a percentage, because the sum
of all size fractions equals 100%. If they do not equal 100%,
then you can conclude that there are samples missing or a data
entry mistake has occurred.

Replicate This represents the facility for making duplicate physical epoxy
pucks, or thin sections for analysis, that share an identical size
fraction, survey, and sample. This is typically done when
searching for rare minerals to increase the reliability of statistics
derived from them. For example, since platinum minerals are
rare (parts per billion) you might only see 1–5 grains per
physical block. Companies typically create 10,20,30 replicates
from the original source material to increase the number of
grains they find, so that they have decent aggregate data such
as grain size histograms.

Table 3 – Post Processing

Property Description

Recipe Name of the Nanomin processing recipe classified with the tile
set after acquisition. If Nanomin has not yet classified the
mineralogy tile set, then Nanomin prompts you to select a
recipe to process the tile set. If Nanomin has classified the
mineralogy tile set, then classification automatically runs.

Mineralogy Report Data

The mineralogy report contains a collection of calculated results for the measured sample. The
table below contains descriptions of the information that is stored in each tab of the Microsoft
Office Excel report. Refer to this table when analyzing the data in your report.
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Tab Description

Deportment This shows an inversion calculation of the elemental
assay and modal mineralogy weight data. For a
specified element (for example, Cu) in the Elemental
Assay report, it shows what minerals are contributing to
the weight of that selected mineral. It can be used in
tailings analysis to determine whether a valuable
element is worth recovering, or whether the mineral
contributing to that signal is too difficult to process.

Deportment Pivot Table This shows the elemental deportment in a pivot table
where you can easily select an element of interest (and
one or more samples) to see a report of that element
alone.

Elemental Assay Shows a bulk computed assay derived from the
minerals identified in the Modal Mineralogy Weight
report (including for region-of-interest). Minerals are
converted into their equivalent chemistry from their
theoretical textbook chemistry. However, if a specific
mineral has a large number of pixels in the image, the
chemistry is not taken from the textbook definition but
instead from an EDS elemental quantification of the
spectrum obtained for that mineral. Data here can be
compared to other bulk analytical techniques, such as
XRF, LIBS, wet chemistry, etc.

Grain Size Distribution This records the grain size distribution for individual
minerals found in the samples exported. They are
recorded in a histogram.

Grain Size Distribution Data This records the grain size distribution for all mineral
grains across all measurements. You should use the
filters at the top of the spreadsheet to select a mineral of
interest.
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Tab Description

Liberation Histogram This shows a liberation report for all minerals and
samples found. Liberation is computed as the total area
of a mineral within each particle, and the report shows a
summary view for all particles in the sample.

Locking Details This is a detailed breakdown of the locking summary
report. For each target mineral, it shows the percentage
of the other minerals found in those particles as their
weight percentage in binary or ternary classes.

Locking Summary This is a refinement of the liberation report in which the
percentage of minerals that are liberated or not
liberated are shown. For particles that have two
minerals, they are shown in the binary column. Particles
with three minerals are shown in the ternary column.
Particles with four or more minerals are shown in the
complex column.

Modal Mineralogy Area Shows the bulk mineralogy by area for the entire
sample for one or more measurements. It also shows
the mineralogy for all regions-of-interest defined in the
exported measurements. Data here can be compared
to other AM systems from other vendors.

Modal Mineralogy Weight Based on the Modal Mineralogy Area, but shows the
bulk results by weight instead of by area. Thus, heavy
minerals (for example, pyrite or gold) have a higher
effect than light minerals (for example, quartz or
carbon). Data here can be compared to other bulk
analytical techniques such as XRD, FTIR, RAMAN, or
other AM systems.

Particle Size Distribution 1 This records a non-cumulative particle size distribution
as a histogram across all measurements.

Particle Size Distribution Data This records the cumulative particle size distribution for
all particles across measurements.
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Maps XPS
Maps XPS allows you to view XPS data and prepare sites, lines, and areas of interest for post
processing within the Avantage software. To get started, follow the procedure below:

Get started
1. Go to the Options menu.

2. Click Settings, and then click the XPS tab.

3. Click Enable XPS to activate the XPS features. The Maps application alerts you if a system
restart is required to proceed.

4. Click OK.

5. Proceed to the XPSWorkflow.
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XPSWorkflow

In the Maps XPS workflow, you can view imported XPS data and create annotations for post
processing with the Avantage software. During post processing, the Avantage software uses the
exported sites of interest for point measurements, converts the lines of interest to line scans,
and converts the areas of interest to snap maps.

Prerequisites:
l You must enable XPS features within the Maps application settings (see Maps XPS).
l You must have a file containing XPS data that was prepared by the Avantage software
(version 6.1 or newer).

l You must have an External Image Import license (see Package options).

Workflow procedure
1. Import XPS Data that are prepared in Avantage software.

2. Initialize XPS Holder (optional).

3. View XPS Layer Types within the Maps application.

4. Create and acquire tile sets (or snapshots).

5. Create Annotations based on acquired data from the microscope.

6. Export XPS to Avantage new annotations to an XML file.

7. Import the XML file to the Avantage software for post processing.

Import XPS Data

When the Maps XPS features are enabled, the Maps application adds an icon for importing XPS
data to the SEM/SDB toolbar. If the XPS features are not enabled, then the icon does not display
within the SEM/SDB toolbar.

1. Go to the right side of the SEM/SDB toolbar.

2. Click the Import XPS Data icon.
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3. Select a file to import (file type *.tfs.xml).

4. Click Open to start the data import.

5. Proceed to View XPS Layer Types.
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Initialize XPS Holder

If the imported XPS data contain information about the XPS holder, then the XPS holder
initialization workflow starts automatically at the end of XPS data import. If desired, you can
abort the initialization workflow anytime after it starts (see Abort holder initialization).

1. Maps locates the imported images that contain the fiducials and then populates them in the
right panel.
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2. Maps processes the fiducials and places reference points for each one. If Maps processes at
least three fiducials, then it prompts you to check the fiducial positions.

l If the status of each fiducial within the right panel indicates success (that is, indicated by a
green status icon), then check for false positives by confirming that the blue crosshair
locations in the fiducial and small reference screens match. If the crosshair locations
match for each successful fiducial, then click Yes to initialize the holder and go to step 5 to
initiate the automated holder alignment. If the crosshair locations do not match for each
successful fiducial, then click No and continue the remaining steps to perform a manual
placement for the false positives.
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l If the status of each fiducial within the right panel indicates failure (that is, indicated by a
red status icon), then click No and continue the remaining steps to perform a manual
placement for the failed fiducials.
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3. Go through failed fiducials in the right panel and manually set the correct fiducial positions by
double-clicking within the fiducial screen to move the blue crosshair so that it is in the same
location as shown in the small reference screen. The small reference screen is located to the
left of the fiducial screen. If needed, you can use the mouse wheel to drag and zoom to
precisely set the fiducial position.

Note: Sometimes the Maps algorithm produces false-positives and places
fiducial positions incorrectly (that is, the blue crosshair locations in the fiducial
and reference screens do not match). If this occurs, you can manually change the
fiducial positions defined by the automated workflow.
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4. After you properly set at least three fiducial positions, click Initialize holder at the bottom of
the panel.
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5. After holder initialization completes, click Yes to start the automated holder alignment.

Alternatively, you can later start the holder alignment from the main toolbar by clicking the
Align to Holder icon. Refer to the Automated Holder Alignment section for more information.

Abort holder initialization
1. Click Abort at the bottom of the right panel.

2. When the application prompts you, click Yes to confirm.
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3. If you abort the holder initialization and would like to start the workflow again, navigate to the
main menu and click XPS >> Initialize Holder. The Initialize Holder submenu is only visible if
you have XPS data with an XPS holder that has not yet been initialized. Once you initialize
the holder, this submenu disappears.

View XPS Layer Types

After importing the XPS data into the Maps application, the Maps project contains the following
new layer types for you to view.

l Measurement point
l Line scan
l Snap map
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Measurement point

Maps displays the measurement point as an elliptical area. This layer type contains multiple
spectra, and you can select which spectrum to display in the left panel.
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At the bottom of left panel, there are two options:

l Open Peak Table: Select this option to open the peak table (if present) in a separate window.

l Open VGP File: Select this option to open the VGP file associated with the measurement
point in the Avantage software. You must have the Avantage software installed to use this
feature.
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Line scan

Maps displays the line scan as thin rectangular area. This layer type contains multiple spectra,
and you can select which spectrum to display in the left panel.
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Additionally, you can select a profile as shown below to display.
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Snap map tab

The Snap Map tab contains the default properties.

Property Description

Name Displays Snap Map name.

Pixels Size of the image in pixels.

Pixel Size Physical size of one pixel.

Physical Size Physical size of the whole image.

Show metadata This property is deactivated and not available since Snap Map does not
include metadata.

Technique Technique used to create the data in XPS. For example, Snap Map is the
technique in this case.
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Visualization tab

Maps imports the Snap Map as a multichannel image layer.

Create Annotations

With the XPS data imported into the Maps application, you can create new annotations for your
lines of interest, areas of interest, and sites of interest.

Toolbar
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Create line of interest annotation

1. Go to the SEM/SDB toolbar. The Line of Interest icon only appears in the toolbar when the
Maps XPS features are enabled.

2. The Line of Interest icon is located in the middle of the toolbar (see image above). Click the
Line of Interest icon.

3. Click and drag your mouse cursor in the Maps Viewer to draw a line.

4. Enter a name for the annotation in the dialog that opens, and then click OK.

5. The Line of interest tab opens in left panel. Update the Line of Interest properties under this
tab.

6. (Optional) Add notes if needed.

7. Click the color picker to designate the annotation color.

8. Set the fill opacity (see details in the table below).

Property Description

Name Displays annotation name.

Notes Displays annotation notes. Click in this field to add or edit these notes.

Color Displays color of annotation. Click the color picker (that is, the eyedropper
icon) to change the color.
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Property Description

Fill Opacity Sets the level of opaqueness for the entire annotation. Click and move the
slider to the right to increase the level of opaqueness, or click and move the
slider to the left to decrease the level of opaqueness. The less opaque, the
more transparent the annotation becomes. Transparent annotations are
useful when overlaying a layer over another layer.

Create area of interest annotation

1. Go to the SEM/SDB toolbar. The Area of Interest icon is present in the toolbar even if the
Maps XPS features are not enabled.

2. The Area of Interest icon is located in the middle of the toolbar (see image above). Click the
Area of Interest icon.

3. Click and drag your mouse cursor within the Maps Viewer to draw a rectangular area.

4. Update the properties as defined and described in the Annotation Tab.

Create site of interest annotation

1. Right-click in the Viewer to access the Viewer Right-Click Menu.

2. Select Add Site of interest.

3. Update the properties as defined and described in the Viewer.

Export XPS to Avantage

After you have created create new annotations for your sites of interest, areas of interest, and
lines of interest, you can export them to an XML file and then later import the XML file into the
Avantage software for post processing.

Export procedure

1. Go to the right side of the SEM/SDB toolbar.

Note: Alternatively, you can start the export with the Main screen method and
then skip to step 5.
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2. Click the Workflow icon.

3. Select Export to Avantage from the menu.

4. Click Begin.
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5. A single-step workflow panel opens on the right side of the export screen. This panel
contains all annotations that you have created in the project.

Here you can do the following:

l All of your annotations are preselected, but you can deselect any of them if desired.

l You can double-click an annotation to center and zoom Maps on it.

l You can also select how these annotations will be exported.

Note: Lines are exported as lines, sites are exported as points, and areas are
exported as either areas or lines. If you export an area as a line, then the area is
collapsed into a central line from within the area.

6. When the File Save dialog opens, select a file system location, enter the name of the
exported file, and then click Save.
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Main screen method

1. Go to the File menu.

2. Select Export to Avantage from the menu.
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Rotational Alignment
This topic gives instructions for using the Rotational Alignment feature.

Caution: Take care when using this feature with detectors inserted. Also, verify the
clearance of installed stage hardware manually using the xT UI before performing the
rotation in Maps.

1. Right-click where point 1 is to be placed.

2. On the context menu, click Rotational Alignment and then Place Point 1.
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3. Right-click where point 2 is to be placed.

4. On the context menu, click Rotational Alignment and then Place Point 2.
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5. Select the rotation that you want to use.

l Stage Rotation: Uses stage rotation to align the image.
l Scan Rotation: Uses scan rotation to adjust the image.

The microscope rotates to make the line between Points 1 and 2 horizontal and zooms the
viewer to the line.
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SEM and SDB Scan Rotation
This function rotates the scan and aligns the image. It has no effect on the stage movements
and is solely a scan coil function, but is used to orient the image relative to mechanical rotation
and detector direction.

Control Description

Scan rotation Displays and controls the current scan rotation in the
microscope. Click the up arrow to assign the viewer
rotation value to the scan rotation text box.

Link Select the Link checkbox to link the scan rotation with
the viewer rotation. When linked, changes to the scan
rotation angle automatically rotate the viewer and vice
versa. This is indicated by the green rotational dial in
the main viewer. When unlinked, the rotational dial is
white.

Stage rotation See Stage Rotation.

Sca n Ro t a t i o n De s c r i p t i o n s , SEM and SDB

Stage Rotation
Type a value into the text box and press Enter to rotate the stage in the microscope.

Limited Rights

PN 1551059 Revision A | 11-Mar-2025

Maps 3.32.1 User Guide

295 | Original Instructions

SEM/SDB



Set sample tilt
Setting the sample tilt allows Maps software to perform stage moves with the stage unlinked.
Having this tilt set lets Maps know how to drive the stage in x and y while maintaining the same
height of the sample. This is vital when performing imaging within the Maps software.

Before you perform this procedure, confirm that the sample is perpendicular to the electron
beam. This preliminary step adjusts the Maps stage to keep the sample at the same distance
from the beam; thus, allowing navigation and tiling at stage tilt.

Note: Setting sample tilt makes the linked focus unavailable.

To set the sample tilt:

Before the sample tilt is set, Maps software displays the current stage tilt in degrees next to the
menu command.

1. On the Microscope menu, click Set Sample Tilt.

2. Maps software asks if you want to set the current sample tilt to the current stage tilt and it will
unlink Z from the working distance. Click Yes.

The Sample Tilt is now set. A check mark is displayed next to the menu command along with
the stage tilt that was set.

Task Result

With the sample tilt set, you can now image the tilted sample with Maps software.
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SEM Nav-Cam Alignment
For systems that have the Nav-Cam, Maps is able to acquire Nav-Cam images and align them.
Maps is also able to save the Nav-Cam Alignment to be automatically applied to all future Nav-
Cam images acquired with Maps.

Align the SEM Nav-Cam
1. Click the Import from Nav-Cam tool bar icon .

2. When the Nav-Cam image appears in Maps, right-click on its name in the Layer control.

3. On the context menu, click Align.

4. Follow the alignment wizard to perform the coarse point alignment (1-, 2- or 3-Point) as
described in Coarse Alignment (1-, 2-, or 3-Point).

5. Follow the alignment wizard to perform fine alignment adjustments as described in Fine
Alignment.

6. Test the Nav-Cam alignment by navigating to features on the sample and acquiring preview
images.

If the Nav-Cam image is not sufficiently aligned, then perform the alignment procedure
again.
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7. When the Nav-Cam image is sufficiently aligned, right-click on its name in the Layer control.

8. On the context menu, click Persist Nav-Cam Alignment.

All subsequent Nav-Cam acquisitions using Maps will use this alignment.

Clear the Nav-Cam alignment

This clears the alignment for an individual image.

1. Right-click the Nav-Cam image in the Layer control.

2. On the context menu, click Alignment and then Clear Alignment.

Clear the saved default Nav-Cam alignment

This clears the alignment for all acquired Nav-Cam images.
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1. On the Options menu, select Settings -> Microscope.

2. Click Clear Nav-Cam Alignment.
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Phenom
This section describes user interface elements and procedures that are specific to the Phenom
desktop SEM systems.

Topics include:

Phenom Connectivity

Phenom Settings

Phenom Operational States

Phenom User Interface Elements
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Phenom Connectivity
When Maps starts for the first time, or when you have configured Maps to ask for a connection
(see Phenom Settings), then the connection dialog opens as shown below.

Connect microscope
1. Click the Device dropdown menu and select a Phenommicroscope from the list of

microscopes. If you do not see the desired microscope in the list, then do the following:

a. Click Refresh and then select the desired microscope from the refreshed list.

b. If the refreshed list does not contain the desired microscope, then enter the IP address of
the desired microscope in the Device field.

2. Optional: If you added a new Phenommicroscope to the list of microscopes (see Phenom
Settings), then select the Remember this Phenom checkbox. Maps will then add the new
Phenommicroscope to the list of known microscopes, so that it is a menu option in the
future.

3. Optional: If you want Maps to automatically connect to your selected microscope upon
startup, then select the Automatically reconnect with this Phenom at the start checkbox.

4. Select one of the following options to complete this procedure:

l Click Connect to initiate the connection between Maps and the selected Phenom
microscope.

l Click Continue offline if you do not want to connect to a microscope. Maps will continue to
perform in the offline mode.
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Connection states

The connection state icon is located in the lower-right corner of the Maps main screen. There
are four color-coded connection states as described below.

States Description

A green icon indicates that Maps is connected to the microscope with full use
and control.

A blue icon indicates that Maps is connected to the microscope, but the
connection is read-only since the microscope is locked by some other process
(es). With this status, you can still use Maps, but you cannot use or control the
microscope.

A yellow icon indicates that Maps has lost the connection to the microscope.
Note that the lost connection might be temporary since Maps automatically
attempts to reestablish the connection while in this status. With this status, you
can still use Maps, but you cannot use or control the microscope.

A red icon indicates that Maps is not connected to the microscope. With this
status, you can only use Maps in the offline mode.
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View microscope details and disconnect

If you want to view the microscope details and/or disconnect the microscope from Maps, perform
the procedure described below.

1. From the Main screen, click Phenom->Phenom instrument to open the Phenom instrument
dialog. This dialog displays the connection state and microscope details.

2. Click Disconnect to disconnect the Phenommicroscope. When disconnected, Maps
switches to the offline mode. Note that Maps cannot reconnect or connect to another
microscope when it is in the offline mode.
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Phenom Settings
The Phenom settings allow you to define the Maps connection startup behavior and manage the
known Phenommicroscopes.
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Configure settings
1. Navigate to the Options menu, click Settings, and then click the Phenom tab.

2. Click one of the following Maps startup options:

l Ask for connection: The connection dialog appears when Maps starts (see Phenom
Connectivity).

l Connect to microscope: Maps automatically connects to the selected Phenom
microscope when Maps starts.

l Start offline: Maps starts in the offline mode without a Phenommicroscope connection.

3. Under Known Phenommicroscopes, review the list of stored Phenommicroscopes. This list
displays the instrument ID, IP address, and user name associated with the microscope.

l To add a new microscope to the list, refer to the connection procedure under Connect
microscope.

l To remove a microscope from the list, click the trash can icon next to the microscope's
user name. When a warning dialog prompts you to confirm the removal, click OK to save
the change and close the warning dialog.

4. Click Apply to save your settings, or click OK to save your settings and close the Settings
screen.

Phenom Operational States
This topic describes the operational states of the connected Phenommicroscope. Maps can use
and control a Phenommicroscope only when the following criteria is met:

l The microscope is operational.

l The microscope is in the operational mode, which is the SEMmode.

If this criteria is not met, then Maps will prompt you to take corrective action through the Phenom
instrument dialog.

Corrective actions

With each of these operational states you have the two options. You can either bring the
microscope to the operational mode, or disconnect the microscope and continue with Maps
offline.
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Note: Note that Maps cannot reconnect to the microscope when it is in the offline
mode.
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Operational state: The sample is unloaded and the microscope door is open
l Click Close the door and move to SEM to bring the microscope to the operational mode.
l Click Continue offline to disconnect and switch Maps to the offline mode.

Operational state: The microscope is on standby
l Click Activate and move to SEM to bring the microscope to the operational mode.
l Click Continue offline to disconnect and switch Maps to the offline mode.
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Operational state: The sample is under NavCam
l Click Move to SEM to bring the microscope to the operational mode.
l Click Continue offline to disconnect and switch Maps to the offline mode.

Phenom User Interface Elements

Phenom Toolbar, Right Side

See Left Side, All Systems for common selections on all systems.

Toolbar, right side, Phenom

Tool Description

Import Nav-
Cam

Imports a Nav-Cam image or acquires a new one if none
is available, and imports the image to project. This top-
down image of the stage can be used for point and click
navigation of the sample. See Nav-Cam Alignment
(SEM/SDB Only).

Too l b a r D e s c r i p t i o n s , P h e n om
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Tool Description

Take Snapshot Acquires an image at the current stage position and
horizontal field width (HFW), and then places the image
in the Maps viewer as a snapshot image. The image is
acquired using the current parameters set in the
microscope.

Too l b a r D e s c r i p t i o n s , P h e n om (Con t i n u e d )

Phenom Tile Set Tab

This topic describes options in the Tile Set tab for the Phenommicroscope.

Basic tab
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Control Description

Name Displays and sets the name of the current tile set.

Tiles X, Y Sets the number of tiles in the X and Y directions.

Tile HFW Specifies the horizontal field width (HFW) for each tile.

Values between 10 μm and 1 mm are always available. Other values can
be used too, but their usage is limited to certain High Voltage and Working
Distance settings. Confirm that your desired value is available for the
acquisition. Limited values are indicated with the following warning icon:

Total HFW Shows the total HFW of the whole tile set.

Resolution Specifies the image resolution. Select the resolution from the list or enter a
custom resolution.

Pixel Size Displays the physical size of a single pixel at the current acquisition
settings. This is based on Tile HFW and Resolution.

Averaging Sets averaging, or the number of image frames. Select a value from the list
of preset options, or enter a custom value (number 1–255).

 The preset options are:
l Live (1)
l Medium (4)
l High (16)
l Best (32)

Contrast Sets contrast. The value is a number between zero and one hundred (that
is, 0.0–100.0).

Brightness Sets brightness. The value is a number between zero and one (that is, 0.0–
1.0).

T i l e S e t T a b , B a s i c T a b Ove r v i ew
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Control Description

Image
acquisition
time

Displays the estimated time required to acquire a single image in the tile
set.

Estimated
acquisition
time

Displays the estimated remaining time required to acquire the whole tile
set.

Elapsed
acquisition
time

Displays the actual elapsed acquisition time.

From
Microscope

Applies the current microscope settings to the tile set.

To Microscope Applies the tile set settings to the microscope. In some instances, this
operation might require additional time to process as shown in the dialog
below:

T i l e S e t T a b , B a s i c T a b Ove r v i ew (Co n t i n u e d )
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Focus tab

Select the Focus Strategy to focus the electron beam to produce a sharp image.

l None: The application does not touch the focus at all.

l Fixed: Uses the same focus for every tile.

To set the fixed focus:

1. In the microscope, navigate to the sample location and manually focus the image.

2. Click Set to retain the working distance in the tile set.
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l Interpolated: Select three focus points on the sample. The focus plane is then defined by
these points. Each tile’s focus is set based on where it is located in this plane.

To set up the interpolated focus:
1. Navigate to the first location.

2. Manually focus the image.

3. When the image is in focus, click Set. The focus is retained for Point 1.

4. Repeat steps 1–3 for Point 2 and then for Point 3. Once all three points are set, the tiles
are ready to be acquired.

5. Choosing points that are at opposite ends of the sample is important to get the best
results.

6. Position of the points is visible in the viewer when the tile set is selected:
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Autofunction tab

Autofunction Description

Auto Focus Focuses the electron beam to produce a sharp
image

Auto Contrast
Brightness

Optimizes the contrast and brightness of the
image

Final Auto Focus Performs on the last focus optimization

Set autofunctions

1. Select the autofunctions to use during acquisition.

2. In the Mode combo box, select the mode in which the autofunction should be performed.
Available modes include the following:

l None: The autofunction is not used.
l Every tile: The autofunction is run locally at every tile.
l First tile: The autofunction is run once at the first tile before the acquisition.
l Custom tile list...: The autofunction is run over specified list of tiles. Select this option to
create a new list.
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Create a custom tile list

Click Custom tile list option and the selection workflow panel opens and displays instructions to
guide you. In the viewer, select tiles where the autofunction should be performed and name the
new list. You can use the Select Nth tile option in the right panel to quickly select tiles at the
selected Nth internal. You can finish the selection with closing the workflow panel or with leaving
the autofunction tab. The new list is inserted to the mode combo box and can be re-used by
other autofunctions in this tile set. Use the edit button if you need to further edit any tile
selection.
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Advanced tab

Use the controls on this tab to set advanced tile acquisition properties for each tile set.

Control Description

Overlap X, Y Displays the percentage of overlap between tiles in the tile set, as well as
the pixels.

Stage X Sets the X stage location of the center of the tile grid.

Stage Y Sets the Y stage location of the center of the tile grid.

Scan Rotation Allows manual adjustment of scan rotation for a tile set. Either enter a
value in the edit box here, or rotate the tile set in the viewer to update the
scan rotation value.

T i l e S e t T a b , A d v a n c e d T a b Ove r v i ew
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Control Description

Detector Selects the detector for the acquisition. Available detectors may be
different for different microscopes.

Note: The SED detector requires High vacuum. If the SED detector is
selected, then the vacuum control is set to High and deactivated.

Activation of the SED detector might need some time, and the Maps
application must wait for the activation while the tile set settings are applied
to the microscope. During this waiting period, an estimate of remaining
time is displayed in the progress dialog.

Note: You can abort the SED activation by clicking Cancel. When aborted,
the SED detector is not set in the microscope.

HDR Specifies whether HDR (High Dynamic Range) should be applied to
images.

Note: If HDR is applied, it also sets the image format to 16-bit.

High Voltage Sets the high voltage setting. Select a value from the list of presets, or
enter a custom value.

The preset options are:
l 5 kV
l 10 kV
l 15 kV
l 20 kV

T i l e S e t T a b , A d v a n c e d T a b Ove r v i ew (Co n t i n u e d )
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Control Description

Intensity Sets beam intensity. Select a value from the list of preset values, or enter a
custom value.

The preset options are:
l Low (2.1)
l Image (3.3)
l Point (4.3)
l Map (5.1)

Vacuum Specifies the required vacuum pressure during acquisition.
Options are:
l High: 0.1 Pa or 1.0 Pa (according to the specification of the connected
Phenommicroscope)

l Medium (10 Pa)
l Low (60 Pa)

If the tile set settings are applied to a microscope, then the microscope
might need some time to reach the required pressure. The Maps
application waits until the pressure level stabilizes. During this waiting
period, current pressure and an estimate of remaining time are displayed in
the progress dialog.

Note: If you need to abort the waiting period for the pressure stablization,
click Cancel.

T i l e S e t T a b , A d v a n c e d T a b Ove r v i ew (Co n t i n u e d )
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Control Description

Acquisition
Order

Determines the order in which the contained tiles are acquired.

Options are:

l Raster: Left to right, then top to bottom.
l Serpentine: Alternating left to right pattern per row, running top to
bottom.

l Spiral In: Iterating over tiles in a clockwise pattern starting with the
outer most tiles moving inward.

l Spiral Out: Iterating over tiles in a clockwise pattern starting with the
inner most tiles moving outward.

From
Microscope

Applies the current microscope setting to the tile set.

To Microscope Applies the tile set settings to the microscope. In some instances, this
operation might require additional time to process as shown in the dialog
below:

T i l e S e t T a b , A d v a n c e d T a b Ove r v i ew (Co n t i n u e d )
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EDS tab

Control Description

EDS
Acquisition
(checkbox)

When selected, activates the acquisition of X-ray spectrums that are
processed into separate element channels.

EDS Dwell Sets the minimum time to acquire X-rays per tile.

Values between 1 millisecond and 10 seconds are allowed.

EDS Tab Ove r v i ew
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Control Description

Elements Defines the elements that will be processed from the acquired spectrum. A
color channel will be added for each element that you select:

You can use the color picker as needed to change the colors in the right
column, but the defaults are shared between the Phenom user interface
and the Maps software application.

If additional elements are added after the acquisition is finished, the
spectrum will be reprocessed and channels will be added for each of the
additional elements. Note that any elements that you deselect will have
their channels deactivated, but they will remain in the layer tree unless you
manually delete them.

See Element Selector for more information.

EDS
Resolution

Sets the resolution of the EDS map, this is directly proportional to the tile
set resolution

EDS Tab Ove r v i ew (Co n t i n u e d )
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Element Selector

To select the elements that you want to identify during acquisition, do the following:

1. Go to the Elements field and click its ellipsis icon to open the Element Selector as shown
below.

2. Right-click each element that you want to identify during EDS acquisition. This action selects
the individual elements.

3. Optional: To associate a specific color with each selected element, right-click the element
and select the desired color from the color picker. The selected color is used for the EDS
map generated for given element. If a color is not associated with the element, then the color
is automatically selected from the system palette to match the color that you typically see in
the xT UI.

4. Click OK.
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Phenom Scan Rotation

This function rotates the scan and aligns the image. It has no effect on the stage movements
and is solely a scan function, but is used to orient the image relative to the detector direction.

Control Description

Scan rotation Displays and controls the current scan rotation in the microscope. Click the
up arrow to assign the viewer rotation value to the scan rotation text
box.

Link Select the Link checkbox to link the scan rotation with the viewer rotation.
When linked, changes to the scan rotation angle automatically rotate the
viewer and vice versa. This is indicated by the green rotational dial in the
main viewer. When unlinked, the rotational dial is white.

Sca n Ro t a t i o n De s c r i p t i o n s , P h e n om
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Phenom Post-Acquisition Actions 

This section describes the post-acquisition actions for Phenommicroscopes.

The table below contains the post-acquisition actions. You can activate any combination of
these actions or all of them depending on your use case. If you activate all of them, then the
Maps application performs them in the following order: Pump to HiVac When Done, Move to
NacCamWhen Done, Go to Standby When Done.

Control Description

Pump to
HiVac When
Done

Returns the microscope to HiVac mode after all jobs are completed.Select
this actionThis can be useful if you used LowVac or MedVac mode for the
acquisition.

Move to
NavCam
When Done

Moves the sample to the NavCam after all jobs are completed.

Go to
Standby
When Done

Puts the microscope in the standby operational state after all jobs are
completed.

Po s t - A c q u i s i t i o n A c t i o n s
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TEM
This section describes user interface elements and procedures that are specific to the TEM,
EFTEM, and STEMmodes on TEM systems.

Topics include:

TEM User Interface Elements

Define a Tile Set for TEM

TEM Tiling Corrections

Tiling Corrections Quality

Magnification Alignment

Use Interpolated Focus Method

STEM Acquisition with Multiple Detectors

STEM Intermediate Images

Automated Image Filtering

TEM Analytics
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TEM User Interface Elements

TEM Options Menu
l For descriptions of common selections to all systems, see Options menu.

l For descriptions of TEM-specific selections outlined in purple, see the table below. Note that
microscope settings are system specific.
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Menu
Selection Description

Microscope
Settings

Autofunction settings:

l Ignore failed autofunctions: When you select this check box, the
autofunction errors during tile set acquisition are ignored and the tile
set acquisition automatically continues without an error dialog. If
desired, you can view failed autofunction errors within the TEM
Notification Panel. They are listed as pipeline warning messages.

l Autofunction failed dialog timeout: When you deselect the Ignore
autofunction errors option under Settings >> Microscope, this option
specifies the timeout period for automatically closing the autofunction
error dialog. Tile set acquisition continues after the error dialog closes.
You can modify the default value in the text field if desired.

Op t i o n s Menu Ove r v i ew
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Menu
Selection Description

Stage settings:

l Use Backlash correction for Stage: When this check box is selected
(default), stage moves are more accurate because the moves are
performed in a way to reduce backlash and wind-up effects. Usually
there is no need to turn this correction off, and this switch is mostly
used for diagnostics. One might consider temporarily turning off the
correction to speed up low-magnification overviews (at the cost of
accuracy) as the corrected move takes a bit longer.

l Stage Axis Angle Correction: This is a small correction angle that
allows for compensating for mechanical imperfections, if present, in
the orthogonality between the X and Y axis of the stage. The default
value is 0. Only adjust this value if there is a recurring, significant
misalignment between tiles in TEM and STEMmodes.

Optics settings:
l STEM Scan Orientation Correction: This is a small correction angle
for compensating imperfections in the calibration of the STEM scan
rotation. The default value is 0. Only adjust this value if there is a
significant systematic misalignment between tiles in STEMmode.

l Beam Blanker Unblank Setting Time: After blanking or unblanking
the beam, it takes a short time for the optics to settle. The default
values are sufficient for most systems, but on Tecnai systems without
a fast beam blanker, a value of 1–3 seconds is recommended. An
insufficient setting time manifests itself only in STEMmode, resulting
in tile images where the top part starts out black and unstable.

Op t i o n s Menu Ove r v i ew (Co n t i n u e d )
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Menu
Selection Description

Acquisition
Settings
(STEMMode)

STEMMode

Displays the Detector, Dwell Time, and Resolution Settings to be used for
acquisitions of snapshot images when in STEMmode. This screen also
displays the Default Autofunctions Templates. These dropdown menus
enable you to select a template for autofunctions with default imaging
parameters that differ from the imaging parameters of tile images. See the
TEM Default Autofunction Templates for details.

The default settings for Eucentric Template and Focus Template contain
default autofunction parameters for new tile sets.

Op t i o n s Menu Ove r v i ew (Co n t i n u e d )
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Menu
Selection Description

Acquisition
Settings
(TEMMode)

TEMMode

Selects the Exposure Time to use for the acquisition of snapshot images.
Snapshots are always acquired with the maximum camera resolution,
such as binning 1. This screen also displays the Default Autofunctions
Templates. These dropdown menus enable you to select a template for
autofunctions with default imaging parameters that differ from the imaging
parameters of tile images. See the TEM Default Autofunction Templates
for details.

The default settings for Eucentric Template and Focus Template contain
default autofunction parameters for new tile sets.

Op t i o n s Menu Ove r v i ew (Co n t i n u e d )
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Menu
Selection Description

Acquisition
Settings
(EFTEMMode)

EFTEMMode
Selects the Exposure Time to use for the acquisition of snapshot images.
Snapshots are always acquired with the maximum camera resolution,
such as binning 1. This screen also displays the Default Autofunctions
Templates. These dropdown menus enable you to select a template for
autofunctions with default imaging parameters that differ from the imaging
parameters of tile images. See the TEM Default Autofunction Templates
for details.
The default settings for Eucentric Template and Focus Template contain
default autofunction parameters for new tile sets.

Op t i o n s Menu Ove r v i ew (Co n t i n u e d )
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Menu
Selection Description

Data Exchange
Settings

GRPC server:

l Port: Shows the port number that the clients use to communicate with
the server. This is used for diagnostics purposes, in case there is a
conflict with another GRPC-based server.

l Server status: Shows the current version and status of the server.
Possible states are Not installed, Running, Stopped.

l Start: Starts the server if it is not running. The server must be installed.
l Stop: Stops the server.

Op t i o n s Menu Ove r v i ew (Co n t i n u e d )
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Menu
Selection Description

GRPC client:
l Server response: Shows the response from the server when the
connection test is in progress. Shows the result of the test when the
test is complete.

l Test Connection: Tests the connection to the server while the server
is running. This connection test is used for diagnostics purposes. It
performs actions that Maps client does when connecting to the server
and shows the result of each of the actions.

Tile Set
Templates...

On TEM, you cannot edit custom tile set templates. See Tile Set
Templates for full template instructions.

Alignment
Corrections...

Displays the corrections that currently apply for metrology analysis.

Tiling
Corrections...

Shows dialog with the list of tiling corrections that are currently available.
See TEM Tiling Corrections topic for more details.

Automatic
Histogram
Stretching

Automatically equalizes the minimum and maximum of associated tile set
histograms during acquisition.

Op t i o n s Menu Ove r v i ew (Co n t i n u e d )

TEM Toolbar, Right Side

See Left Side, All Systems for common selections to SEM/SDB systems.
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Toolbar, right side, TEM, EFTEM, STEM modes

Tool Description

Run Eucentric
Height
autofunction at
current position

Runs Eucentric Height autofunction at current stage position. Default
autofunction template for Eucentric Height autofunction will be used to
set acquisition parameters on the microscope. Click Stop to cancel
operation.

Take Snapshot Acquires an image at the current stage position and magnification and
places it on the Maps viewer as a snapshot image.

See TEM Options Menu.

Magnification
Alignment

Aligns tile sets from one magnification to another to correct small shifts.
See Magnification Alignment.

Import
Fluorescence
Data

Opens dialog where fluorescence data from optical microscope can be
selected and imported to the current Maps project.
Note: Requires Cryo features to be activated within the Settings.

Import Arctis Data Opens a dialog for you to select and import Arctis data into the current
Maps project. See Import and view Arctis data.
Note: Requires Cryo features to be activated within the Settings.

Too l b a r TEM , EFTEM , STEM mode De s c r i p t i o n s

Maps 3.32.1 User Guide
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Tool Description

Toggle Automatic
Synchronization

Toggles automatic synchronization of data with Tomography ON and
OFF.
Note: Requires Thermo Scientific Maps Data Exchange Service to be
installed and running.

Start Workflow Opens workflow selection dialog, from where specific alignment
workflow can be started.

Too l b a r TEM , EFTEM , STEM mode De s c r i p t i o n s (C o n t i n u e d )

TEM Tile Set Tab

Basic group, TEM and EFTEMmodes
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Control Description

Name Displays the name of the current tile set.

Tile Set Type Indicates that the acquisition mode for this tile set is TEM, EFTEM, or
STEM.

Camera Selects the camera to use for the acquisition of tile images. Unsupported
cameras are also listed and indicated in the camera dropdown list. These
unsupported cameras may work with Maps, but compatibility is not
guaranteed.

Tiles X, Y Sets the number of tiles in the X and Y directions.

Overlap X, Y Displays the percentage of overlap between tiles in the tile set as well as
the pixels.

Tile HFW For TEM, this is not editable. It is determined by the magnification,
camera, and other optical settings.

Total Area Displays the total HFW for all of the tiles.

Grid Squares
Mask

Selects the detected grid layer to apply as a mask for the current layer.

Resolution Specifies the image resolution. The choices are specific to each system
type.

Magnification Selects the magnification to use for the acquisition of the tile images

Pixel Size Displays the physical size of a single pixel at the current acquisition
settings. This is based on Tile HFW and Resolution.

Exposure Time Specifies the exposure time on the camera for each tile acquisition.

Number of Tiles
Acquired

Displays the number of tiles and the total disk space required to acquire
the current tile set. A message appears if there is not enough space on
disk for the acquisition.

T i l e S e t T a b , TEM and EFTEM Mode s , B a s i c G r o u p Ove r v i ew
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Control Description

From
Microscope

Reads the current optical settings from the microscope and stores them in
the acquisition settings of the selected tile set.

To Microscope Sets the optical parameters of the acquisition settings of the selected tile
set to the microscope.

T i l e S e t T a b , TEM and EFTEM Mode s , B a s i c G r o u p Ove r v i ew (Co n t i n u e d )

Note: From Microscope/To Microscope controls:

l Camera settings are not read from or written to the microscope; camera settings
only apply during acquisition.

l Not all the optical acquisition settings can be edited directly. Some optical
acquisition settings require clicking From Microscope to update the values.

Focus group, TEM and EFTEMmodes
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Control Description

Focus
Method

Specifies whether the tile set is acquired with specific focus settings or none
at all. The options are:

l None: The focus on the microscope is left as-is.
l Fixed: The tile set is acquired at a fixed focus value to be stored in the
tile set with the From Microscope button plus an optional relative
Defocus for contrast formation.

l Interpolated: You select three focus points on the sample and a focus
plane is defined by these points. Each tile focus is set based on where it
is located in this plane. See Use Interpolated Focus Method to perform
the interpolated focus method procedure.

Nominal
Defocus

When Focus Method is set to Fixed, specifies the amount of relative defocus
to apply when acquiring the tiles.

Note: Sets the focus to the microscope, not the defocus. The
defocus is only applied during acquisition as a relative value on
top of the Focus setting that was stored with the tile set.

T i l e S e t T a b , TEM and EFTEM Mode s , F o c u s G r o u p Ove r v i ew
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Control Description

Objective
Lens

When the Focus Method is set to Fixed, this is the objective lens strength
setting to apply when acquiring the tile set. To update this value, click From
Microscope.

Stage Z When Focus Method is set to Fixed, specifies the Z coordinate at which the
tile set is acquired.

Click the check box to retrieve the current value from the instrument.

From
Microscope

Reads the current optical settings from the microscope and stores them in
the acquisition settings of the selected tile set.

To
Microscope

Sets the optical parameters of the acquisition settings of the selected tile set
to the microscope.

T i l e S e t T a b , TEM and EFTEM Mode s , F o c u s G r o u p Ove r v i ew (Co n t i n u e d )
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Autofunction group, TEM and EFTEMmodes

Use the controls in this group to define the Eucentric Height and Focus autofunction parameters
for each TEM tile set. The Eucentric Height autofunction parameters are initially set at the
creation of the tile set and filled with the values of the selected template, or with the current
values on the instrument if the default template is used. After creation of the tile set, click From
Microscope to update the values to the current state on the microscope. Some settings can be
entered directly. For each autofunction, for example, you can specify which tiles of the tile set to
run the autofunction. The list of values is specific for each autofunction.

Control Description

Name Available autofunctions are listed in this column.
l Eucentric Height: The Eucentric Height autofunction will adjust the sample
height so that the sample can be tilted and the area of interest remains in
the field of view. For the current tile set, you can select a custom
autofunction template that is different from the default autofunction
template.

l Focus: The Focus autofunction will adjust the focus for a clear, sharp image.
For the current tile set, you can select a custom autofunction template that is
different from the default autofunction template.
For both autofunctions, the options are:
l The default autofunction template is the template that you defined under
the Tile Set Templates settings.

l The other options include a dynamic list of templates that you define as
the user.

T i l e S e t T a b , TEM and EFTEM Mode s , A u t o f u n c t i o n G r o u p Ove r v i ew
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Control Description

Mode Mode selection of the autofunction.

Note: For the Eucentric Height autofunction, only the None and First
Tile modes are available.

Choices from the dropdown menu include the following:
l None: Autofunction does not run on the tile set.

l First Tile: Autofunction runs only on the first tile within the tile set.

l Every Tile: Autofunction runs on every tile within the tile set.

l Custom Tile List: This allows you to select a custom collection of tiles
where autofunction runs. Select your collection of tiles by pressing
Ctrl+right-click, or by using the Select Nth tile option in the right panel.

T i l e S e t T a b , TEM and EFTEM Mode s , A u t o f u n c t i o n G r o u p Ove r v i ew (Co n t i n u e d )
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Configure autofunctions

You can configure parameters for each autofunction by selecting Autofunction, and then
clicking Configuration or the gear icon.

Autofunction Control Description

Eucentric Height Final Stage
Angle°

Specifies the final stage angle. The default value is set
to 15.0 degrees and accepts values from 1.0 to 90.0
degrees.

Maximum Z-
Height
Deviation

Specifies the maximum accepted Z-height difference
measured between negative and positive final stage
angles. The default value is set to 250 nm and it accepts
values from 250 nm to 2 µm. Autofunction processes
more quickly if you use a high value for this control, but
the result will be less accurate.

(Beta) Use
Image
Filtering

When activated, automatic image filtering is applied to
cross-correlation algorithm.

T i l e S e t T a b , TEM and EFTEM Mode s , A u t o f u n c t i o n Con f i g u r a t i o n
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Autofunction Control Description

 Focus Desired
Defocus

Desired result of Focus Autofunction - expressed as a
difference against optimal focus.

Iterate to Specific focus level to which Focus Autofunction
iterates - expressed as a difference against optimal
focus.

Focus Method Method used to adjust current focus. Possible values
are Objective Lens and Stage Z Height.

Use Auto
Stigmate

When enabled, performs astigmatism correction.

Use Three
Image Method

When enabled, uses three image method to determine
cross-correlation and peaks, as the function computes
focus adjustment.

(Beta) Use
Image
Filtering

When activated, automatic image filtering is applied to
cross-correlation algorithm.

T i l e S e t T a b , TEM and EFTEM Mode s , A u t o f u n c t i o n Con f i g u r a t i o n (C o n t i n u e d )

Autofunction error dialog

If you experience an autofunction error (and the Ignore autofunction errors option is not
selected under Settings >> Microscope), then the following error dialog appears. This error
dialog closes after the specified time (defined in the Autofunction failed dialog timeout option
under Settings >> Microscope), and the tile set acquisition job continues.
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Choices include:
l Yes {28s}: Click to ignore the error dialog and continue with the image acquisition. The value
in brackets indicates the total number of seconds required to perform the image acquisition.

l Ignore: Click to prevent these error dialogs from appearing in the future. If you opt to ignore
future error dialogs, you can still view failed autofunction errors within the TEM Notification
Panel. They are listed as pipeline warning messages.

l No: Click to stop the acquisition job.

Maps 3.32.1 User Guide
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Advanced group, TEMmode

The advanced parameters are initially set at the creation of the tile set and filled with the settings
of the selected template (or filled with the current settings on the system if the default template is
used). After creation of the tile set, click From Microscope to update the settings to the current
state on the instrument. For some settings, you can enter values directly into the user interface.

Control Description

Noise Reduction Specifies the Noise Reduction setting
associated with the BM-Ceta camera.
See the Ceta 16M Application Instructions
for details.

Frames Summed Specifies the Frames Summed setting
associated with the BM-Ceta camera.
See the Ceta 16M Application Instructions
for details.

T i l e S e t T a b , TEM Mode , A d v a n c e d G r o u p Ove r v i ew
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Control Description

Illuminated Area Specifies the beam intensity to use during
the tile set acquisition.

Spot Size Specifies the spot size to use during the
tile set acquisition.

Probe Mode Specifies the probe mode, such as the
NanoProbe or MicroProbe, to use during
the tile set acquisition.

C2 Aperture Specifies the C2 aperture size to use
during the tile set acquisition. Select a
value to activate, or select None to
deactivate.

Use image corrections When this setting is activated, a small
image correction is applied to the
acquired tile images resulting in improved
tile set accuracy. Using this setting
slightly affects the raw data recorded by
Maps. If this result is undesired, turn off
the image correction. This results is less
accurate navigation.

Note: When the correction is
activated, the tiles are slightly
smaller. Also, with the
correction activated you can
notice a small difference
between the purple field-of-
view rectangle and outline of
the tiles.

T i l e S e t T a b , TEM Mode , A d v a n c e d G r o u p Ove r v i ew (Co n t i n -
u e d )
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Control Description

Use Tiling Correction When this setting is activated, tile
alignment is corrected during acquisition
according to a matching tiling correction.
If matching correction is not available,
then by default Maps performs an
uncorrected acquisition. See TEM Tiling
Corrections.

Settling Time Specifies the duration of time in which
acquisition is paused before each tile,
which allows the stage to settle after
moving to the target position.

From Microscope Reads the current optical settings from
the microscope and stores them in the
acquisition settings of the selected tile
set.

To Microscope Sets the optical parameters of the
acquisition settings of the selected tile set
to the microscope.

T i l e S e t T a b , TEM Mode , A d v a n c e d G r o u p Ove r v i ew (Co n t i n -
u e d )
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Advanced group, EFTEMmode

The advanced parameters are initially set at the creation of the tile set and filled with the settings
of the selected template (or filled with the current settings on the system if the default template is
used). After creation of the tile set, click From Microscope to update the settings to the current
state on the instrument. For some settings, you can enter values directly into the user interface.

Control Description

Camera
Mode

Specifies the Camera Mode setting associated with Falcon camera.

Intensity Specifies the beam intensity to use during the tile set acquisition.

Spot Size Specifies the spot size to use during the tile set acquisition.

Probe Mode Specifies the probe mode, such as the NanoProbe or MicroProbe, to use
during the tile set acquisition.

T i l e S e t T a b , EFTEM Mode , A d v a n c e d G r o u p Ove r v i ew
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Control Description

C2 Aperture Specifies the C2 aperture size to use during the tile set acquisition. Select a
value to activate, or select None to deactivate.

Insert Slit When this setting is set to Yes, energy-selecting slit is inserted before tile
set acquisition. When the value is set to No, energy-selecting slit is retracted
before tile set acquisition.

Slit Width Specifies the width of the energy-filtering slit.

Note: This setting is applied only when the energy-filtering slit is
set to be used for the acquisition (Insert Slit settings is set to
Yes).

Use image
corrections

When this setting is activated, a small image correction is applied to the
acquired tile images resulting in improved tile set accuracy. Using this
setting slightly affects the raw data recorded by Maps. If this result is
undesired, turn off the image correction. This results is less accurate
navigation.

Note: When the correction is activated, the tiles are slightly
smaller. Also, with the correction activated you can notice a small
difference between the purple field-of-view rectangle and outline
of the tiles.

Use Tiling
Correction

When this setting is activated, tile alignment is corrected during acquisition
according to a matching tiling correction. If matching correction is not
available, then by default Maps performs an uncorrected acquisition. See
TEM Tiling Corrections.

Settling Time Duration for which acquisition is paused before each tile, to let the stage
settle after moving to the target position.

T i l e S e t T a b , EFTEM Mode , A d v a n c e d G r o u p Ove r v i ew (Co n t i n u e d )
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Control Description

From
Microscope

Reads the current optical settings from the microscope and stores them in
the acquisition settings of the selected tile set.

To
Microscope

Sets the optical parameters of the acquisition settings of the selected tile set
to the microscope.

T i l e S e t T a b , EFTEM Mode , A d v a n c e d G r o u p Ove r v i ew (Co n t i n u e d )

STEM Tile Set Tab

Basic group, STEMmode
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Control Description

Name Displays the name of the current tile set.

Tile Set Type Displays the microscope mode for the tile set, which is either STEM, TEM,
or EFTEM (see TEM Tile Set Tab for TEM or EFTEMmodes).

Tiles X, Y Sets the number of tiles in the X and Y directions.

Overlap X, Y Displays the percentage of overlap between tiles in the tile set as well as the
pixels.

Tile HFW For STEM, this is not editable. It is determined by the magnification, camera,
and other optical settings.

Total Area Displays the total HFW for all of the tiles.

Grid Squares
Mask

Selects the detected grid layer to apply as a mask for the current layer.

Mode Selects the probe mode of the beam: Microprobe, Nanoprobe, or LM. Note
that to use LM STEM, it is strongly recommended to first enable LM STEM
via the TEM User Interface.

Scan Field Of
View

Defines the size of the scan area and magnification for the acquisition of
each tile.

Resolution Specifies the image resolution. The choices are specific to each system
type.

Pixel Size Displays the physical size of a single pixel at the current acquisition settings.
This is based on Tile HFW and Resolution.

Dwell Time Specifies the amount of time the beam dwells on each pixel when images
are acquired.

Scan Rotation Defines the orientation of the scanning, which determines the orientation of
the image. The tile set orientation is adjusted accordingly. Typical use of this
property is to line up the acquired images to a feature on the sample.

T i l e S e t T a b , STEM Mode , B a s i c G r o u p Ove r v i ew
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Control Description

Selected
Detectors

Specifies the detectors to use for the acquisition of tile images. You are
required to select at least one detector. Choices depend on which detectors
are available on the system.

Default
Detector

Specifies the default detector for the acquisition. This detector is used for
situations in which only one detector is required for acquisition such as
within stitching and autofunctions. Choices only include the detector(s) that
you selected for acquisition under Selected Detectors.

Frame Time The estimated time for each tile acquisition.

Number of
Tiles
Acquired

Displays the number of tiles and the total disk space required to acquire the
current tile set. A message appears if there is not enough space on disk for
the acquisition.

From
Microscope

Reads the current optical settings from the microscope and stores them in
the acquisition settings of the selected tile set.

To
Microscope

Sets the optical parameters of the acquisition settings of the selected tile set
to the microscope.

T i l e S e t T a b , STEM Mode , B a s i c G r o u p Ove r v i ew (Co n t i n u e d )

Note: From Microscope/To Microscope controls:

l Camera settings are not read from or written to the microscope; camera settings
only apply during acquisition.

l Not all the optical acquisition settings can be edited directly. Some optical
acquisition settings require clicking From Microscope to update the values.
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Focus group, STEMmode

Control Description

Focus
Method

Specifies whether to acquire the tile set with specific focus settings or none
at all. There the following options:

l None: The focus on the microscope is left as-is.
l Fixed: The tile set is acquired at a fixed focus value to be stored in the
tile set with the From Microscope button.

l Interpolated: You select three focus points on the sample to define a
focus plane. Each tile focus is set based on where it is located in this
plane. See Use Interpolated Focus Method to perform the interpolated
focus method procedure.

T i l e S e t T a b , STEM Mode , F o c u s G r o u p Ove r v i ew
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Control Description

Intensity Lens When the Focus Method is set to Fixed, specifies the beam intensity
percentage value at which the tile set is acquired. This lens focus setting is
set during tile set acquisition. To update this value, click From Microscope.

Objective
Lens

When the Focus Method is set to Fixed, specifies the objective lens
percentage value at which the tile set is acquired. This objective lens setting
is set during tile set acquisition. To update this value, click From
Microscope.

Stage Z When Focused Method is set to Fixed, specifies the Z coordinate at which
the tile set is acquired.

From
Microscope

Reads the current optical settings from the microscope and stores them in
the acquisition settings of the selected tile set.

To
Microscope

Sets the optical parameters of the acquisition settings of the selected tile set
to the microscope.

T i l e S e t T a b , STEM Mode , F o c u s G r o u p Ove r v i ew (Co n t i n u e d )
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Advanced group, STEMmode

Use the controls in this group to set advanced tile acquisition properties for each STEM tile set.
The advanced parameters are initially set at the creation of the tile set and filled with the settings
of the selected template or with the current settings on the instrument if the default template is
used. After creation of the tile set, click From Microscope to update the settings to the current
state on the microscope. Some settings can be entered directly.

Control Description

Spot Size Specifies the spot size to use during the tile set acquisition.

Camera
Length

Specifies the STEM camera length, which is typically used to tune the
contrast of the images.

T i l e S e t T a b , STEM Mode , A d v a n c e d G r o u p Ove r v i ew
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Control Description

Detectors Specifies the individual detector settings for the detectors available on the
system. You can only change settings of the detectors selected for STEM
acquisition.
Choices for each detector include:
l Gain: Specifies the contrast setting of the detector, which represents the
dynamic range of the detected signal (that is, it defines the amplification
of the detector signal).

l Offset: Specifies the brightness setting of the detector, which represents
the null level of the detected signal (that is, it defines the offset of the
detector signal).

Use image
corrections

When this setting is enabled, a small image correction is applied to the
acquired tile images resulting in improved tile set accuracy. Using this
setting slightly affects the raw data recorded by Maps. If this result is
undesired, turn off the image correction (that is, at cost of slightly less
accurate navigation).

Note: When the correction is enabled, the tiles are slightly
smaller. Also, with the correction enabled you can notice a small
difference between the purple field-of-view rectangle and outline
of the tiles.

Settling Time Specifies the amount of time it takes for the stage to settle.

From
Microscope

Reads the current optical settings from the microscope and stores them in
the acquisition settings of the selected tile set.

To
Microscope

Sets the optical parameters of the acquisition settings of the selected tile set
to the microscope.

T i l e S e t T a b , STEM Mode , A d v a n c e d G r o u p Ove r v i ew (Co n t i n u e d )
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Autofunction group, STEMmode

Use the controls in this group to define the Eucentric Height and Focus autofunction parameters
for each STEM tile set. The Eucentric Height autofunction parameters are initially set at the
creation of the tile set and filled with the values of the selected template, or with the current
values on the instrument if the default template is used. After creation of the tile set, click From
Microscope to update the values to the current state on the microscope. Some settings can be
entered directly. For each autofunction, for example, you can specify which tiles of the tile set to
run the autofunction. The list of values is specific for each autofunction.
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Control Description

Name Available autofunctions are listed in this column.
l Eucentric Height: The Eucentric Height autofunction will adjust the sample
height so that the sample can be tilted and the area of interest remains in
the field of view. For the current tile set, you can select a custom
autofunction template that is different from the default autofunction
template.

l Focus: The Focus autofunction will adjust the focus for a clear, sharp image.
For the current tile set, you can select a custom autofunction template that is
different from the default autofunction template.

l (Beta) OptiSTEM: The OptiSTEM autofunction adjusts both the focus and
condenser astigmatism (A1/C1). For the current tile set, you have the option
to select a custom autofunction template that is different from the default
autofunction template. This feature is only available on 2.15 and 3.15 TEM
Server versions.

For all autofunctions, the options are:
l The default autofunction template is the template that you defined under the
Tile Set Templates settings.

l The other options include a dynamic list of templates that you define as the
user.

T i l e S e t T a b , STEM Mode , A u t o f u n c t i o n
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Control Description

Mode Mode selection of the autofunction.

Note: For the Eucentric Height autofunction, only the None and First
Tile modes are available.

Choices from the dropdown menu include the following:
l None: Autofunction does not run on the tile set.

l First Tile: Autofunction runs only on the first tile within the tile set.

l Every Tile: Autofunction runs on every tile within the tile set.

l Custom Tile List: This allows you to select a custom collection of tiles
where autofunction runs. Select your collection of tiles by pressing
Ctrl+right-click.

T i l e S e t T a b , STEM Mode , A u t o f u n c t i o n (C o n t i n u e d )
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Configure autofunctions

You can configure parameters for each autofunction by selecting Autofunction, and then
clicking Configuration or the gear icon.

Autofunction Control Description

Eucentric Height Final Stage
Angle°

Specifies the final stage angle. The default value is set to
15.0 degrees and accepts values from 1.0 to 90.0
degrees.

Maximum
Z-Height
Deviation

Specifies the maximum accepted Z-height difference
measured between negative and positive final stage
angles. The default value is set to 250 nm and it accepts
values from 250 nm to 2 µm. Autofunction processes
more quickly if you use a high value for this control, but
the result will be less accurate.

 Focus Include
Coarse
Search

Allows using the coarse search method.

Coarse
Step

Specifies the coarse step value.

Fine Step Specifies the fine step value.

T i l e S e t T a b , STEM Mode , A u t o f u n c t i o n Con f i g u r a t i o n
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Autofunction Control Description

Number of
Steps

Specifies the number of steps for focus autofunction.

Use Tree
Image
Method

Specifies if the tree image method is used.

(Beta)
OptiSTEM

Algorithm This read-only field specifies the OptiSTEM algorithm.
Currently, only the A1/C1 algorithm is supported. This
feature is only available on 2.15 and 3.15 TEM Server
versions.

T i l e S e t T a b , STEM Mode , A u t o f u n c t i o n Con f i g u r a t i o n (C o n t i n u e d )

Autofunction error dialog

If you experience an autofunction error and the Ignore autofunction errors option is not selected
under Settings >> Application, then you can view the following error dialog. The error dialog
automatically closes after the time specified in the Autofunction failed dialog timeout option
under Settings >> Microscope, and the tile set acquisition job continues.

Choices include:
l Yes {28s}: Click to ignore the error dialog and continue with the image acquisition. The
value in brackets indicates the total number of seconds required to perform the image
acquisition. This option is the default.

l Ignore: Click to prevent these error dialogs from appearing in the future. If you opt to ignore
future error dialogs, you can still view failed autofunction errors within the TEM Notification
Panel. They are listed as pipeline warning messages.

l No: Click to stop the acquisition job.
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TEM Notification Panel

You can view additional information about the progress of the tile set acquisition jobs (and
potentially any other job) in the Notification Panel, which is located under Job Control >>
Notifications.

The Notification Panel contains these three sections.

l Filters: This section is located at the top of the screen and contains three filter buttons:
Notifications, Warnings, and Errors. Toggle each button to show/hide the notification,
warning, and error messages associated with each selected pipeline. If needed, click Clear
All to delete the list of all pipelines and their associated messages.

l Pipelines: This section is located in the middle of the screen and contains a list of pipelines.
A pipeline typically corresponds to a single job, and each pipeline indicates when it was
started. If the pipeline is closed/ended, then is also indicates the time it finished and job
duration.

l Pipeline messages: Click a single row to select a pipeline. Once selected, you can view the
list of associated messages for the pipeline at the bottom of the screen.

Maps 3.32.1 User Guide

362 | Original Instructions

Limited Rights

PN 1551059 Revision A | 11-Mar-2025

TEM



TEM Default Autofunction Templates

See the TEM Options Menu to open Settings >> Acquisition. This screen enables you to assign
a template to each autofunction and mode (TEM, EFTEM, or STEM), which then applies to all
projects. You can select any autofunction template from this screen except for the default factory
template. If a template is not selected for an autofunction and mode (displayed as None in the
dropdown menus), then it is not possible to run an autofunction.
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Template parameters

There are two parts to the autofunction parameters.

l Common imaging parameters (such as magnification, resolution, and pixel size): These
parameters are defined by the autofunction template and used during the tile set
autofunction run.

l Autofunction-specific parameters (such as final stage angle, use auto stigmate, and iterate
to): These parameters are initially determined by the tile set template, but can be changed
for each tile set instance. These settings are available under the configuration button under
the Autofunction tab.

Follow these guidelines to achieve the best results from the autofunctions during your
workflows:

l Either manually create tile set templates, or import templates from the Tomography
application to be used as default autofunction templates.

l For manual template creation, create a new tile set and set parameters to be used for a
specific autofunction run.

l Parameters suitable for autofunction templates can vary based on the specimen or tool type.
For the Eucentric Height autofunction, it is recommended that you use a low SA
magnification range; whereas, for the Focus autofunction, it is recommended that you use a
higher SA magnification range.

l Consider selecting (Beta) Use Image Filtering if you want to improve the reliability of the
default cross-correlation algorithm (depends on your sample type). See Automated Image
Filtering for more information.

l If you right-click your mouse cursor directly on the tile set in a layer tree, then it is possible to
save the tile set as a template. This template can then be aligned to a specific autofunction
by selecting it from the Focus Template dropdown menus listed under Settings >>
Acquisition.

Focus autofunction example

1. Create a new tile set (manually or import it).

2. Set the magnification to 120 kx and other parameters suitable for the Focus autofunction.

3. Right-click your mouse cursor directly on the tile set in layer tree and select Save as
Template, select, New Template, and then enter Focus Template as the name.

4. Go to the main screen, click the Options menu, and then select Default Autofunctions
Templates.
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5. From the Focus Template dropdown menus, select your new focus template and close the
dialog.

6. Create a new tile set and activate Focus Autofunction under that Autofunction tab.

7. Set additional parameters (such as desire defocus for, focus method, etc.) for the Focus
autofunction through the Configuration button under the Autofunction tab.
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TEM Viewer Tile Context Menu

Right-click on a tile within the tile grid to access a context menu.

l For common selections, see the Common Viewer Tile Context Menu Overview.
l For TEM-specific selections, see the table below. and Define a Tile Set for TEM.

Menu
Selection Description

Take Snapshot Takes a single snapshot at the current microscope location.

V i ewe r T i l e C o n t e x t Men u , TEM Ove r v i ew
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Menu
Selection Description

Acquire/Queue
for re-acquisition

Displays whether or not the tile has already been acquired as defined
below. You can toggle between the two tile acquisition states as needed;
however, only the selected acquisition state appears in the menu.

l Acquire: This acquisition state displays if the tile has not been
acquired. If you select the check box for this menu item, then Maps
queues the selected tile to be acquired.

l Queue for re-acquisition: This acquisition state displays if the tile
has already been acquired. If you select the check box for this menu
item, then Maps queues the selected tile to be re-acquired and
replaces the original image.

For TEM, turning off a tile acquisition state will only be remembered
while the tile is inside the stage boundary.

See Define a Tile Set for TEM for more information.

Send to Amira-
Avizo2D

If activated, sends the tile image to Amira-Avizo2D.

Rotate Viewer to
FOV

Digitally rotates the viewer to line up the display to the orientation of the
current field-of-view (as indicated by the purple rectangle).

Rotate Viewer to
Tile Set

Digitally rotates the viewer so the current tile set is aligned with the
screen. See Viewer Tile Context Menu for TEM.

V i ewe r T i l e C o n t e x t Men u , TEM Ove r v i ew (Co n t i n u e d )

TEM Post-Acquisition Actions

This section describes the post-acquisition actions for TEMmicroscopes.
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Control Description

Close Column
Valves When
Done

Closes the column valves after all jobs are completed. Select the check box
to close the column valves after all jobs are completed.

Switch off
Emission
when Done

Applies only to systems with thermionic guns, such as a Talos LaB6. Select
the check box to turn off the gun emission for any queued acquisition to
preserve the filament.
In order to turn the gun emission on again after it is switched off, you must
use the TEM UI, which is outside of Maps.

Po s t - A c q u i s i t i o n A c t i o n s

Define a Tile Set for TEM
This section is a supplement to the general operations on tiles and tile sets. Tiles for TEM cannot
be acquired when they are situated outside the stage boundary. That is why defining, resizing
and moving a tile set on TEM is different from those actions on other systems. It also affects
enabling and disabling Acquire property for a tile.

Methods for defining a tile set

A tile set can be defined the same way as described in Define a Tile Set. When creating a tile
set, Maps software creates a layer in the Layer control. Tiles in that layer that are created inside
the stage boundary have Acquire available by default. Tiles in that layer that are created outside
the stage boundary cannot be acquired (Acquire command is unavailable).

Manually adjust tile sets

Once a tile set is created, you can adjust the size of the tile set with the drag handles in the
viewer as described in Define a Tile Set.
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Acquire menu command

The Acquire menu command is described in TEM Viewer Tile Context Menu. When a tile
Acquire property is turned off, and the tile is moved inside the stage boundary, then the Acquire
command remains unavailable. When the tile Acquire property is turned off, and the tile is
moved outside the stage boundary, and then back inside the stage boundary, then the Acquire
command is made available.

Automatically deactivate a tile after acquisition

When a tile set has been acquired, the tile set cannot be moved again. Also, the Acquire menu
option is not available when the tile has been acquired.

TEM Tiling Corrections
On TEM systems, you will observe imperfections in tile alignment during tile set acquisition. The
imperfections vary across different magnifications and result in visible artifacts along the edges
of individual tiles. The sources of these errors include magnification error, rotation error, and
imprecision of stage movement. You can use the Tiling Correction beta feature to compensate
for these errors and achieve better tile alignment during acquisition.
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Note: This functionality is intended to compensate only for relatively small errors that
remain on an aligned and calibrated system. It is recommended that you always
ensure that your system is properly calibrated and aligned before using Tiling
Corrections.

Stitching verses tiling correction

There are two tiling correction mechanisms available in Maps for TEM systems: stitching and
tiling correction.

Stitching creates a new image layer from a given tile set, in which individual tiles are moved so
that the overlapping portions of neighboring tiles match each other. While the relative shift
between neighboring tiles is computed and stored in tile registration data already during
acquisition, stitching is a post-processing action and can be performed only after the acquisition
is finished.

Tiling correction, on the other hand, takes advantage of the fact that the tile alignment error is
static for a given set of optical settings. This means that the alignment error can be
compensated by correcting tile rotation and magnification during tile set acquisition. The
correction is computed from the same tile registration data as stitching, but instead of using the
correction only on a single layer it is saved for subsequent acquisitions of all tile sets that match
a given set of optical settings.
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Create tiling correction based on existing tile set
1. Click the acquired tile set that has misaligned tiles. For example, the tiles in the following 3x3

tile set are misaligned since the cross-grating pattern is broken along the edges of
neighboring tiles.
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2. Right-click on the selected tile set.

3. In the context menu, click Beta - Save As Tiling Correction.
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4. When the Create Tiling Correction screen appears, review the correction parameters and
quality score generated by Maps.

5. Click OK to create the tiling correction.

Note: If the quality score is Medium or Low, move your mouse over the quality
indicator to view the tool tip. The tool tip contains a short description of why the
quality is lower than High and it provides suggestions for quality improvement.
See Tiling correction quality for more information.
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View available tiling corrections

When a tiling correction is created, Maps stores a record of the correction and associates it with
optical settings that match the original tile set. Click Options > Tiling Corrections to view the
records in the Tiling Corrections screen.

The tiling corrections are stored in a table per instrument mode within the Tiling Corrections
screen, so that subsequent acquisitions benefit from the tiling corrections. Be aware that the
tiling corrections are not part of the project; instead, they are part of the Maps global settings.

Interface Item Description

Mode Indicates the magnification mode (values include: LM, HM).

Magnification Specifies the magnification value.

Probe Mode Indicates the probe mode (values include: MicroProbe and NanoProbe).

Camera Displays the Camera name.

Co r r e c t i o n Re c o r d O v e r v i ew
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Interface Item Description

%Hfw Specifies the horizontal field width correction that Maps applies during
acquisition.

ΔRotation Specifies the rotation correction that Maps applies during acquisition.

Quality Indicates the quality score (values include: High, Medium, and Low).
Maps uses a cross-correlation algorithm to determine the quality score.
See Tiling correction quality.

Co r r e c t i o n Re c o r d O v e r v i ew (Co n t i n u e d )

There are additional controls in the Tiling Corrections screen that you can use to import, export,
or delete corrections.

Control Description

Export Exports the corrections for TEM and EFTEM instrument modes to a file.
Select the instrument tab (EFTEM or TEM), and then click Export.

Import Imports the corrections for TEM and EFTEM instrument modes from a
file. Select the instrument tab (EFTEM or TEM), and then click Import.

Delete All Removes all corrections for the selected instrument mode (EFTEM or
TEM).

OK Saves the changes made to the EFTEM and TEM tables, and then closes
the window.

Cancel Cancels the changes made to the EFTEM and TEM tables, and then
closes the window.

T i l i n g Co r r e c t i o n s T a b l e O v e r v i ew

Use tiling correction during acquisition

To use tiling correction, you will need to create a new tile set with parameters that match one of
the saved tiling corrections and then acquire the tile set. For example, consider the correction
that is highlighted below (parameters: HM, 11000x, MicroProbe, BM-Ceta, 3.10%, 3.34°, High).
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Create a TEM tile set

1. Click the TEM Tile Set tab, and then do the following:

a. Select BM-Ceta from the Camera dropdown menu.

b. Select SA 11000x from the Magnification dropdown menu.
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2. Click the Advanced tab.

a. Select MicroProbe from the Probe Mode dropdown menu.

b. Notice that the Use Tiling Correction checkbox is automatically selected.

3. Acquire the tile set. If needed, refer to Acquire a Tile Set.
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4. View the results in the main Viewer. Notice that the tiles are better aligned as a result of the
tiling correction applied during acquisition.

Tiling correction quality

Tiling correction is computed from cross-correlation of overlapping portions of neighboring tiles.
The quality and precision of the computation depends on several factors, including:

l Image intensity and focus
l Size of tile overlap
l Distinct features in the overlap portion of the tiles
l Stitching profile that matches sample type
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Note: As a general rule, it is recommended to use tile sets with the following
parameters as a basis for tiling corrections:

l Dimensions at least 3x3, with at least 20% tile overlap
l All tile overlaps are successfully registered (no red outlines in the tile set)
l Image has sufficient intensity and is in focus

You can observe the quality score of the tiling correction in the following screens:

l The Create Tiling Correction screen (when you are creating a new tiling correction)
l The Tiling Corrections screen (when you review available corrections)

See Tiling Corrections Quality for additional instructions on how to resolve issues related to
quality.

Tiling Corrections Quality
This topic describes how you can resolve issues that negatively impact the quality and precision
of tiling corrections.

Note: For a general description of tiling corrections and the quality of tiling
corrections, see TEM Tiling Corrections.

The following issues cause the quality score of a tiling correction to be lower than desired:

l Failed tile registrations
l Insufficient size of tile overlap
l Insufficient size of the tile set
l Large error margin in a portion of the tile set
l Large overall size of the correction
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Failed tile registrations

You can recognize failed tile registrations by one or more red outlines visible in the acquired tile
set. The failed registrations are caused by inability to compute cross-correlation on overlapping
portions of neighboring tiles. This is usually due to poor imaging conditions, or when the tile set
is being partially placed on a portion of the sample with no visible details.

For example, the tile set below has several failed tile registrations because the affected tiles are
placed on a grid bar. To resolve this issue, reposition the tile set so that all tiles contain a
sufficient level of detail and then acquire the tile set again.
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Insufficient tile overlap size

It is recommended to use a tile overlap of at least 20% for tile sets that are used as a basis for
tiling correction. The overlapping regions of neighboring tiles should ideally contain distinct
features that the cross-correlation algorithm can use to compute necessary correction. A larger
size of tile overlap gives the algorithm larger areas to work with, which is desirable.

For example, the following tile set has only 5% tile overlap, causing the quality indicator to report
a low quality score. To resolve the issue, reset the tile set, increase the size of tile overlap to at
least 20%, and then acquire the tile set again.
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Insufficient tile set size

It is recommended to use a tile set of at least 3x3 size as a basis for tiling correction. This size
gives the cross-correlation algorithm a sufficient number of overlapping regions to compute
overall correction from since they are equally distributed across both columns and rows.

For example, the following tile set has only 3 tiles in a single row, thus causing the quality
indicator to report a low level of quality. To resolve the issue, reset the tile set, increase its size
to at least 3x3, and then acquire the tile set again.

Large error margin

Error margin is the difference between the average correction computed from the whole tile set
and a local correction that is computed from a specific tile overlap. When the corrections
computed for different tile overlaps differ by a large extent from each other, the quality indicator
reports a large error margin.

Increased error margin can be caused by one of the following issues:

l Different imaging conditions in one portion of the tile set compared to the rest of the tile set.
l Recurring pattern in the specimen that causes false peak in the cross-correlation, so the
correction targets the pattern rather than a distinct feature in the specimen.

l Lower signal-to-noise ratio such as low-dose conditions in which the signal counts are so low
that recurring patterns and noise in the dark, and gain reference images, are interpreted as
features of the specimen.

l Imprecision of mechanical stage movement at high magnifications.
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For example, the following tile set contains a recurring grid pattern. The default stitching profile
is not able to detect false peaks in cross-correlation, thus causing a large error margin in a
portion of the tile set.
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To resolve the issue in this specific use case, do the following:

1. Right-click the tile set to open the context menu and then select Tile Registration to open the
Tile Registration - Define Parameters screen. See - topic for details.

2. Select Repetitive Structures from the stitching profile dropdown menu.

3. Click Queue job to rerun the tile registration with the selected stitching profile.

4. Create a tiling correction for the tile set based on the updated stitching profile (see Create
tiling correction based on existing tile set).
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5. View the improved quality for the tile set with the recurring grid pattern. As shown below, the
tile alignment is properly aligned with the high-quality tiling correction compared to the original
low-quality tiling correction.

High-Quality Tiling Correction Low-Quality Tiling Correction

Large correction size

Tiling corrections are intended to compensate only for relatively small errors that remain on a
well aligned and calibrated system. If the computed size of the correction is too large, then the
quality indicator will display a lower quality score. To resolve the issue, ask the system owner to
verify and rerun the magnification calibrations on the microscope.
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Magnification Alignment
On TEM systems, you will observe imperfections in the tile set alignment from one magnification
to another. These imperfections result in small shifts when changing the magnifications. You
must always properly calibrate and align the system, but small shifts may still remain since
changes in the optics can lead to additional shift. To compensate for the small shifts that may
remain, you can use the drag-and-drop functionality of Maps to align tile sets.

Note: This functionality is available for both TEM and STEMmode, but the remainder
of this section explains how it works for TEM tile sets. For STEMmode the
functionality is similar, with the small difference that the magnification is a derived
value (inferred from the Field of View).

Magnification Alignment versus Manual Alignment

There are two alignment mechanisms available in Maps: Magnification Alignment and Manual
Alignment.

Magnification Alignment moves the data in the Maps canvas and stores this alignment for
subsequent acquisitions at the same magnification.

Manual Alignment only aligns the data within the Maps canvas. Any subsequent acquisition will
not have access to information about the alignment.
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Align a Tile Set and Its Magnification
1. Click the acquired tile set that is slightly misaligned.

For example, the higher magnification tile set within the green border is misaligned with
respect to the lower magnification.

2. Right-click on the selected tile set.
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3. Do one of the following:

l In the context menu, click Alignment and then click Magnification Alignment.

l On the right side of the tool bar, click Magnification Alignment
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l On the right side of the tool bar, click Workflow. See Workflow.

The Workflow Magnification Alignment panel appears.

Maps 3.32.1 User Guide

390 | Original Instructions

Limited Rights

PN 1551059 Revision A | 11-Mar-2025

TEM



4. Reposition the tile set using the directional buttons in the Workflow Magnification Alignment
panel.

You can reposition the tile set by clicking and holding the left-mouse button while hovering
over the tile set.

5. Click the check mark within the alignment workflow panel to complete the current alignment,
or click the X to cancel it.

The results of the alignment are twofold:

l The tile set with the existing data is realigned within the Maps canvas.
l An alignment correction record is stored for the magnification associated with the tile set.
All subsequent acquisitions are automatically aligned based on this record. See Alignment
Corrections Table.
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Alignment Corrections Table

When a tile set is aligned, Maps stores a record of the magnification associated with the tile set.
Click Options > Alignment Corrections to view the record in the Alignment Corrections table.

The Alignment Corrections are stored in a table per instrument mode, so that subsequent
sessions benefit from the alignments. Note that the corrections are not part of the project; they
are part of the Maps global settings.
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Interface
Item Description

Import Imports all the alignment corrections for TEM and STEM.

Export Exports the alignment corrections for TEM and STEM.

Delete All Removes all alignment corrections for the currently selected mode (STEM
or TEM).

Cancel Cancels the changes made to the tables and then closes the window.

OK Saves the changes made to the tables and then closes the window.

A l i g nmen t C o r r e c t i o n s T a b l e O v e r v i ew

Propagation of Alignment Corrections

The magnification alignments automatically propagate to higher magnifications that do not have
an entry in the Alignment Correction table. However, individual magnifications can be aligned at
any time, overruling the propagated alignment. With this approach, only a minimum number of
alignments is required and it allows for refinement when needed. An additional benefit of this
approach is that it naturally follows the typical Maps workflow from low-to-high magnification,
allowing you to realign during the workflow when needed.

l In TEM, alignment corrections for low-magnification mode (LM) do not automatically
propagate to the high-magnification modes (Mi/Sa/Mh), because on TEM systems these
modes are mostly uncorrelated.

l In STEM, alignment corrections only propogate within the same mode
(LM/NanoProbe/Microprobe).

The concept of the propagation is demonstrated in the example described below.

Example: Assuming you have an Alignment Corrections table as shown below and the system
supports the magnifications as listed in Example of Propagation.
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Example of Propagation

In the example, the propagation works as follows. Numbers used below correspond to the
annotation in the table above.

1. The first magnifications have no alignment correction.

2. The LM 500x magnification has an alignment correction, which propagates to the next
magnifications LM 1000x and LM 1800x, but not to the high magnification modes (3, 4 and
5).

3. The first high magnifications do not have an entry in the alignment corrections table, hence
they have no correction.

4. The SA 5000x is the first high magnification with a correction, which propagates only to the
next magnification SA 12000, because SA 20000x has its own entry in the alignment
correction tables (5), which overrules the propagated correction of SA 5000x.

5. The correction of SA 20000x propagates to all the next magnifications.

Working with Magnification Alignments
l You can refine the alignment at any point in time, even when job execution is paused during
tile set acquisition.

l A magnification alignment automatically applies to higher magnifications, so not all
magnifications need realignment. See Propagation of Alignment Corrections.
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l You can align multiple tile sets simultaneously by selecting a number of tile sets before
starting the alignment.

l The alignment corrections are stored on disk and remain active for subsequent sessions.
l View which alignment corrections are present in the Alignment Corrections Table.
l If alignment corrections apply, you should see the field-of-view rectangle shift when
changing the magnification on the system as Maps tracks the current field-of-view. Tracking
includes the alignment corrections.

l Magnification Alignment can be used to compensate for shifts between STEM and TEM
mode. This allows you to use a LM TEM tile set as reference for navigation while in
NanoProbe STEM.

Alignment Tips
l The magnification alignments are for Maps only. They determine how Maps controls the
stage and how acquired images are positioned in the Maps canvas without affecting the
optics of the microscope. This mechanism can safely coexist with other applications that use
different means for realignment.
l The FOV visualization automatically incorporates the image beam shift set by other
applications, such as with Thermo Scientific Tomography. This allows Maps to be used
side-by-side with other applications, since it ensures that the FOV is the same in both
applications. See Alignment with Other Applications.

l Magnification Alignment is related to Align Layer (see Layer Context Menu) and Global
Alignment functions (see Toolbar), but serves a different purpose.
l Global Alignment realigns existing data to the coordinate system of Maps. This
functionality is typically used for imported data.

l Magnification Alignment targets misalignments on the instrument itself.
l Magnification Alignment is a mechanism to compensate for imperfections in the optical
alignment of the microscope. It is global in nature and applies to all positions. Small position-
dependent shifts might remain due to other factors.
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l Performing a Magnification Alignment for a magnification changes the current alignment
state. That means that tile sets that have already been acquired before the adjustment were
using a different Magnification Alignment. If you would re-acquire such tile sets, the images
may be shifted due to the new alignment. This situation is detected and he system displays
the following warning:

Alignment with Other Applications
l The FOV visualization automatically incorporates image beam shift set by other applications,
such as Thermo Scientific Tomography. This allows Maps to be used side-by-side with other
applications, since it ensures that the FOV is the same in both applications.

l Image beam shift is a mechanism that compensates for imperfections in the optical
alignment of the microscope. The image beam shift changes the current alignment state.
This means that tile sets that were already acquired before changing the image beam shift
used a different magnification alignment. If you reacquire these tile sets, the images might
shift due to the new alignment. The new alignment is not detected automatically, and no
warning is displayed.

Note: With some applications, such as Thermo Scientific Tomography, the image
beam can shift regularly.
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Use Interpolated Focus Method
This topic explains the procedure for the interpolated focus method.

1. Navigate to the first location.

2. Manually focus the image.

3. When the image is in focus, click Set Focus 1.

The current focus will be remembered for that point and the button is now selected.

4. Repeat for the other two Set Focus buttons.

Once all three are checked, tiles are ready to be acquired.

Note: These points will be used to define a focus plane. All tiles will use a focus as
defined by this plane. For best results, choose points at opposite ends of the sample.

To unset a focus point, click Delete Focus for that point.
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STEM Acquisition with Multiple Detectors
This topic describes how to set up tile set STEM acquisition with multiple STEM detectors.

Create STEM acquisition with multiple detectors

Do the following to set up STEM acquisition with multiple detectors, do the following.

1. Define a new STEM tile set (see Define a Tile Set for TEM).

2. Click the Tile Set tab, and then select the checkbox of more than one detector within the
Selected Detectors section. Detector choices depend on which detectors are available on the
system.
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3. Select a default detector from the Default Detector dropdown menu. The default detector is
used for operations that require only one detector (for example, autofunctions and stitching).
The acquired images from the default detector automatically display in the main Viewer.

4. Click the Advanced tab and locate the Detectors section. Edit the values of the Gain and
Offset fields as desired (see Advanced group, STEMmode). You can only edit the parameters
of the detectors that you previously selected for acquisition. Unselected detectors are
deactivated.
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Result of multiple detector acquisition

The result of STEM acquisition with multiple detectors is a multichannel tile set in which each
channel corresponds to each of the selected detectors. The channel with the default detector is
always displays as the first channel and its acquired image is automatically displayed in the
main Viewer.
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To view images from other detectors, deselect the tile set channels above the selected tile set
channel in the layer tree. In the example below, you can view the BF-S image because this tile
set channel is selected and the HAADF tile set channel above it is deselected.
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STEM Intermediate Images
This topic describes the intermediate images during STEM AutoFocus and the STEM Eucentric
autofunction. Intermediate images are visual observations that display in the right-side panel of
the Main Screen, which appears when autofunction starts and then disappears when
autofunction stops.

STEM Autofocus

You can observe the intermediate images acquired during the AutoFocus process to determine
if the parameters used for AutoFocus are acceptable. The same feature can be found also in
STEM Tomography software.

The AutoFocus image contains the defocus value for the image. A graph of the contrast quality
appears directly below the intermediate image screen, and the contrast quality increases and
then decreases within the range of different defocus values. When the graph reaches the
maximum value for quality along the Y axis, then the image is focused.

Note:
Quality is defined as a unitless number that is based on the measured contrast of the
image.
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STEM Eucentric Autofunction

You can observe intermediate images captured at different angles, typically between -15° and
15°, during the Eucentric autofunction measurement. You can also change the angle value by
configuring the Final Stage Angle of the Eucentric autofunction (see Configure autofunctions).
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A cross correlation image displays under the positive and negative images. The cross
correlation image contains a crosshair cursor at the center of the image, as well as a circle
marker at the position of the highest cross correlation peak.
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Automated Image Filtering
This topic describes automated image filtering, which you can use to improve image shift
calculation associated with TEM and EFTEM autofunctions.

Image shift calculation

TEM and EFTEM autofunctions are often implemented by calculating the shift between two
images. For example, the Eucentric Height autofunction determines the eucentric height by
minimizing shift between positive and negative tilt images. The image shift calculation typically
uses the cross-correlation of the Fourier transform for the images. Depending on the specimen
and the required imaging conditions, there are multiple factors that can decrease the reliability
and accuracy of the image shift calculation.

l Recurring patterns in the specimen can cause false peaks in the cross-correlation at various
shifts. The peaks are related to the pattern rather than a distinct feature in the specimen.

l The signal-to-noise ratio of the images influences the quality of the cross-correlation.
Especially in low-dose conditions, the signal counts can be so low, that recurring patterns
and noise in the dark and gain reference images can be interpreted as features of the
specimen. Because the reference images are identical in all acquired images, the cross-
correlation image may show a peak at zero shift.

l A Fourier transform is based on the assumption that the image can be extended periodically
in all directions. In practice, however, the image is finite and has edges. This results in
artifacts in the Fourier transform, such as horizontal and vertical lines (for example, when the
image is dark on one edge and bright on the opposite edge). These artifacts can have a
negative impact on the accuracy of the image shift calculation.

To overcome these factors, you can use automated image filtering to do the following:

l Improve the sharpness and relative height of the peak in the cross-correlation by enhancing
features of a specific size range.

l Reduce artifacts introduced by the edges of the image.
l Decrease or eliminate the peak at zero shift.
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Automated image filtering

With automated image filtering, the Maps software application selects the following set of filters
and tunes them automatically by using recommended default values.

l Band Pass filter: Enhances features of size range between 1/200 of FOV width and 1/20 of
FOV width.

For example, when running automated eucentric height at 7500X magnification with FOV
width of 4 µm, enhances features between 20 nm and 200 nm in size.

l Hanning Window filter: Reduces artifacts introduced by the edges of the image.

l Suppress Zero Peak filter: Decreases or eliminates the peak at zero shift.

Configure automated image filtering

You can configure automated image filtering as the default setting for all new tile sets through
the application settings. If desired, you can also override the default setting for all new tiles sets
and configure the automated image filtering for a specific tile set through the tile set tab.

To configure the default setting in TEMmode (or EFTEMmode) for all new tile sets.
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1. Click the TEM Options menu >> Settings... menu >> TEM tab (or EFTEM tab) >>
Acquisition tab.

2. Under the Eucentric Height Default Settings section, click the Use Image Filtering check
box.

3. Under the Focus Default Settings section, click the (Beta) Use Image Filtering check box.

4. Click OK.

To override the default setting and configure the automated image filtering for a specific tile set
through the tile set tab (TEM and EFTEM modes).

1. Under the tile set tab, click the Autofunction tab.

2. Click Configuration... to open the Advanced Autofunction Settings (Tile Set) screen.

3. Click the Eucentric Height tab within the Advanced Settings (Tile Set) screen.

4. Click the (Beta) Use Image Filtering check box.

5. Click the Focus tab within the Advanced Autofunction Settings (Tile Set) screen.

6. Click the (Beta) Use Image Filtering check box.

7. Click OK.
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TEM Analytics
With the Analytics plug-in, the Maps software can acquire EDS data through a software
application interface with Thermo Scientific Velox™.

Note: This plug-in is not be confused with Maps Min or Generic Detector Interface
(GDI).

Preparation for TEM Analytics

Preconditions

To run Analytics, your Maps installation must include the following components:

l At least one software package from a provider for EDS acquisition
l An Analytics plug-in with the correct license
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To verify that your license includes the Analytics plug-in option, on the Help menu, click About.

Analytics Workflow for TEM

The Analytics workflow explains how to set up and activate the Velox software on your TEM
system before you define a tile set. It also explains how to configure Analytics, acquire a tile set,
and view the results of the acquisition.

Proceed with the workflow in the following order:

1. Set Up Velox Software: Before you acquire EDS images in Maps with Velox, you must set up
the Velox software.

2. Activate Velox Software: To perform the initial configuration for Analytics, you must activate
Velox in Maps.

3. Define a Tile Set: Use the normal procedure to define a tile set, and then navigate to the tile
set section and click the Analytics tab.

4. Configure Analytics for Acquisition: Configuration depends upon which EDS acquisition
software you have, either Velox or Bruker. Follow the instructions for your specific EDS
acquisition software.
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5. Acquire a Tile Set: Use the normal procedure to acquire an Analytics tile set.

6. View Results of Acquisition: Once an Analytics tile set has finished acquisition, you can view
the results in the layer tree and the Results pane.
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Set Up Velox Software

Before you acquire EDS images in Maps with Velox, you must set up the Velox software.

1. Launch the Velox software application to the Acquisition and Processing screens.

2. In the Acquisition screen, under the Optics pane, click STEM.

3. Within the Detectors pane, click HAADF.

4. Within the STEM Imaging pane, click the Scanning button to pause.
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5. Within the STEM Imaging pane, change the resolution to match the tile set resolution in the
Maps application.

6. Within the SI pane expander, select Auto stop.
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7. In the Processing screen, click to the elements of interest under the Periodic Table (Spectrum
Imaging) pane.

8. Go to Activate Velox Software.
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Activate Velox Software

To perform the initial configuration for Analytics, you must activate Velox in Maps.

1. Under the Options menu, click Settings.

2. Click the Velox tab, and then select the Use Velox check box.

3. Click OK.

4. Restart the Maps software application.

5. After restarting Maps, a green status icon appears next to the Velox label on the status bar to
confirm success.
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Configure Analytics for Acquisition

Most Analytics details are set up in the software packages from the EDS acquisition providers. If
you are using Velox software for EDS acquisition, then follow the setup instructions below. If you
are using Bruker software for EDS acquisition, then follow the instructions under Set up Bruker
Analytics.

Set up Velox Analytics

1. Select the EDS Acquisition check box.

2. If the Velox software did not provide the required fields, then Maps shows a warning icon and
activates the Resolution dropdown menu. Select the same value here that you selected when
you set up the Velox software.
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3. Select 1–4 quantification modes as desired.

Note: The tile set resolution must match the resolution of the image returned from the
Velox application, so verify they are the same before acquisition begins. For
example, resolution width: 512, and resolution height: 512.

The tile set is now set up and ready for acquisition. If you change parameters on the tile set
(specifically anything related to resolution), then you might need to run the setup again. See
Configure Analytics for Acquisition.

Set up Bruker Analytics

Follow the procedure in the Configure Mineralogy Acquisition section.

View Results of Acquisition

Once an Analytics tile set has finished acquisition, you can view the results in the layer tree and
the Results pane.
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Layer tree

In the layer tree, the tile set has a collection of layers within it that corresponds to each element
and STEM image.

l Click the colored circle on the right to change the color of the element layer.
l Select the check box on the left side of the layer to toggle visibility.

Results tab

The Results tab of the tile set shows the list of channels for the tile set, which corresponds to
each of element and STEM image. You can expand each any of these channel controls by
clicking in the channel header.
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In expanded control, you can modify the channel and view the metadata collection of the given
element and STEM image. An example of an expanded channel follows.
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Sample Holders
This section describes the sample holders that are available for Maps.

When a holder is selected and applied to the project:

l The outline displays in green on the viewer. The holder outline is red until it is aligned.
l The name, drawing, version, and so on are displayed on the Holder tab.
l A new Layer is added to the Layer Control. This is where you choose to show or hide the
Holder outline and Fiducials. The Fiducials only show after image acquisition. The default is
to not show them. Select the check box to view your fiducial images.

Refer to your application specialist for procedural information for each sample holder type.

Holder Tab
When a holder is selected and applied to the project:

l The outline displays in red on the viewer if automated holder alignment is supported. If
automated alignment is not supported, then the outline displays in green.

l The name, drawing, version, and so on are displayed on the Holder tab.
l A new Layer is added to the Layer Control. This is where you choose to show or hide the
Holder outline and Fiducials. The Fiducials only show after image acquisition. The default is
to not show them. Enable the check box to view your fiducial images.
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l The Left , Middle, and Right quick access buttons for the sample area appear adjacent to
Right Slide.

l Left: Centers the view on the sample area
l Middle: Drives the stage to the center of the sample area
l Right: Creates a new tile set that covers the sample area
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Holders Supported for Automated Holder Alignment
When selected, the holder outline displays in red on the viewer, if automated holder alignment is
supported. See Automated Holder Alignment.

Topics include:

3 mmGrid Holder

Single 22 mm Coverslip Holder

Double 22 mm Coverslip Holder

3 mmGrid Holder

This is a holder for 3 mm diameter grids that can be loaded inside a transmission electron
microscope (TEM).

3 mm Grid Holderwith Upper and Lower Fiducials Marked
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Single 22 mm Coverslip Holder

This is a single 22 mm coverslip holder.
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Double 22 mm Coverslip Holder

This carrier holds up to two samples.
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Holders Supported for Graphical Overlay
Maps can draw a graphical overlay to assist with navigation. The graphical overlay can be
aligned manually to other image layers, but the automated holder alignment is not supported on
these layers.

Note: When selected, the holder outline displays in green on the viewer, indicating
that automated holder alignment is not supported.

Topics include:

Cryo Corrsight Shuttle Holder

Cryo AquilosSEM Shuttle Holder

Slide 75 mm x 25 mm Holder

12xthin-section Quanta Mount Holder

14 x 30 mm Round Quanta Mount Holder
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Cryo Corrsight Shuttle Holder

This holder can be connected to a cooling system for imaging samples at cryogenic
temperatures.
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Cryo AquilosSEM Shuttle Holder

This holder is used for Cryo applications. It can be connected to a cooling system for imaging
and sample preparation at cryogenic temperatures.
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Slide 75 mm x 25 mm Holder

This holder represents a slide with dimensions 75 mm x 25 mm.
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12xthin-section Quanta Mount Holder

This mount holder is designed to handle up to 12 thin mineralogy samples. The mount holder
includes a Faraday cup; meets gold, quartz, and copper standards; and has a magnesium
calcium position.
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14 x 30 mm Round Quanta Mount Holder

This mount holder is designed to handle up to 14 samples of 30-mm resin embedded
mineralogy samples. The mount holder includes a Faraday cup; meets gold, quartz, and copper
standards; and has a magnesium calcium position.
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Automated Holder Alignment
This section describes the procedure for automated holder alignment (AHA) setup, calibration,
and operation for a particular supported holder on SEM/SDB systems. It is a guideline for using
Maps and the automated holder alignment, and can also be used for SEM/SDB-only as well as
multi-system correlative Maps projects.

Note: Automated Holder Alignment is not supported for Maps on TEM systems.

Topics include:

Holders Supported for Automated Holder Alignment

Automated Holder Alignment User Interface

Execute Holder Alignment

SEM/SDB Holder Calibration

Correlating Projects

Problems with Alignment

Holders Supported for Automated Holder Alignment
When selected, the holder outline displays in red on the viewer. They appear in green if
automated holder alignment is not supported. See Sample Holders.

l 3 mmGrid Holder
l Double 22 mm Coverslip Holder

All supported holders must be manually calibrated on a given system before Automated Holder
Alignment is possible. This is a one-time procedure. After manual calibration is complete, little to
no manual action will be required.
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Automated Holder Alignment User Interface
Click the Align to Holder icon in the tool box and select the appropriate holder from the Sample
Holder dropdown menu to cause the Automated Holder Alignment user interface to appear next
to the viewer.

Automated Holder Alignment UI

Interface
Item Description

Buttons at
Bottom
(Before
Starting
Alignment):

Run
Alignment

Moves the stage to the position where it expects to find the fiducial, auto-
focuses, and attempts to match the fiducial.

Au t oma t e d Ho l d e r A l i g nmen t U I O v e r v i ew
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Interface
Item Description

Apply Applies the alignment to the project if the alignment is not immediately
applied when the automated procedure completes. This can be used if the
automated alignment completes but manual adjustment is needed.

Close Closes the alignment UI and returns to the main viewer before the
automated procedure has begun.

Buttons at
Bottom
(During
Alignment):

Continue On SEM systems, the automated holder alignment requires manual
optimization of the image (contrast, brightness, focus, and so on). After the
stage is automatically moved to the location of the first fiducial and the
prompt for image optimization has appeared, use Continue to proceed with
fiducial matching.

Retry Autofocuses and attempts to match the fiducial. If the match is successful,
the automated alignment procedure will continue to the next fiducial.

Skip Skips the current fiducial matching procedure and proceeds to the next
fiducial. This can be useful if Maps encounters difficulty matching, however,
the best practice is to optimize the image for successful automatic matching
or to manually select the fiducial position.

Abort Cancels the alignment procedure currently in progress and returns to the
main viewer.

Au t oma t e d Ho l d e r A l i g nmen t U I O v e r v i ew (Co n t i n u e d )
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Interface
Item Description

Fiducial
Window

Green/Red
Ball

Indicates if the fiducial was found: Green = Found; Red = Not Found.

Fiducial
Name

Displays the name of the fiducial. In this example, Upper Left.

Reference Displays the reference image.

Initial Displays the result of the previous alignment procedure for a project that has
already been automatically aligned.

Current
Fiducial
Window

Displays the fiducial image acquired during the current automated holder
alignment procedure.

Acquire Acquires an image of the specified fiducial. Maps will move to the expected
location for the specified fiducial and attempt to match.

Au t oma t e d Ho l d e r A l i g nmen t U I O v e r v i ew (Co n t i n u e d )
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Interface
Item Description

Fiducial
Markers for
Matching

The fiducial marker is placed on the fiducial image as a point of reference.
Maps will align these reference points during alignment.

l Light Blue markers are used in the reference images to display the
reference point that the automated procedure expects to find. Light blue
markers are also automatically placed on the fiducial image when a
match is successful.

l Light green markers denote the reference points from the previous
alignment procedure and appear in the initial fiducial images.

Au t oma t e d Ho l d e r A l i g nmen t U I O v e r v i ew (Co n t i n u e d )
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Execute Holder Alignment
When using a sample holder that has already been calibrated on your microscope, the following
procedure describes how to execute the alignment sequence.

1. Click Align to Holder icon.

2. Select the same holder that was just calibrated, in this case Double 22 mm coverslip holder,
and then click OK.
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3. Click Run Alignment. The Alignment proceeds automatically.

l If the automated alignment is able to match all fiducials successfully, the holder calibration is
complete.

l If the alignment failed to recognize any of the fiducials, then perform the calibration
procedure (see SEM/SDB Holder Calibration
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SEM/SDB Holder Calibration
This topic explains the procedure for calibrating a SEM/SDB holder.

Mount the Coverslip Holder and Adaptor to the Stage

Follow this procedure to mount the Double 22 mm coverslip holder and adaptor to the stage.

Top View of the Holder

The holder only fits in the adaptor in one position.
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1. Withdraw the clamp and place the holder with the cut off side facing the clamp in the holder.
The holding device (encircled in red) fits the hole (encircled in red) in the adaptor.

Bottom View of the Holder

6 inch Stage Adaptor for Double 22 mm Coverslip Holder

2. If the holder is positioned, then release the clamp.

Holder Positioned on Adaptor
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3. Place the holder and adaptor on the stage. This can only be done in one orientation. The
adaptor has three screws (encircled in red) and two pins (encircled in green) that fit nicely
into the stage.

Adaptor Base with Screw and Pin Positions

Stage Screw and Pin Placement Indicators

4. Tighten the screws so the stage cannot move.
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5. Set the Z coordinate to 0 using the xT UI to make sure the holder will not touch the pole piece
when inserting.

6. Close the chamber.

7. Press Pump.

Note: Refer to your application specialist for procedural information for each sample
holder type. See Sample Holders for descriptions of the other types of holders.

SEM/SDB Preconditions

Before performing calibration on a Maps supported holder using an SEM/SDB system, verify
that the following preconditions are satisfied:

l Home stage
l SEMmode: lowest magnification
l ETD
l BSE
l 10 kV
l 100 pA (Use higher beam current of about 1 nA if you have difficulty matching automatically)
l Eucentric
l Link stage to WD
l Optimize contrast such that the fiducial holes are black and the background is white

Find the Fiducials and Store their Coordinates

This procedure is only necessary when starting Maps for the first time on a particular SEM/SDB,
using a particular holder.

Using the xT UI, find the upper right (UR), upper left (UL), and bottom left (BL) fiducials and store
the coordinates on the Stage tab.
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The fiducial orientation must match the reference image.

The fiducial next to the chamfer/cut off (encircled in red) is called upper right.

Upper Right Fiducial

The upper right fiducial should be present at coordinates:

l X: 9.5 mm
l Y: –35.0 mm
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The upper left (UL) fiducial should be present at coordinates:

l X: 9.5 mm
l Y: 35.0 mm

The bottom left (BL) fiducial should be present at coordinates:

l X: –9.5 mm
l Y: 35.0 mm

Note: Depending on the system type, X and Y coordinates might be reversed.

l If you are entirely unable to find the fiducials on the holder, perform a large
overview tile for help in navigation.

l If the system is equipped with a NavCam, use the NavCam navigation image to
assist with finding the fiducials.
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Calibrate the Holder
1. Load the appropriate sample holder. In this example, it is Double 22 mm coverslip holder.

Note: Refer to your application specialist for procedural information for each
sample holder type. See Sample Holders or descriptions of the other types of
holders.

2. Create a new project or open a project that uses the loaded holder type. See Create a
Project for more information about creating projects.

3. Click the Align to Holder tool box button.

4. Select the appropriate holder from the dropdown and then click OK.
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5. In the fiducial alignment controls that appear, click Run Alignment.

The stage drives to the position where it expects to find the upper left fiducial. Maps displays
a prompt to adjust microscope settings for optimal fiducial image.
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6. Click Close.

7. Go to the xT UI and find the stored position for upper left fiducial. Select the upper left
coordinates and then click GoTo. The stage navigates to the stored coordinates of the upper
left fiducial.

8. Optimize the image (set correct focus and contrast/ brightness) of the upper left fiducial
using the xT UI. The optimal image will have completely black fiducial holes against a
completely white background.
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9. When the image has been optimized, return to the Maps UI and click Continue.

Note: If you are having trouble matching, make sure the:

l Contrast / brightness matches reference
l Fiducial orientation matches reference
l HFW is 1.5 mm
l Sample is clean with clearly distinguishable features and no dust /
contamination
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During calibration, Maps does not know the orientation of the holder. This can cause false
positive matches, as shown in the diagram below. This is normal and these false positives
will not occur after the holder has been successfully calibrated.
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10. The Microscope Settings box appears again if Maps still does not recognize the acquired
fiducial. Click Close.

11. Optimize the fiducial image again to match the reference image and then click Retry.
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12. If Maps is not able to automatically match the fiducial, double-click to place the blue cross
hair on the same fiducial hole that contains the red crosshair in the Reference image.

The red button turns green if Maps recognizes the fiducial.

If Maps does not automatically navigate to the second fiducial, then click Continue.

13. Maps automatically attempts to match the second fiducial. If the match is not successful,
then repeat the calibration for the second fiducial. Once the second fiducial is recognized,
Maps will automatically navigate to the final fiducial (for holders with more than two
fiducials).

14. Since the automated alignment required manual adjustment, the Calibration prompt
appears. Click Yes to save the holder calibration.
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Note: If the calibration prompt does not appear, Maps has low confidence in the
calibrated fiducial positions and will not allow you to save the potentially bad
calibration values. This can occur if there is a large unexpected rotation between
fiducials. Perform the calibration a second time, and make sure fiducials are well
centered and are oriented properly to match the reference.

Verify Alignment
1. On the File menu, click Project Properties.

2. In the Sample holder list, click none.
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3. Click OK to clear the holder from the project. Click OK again at the prompt.

4. Proceed to Execute Holder Alignment.
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Correlating Projects
Prerequisites for running a multi-tool correlative experiment with Maps using Automated Holder
Alignment:

l Sample is mounted on a supported sample holder
l Holder to be used has been calibrated on all systems

Note: Manual correlation can be performed on non-supported sample holders using
the Maps Global Alignment procedure.

To perform a correlative project:

1. Create a new project in Maps on the first system.

2. Run the AHA (Automated Holder Alignment).

3. Acquire the desired sample data.

4. Close Maps.

5. Make a copy of the entire project directory and move it to the second system’s PC.

6. Install the supported holder into the second system.

7. Open Maps on the second system and Import the project.

8. Run the AHA.

9. Acquire the desired sample data.

10. Use alignment to adjust the position of sample data, as desired.

11. Export the results by stitching or saving images to file.
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Problems with Alignment
Misalignment between data in a Maps project can be due to one or more of the following
contributing factors:

l Stage positioning error
l Stage drift
l Modified scanning parameters
l Modified column parameters
l Microscope modality change
l Sample moved relative to holder
l Sample changed physically during sample prep
l Misalignment between imaging modes/microscope objectives
l Improper holder calibration or false positives during Automated Holder Alignment
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Manual Alignment
This section describes manual alignment workflows.

Alignment is used in Maps to adjust project data to the current stage position. For example, this
is useful after a sample has been removed and re-installed into a system in a different
orientation.

Alignment can be performed on imported images, tile sets, stitched tile set data, layers, and
entire projects (Global Alignment). The procedure is identical when aligning each of these
different objects.

It is worth noting that objects are never aligned to each other in Maps, but instead are aligned to
the current stage position. If two objects do not match up, align the first to the stage, then align
the second to the stage. To maintain alignment between objects, place all the aligned objects
into a separate layer. Then, you can perform alignment on the Layer and all objects in the layer
will be moved in unison.

For Offline alignment where there is no stage present, simply choose one image or tile set as a
standard and align all other data to this standard. When the project is reopened on a system, a
single Global Alignment will correctly adjust all the project data.

There are four levels of alignment:

l Align: Aligns a single tile set or image. Selected from the Tile Set Context Menu.
l Align Layer: Aligns an entire layer, including all tile sets and images at once. Selected from
the Layer Context Menu.

l Global Alignment: Performs an alignment to align all previously acquired data to the stage.
Selected from the Toolbar.

l Magnification Alignment: Performs an alignment to align TEM-acquired layers based on
magnification. Selected from the Layer Context Menu.

Topics include:

Coarse Alignment (1-, 2-, or 3-Point)

Fine Alignment
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Coarse Alignment (1-, 2-, or 3-Point)
Use 1-, 2-, or 3-point alignment to match up a previously acquired image with the current stage
position.

l 1 point: Adjusts the data using translation only.
l 2 point: Adjusts the data using translation, rotation, and scale.
l 3 point: Adjusts the data using translation, rotation, scale, and orthogonality.

Workflow

The workflow described below relates to aligning a single tile set. The same procedure is used
for all alignments in Maps.
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Coarse Alignment from Tile Set
1. Acquire a tile set as described in Acquire a Tile Set.

2. Right-click on the tile set in the Layer control and click Alignment > Align.
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Coarse Alignment fromWorkflow

1. Click the workflow button, and then click Alignment Wizard and Begin. The workflow panel
opens and lists layers for alignment.
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2. Select an acquired tile set to align.

3. Click the right arrow button at the bottom of the workflow panel to go to the next step.
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4. Select a Tile Set to which you want to align to (such as the Tile Set as acquired in step 1).
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5. Click the right arrow button at the bottom of the workflow panel to go to the next step.

The Tile Set that was selected in step 1 appears in the workflow panel.

The Tile Set that was selected in step 2 appears in the Viewer.

6. Follow the instructions in the workflow panel.
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7. Follow the guided instructions in the workflow panel to find the same distinct feature in both
windows and place Point 1, 2, or 3 in each window. You might have to zoom in close on a
feature and grab a new preview image with more resolution to make the best match.

8. (Optional) Using the Mirror Stage Axis or Mirror Image controls below the viewer in the
workflow panel, you can mirror the image horizontally or vertically. Use Swap Stage Axes to
swap the X and Y stage positions. It is common to use combinations of these buttons when
aligning optical images. If you select the checkbox for the Link Rotation option, the left and
right image viewers will rotate together. Deselect the checkbox for the Link Rotation option
to rotate them independently.

9. Select 1, 2, or 3 point alignment.

10. Click the right arrow button at the bottom of the workflow panel to enter Fine Alignment.
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Fine Alignment
Use Fine Alignment to fine-tune the alignment of layers and tile sets visually.

Note: When you start a second alignment on a layer, the Maps application
remembers and reuses the alignment points from the previous alignment.

Fine alignment user interface

The Alignment Wizard appears when you do either of the following:

l Click the right arrow button at the bottom of the workflow panel after a 1-, 2-, or 3-point
alignment.

l Right-click the Tile Set in the Layer control and then click Alignment > Fine Alignment.
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Interface
Item Description

Viewer
Window

The work area within the Alignment Wizard. You can drag alignment points
into the viewer during the fine alignment (see Fine alignment mouse controls)
process. This window is empty when it opens.

Back Arrow Returns to the selection of alignment points in the coarse alignment workflow.
From there, click Cancel if you want to undo the coarse alignment.

Finish
Check Mark

Closes the Fine Alignment workflow panel.

F i n e A l i g nmen t O v e r v i ew

Fine alignment mouse controls

During fine alignment, you can:

l Drag an alignment point into the viewer by left-clicking the alignment point with your mouse
and holding the mouse button down as you drag the alignment point into the viewer.

l To pan within the viewer, left-click your mouse and then hold down the mouse button as
move your mouse up, down, left, or right.

l Rotate the viewer by clicking the viewer and holding down the Shift button.
l Add a new alignment point, or reposition an existing alignment point, by positioning your
mouse within the viewer and right-clicking your mouse to open the viewer's context menu.
Click the menu option associated with your desired task.
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Correlation
This section describes the correlation controls you can use to apply simple coloring to the tile set
images when they are acquired. This can be used to highlight some features for demonstration
or evaluation purposes.

Topics include:

Visualization Tab

Segmentation
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Visualization Tab
The Visualization tab (formerly called "Results" tab) contains the correlation controls, which you
can use to apply simple coloring to the tile set images when acquired. Some correlation controls
appear unavailable if they are not applicable to the system type.

Correlation controls

Control Description

Opacity Sets the measure of opaqueness for the entire image. The less opaque,
the more transparent it becomes. Transparent images are useful when
overlaying on image over another.

Co r r e l a t i o n Con t r o l s O v e r v i ew
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Control Description

Additive Opacity Sets the control the opacity between fluorescence and regular channels.
This is useful for the Analytics tile sets as they contain many non-
overlapping channels. The Additive Opacity option is the default for EDS
tile sets. Increasing the additive opacity makes fluorescence channels
more visible.

Stitching
Channel

Sets the channel used for stitching.

Show histogram Shows/hides the histogram panel. See Histogram.

Quantification
Modes

EDS channels acquired with Velox can have up to four different
quantification modes. Click one of the activated buttons (shown in white)
to select a quantification mode, which is used to visualize the elements. A
deactivated button (shown in grey) indicates that the quantification mode
was not calculated and is not available.

The elements display data in each quantification mode as follows:

l int: the counts according to the raw integrated spectrum
l net: the counts according to the background corrected and fitted
model

l wt%: the weight fractions
l at%: the atomic fractions

Co r r e l a t i o n Con t r o l s O v e r v i ew (Co n t i n u e d )
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Control Description

Channels with
Opacity slider
and
Gamma
adjuster

Click the dropdown menu for each channel to view and select the options
described below.

l Channel name: Located at the top of the screen. This text field
displays the channel name.

l Delete Channel: For a multichannel image layer, the delete channel
option is available and appears as a trash can icon. Click the trash can
icon to delete the channel. This function is not available for a single
channel image layer and when using the Offline Viewer.

l Color picker: Located next to the delete channel option. Click this
button to select a unique color to display in the histogram. The color
picker is set to white by default.

l Opacity slider: Adjusts opacity for this channel only.
l Gamma: Displays the gamma curve adjustment.
l Reset: Resets the Gamma slider to the default.
l Saturation: Select this check box to highlight saturated pixels.
l Additive: Select this check box to designate this channel to use
additive color mixing. Additive color mixing is used for channels such
as fluorescence, cathodoluminescence, and EDS. Black is considered
transparent and colors are added with other channels/images behind
it. All channels marked additive are painted together (for example, red
and green combine to display yellow).

l Add Color: Launches Segmentation. Displays an additional histogram
every time you click the button.

l Metadata: Click the dropdown menu to view the channel metadata.

Co r r e l a t i o n Con t r o l s O v e r v i ew (Co n t i n u e d )
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Histogram

Displays a histogram for the selected channel. Click a different channel name to select its
histogram and associated color.

Selected Channel Histogram
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Interface Item Description

Selected channel
name

Displays the selected layer item (a tile set or image) from the Layer
control.

Hide Hides the histogram.

Zoom Expands the histogram area of images with less than 255 colors.

Semi-log When selected, changes the histogram intensity display to logarithmic.

Invert Inverts the intensity of the image, e.g., black to white.

Auto When selected, continuously adjusts the min and max for the histogram
display.

Current max
position

Displays the current max slider position.

Max slider Any data above the max line is white. Gray levels display between the
max and min sliders.

Histogram data Displays the histogram data for the selected channel.

Min slider Any data below the min line is black. Gray levels display between the
max and min sliders.

Current min
position

Displays the current min slider position.

Se l e c t e d Cha n n e l H i s t o g r am Ove r v i ew
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Segmentation
Image segmentation is the process of partitioning a digital image into sets of pixels, called
segments. The goal of segmentation is to simplify and/or change the representation of an image
into something that is more meaningful and easier to analyze.

Add Color

In Maps, images and tile sets can be segmented such that each segment is assigned a color.
Segments are defined using the image histogram and a min/max slider that determines the
regions of the image to be included in the segment. Additionally, Maps automatically calculates
the number of pixels within the segment as a percentage of the total number of pixels and
displays the result.

Segmentation, One Color
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Segmentation, Two Colors

1. Click Add Color to add an additional image segment.

2. Choose a color from the Color Selector and select the Solid check box. When not selected,
the color will be a gradient. See Segmentation, One Color with Gradient.
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3. Adjust the Max and Min sliders to change the range of the histogram data to be assigned to
the segment.

4. Click Add Color again to add another image segment and get segmentation with two colors.

5. Adjust the Max and Min sliders to select a different range of the histogram data to be
assigned to the second image segment.

Segmentation, One Color with Gradient

When the Solid check box is not selected, the histogram fill color is a gradient from light to dark.

Segmentation, One Color with Gradient
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Segmentation Controls Overview

Interface
Item Description

Remove Removes the segment from the image and returns to normal display.

Color Picker Displays the color picker for selecting a color, then colors the area between
the Min and Max sliders with the selected color.

Solid When selected, the data between min and max on the Segmentation
histogram will be one color instead of a gradient.

% Calculates the number of pixels between min and max as a percentage of the
entire image.

Segmen t a t i o n Con t r o l s O v e r v i ew
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Amira-Avizo2D Connectivity
This section describes how to set up the connectivity between Maps and Amira-Avizo2D, so that
you can do the following:

l Create a recipe in Amira-Avizo2D from an image sent by Maps
l Define post-processing options in Amira-Avizo2D

Prerequisites
Maps with Amira-Avizo2D is designed to run on a system with resources equal to or greater than
the following:

l 8 GB of physical RAM

l Maps must run in offline mode, or with a SEM or TEMmicroscope

l Analyzer is installed by Amira-Avizo2D product installer (minimum version 2021.1).

Configuration options
There are four configuration options for connecting Amira-Avizo2D to Maps: None, Local, Direct,
or NAT. Select the option based on your network setup, and then refer to the corresponding
section below for detailed instructions.

1. None: Use the None option if connectivity with Amira-Avizo2D is not required.

2. Local: Use the Local option if Amira-Avizo2D is installed on the same PC as Maps. This will
typically be for Maps Offline installations on a workstation.
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3. Direct:

l Use the Direct option if Amira-Avizo2D is installed on a different PC on the same network.
This may be applicable if Maps is on the Microscope PC and Amira-Avizo2D is installed on
the Support PC, or if Maps Offline is installed on a different PC other than Amira-Avizo2D.

l Also, use the Direct option for microscopes with a G5 network if a managed switch is used
instead of a Support PC.

4. NAT: Use the NAT option if Amira-Avizo2D is installed on a different PC on the customer
network and the Microscope PC is only connected to the Support PC on the private
microscope network.
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Local setup
1. From the Maps PC, navigate to Maps Options>>Settings... menu item to open the Amira-

Avizo2D settings.

2. Click the Amira-Avizo2D tab.

3. Select Local from the Connection Type field.

4. Configure the shared folder path as indicated in the table below.

Interface
Element Description

Maps - Amira-
Avizo2D
folder

Enter the path to the shared folder for the image and recipe data. See
Configure shared folder for details.

Connection
time out

Determines the duration time required for Maps to connect with Amira-
Avizo2D before Maps cancels the connection. The duration time is
measured in seconds.

Am i r a - A v i z o 2D Lo c a l S e t t i n g s

5. From the same PC, launch the Analyzer application (see Start Analyzer application).

Direct setup
1. From the Microscope PC, navigate to Maps Options>>Settings... menu item to open the

Amira-Avizo2D settings.

2. Click the Amira-Avizo2D tab.

3. Select Direct from the Connection Type field.
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4. Configure the shared folder path as indicated in the table below.

Interface
Element Description

Shared folder
path from
Maps PC

Enter the path to the shared folder for the Maps software PC. See
Configure shared folder for details.

Note: If the shared folder is on the Maps PC and the
application encounters an I/O error while processing a recipe,
consider moving the shared folder to the Amira-Avizo2D PC.
See Define Shared Folder for instructions.

Shared folder
path from
Amira-
Avizo2D PC

Enter the path to the shared folder for the Amira-Avizo2D PC. See
Configure shared folder for details.

Hostname of
Amira-
Avizo2D PC

Enter the hostname of the Amira-Avizo2D PC. See Locate hostname for
details.

Connection
time out

Determines the duration time required for Maps to connect with Amira-
Avizo2D before Maps cancels the connection. The duration time is
measured in seconds.

Am i r a - A v i z o 2D D i r e c t S e t t i n g s

5. From the Amira-Avizo2D PC, launch the Analyzer application (see Start Analyzer
application).

NAT setup

It is required that you first set up the Support PC by following steps indicated in Maps settings to
connect Maps with Amira-Avizo2D.

1. From the Microscope PC, navigate to Maps Options>>Settings... menu item to open the
Amira-Avizo2D settings.

2. Click the Amira-Avizo2D tab.

3. Select NAT from the Connection Type field.
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4. Configure the shared folder path as indicated in the table below.

Interface
Element Description

Shared folder
path from Maps
PC

Enter the path to the Support PC shared folder for the Maps software
PC. See Configure shared folder for details.

Shared folder
path from Amira-
Avizo2D PC

Enter the path to the Support PC shared folder for the Amira-Avizo2D
PC. See Configure shared folder for details.

Hostname of
Support PC

Enter the hostname of the Support PC. See Locate hostname for
details.

Hostname of
Amira-Avizo2D
PC

Enter the hostname of Amira-Avizo2D PC. See Locate hostname for
details.

Connection time
out

Determines the time duration required for Maps to connect with
Amira-Avizo2D before Maps cancels the connection. The time
duration is measured in seconds.

Am i r a - A v i z o 2D NAT Se t t i n g s

5. Click Setup Support PC.

6. Click OK, and then follow steps indicated to set up the Support PC.

7. From the Amira-Avizo2D PC, launch the Analyzer application (see Start Analyzer
application).
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Configure shared folder

The shared folder is used as an image and recipe exchange location between Maps and Amira-
Avizo2D (see Define Shared Folder for details). Configure the shared folder the way it can be
accessed by both Amira-Avizo2D and Maps applications. The shared folder must be mapped as
drive according to the following connection options:

l Local: On the same computer as Maps if both Amira-Avizo2D are hosted on the same
computer.

l Direct: Either on the Amira-Avizo2D computer and drive mapped to the Maps computer, or
on the Maps computer and drive mapped to the Amira-Avizo2D computer.

l NAT: On the Support PC, drive mapped on both the Microscope PC and the Amira-Avizo2D
computer.

Test connections

Test the Maps and Amira-Avizo2D connectivity after configuration of the hardware and shared
folder to verify the connection. Go to the Connection with the Amira-Avizo2D field, and then click
Test Connection to test the connection between Maps and Amira-Avizo2D.

When testing the connection to determine whether or not the images can be analyzed with
Amira-Avizo2D, there are five possible results.

l Connection: If the Maps and Amira-Avizo2D connection and shared folder are correct, then
the following message appears. Click OK.

The message indicates settings supported by an Amira-Avizo2D instance connected to
Maps (see Recipe processing specification).
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l No Connection: If the Amira-Avizo2D host is incorrect while in Direct or NAT mode, or the
Analyzer application is not launched in Local or Direct mode, then the following message
appears.

Solution: Click OK, and then check that the hostname is entered correctly and that Analyzer
is running. If not, see Configuration options and Start Analyzer application.

l No Connection: If the Analyzer application is not launched in NAT mode, then the following
message appears.

Solution: Click OK, and then check that Analyzer is running. If not, then see Start Analyzer
application.

l No Connection: If the selected Amira-Avizo2D version does not correspond to the running
application, then the following message appears.

Solution: Click OK, and then check that the Amira-Avizo2D version matches with the
running application. If not, then select the matching version.
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l Connection without shared folder: If Amira-Avizo2D connects and the shared folder is not
set up correctly, then the following message appears.

Solution: Click OK, and then check that the entries for the shared folder point to the same
location from both PCs. If not, see Configure shared folder.

Start Analyzer application
It is required that you run the Analyzer application on the Amira-Avizo2D PC to use Amira-
Avizo2D capabilities with Maps. The Analyzer application is included with the Amira-Avizo2D
software package.

Click the Analyzer for MAPS desktop shortcut, which launches the Analyzer application with
the graphical user interface (GUI) used for recipe processing.

Process images with recipe
Once the connection to Amira-Avizo2D is successful and you have launched the Analyzer
application, then the system is ready to process images with Amira-Avizo2D. To begin this
process, you must open, create, or import a Maps project from the shared folder. You can use
either a SEM/SDB or TEM tile set; SEM/SDB or TEM acquired tile set; or stitched image. Note
that the recipe processing specification differs depending on the software version that is defined
in the Amira-Avizo2D settings (see Recipe processing specification).
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SEM/SDB or TEM Tile Set
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1. On a newly created tile set, open the Amira-Avizo2D section.

2. Configure recipe processing options according to your use case:

Interface
Element Description

Recipe file
path

Select the .hxisp file used for recipe processing. This file must be located
in the shared folder.

Measure
group

Select the measure group that will be processed on Amira-Avizo2D from
all measure groups available in the A2DAnalyzer application. See the
Amira-Avizo2D documentation for more information on Measures.

l Select the Refresh button to reload measure groups available in Amira-
Avizo2D. Refresh is useful if measure groups were added or removed
on A2DAnalyzer in the meantime.

l By default, a None entry is selected and it will not produce any .csv
measure output in the layer directory.

Note: When measure groups cannot retrieved, the default
measure group list contains a Custom measure group. Select
the Custom measure group only when it is available in the
A2DAnalyzer application, otherwise recipe processing fails.

SEM o r TEM T i l e S e t R e c i p e P r o c e s s i n g Ov e r v i ew
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3. Finalize your tile set configuration and run the Job Queue. While the tile set is acquired, the
resulting layer tiles are updated once they are processed by Amira-Avizo2D.

Note: For each Amira-Avizo2D recipe processing job that fails, acquisition
continues normally and Maps displays a warning message. Select the Do not
show this message again box if you do not want this warning to appear again
while the recipe processing job is running.
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SEM/SDB or TEM Acquired Tile Set
1. Right-click on the tile set acquired on the layer tree, and then select Recipe Processing.

2. Configure recipe processing options according to your use case:

Interface
Element Description

Recipe file
path

Select the .hxisp file used for recipe processing. This file must be located
in the shared folder.

Measure
group

Select the measure group that will be processed on Amira-Avizo2D from
all measure groups available in the A2DAnalyzer application. See the
Amira-Avizo2D documentation for more information on Measures.

l Select the Refresh button to reload measure groups available in Amira-
Avizo2D. Refresh is useful if measure groups were added or removed
on A2DAnalyzer in the meantime.

l By default, a None entry is selected and it will not produce any .csv
measure output in the layer directory.

Note: When measure groups cannot be retrieved, the default
measure group list contains a Custom measure group. Select
the Custom measure group only when it is available in the
A2DAnalyzer application, otherwise recipe processing fails.

SEM o r TEM Acq u i r e d T i l e S e t R e c i p e P r o c e s s i n g Ov e r v i ew

3. Click Queue Job to create a new job in the job control.

4. Run the Job Queue to start processing.

5. When the job is finished, a tile set is created containing the processing results from Analyzer.
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Stitched image
1. Right-click the stitched image on the layer tree, and then select Recipe Processing.

2. Configure recipe processing options according to your use case:

Interface
Element Description

Recipe file
path

Select the .hxisp file used for recipe processing. This file must be located
in the shared folder.

Measure
group

Select the measure group that will be processed on Amira-Avizo2D from
all measure groups available in the A2DAnalyzer application. See the
Amira-Avizo2D documentation for more information on Measures.

l Select the Refresh button to reload measure groups available in Amira-
Avizo2D. Refresh is useful if measure groups were added or removed
on A2DAnalyzer in the meantime.

l By default, a None entry is selected and it will not produce any .csv
measure output in the layer directory.

Note: When measure groups cannot be retrieved, the default
measure group list contains a Custom measure group. Select
the Custom measure group only when it is available in the
A2DAnalyzer application, otherwise recipe processing fails.

S t i t c h e d Imag e Re c i p e P r o c e s s i n g Ov e r v i ew

3. Click Queue Job to create a new job in the job control.

4. Run the Job Queue to start processing.

5. When the job is finished, an image layer is created containing the processing results from
Analyzer.
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Recipe processing specification

The recipe processing specification differs depending on the connected A2DAnalyzer instance
(that is, the version and licensing). To confirm A2DAnalyzer supported settings, test the
connection between Maps and Amira-Avizo2D.

l Test connection to A2DAnalyzer 2021.1 licensed without PRO extension

l Test connection to A2DAnalyzer 2021.1 licensed with PRO extension
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Settings Description

Maximum resolution Indicates the maximum resolution in pixels supported by the
connected A2DAnalyzer instance.

Input type Indicates the recipe input types supported by the connected
A2DAnalyzer instance.

Choices include:

l Single: Recipe supports only a single input image and
generates a single output image. As a result, applying a recipe
on a multichannel layer produces a multichannel layer with the
same number of channels.

l Multiple: Recipe supports multiple input images and generates a
single output image. As a result, applying a recipe on a
multichannel layer produces a single channel layer.

Combined CSV file Determines if a measure as a recipe parameter produces a single
.csv file for all processed images named 'CombinedMeasure.csv' in
the result layer folder. If not activated, Maps produces a .csv file for
each processed image in the result layer folder.

Default unit Default unit supported by the connected A2DAnalyzer instance,
which is used to exchange images.

Rec i p e p r o c e s s i n g s e t t i n g s o v e r v i ew
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Define Shared Folder
A shared folder is necessary to allow data exchanges. This folder can be located in any place,
as long as it is accessible to both software applications. It can be located on one of the two
computers.

1. To share a folder, determine the folder you want to share.

2. Right-click on the folder and click Show Properties.

3. Click Share in the Properties dialog box.
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4. Select Everyone for Name, click Read/Write for Permission Level, and then click Share.

5. Click Done.
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6. Right-click on the shared folder and then click Map Network Drive to define the shared
folder as a network drive to simplify access to this folder.

7. Select the network drive and click Finish.
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Locate hostname
A hostname is a label assigned to a device (that is, a "host") on a network. It distinguishes one
device from another on a specific network, or over the Internet.

Do the following to locate the hostname for your computer.

1. Click the Windows Start icon on the left end of the taskbar to open the Start menu.

2. Click the Settings cogwheel icon to open the Settings menu.

3. Click the System icon to open the system settings screen.

4. Navigate to the left-side panel and click About.

5. Scroll down to the Device specifications section and locate the computer model (for
example, Precision 7540).

6. View the Device name, which is also the hostname for your computer.
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Tomography
This section describes how to use Tomography with the Maps software.

Topics include:

Import Tomography Presets

Import Tomography Batch Positions

View and Visit Tomography Batch Positions

Send Annotations to Tomography (Beta)
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Import Tomography Presets
This topic describes the Import Presets option under the Tomography menu.

Note: For this menu option to work, you must have both Maps and the Tomography 5
Software installed. Also, you must have used Tomography at least once, and be
aware that the import will only work for the instrument modes that have been used for
Tomography (EFTEM, STEM, and TEM).

The following settings, which are available in both Tomography and in Maps, are stored as
templates when you use the import option.

l Atlas
l Exposure
l Template
l Overview
l Search
l Template

Import presets
1. Navigate to the TEM Options menu and click Import Tomography presets....

2. If not all the instrument modes are available, then a message appears to indicate which
instrument modes are missing. Click Yes to continue.
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3. If a template already exists for Tomography presets, then the following warning appears to
indicate that it will be overwritten by the import. Click Yes to continue.

4. The following message appears in the import is successful. Click Yes to continue.
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View stored templates

Each successful import is stored as a template, and you can inspect or alter them from within the
Tile Set Templates screen. Note that the imported presets end with (from Tomo) as shown
below.

Maps 3.32.1 User Guide

496 | Original Instructions

Limited Rights

PN 1551059 Revision A | 11-Mar-2025

Tomography



Import Tomography Batch Positions
This topic describes how batch positions are imported from Tomography to Maps. How you
import batch positions depends on whether or not the Maps Data Exchange Service is installed
on the system.

Note: For the import operation to work, you must have both Maps and the
Tomography 5 Software installed. Also, you must have imported the Exposure preset
from the Tomography 5 Software. If you want to use automatic synchronization
instead of the file-based exchange to import the positions, then the Maps Data
Exchange Service must also be installed.

Import and update batch positions
1. Navigate to the Tomography menu, and then click Import Batch Positions... to open the

system file dialog.

2. Click the file you want to import, and then click Open.

3. Maps imports the Tomography batch positions after successfully importing a new top layer.
You can view the imported positions in the Viewer as shown below.

4. Hover your mouse cursor over an imported position and right-click to open the context menu.

5. Select Update Tomography batch positions to update the current list of batch positions.
Positions are reloaded from the batch positions file last used. If the file is no longer available,
the system file dialog opens so that you can select a different file to import. All existing
positions that are not included in the new file will be deleted.
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Synchronize batch positions with Maps Data Exchange Service (beta)
1. Confirm the following preconditions are met.

a. Maps is running

b. Tomography is running and a session has been created

c. Tomography is connected to the Maps Data Exchange Service

d. One or more batch positions have been created

2. To activate the automatic synchronization of data with Tomography, either click Synchronize
With Tomography under the Tomography menu, or click the Toggle Automatic
Synchronization icon in the TEM Toolbar, Right Side. Once activated, the arrows in the
toolbar icon turn green.

3. Maps creates a new layer that represents the active Tomography session. It also imports
batch positions from the active session. You can view the imported positions by expanding
the layer, as shown below.

4. While the automatic synchronization is turned ON, any batch position changes in the active
Tomography session are automatically propagated to Maps (end-user interaction is not
required).
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View and Visit Tomography Batch Positions
This topic describes how you can view and visit Tomography batch positions after they are
imported from the Tomography 5 Software application.

View batch positions

You can view the batch positions in the Viewer from two different modes, zoomed-out or
zoomed-in.

Zoomed-out mode

When you view the batch positions from the Zoomed-Out mode, you can see an overview of all
the lamellae locations (indicated in green).
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Zoomed-in mode

When you view the batch positions from the Zoomed-In mode, you can see the locations of the
tracking area (indicated in green), exposure area (indicated in yellow), and focus area (indicated
in purple) for each individual lamella.
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Visit batch positions

You can move the stage to the batch position or zoomed-in location of a lamella's areas for
tracking, focus, and exposure. To move the stage, click Drive To under Position properties as
shown below.
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Send Annotations to Tomography (Beta)
This topic describes how annotations are sent from Maps to Tomography.

Note: For the operation to work, you must have both Maps and the Tomography 5
Software installed. Also, Maps Data Exchange Service must be installed.

Preconditions
1. Before sending the annotations, confirm the following preconditions are met.

a. Tomography is running, a session has been created, and the session is connected to the
Data Exchange Service

b. Maps is running, a project has been created, and the project is connected to the Data
Exchange Service

2. Create one or more annotations in Maps. The annotations may include any of the following:
a. Sites of interest

b. Areas of interest

c. Lamella sites

Synchronize all annotations automatically
1. To activate the automatic synchronization of data with Tomography, either click Synchronize

With Tomography under the Tomography menu, or click the Toggle Automatic
Synchronization icon in the TEM Toolbar, Right Side.

2. The arrows in the toolbar icon turn green once the automatic synchronization is activated.
Maps sends all annotations to Tomography and then displays them in the Tomography
viewer.

3. While the automatic synchronization is turned ON, any batch position changes in the active
Tomography session are automatically propagated to Maps (end-user interaction is not
required).

Maps 3.32.1 User Guide

502 | Original Instructions

Limited Rights

PN 1551059 Revision A | 11-Mar-2025

Tomography



Send all annotations of given type manually
1. Click Send To Tomography under the Tomography menu.

2. Click an annotation type from the submenu to send all annotations of the selected type from
the current Maps project to Tomography.

3. To update the annotations of your selected type at a later time, repeat the previous steps.
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Send selected annotations manually
1. Select annotations in the layer tree of the current project.

2. Hover your mouse cursor over an imported position and right-click to open the context menu.

3. Click Send to Tomography to send selected annotations from the current Maps project to
Tomography. Any annotations that have been previously sent, are replaced by the current
annotations.

4. To update the annotations at a later time, repeat the previous steps.
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Array Tomography
This section describes how to create an Array Tomography (AT) job using Maps software. Maps
AT functionality requires an active AT license.

Topics include:

About Array Tomography

Array Tomography Workflow

Extended Controls

About Array Tomography
AT is an imaging technique in which 3D image data is reconstructed from serial recordings on
serial sections that are spread out on a large sample carrier.

Samples

Samples for AT are produced by serial sectioning of a plastic-embedded sample in a microtome.
Sections are deposited on ITO-coated glass substrates (that is, 22 x 22mm cover glasses) or on
wafers.

Depositing samples is done manually or by a tape collection device (that is, ATUMtome). The
resulting AT samples differ fundamentally.

Classic and Tape Ribbons
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Sample Sections and Tile Set Arrays

The main purpose of the AT feature is to easily align high-resolution imaging on areas of interest
on all sample sections. The AT feature set consists of a concept called a Tile Set Array. The Tile
Set Array sets up local coordinate systems around the individual sample sections to create a
collection of tile sets across all sample sections.

Terminology
l Section: Defined as a single slice of the overall sample placed on the stage. Alternatively
used to refer to the outline of a given sample slice that is used in Maps.

l Tile Set Array: A collection of tile sets that span all or some of the sample sections. There will
be one tile set per section initially and they are all placed in the same relative location within
their section. Tile set arrays are used as the source images for creating a 3D data set. Most
tile set settings are shared across the whole array. All the tile sets created within this array
are linked. If the position, rotation, or imaging parameters of one tile set changes, then the
rest of the tile sets will be updated.
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Array Tomography Workflow
The AT workflow contains two branches to set up and capture images for an AT reconstruction:

l A branch for mapping out all sections on your sample manually.
l A branch for running an algorithm to auto detect the sections.

The following diagram shows the steps in the worklfow for both branches.

Start the Array Tomography Workflow

Step 1: Define and Place Sections

Step 2: Define Section Order

Step 3: Preview Sections (Optional)

Step 4: Refine Positions

Step 5: Create Tile Set Arrays

Step 6: Acquire Tile Set Arrays
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Start the Array Tomography Workflow

An Array Tomography (AT) job is a workflow used within the Maps workflow panel. The workflow
panel is a control that contains step-by-step processes that help make complicated jobs easier.
The workflows available depend on your product license.

1. Click the Start Workflow icon located on the right side of the Toolbar.

2. In the Select Workflow window, click Array Tomography, and then click Begin.
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3. The Workflow: Array Tomography window appears on the right side of the main screen. To
navigate through the steps within the workflow, use the forward and back arrows located at the
bottom of the window. To exit the workflow, click X at the top-right corner of the panel.
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Step 1: Define and Place Sections

The first step of the workflow is to define a section template to pattern match across the entire
sample for section placement.

Workflow procedure

1. Define the section template.

a. Use the mouse scroll wheel to zoom into one section of the sample.

b. Press Shift+left mouse button to rotate the viewer until the section aligns horizontally and
vertically within the viewer.

c. Click Define Section Template, and then draw a rectangle around the sample slice in the
viewer. Maps displays this image selection in the Section Template Image box within the
workflow panel. Array Tomography then uses this image as the search template within the
section finder.
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2. Use the section finder to automatically search for regions of overview images that match the
Section Template Image for fast section placement. Note that if you have 10 sections or
less in your workflow, then it is faster to perform this step manually.

a. In the Searchable Layers pane, select the desired overview image layers for the Array
Tomography search.

b. Optional: You can click the double gear icon to open a dialog to set a matching threshold
for the section finder. This icon is located below the layers pane.

c. Optional: You can click the trash can icon to either clear all sections if (a) you would like to
start over, or (b) the section finder did not function as expected with your defined
parameters. This icon is located below the layers pane.
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d. Click Find Sections to start the automated section finder. When the automated section
finder finishes searching, the viewer displays the outlined sections.

e. The section finder might place an extra section outline where a sample section does not
exist (this is called a "false positive"). If this occurs, then delete the false positive as
follows:
a. Click the section outline in the viewer.

b. Press the Delete key to remove the extra section outline.
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3. Add any remaining sections manually.

a. Confirm that the section requiring an outline is correctly aligned within the viewer. The
software application typically aligns the section within the viewer.

b. Click Place Section Outline (s) to generate a preview outline of the missing section or
press the letter s on your keyboard as a shortcut. Next, select the Move View To Next
Predicted Location check box to auto-orient the view based on the two previously placed
section locations and rotation.

c. Click in the viewer to place the outline.

4. Once you place all the sections, click the forward arrow at the bottom of the workflow panel
to continue to Step 2: Define Section Order.
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Step 2: Define Section Order

The second step of the workflow defines the order of the sections.

Ordering tool

An ordering tool allows you to draw a line through a collection of sections within the viewer to
determine the order. Sections closest to the start of the line are first in the order; whereas,
sections near the end of the line are at the end of the sequence.

There are two available ordering tools for you to use:

l Freeform Tool: Use this ordering tool to draw a custom line in the viewer like a pencil tool
used in graphical editors.

l Line Tool: Use this ordering tool to draw a line between two points by dragging a line in the
viewer.

Workflow procedure

The viewer displays the newly ordered sections once you define their order. To define the order
of the sections, do the following workflow procedure:
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1. Click the user interface button of your chosen ordering tool to activate it.

l Freeform Tool: Click the Freeform Tool (f) button.
l Line Tool: Click the Line Tool (s) button.

2. Starting with the first section in the sequence, use the ordering tool to draw a line in the
viewer tool to indicate section order. Note that the unordered sections are highlighted in
brown and the ordered sections are highlighted in green.

Note: Use the keyboard shortcut to quickly switch ordering tools anytime during
this step of the workflow. Press the letter f on your keyboard to activate the
Freeform Tool; press the letter s on your keyboard to activate the Line Tool.

3. Repeat the previous step until all sections appear in the ordered list. If you want to delete the
current order and start over, then click Reset. The number of unordered sections is
displayed at the bottom of the panel for your quick reference.

4. After you have ordered all sections, click the forward arrow at the bottom of the workflow
panel to continue to Step 3: Preview Sections (Optional).
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Step 3: Preview Sections (Optional)

The third step of the workflow is optional, but this step is highly recommended since it will
increase the accuracy of the section placement on your sample for more aligned final data
capture. Proceed with this workflow step to acquire high-resolution images for each section, so
that you can then perform section position refinement.

Note: To skip this step and Step 4: Refine Positions in the workflow, DO NOT
acquire any additional section previews. Be sure to delete all acquired section
previews and existing section preview tile sets. Once you have deleted these items,
click the forward arrow at the bottom of the workflow panel to continue to Step 5:
Create Tile Set Arrays.

Workflow procedure
1. Determine a section in the viewer to acquire and use for your section preview tile sets.

2. Optional: Select the desired tile set to use for previews in the viewer, and then click Center
View to zoom in on and match the rotation of the tile set.

3. Click Create Tileset to define the section preview template, which is a tile set that will be
used for all other section preview tile sets (including their properties).
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4. Edit the section preview template to capture a quality image of the section. Note that you can
edit the section preview template like other tile sets.

a. Set up the recommended parameters, so that the section preview template has good
image contrast and recording speed:

l Use a single tile with a 100–1000 nm pixel size

l Set the dwell time to 2 µs

l Use a minimum total resolution of 2K for the tile set

b. Click Acquire to acquire, or click Reset to reset the acquisition results of the section
preview template.

5. Click Acquire Previews to create and acquire all remaining section previews based on the
section preview template.

6. Optional: Click Delete Previews to delete all section previews except the template section
preview.

Note: If you encounter workflow issues while acquiring section previews, repeat
Steps 1–5 to recreate the template section preview and delete all section
previews.
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7. Once you have acquired all section previews, click the forward arrow at the bottom of the
workflow panel to continue to Step 4: Refine Positions.
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Step 4: Refine Positions

The fourth step in the workflow will help increase the accuracy of the positions of the section
outlines based on the preview images acquired during Step 3: Preview Sections (Optional) of
the workflow.

Workflow procedure

1. Click View First Section, and then click Define Refinement Region.

2. In the viewer, drag the mouse to create a yellow border box to define the refinement region.
The Maps software application will then use this region to begin refining the section
positions. The refinement region image cutout is displayed in the Section {section #} Result
box.
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3. Click Run Refinement to begin the refinement process.

l Refinement progress is displayed in the workflow panel. The example below shows the
refined result for a selected section. To stop the refinement process, click Stop.
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l During the fine refinement sequence, Array Tomography places green rectangles in the
viewer where the refinement process found an appropriate match. The refinement region
image displayed and the offset results both update based on the incoming results.
Refinement results appear based on the order of the sections.

l After the refinement process completes, you can browse sections using the slider, input a
number in the input box, or press the play button to navigate through all sections.

l Adjusting the Target-Result slider will adjust the relative transparencies of the current
result and the previous result.
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4. If there are no failures during the refinement run, then the workflow skips this step. If there
are failures, then a dialog box appears after the refinement completes. The dialog box
displays the names of the sections that require your attention.

Failed sections are highlighted red in the viewer.

a. To update or fix failed sections, navigate within the viewer to the failed section cutout and
select it.

b. Click Adjust Result. The cutout color should change to blue, indicating that a manual
adjustment is in progress.

c. Move and rotate the cutout in the viewer to correct its placement.
l Move the slider control below the Section Result image to the Target side. This will
overlay the current result on top of the previous result with varying transparency.

l To help target a center spot, match the location of the green crosshair displayed within
the blue box of the viewer to the red crosshair displayed in the Section Result image.
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d. There are several choices once the manual adjustment has been made.

l Save
o Use the Save option to save the current manual adjustment for the section.
o The section cutout will update to green in the viewer, thus indicating that it has
been refined.

o All other sections have their refinement status retained.

l Save and Continue
o Use the Save and Continue option to save the current placement of the section
cutout. Array Tomography starts running the refinement again from this section
onwards, thus redoing any previous refinement for sections following the saved
section cutout.

o The section cutout will update to green in the viewer, thus indicating that it has
been refined.

l Cancel
o Use the Cancel option to cancel any current adjustments to the section.
o The section cutout will update to its color in the viewer to the color it had prior to
starting the adjustment.

l Trash can
o Use the Trash Can option for sections that were damaged during sample prep and
will result in inadequate final data.

o The Trash Can option marks the section to be deleted.
o The section cutout will be updated to a light grey color in the viewer.
o If the refinement is re-run, this section will be ignored from the run.
o When applying the refinement results, this section will be deleted from the project
along with its associated preview tile set.

e. Repeat the previous steps for any remaining failed sections.

5. After all sections have passed refinement, check how well the refinement placed itself by
using the slider bar above the Section Result image box. Do the following to check all refined
sections:

a. Move the slider from left to right to show the final results in the Section Result image
region.

b. Use the Play button to the right of the slider bar to automatically animate the sequence.
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6. Click Apply Refinement Results to apply the refinement offsets to the section outline
placement. Or, click Reset All Results to start from the beginning of this step.

Note: Applying the refinement results is a one-time action is not reversible and it
will automatically progress you to the next step in the workflow.

7. When you are satisfied with the section outlines placement, click the forward arrow at the
bottom of the workflow panel to continue to Step 5: Create Tile Set Arrays.
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Step 5: Create Tile Set Arrays

In the fifth step of the workflow, you create and edit the tile set arrays.

Workflow procedure

1. Click Create Tile Set Array.

This step creates a new tile set array. Each tile set is placed in the center of a section.

Note: There is an exception to the tile set linking functionality in the array for one
of the imaging parameters. The Focus Strategy for all tile sets within the array are
shared. However, if the Focus Strategy is set to Fixed, then the actual Fixed
Value is not shared between each tile set. This allows you to manually focus and
store the found focus position for each tile set for samples on which autofocus
does not work.
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2. Once the tile set array is created, you can adjust the properties of the tile set array with the
edit controls provided. To learn more about these edit controls, see Extended Controls.

3. Optional: After final acquisition, select the Stitch during acquisition checkbox and a folder to
output each stitched tile set to a designated folder. When activated, this functionality outputs
a series of images to your specified folder after acquisition. These images are all fitted to be
the exact same size and are aligned, so they can be reconstructed into a 3D volume within
another software application. If data has already been acquired, then the Finalize Stitch
Results button becomes activated and you can click it to manually export the images.

4. When you have created and edited all tile set arrays as desired, click the forward arrow at the
bottom of the workflow panel to continue to Step 6: Acquire Tile Set Arrays.
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Step 6: Acquire Tile Set Arrays

In the sixth step of the workflow, you acquire the tile set arrays.

Workflow procedure

1. Double-check that all desired tile sets have been created.

2. Order the tile sets.
a. Click a tile set to select it.

b. Click the arrow buttons to move it either up or down.

3. Click Update Queue to add all tile sets to the acquisition queue, grouped by their section.

4. Click the RUN Button on the bottom status bar to begin final acquisition.
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Extended Controls
Create and manipulate AT data sets with tools described in this topic.

Most of the work for AT occurs within the Start the Array Tomography Workflow. These
extended controls allow you to create and manipulate AT data sets outside of the workflow.

Layer property pane

Some layers types that are associated with an AT job have extended controls in the layer
property pane in the Array Tomography section. The options change depending on what you
select in the layer tree.

Tile set array

Click the tile set array group layer. Controls appear in the Array Tomography pane that allow
you to edit the tile set array.

l Name – The name of the selected tile set array.
l Opacity – Controls the level of transparency for the tile set array. Click the slider knob and
move it to the right for low transparency, or move it to the left for high transparency. By
default, the slider knob is on the extreme right so that the tile set array is completely visible.
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l Section Span Slider – Controls which sections the tile set array spans across. The left value
is the section index that the tile set array starts on, the right value is the section index where
the tile set array ends.

l Current Edit Mode – Changes which tile sets within the selected array change when one tile
set from the array is dragged or rotated in the viewer.

l View Controls – Center the viewer on the displayed section or move the view from one
section to another while keeping the same relative field of view. This can help you inspect the
results of a tile set array.

Section outlines

The layer group that contains all the section outlines. It includes View Controls described above
and displays the number of Total Available Sections.
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Section

The Section layer includes View Controls described above and shows the Section Index and
Section Rotation of the selected section.

Layer tree context menu

Tile set array

The tile set array layer group in the layer tree has some extended options in its right-click context
menu.
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l Copy Tile Set Array – Creates a complete copy of the whole tile set array.
l Reset Acquisitions – Resets the acquisitions of any tile sets within the tile set array.
l Enqueue Tile Set Array – Queues up the whole tile set array for acquisition.
l Dequeue Tile Set Array – Removes the whole tile set array from acquisition.
l Stitch All... – Prompts you to start a Stitch All operation. This has the following outcomes:

l All stitched images are saved to one output directory.

l All images are saved with the same dimensions. This makes it easier to create image
stacks.

l Delete – Deletes the whole tile set array. When you select this option, a message dialog
appears to summarize all the items designated for deletion. Verify the summary, and then
click Delete to confirm.

Create a new tile set array
1. To create a new tile set array outside of the workflow:

2. Press Alt and drag to select an area that is completely contained within a section in the
viewer.

3. Right-click and then click Create Tile Set Array here.

This creates a new tile set that spans all selected sections.
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Known issues
The following known issues have been identified in the Maps software application.

Maps 3.32.1 known issues

Maps 3.30.2 known issues

Maps 3.29.1 known issues

Maps 3.28.1 known issues

Maps 3.27.1 known issues

Maps 3.24 known issues

Maps 3.22 known issues

Maps 3.20 known issues

Maps 3.18 known issues

Maps 3.14 known issues

Maps 3.13 known issues

General known issues

Amira-Avizo2D known issues

SEM known issues

TEM known issues

Mineralogy known issues
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Maps 3.32.1 known issues

Channels for removed elements are not always properly deleted

When reprocessing of EDS channels starts before everything has been drawn to the layer from
previous reprocessing or acquisition, the element maps might not be properly finished.

l To prevent this issue, wait until everything is drawn to the element channels.

l If the issue occurs, reprocess the layer again. It is recommended that you first remove count
and quant maps, and then initiate the reprocessing again from the very beginning.

Maps 3.30.2 known issues

Mineralogy: Maps freezes when simultaneously updating Mineral
Reference Editor and running a mineralogy acquisition with a recipe
(also affects all previous Maps versions)

If you update Mineral Reference Editor (MRE) while running an acquisition with a configured
MRE recipe, then the Maps user interface freezes during the X-ray acquisition steps. To prevent
this issue, perform all necessary Mineral Reference Editor updates prior to initiating a Maps
acquisition. If you encounter the user interface freeze, click Stop to pause the acquisition and
then click Run to resume the acquisition.

Maps 3.29.1 known issues

TEM: Data exchange between Maps and Tomography does not work

The data exchange does not work with the version 3.0.0.72 of the Maps Data Exchange Service,
which is included in the Maps 3.29.1 installation package
(ThermoScientificMapsDataExchangeService3.0.0.72.exe).

Workaround: Use the ThermoScientificMapsDataExchangeService3.0.0.70.exe file, which is
included in the Maps 3.27.1 installation package.
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Mineralogy: Loading time for Mineral Association report

The Mineral Association report in Reporting may take some time to load due to the complexity of
the analysis involved. However, to provide a better user experience, a loading icon is displayed
to indicate that the report is loading. Additionally, a warning icon is displayed next to the report
selection to alert you about the loading time.

Mineralogy: Reports data cannot be displayed after installation

When upgrading from Maps Min Reporting 3.28 to 3.29, you might encounter a problem in which
the data are not displayed on the Reporting web page for a few minutes after the installation
process successfully completes. To address this issue, it is recommended that you uninstall the
Maps Min Reporting application and then reinstall it as a temporary workaround.

Mineralogy: Nanomin cannot open exported report in Excel (affects
Maps 3.29.1 and any other Maps version on a Windows 11 system)

Nanomin might crash when attempting to open Excel with newly exported reports in Excel
format on Windows 11. This issue occurs specifically when Excel displays the "Your privacy
matters" dialog with Microsoft 365 (Office), or when the Excel license is not activated. To resolve
this issue on Windows 11 systems, follow the steps listed below on the next page.
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1. Ensure that your Excel license is activated and up to date.

2. Follow these steps to deactivate any Microsoft 365 (Office) privacy matters dialog that is
triggered by Excel:

a. Open any Office 365 application, such as Word or Excel.

b. Click the "File" tab in the upper left corner.

c. Select Options from the drop-down menu.

d. In the Options window, navigate to the "Trust Center" tab.

e. Click Trust Center Settings...

f. In the Trust Center window, select Privacy Options.

g. Click Privacy Settings...

h. Uncheck the box that says, "Turn on optional connected experiences".

i. Sign out of the Microsoft application that you have open.

j. Open the Microsoft 365 (Office) application on your computer and sign out.

k. Restart all Office applications.

l. Sign back into your Microsoft 365 (Office) account.

m. Open a Microsoft application and log in. The privacy matters dialog should no longer
appear.
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Maps 3.28.1 known issues

TEM: Maps Data Exchange Service installer is missing in 3.28.1
installation package

The ThermoScientificMapsDataExchangeService3.0.0.70.exe file is not present in the Maps
3.28.1 installation package.

Workaround: Use the ThermoScientificMapsDataExchangeService3.0.0.70.exe file, which is
included in the Maps 3.27.1 installation package.

Mineralogy: Centroid mode slows down Maps

When running the Centroid mode only or when using the BSE search ranges option within the
Maps Min workflow, the Maps application could hang if you use high-resolution tiles, or if you
use very fine particles or grains. The particles split into very fine particles if you use a high-
strength setting during particle segmentation, and the grains split into very fine grains if you use
a small grain size setting during grain segmentation.

The following can help you to prevent this issue:

l Use 512x442 for BSE resolution
l Use a lower strength setting for particle segmentation
l Use a larger grain size setting for grain segmentation

Maps 3.27.1 known issues

Inability to recover data if rare error occurs during splitting of tile set
channels

If a rare error occurs during the splitting of tile set channels, data loss can occur in Maps and the
data would not be recoverable. Also, if a Phenom EDS or Mineralogy tile set is split through the
Split Channels feature, then the backing Mineralogy or Phenom data will be lost. This specific
data loss would result in not being able to reprocess a Phenom EDS tile set and the data loss
could also break Mineralogy tile sets.
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Mineralogy: Distinct Particle Size Distribution report results between
Nanomin and Reporting

Nanomin and Reporting use two different methods to calculate the Particle Size Distribution
report results. Nanomin uses a calculated pixel area that encompasses all pixels within the
particle, including those within porous regions; whereas, Reporting, uses a calculated pixel area
equivalent to the sum of all grain pixel areas of the particle.

Phenom: Compatibility limitation (affects Maps 3.26.1 and Maps 3.27.1)

Maps requires the Phenom server version 6.6 or later.

Phenom: Remote connections not supported for EDS acquisition

Maps must be running on a computer directly connected to the Phenom instrument when
performing EDS acquisition. Remote connections are not supported due to slow performance.

Maps 3.24 known issues

TEM: Lamella site imported from SDB might show incorrect milling
angle

The milling angle of a lamella on SDB systems is computed based on several parameters,
including the sample pre-tilt angle (which depends on the sample shuttle type), the stage tilt
angle, and the angle of the ion beam. The sample pre-tilt angle is currently assumed to always
be 35 degrees on TEM systems. If the shuttle type with a different pre-tilt angle was used on the
SDB system, then the milling angle that is shown on the TEM system will not be correct.

This known issue will be resolved in an upcoming release of Maps. A workaround is not
available.

Maps 3.22 known issues

TEM: Failure to acquire EDS tile set (affects Maps 3.19–3.22)

Maps encounters an error during acquisition of EDS tile set. The error description is the
following: "Error encountered during job execution: Error trying to acquire an image: Index (zero
based) must be greater than or equal to zero and less than the size of the argument list." The
error is caused by a timing issue and thus appears to show up randomly.
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Workaround: Restart Maps and Velox, and then perform the acquisition again to resolve the
error. If the error persists, decrease the amount of data that is exchanged between Velox and
Maps during acquisition (for example, by lowering the resolution of the acquired images and
EDS maps).

Maps 3.20 known issues

Mineralogy: Segmentation Wizard hang

When running the Segmentation Wizard, the Maps application will hang if you use very fine
particles or grains. The particles split into very fine particles if you use a high strength setting
during particle segmentation, and the grains split into very fine grains if you use a small grain
size setting during grain segmentation.

The following can help you to prevent this issue from happening:

l Use a lower BSE resolution
l Use a lower strength setting for particle segmentation
l Use a larger grain size setting for grain segmentation

Maps 3.18 known issues

SEM: Quattro acquisition failures

Maps may encounter an error during the first acquisition of a tile set or snapshot. The error
description is "Error encountered during job execution: Job execution failed: Image grab action
failed. The following error occurred: No description available. The error occurred was: No
description available:" To resolve this error, close Maps and restart the xT Microscope Server.

Mineralogy: Data migration performance

Performing data migrations from Maps Min 3.14 or 3.1 can be slow. Terminating the process can
corrupt the underlying database. Allow the migration process to complete to preserve data
integrity.

Mineralogy: Mineral classification requires free space on C: drive

If the system C: drive is low on space, then Nanomin will report that the C: drive is out of space
during classification even if the data is stored on a different drive. Ensure the C: drive has at
least 10 GB of free space.
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Maps 3.14 known issues

TEM: 4D-STEM acquisitions fail

If the camera is selected for STEMmode when acquiring EDS data in the Maps application with
Velox, the acquisition fails and displays the following error message: "Error trying to acquire an
image: Camera cannot be enabled in STEMmode during remote acquisition." When you receive
this error message, deselect the camera and then restart Maps to continue acquisition.

TEM: Templates and camera replacement

If the camera is replaced with a different camera, then the tile set templates may no longer be
valid and thus require manual updating.

Maps 3.13 known issues

SEM: Failure to acquire square resolutions

When acquiring square resolutions on Windows 7 microscopes (for example, 8096 x 8096), the
acquisition may fail with an unhandled exception. If this error is encountered, either use a non-
square resolution, or install the platform update for Microsoft Windows 7 SP1 KB2670838.

General known issues

Error message: "A generic error occurred in GDI+."

After installing the application and starting it for the first time, this message might appear.

Workaround: Restart the PC to resolve the issue.

Cannot select a tile set in the viewer

Workaround: Hide other items in the layer tree that are in front of the desired tile set.
Alternatively, select the tile set in the layer control.

Error message: “There was a problem preparing the tiles for stitching.
Please restart the application as soon as possible.”

Workaround: Restart the application. If this does not resolve the problem, then restart the PC.
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Stitching errors occur when stitching a tile set

See the “Stitching Best Practices” section of the Maps user guide.

Workaround: Optimize your tile set parameters and image quality, or try a different stitching
profile.

Maps appears to hang while recalculating tile positions

For very large (> 100 GB) high-resolution tile sets, recalculation of tile positions can be time
consuming.

Workaround: Allow a few minutes for this procedure to complete.

Maps does not open on the correct monitor

Workaround: Move the Maps window to the desired screen and click the X button located in the
top right corner to close Maps. The next time Maps is opened, it opens to the correct monitor.

Newly-created tile set does not appear in the viewer

Workaround: Ensure the tile set and associated layer are enabled in the layer control. Also, the
Hide Annotations feature (press Ctrl+H) can be used to make all Maps viewer graphics enabled
or not enabled.

Projects from Maps v1.0 cannot be imported

Maps v1.0 projects are not supported.

Workaround: You can import Maps v2 and v1.1 projects.

Quit is not enabled in the Maps File menu

Workaround: If the automated holder alignment is running, Abort and Close the holder alignment
UI. It should then be possible to quit Maps.

Amira-Avizo2D known issues
Sending two images in a row without performing the image calibration results in unexpected
behavior from Analyzer. It is recommended that you always perform the image calibration after
you send an image to Amira-Avizo2D.
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SEM known issues

AutoFocus only runs in Quad 1

Even when acquiring multiple Quads or when Quad 1 acquisition is disabled, AutoFocus only
runs in Quad 1. You cannot define a tile set that will AutoFocus on a different quad. Workaround:
If you select AutoFocus or InitialAutoFocus in the Focus Setting property of a tile set, then the
detector that you use for Quad 1 imaging must be the one that you intend to use for the
AutoFocus operation.

Cannot use Line Integration with 8192 x 8192 or 4096 x 4096 image
resolution

An error occurs when you use try to use Line Integration to capture a tile set with 8192x8192 or
4096x4096 resolution on the Helios PFIB microscope.

Workaround: If you need to use line integration, then select a different image resolution.

Note: This issue only occurs on the Helios PFIB product.
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SEM: Focus stack can result in blurry images

On Quanta and Prisma E systems, acquiring a focus stack can result in a blurry stripe along the
top of the images.

There is no workaround. Avoid focus stack acquisition on these systems.

Line Integration and Scan Interlacing are ignored when acquiring
multiple detector channels

When you use multiple quads on the Advanced tab of a SEM tile set, Maps ignores any values
in the Line Integration or Scan Interlacing settings.

Workaround: If you need to use Line Integration or Scan Interlacing, then you can only specify a
single detector channel in your tile set.

Unable to queue jobs that involve detector insertion/retraction

Maps does not insert or retract detectors.

Workaround: Manually insert retractable detectors.

Some tiles are not in focus when running tile sets with AutoFocus
enabled

Workaround: Try modifying the AF parameters using the microscope control software.
Alternatively, you can reacquire the tiles with bad focus using a different focus strategy.

Rotation is not supported when using Set Sample Plane

Workaround: Do not change stage R while using this feature.
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Fast multi-detector tile acquisitions error message: “This detector
combination is not supported for multiple detector acquisitions”

Fast acquisitions could be, for example, 1024 resolution with 50 ns dwell.

Workarounds:

l Use single-detector acquisition.
l Use a longer dwell time.
l Use a larger resolution.

SEM tile sets from earlier versions

Due to architectural changes, SEM tile sets from versions prior to Maps 3.6 can no longer be
manipulated or acquired. This data can still be imported, visualized, and stitched. To acquire
new SEM data into these projects, create new tile sets.

When acquiring a STEM tile set that is using auto focus and the auto focus routine fails on a tile,
no image for that tile is acquired. This can result in some tile sets having blank tiles.

SEM: Lens Alignment auto-function is not available on Quanta FEG

This auto-function does not support the Quanta FEG.

SEM: PrismaE xT version 16.1 intermittently fails when using square
resolutions

Square resolutions (such as 2048 x 2048 and 40960 x 40960) fail intermittently with an error:
"Cannot move stage in X axis. It is either unavailable or locked." Do not use square resolutions
on PrismaE with xT version 16.1. This issue is resolved in xT 16.2.

TEM known issues

After you select Ceta or Falcon I/II camera in PEOUI, it is not selected in
Maps

When both Ceta and Falcon I/II cameras are not inserted, the Microscope Field of View (FOV)
might show an unsupported camera.

Workaround: In PEOUI, insert the Ceta or Falcon I/II camera.

Limited Rights

PN 1551059 Revision A | 11-Mar-2025

Maps 3.32.1 User Guide

543 | Original Instructions

Known issues



For large magnifications, the Microscope FOV might not be located at
the exact position of the last acquired tile

At high magnifications, there can be a small differences between the tile positions and position
of the Microscope FOV rectangle when the tile is being acquired. This small offset originates
from small mechanical errors in the stage positioning.

Workaround: The FOV rectangle is the most accurate representation since it tracks the stage
measuring system.

Snapshot image differs from a tile image.

When a snapshot image is taken at the same location and with equal settings that a tile was
acquired with, the snapshot image differs from the tile image because the histogram of a
snapshot is based on a single image; whereas, for a tile, the histogram is based on the entire tile
set.

Unclear with which spot size a tile set is acquired when spot size is
clipped

For example, when you select a spot size of 1 in Maps and acquire the tile set, the microscope
clips the spot size to 5 for X-ray safety. In this case, the tile set is acquired with spot size 5.
However, if you look at the tile set parameters it seems that it was acquired with a spot size of 1.

Workaround: Set the tile set to be acquired with a spot size that is not going to be clipped.

Tiles are misaligned

This can happen for a number of reasons. Maps uses the instrument alignments and
calibrations to determine tile size and orientation. If these are off, then the tile set will not be
properly aligned. Regular system alignments and calibrations are recommended as described in
the system documentation.

Workarounds (contact your application support engineer for details):

l If the instrument is not at eucentric height and/or far out of focus, then adjust Z to set the
stage at eucentric height and/or focus.

l If there are inaccurate lens alignments and magnification calibrations, redo the alignments
and calibrations for the applicable magnification.
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l If the stage is non-orthogonal: Some TEM stages have a slight angle between the X and Y
stage axis. This can be checked by performing pure X and Y moves using PEOUI and TIA.
Then measure the angle. Maps has a provision to take this into account, but this requires
adjustment of one of the configuration files.

When a tile set with invalid values is acquired, it is unclear with which
settings it is acquired

When one or more parameters of a tile set are out of range, this is indicated by a red box. It is
still possible to acquire such a tile set. The values used during acquisition are the last valid
values that you entered.

Workaround: Enter valid values, so that a red box is not shown before acquisition.

When C2 or C3 lens is switched off, a tile set can be acquired with an
unrelated intensity value

On a system with three condenser lenses, you can switch off either C2 or C3. Maps does not
detect which lens is switched off. You can create a tile set when C2 (or C3) is switched off and
then acquire it when C3 (or C2) is switched off, which results in an unrelated intensity value.

Workaround: Complete tile set creation and acquisition before switching to another lens.

Maps might prevent or fail acquisition in other applications

Maps does not check if other applications use a detector or camera. The detectors and cameras
are retracted, except the one that the tile set is going to be acquired with. As soon as Maps starts
acquisition, it detects that another application is using the detector or camera (and does not start
acquisition). This behavior might prevent acquisition from being done in the other applications.

Workaround: Do not start acquisition of a tile set when another application is using a detector or
camera.

Intensity or illuminated area is not set to the microscope

When you switch off C2 or C3 on a system with three condenser lenses, the intensity is not set to
the Microscope for a tile set that was created when you switched on both C2 and C3.

Workaround: Switch on both C2 and C3 and then click To Microscope. When you switch on C2
and C3 on a system with three condenser lenses, the illuminated area is not set to the
Microscope for a tile set that was created when you switched off C2 or C3.
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Workaround: Switch off C2 or C3 and then click To Microscope.

Errors occur when TEM server, TIA and Digital Micrograph are not
running

Before Maps can be started, the TEM server, TIA, and Digital Micrograph (when applicable)
must be running. When Digital Micrograph, TIA, or the TEM server crashes or is stopped, Maps
might crash, show error messages, or behave incorrectly. Examples include the following:

l TEM plug-in generated an exception during initialization.
l Object reference not set to an instance of an object.
l FOV size incorrect.
l Maps crash during acquisition as soon as TIA crashes or is stopped.

Workarounds:

l When using the Camera ocx in PEOUI, the camera combo box is empty, TIA has crashed, or
is not running. Restart TIA and ensure that the camera combo box lists your cameras, and
then restart Maps.

l When the TEM server has crashed or is not running, restart the TEM server, start TIA, and
then restart Maps.

l For camera usage that depends on Digital Micrograph, the startup order is:
1. TEM server

2. TIA

3. Digital Micrograph

When TEM server is restarted, restart TIA and then Digital Micrograph. When TIA is
restarted, restart Digital Micrograph.

l After changing the high-tension value or executing camera calibrations, restart Maps.

Maps becomes unresponsive

This can happen when the stage is not working properly.

Workaround: In PEOUI, verify that the stage is working properly and restart Maps.
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Maps becomes unresponsive when deleting a large amount of large tile
sets

When you delete a large amount of large tile sets, Maps becomes unresponsive during this
operation. It can take extra time to delete large tile sets. Do not end the program, or you will
interrupt the operation and need to start over.

When Maps is running offline, sometimes Intensity is displayed instead
of Illuminated Area

When Maps is running offline, Maps does not know whether the TEM tile set was acquired on a
system with two or three condenser lenses. Maps incorrectly shows Intensity for a TEM tile set
that is acquired on a system with three condenser lenses.

The disk space usage estimate may be incorrect

The total disk space required is only an estimate and might vary. Please allow extra space for
large data sets.

Images that include part of a grid bar are slightly darker

In a tile set, the images that contain a part of a grid bar are slightly darker due to a difference in
image contrast.

Workaround: Avoid images with grid bars.

New tile sets are deselected in the Job Queue after a Magnification
Alignment

When Magnification Alignment is performed on a tile, empty tile set jobs in the Job Queue might
become deselected causing them to not get acquired.

Workaround: Go to the Job Queue and select the check boxes of the applicable tile sets.

Microscope FOV is not updated when the Stage Axis Angle Correction
is updated

When the Stage Axis Angle Correction is updated in the Settings menu, the microscope Field of
View (FOV) is not updated.
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Workaround: Change the magnification to update the microscope FOV for magnification, or
move the stage to update the microscope FOV for location.

Microscope FOV is not updated when the STEM Scan Orientation
Correction is updated

When the STEM Scan Orientation Correction is updated in the Settings menu, the microscope
FOV is not updated.

Workaround: Change the STEM FOV or magnification.

Maps software hangs when acquiring on a microscope with a Gatan
camera or DigitalMicrograph

On a microscope with a Gatan camera or Gatan DigitalMicrograph running, Maps software can
sometimes freeze during acquisition.

Workaround: Close Maps software and restart Maps.
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In EFTEMmode, images can be acquired only with maximum camera
resolution

In EFTEMmode, images can be acquired only with maximum camera resolution , such as
binning 1.

In EFTEMmode, stitched images are incorrect

When tile sets acquired in EFTEMmode are stitched, the size of the stitched output is incorrect
and tiles are incorrectly joined.

Mineralogy known issues

Mineralogy: The reporting page is not reachable due to WSL

The reporting page may fail to work properly if the Windows Subsystem for Linux (WSL) is not
started.
This issue can occur in situations where the WSL service is not running or encounters an error
during the startup process.

To resolve this issue, please follow the steps outlined below:

1. Open a command window as an administrator.

2. Type the command: tasklist /svc /fi "imagename eq svchost.exe" | findstr LxssManager
and note the returned PID.

3. Run the Task Manager as an administrator.

4. Go to the "Details" tab in Task Manager.

5. Search for the svchost.exe process containing the previously noted PID.

6. Right-click svchost.exe and select "End Process Tree."

7. Return to the command window opened as an administrator and type 'wsl –shutdown',
followed by 'wsl'.

8. Ensure that a command line is returned without any errors.

By following these steps, you can resolve the issue related to the reporting page not working due
to WSL not being started. This workaround will help restart the necessary services and ensure
the proper functioning of the reporting page.
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Mineralogy: Bruker Esprit error on long running acquisition

During the process of running a long acquisition with the Bruker Esprit tool, there is a known
issue where an error message may appear stating 'An expected error occured on
server. Consider to save your current and restart Esprit'. In some cases, this error message can
cause the acquisition process to stop unexpectedly on the Support PC. A workaround is
currently not available.
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Release Notes
Be sure to read the release notes for the latest software version of the Maps software to learn
about new features and changes in functionality.

Maps 3.31.1 Release Notes

Maps 3.30.2 Release Notes

Maps 3.30.1 Release Notes

Maps 3.29.1 Release Notes

Maps 3.28.1 Release Notes

Maps 3.26.1 Release Notes

Maps 3.25.1 Release Notes
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Maps 3.31.1 Release Notes
This document specifies changes made to the Thermo Scientific™ Maps 3.31.1 software
application.

New Features

SEM Analytics

Maps can now acquire EDS data through a software application interface on a SEM/SDB
microscope. This functionality is available on systems with ChemiSEM support, including Apreo
ChemiSEM, Axia ChemiSEM, and Quattro ESEM.

See SEM Analytics for more information.

TEM: Support for TEM 3.22 and TEM 2.22

Maps now supports TEM server versions 3.17–3.22 for Titan and 2.17–2.22 for Talos.

Bug Fixes

The following bugs were fixed in this release of the Maps software.

Bug ID Description

MAPS-11821 The Job Control button located in the status bar now supports a toggle
pattern with a chevron icon. When you click the Job Control button
repeatedly, the Job Control screen toggles between expanded and
collapsed states. Previously, you could not collapse the screen by clicking
the Job Control button.

MAPS-12455 A resolution of 512 x 512 pixels is now available on Phenommicroscopes.

MAPS-12655 Maps now removes temporary acquisition files on Phenommicroscopes
when the files are no longer needed. This previously caused problems
during long acquisitions of large tile sets, including errors and crashes
when a system's temporary space filled up.
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Maps 3.30.2 Release Notes
This document specifies changes made to the Thermo Scientific™ Maps 3.30.2 software
application

Known Issues

See Known issues for known issues introduced with this version of Maps software.
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Maps 3.30.1 Release Notes
This document specifies changes made to the Thermo Scientific™ Maps 3.30.1 software
application.

New Features

Phenom: Default license includes basic features

Maps on your Phenommicroscope now includes basic features without a need for product
registration and activation. The basic features allow you to control the Phenommicroscopes;
create and edit projects; create and acquire tile sets; and perform stitching of acquired data.

TEM: Support for TEM 3.21 and TEM 2.21

Maps now supports TEM server versions 3.16–3.21 for Titan and 2.16–2.21 for Talos.

Known Issues

See Known issues for known issues introduced with this version of Maps software.

Bug Fixes

The following bugs were fixed in this release of the Maps software.

Bug ID Description

MAPS-
11391

TEM: Autofunctions now run correctly in EFTEMmode on all supported
cameras. Previously, the autofunctions failed to run on some cameras.

MAPS-
11407

Maps no longer freezes when exporting a group layer to a new or existing
project.

MAPS-
11418

TEM: The first tile is now acquired in a more precise position after eucentric
height autofunction runs on the first tile. Previously, it could be visibly shifted
relatively to the rest of the tile set in some use cases.

MAPS-
11478

Leica XLEF import: Confocal stacks are now oriented consistently with
overview images.
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Bug ID Description

MAPS-
11479

The color indicator for fluorescence channels now shows a color gradient
based on a lookup table. Previously, the color indicator showed as white if the
lookup table was used.

MAPS-
11793

TEM: The Data Exchange Service runs correctly again, thus allowing data
exchange between the latest versions of Maps and Tomography. This service
was previously broken by a library update conflict, which caused the data
exchange to fail.
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Maps 3.29.1 Release Notes
This document specifies changes made to the Thermo Scientific™ Maps 3.29.1 software
application.

Product News

Mineralogy: Revised product name

The product name of the Maps Mineralogy plugin application has been revised to "Maps Min".
The new product name is effective as of this release.

New Features

Mineralogy: Bruker XFlash® 7 EDS Detector support

Maps Min now supports the Bruker XFlash 7 EDS detector. This new option enables you to
configure and utilize the advanced capabilities of the Bruker 7 Series detector for your elemental
mapping analysis. You can select this detector when you configure the Maps software for
mineralogy acquisition.

See Configure Mineralogy Acquisition for more information.

Mineralogy: Maps Min Reporting plugin application
l You now have the ability to import a reporting list from another project and integrate it into
your current project.

l You can now easily delete project and associated data. Select a project, click the delete
button, confirm the deletion, and then project will be permanently removed.

l A new report named 'Mineral Association' is available and is visible in tabular form. This
report provides an analysis of the minerals grains relationships and interactions through the
perimeter proportion between grains. This report also includes particle filter; data set
selection; reporting list selection and combination by replicates; and can it can be exported in
.csv format.

l Previously, you were limited to publishing particles with BSE (Backscattered Electron) data
less than 20 MB. Now, you can publish and view large particles without any size limitations.
This enhancement ensures compatibility with image sizes up to 50–82K pixels, allowing you
to work with high-resolution particles.
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l In the Reporting user interface, you can open the dataset and select the Particle View report.
All particles (including those exceeding 20 MB), will be displayed, thus, providing a
comprehensive view of the dataset.

Phenom: Advanced tab control enhancements

The following enhancements have been added to the advanced tile acquisition controls.

l High Voltage: The preset options now include 20 kV.

l Detector: The options now include the SED detector.

See Phenom Tile Set Tab for more information.

Phenom: New advanced tab controls

There are new advanced tile acquisition controls in the user interface.

l Vacuum: Use this control to specify the required vacuum pressure during acquisition.

l Acquisition Order: Use this control to determine the order in which the contained tiles are
acquired.

See Phenom Tile Set Tab for more information.

Phenom: Post-acquistion actions

Post-acquisiton actions are now available for Phenom. After all jobs are completed, you can
return the microscope to HiVac mode, move the sample to the NavCam, and put the microscope
in the standby operational state.

See Phenom Post-Acquisition Actions for more information.

SEM: Support for Quattro 35.0

Maps now fully supports Quattro 35.0. The corresponding xT server version is automatically
recognized during Maps installation.

TEM: Support for TEM 3.20 and TEM 2.20

Maps now supports TEM server versions 3.15–3.20 for Titan and 2.15–2.20 for Talos.
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Updated system requirements for installation
l Windows compatibility: The Maps application can now run on Windows 11.

l .Net Framework: The required version of .Net Framework has been updated to 4.8, which
will be now installed during the Maps installation process if it is not already installed on the
system.

Known Issues

See Known issues for known issues introduced with this version of Maps software.

Bug Fixes

The following bugs were fixed in this release of the Maps software.

Bug ID Description

MAPS-10804 Stitching of tile sets with some tiles deactivated no longer causes an
exception to occur.

MAPS-11136 Importing TIF files with invalid metadata no longer causes Maps to crash.

MAPS-7863 Mineralogy: Detector names in the xT quadrants are now being retained
correctly.

MAPS-10158 Mineralogy: Exporting size distribution to CSV now produces correct
ranges for the X-axis depending on the dynamic or fixed bins.

MAPS-10680 Mineralogy: The Mineralogy Reporting server graphs are now accurate.

MAPS-10901 Mineralogy: You can now export images with Porosity overlay on BSE in
Nanomin.

MAPS-11034 Mineralogy: The Sort by Mineral or Element proportion are now functional
within the Particle View report.

MAPS-10967 STEM: The beam convergence angle now displays in a more user friendly
manner, rounded to two decimal places and with units displayed after the
angle value.
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Maps 3.28.1 Release Notes
This document specifies changes made to the Thermo Scientific™ Maps 3.28.1 software
application.

New Features

Bright Phase Search acquisition

The Maps application now supports Bright Phase Search acquisition, which produces faster
acquisition and results within the web-based Maps Mineralogy Reporting application. Bright
Phase Search acquisition is available in either Grid mode or Centroid mode (beta).

See Optional: Bright Phase Search Acquisition Workflow for more information.

Maps improvement program

Maps has introduced an improvement program that will send your anonymous usage data back
to the Maps team for product improvement purposes. If desired, you can opt out of this program
after you first launch the Maps application and accept the End User License Agreement (EULA).
Go to the application settings and deselect the "Allow usage logging" setting under the
Improvement Program section.

See Options menu for more information.

Mineralogy: Bruker and Nanomin connection states

The Analytics connection indicator has been expanded to separate the Bruker and Nanomin
status icons, which indicate the online connection states between the Maps application and the
microscope. This change provides more status support by communicating if a connection is in
use, if a connection is attempting to connect, or if a connection has timed out.

See Microscope connection states for more information.

Mineralogy: Improved Nanomin performance for large datasets

Pyramid rendering has been updated in the Nanomin application to improve panning, zooming,
and overlay rendering speeds while you navigate large datasets.
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Mineralogy: Maps Mineralogy Reporting application
l A desktop shortcut is now available on your desktop soon after you successfully install the
Maps Mineralogy Reporting application. Double-click the desktop shortcut and the
application will launch the user interface within your browser.

l You can now generate Locking and Liberation reports by Area % within the Maps Mineralogy
Reporting application. This means that you can choose between Weight % or Area % as the
output type for increased flexibility and precision.

l When you select either a locking or liberation report while using the Maps Mineralogy
Reporting application, the initial option within the Liberation Type field has been changed
from "Area %" to "Composition" to clearly identify particle composition.

l You can now view product information within the Maps Mineralogy Reporting application.
This information includes the version number of the application, server, and client for you to
share with Thermo Fisher Scientific while troubleshooting a software issue.

Mineralogy: Plugin enhancements
l New and improved data tracking of Mineralogy tile set metadata.

l You can now view Mineralogy tile set parameters offline.

l Mining tags have moved to a new tab.

l Analytics tab for mineralogy has been renamed to "Mineralogy Acquisition" tab.

Phenom: Simplified connectivity

The microscope connection process for the Phenom has been simplified, so that the connection
dialog no longer requires you to enter your user name and password. The Maps application
contains a security tool that allows it to connect to any available Phenom within your network.

See Phenom Connectivity for more information.

TEM: Added support for TEM 3.19 and TEM 2.19

Maps 3.28.1 supports TEM server versions 3.14–3.19 for Titan and 2.14–2.19 for Talos.

TEM: Standalone Velox plugin

Acquisition of EDS tile sets through Velox is now available as a standalone plugin, so
connectivity to Velox and the acquisition process is more robust.

See Activate Velox Software for more information.
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TEM: Tiling correction

You can use the Tiling Correction beta feature to achieve better tile alignment during acquisition.

See TEM Tiling Corrections and Tiling Corrections Quality for more information.

Known Issues

See Known issues for known issues introduced with this version of Maps software.

Bug Fixes

The following bugs were fixed in this release of the Maps software.

Bug ID Description

MAPS-7863 Mineralogy: Detector names in the xT quadrants are now being retained
correctly.

MAPS-10158 Mineralogy: Exporting size distribution to CSV now produces correct
ranges for the X-axis depending on the dynamic or fixed bins.

MAPS-10774 The beam convergence angle on STEM is now displayed in mrad units
instead of degrees.

MAPS-10781 Taking a STEM snapshot on a system without the HAADF detector no
longer causes an error. Previously, the HAADF detector was used as a
default detector for snapshots on all systems, regardless of the actual
configuration.
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Maps 3.26.1 Release Notes
This document specifies changes made to the Thermo Scientific™ Maps 3.26.1 software
application.

New Features

Array Tomography workflow controls

The Array Tomography workflow has been streamlined with new and improved controls
including:

l New Line Tool to order sections
l New keyboard shortcuts for specific steps to expedite workflow
l Increased flexibility for section previews creation
l Revised refinement step to improve viewing and editing of results
l New "stitch all" option during tile set array acquisitions

See the Array Tomography Workflow for more details.

CRYO: Arctis data features

This bundle of new features allow you to import and view Arctis Cryo-Plasma-FIB data in the
Maps software application on TEM systems.

See Import and view Arctis data for more information.

TEM: OptiSTEM autofunction automatically restores last known good state

When the OptiSTEM autofunction fails to converge or the quality of the result is poor, the Maps
software application automatically restores the focus and stigmator values to the last known
good state.

TEM: Added support for TEM 3.17 and TEM 2.17

Maps now supports the latest TEM server versions for Titan (TEM 3.17) and Talos (TEM 2.17).
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Documentation Update

A comprehensive Phenom section has been added to the Maps software application user guide.
This new section describes the Phenom connectivity, settings, operational states, and user
interface elements.

See Phenom for more information.

Bug Fixes

The following bugs were fixed in this release of the Maps software.

Bug ID Description

MAPS-9687 TEM: The position of the crosshair and cross-correlation peak annotations is
now correct. Previously, the annotations in the intermediate cross-correlation
images during the execution of autofunctions were not positioned correctly
when a camera with a rectangular image resolution was used (for exmaple, a
Gatan K3 camera).

MAPS-
10276

TEM: Camera settings are now properly applied when used in the
autofunction templates on TEM and EFTEM. Previously, autofunctions used
the default camera settings and ignored settings like Frames Summed for
Ceta-F camera or Electron Counting Mode for Falcon camera.
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Maps 3.25.1 Release Notes
This document specifies changes made to the Thermo Scientific™ Maps 3.25.1 software
application.

New Features

Animation for viewer functions

The “Center View on Sample,” “Center View on Selection,” and “Go to Microscope FOV” viewer
functions in the toolbar now animate pan and zoom to help keep you oriented in the sample
space. If desired, you can deactivate this feature under the “Animate Pan & Zoom” View menu
item.

See Toolbar and View menu for more information.

EFTEM slit control

Slit insertion state and energy-selecting slit width can now be set directly on a tile set. Slit
parameters are also now part of EFTEM tile set templates, and are propagated from
Tomography presets when importing the presets to Maps.

See Advanced group, EFTEMmode for more information.

Phenom SEM support

This version of Maps now supports the Thermo Scientific™ Phenom™ desktop SEM series. As a
Phenom user, you will be able to access all the Maps features that are currently available on
your other Thermo Fisher SEM, SDB, and TEM systems. This integrated support also allows
you to expand the correlative workflows within Maps from desktop SEMs to high-end TEM
systems for a variety of scientific experiments. A Maps Phenom license is required, so please
contact your Thermo Fisher account manager for additional information.

Note: The Maps software application user guide will be updated in a future release to include the
Phenom functionality.

Project History search bar

The Project History window now has a search bar available. When you use this search bar, it
immediately filters the project history and provides results that match either the Project Name or
Project Description fields.

See Open a Project for more information.
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TEM/EFTEM: Automated image filtering for autofunctions

TEM and EFTEM autofunctions support a new setting called "Use Image Filtering". You can use
this new setting to improve the reliability and accuracy of these autofunctions.

See Automated Image Filtering for more information.

TEM: Added support for TEM 3.16 and TEM 2.16

Maps now supports the latest TEM server versions for Titan (TEM 3.16) and Talos (TEM 2.16).

Bug Fixes

The following bugs were fixed in this release of the Maps software.

Bug ID Description

MAPS-9271 TEM: Correct milling angle of a lamella is now displayed in projects imported
from SDB to TEM. Previously, the sample pre-tilt angle used on SDB was
either ignored, or assumed to be 35 degrees (Maps 3.24), causing the
incorrect milling angle to be computed on TEM. Maps on TEM systems now
reads the sample pre-tilt angle that was used on the SDB system and adjusts
the computed milling angle accordingly.

MAPS-9274 TEM: Falcon 4 camera settings now work properly in EFTEMmode.
Previously, the camera mode was not properly initialized based on
microscope state, and Linear mode was used for acquisition even if Counted
mode was specified on the tile set.

MAPS-9442 TEM: Templates created from a new tile set can now be used immediately as
an autofunction template within the new tile set. Previously, there was a
synchronization issue that caused the new template to appear only after
switching to another layer in the layer tree and then back to the tile set.
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License Information
The following licensed content is included in Maps 3.32.1.

Accord.NET Framework
The Accord.NET Framework Copyright © 2009–2017, Accord.NET Authors <authors@accord-framework.net>

This library is free software; you can redistribute it and/or modify it under the terms of the GNU Lesser General Public
License as published by the Free Software Foundation; either version 2.1 of the License, or (at your option) any later version.

The copyright holders provide no reassurances that the source code provided does not infringe any patent, copyright, or any
other intellectual property rights of third parties. The copyright holders disclaim any liability to any recipient for claims brought
against recipient by any third party for infringement of that parties intellectual property rights.

This library is distributed in the hope that it will be useful, but WITHOUT ANYWARRANTY; without even the implied warranty
of MERCHANTABILITY or FITNESS FOR A PARTICULAR PURPOSE.

See the GNU Lesser General Public License for more details.

You should have received a copy of the GNU Lesser General Public License along with this program. If not, see
<http://www.gnu.org/licenses/>.

Some modules of this library are distributed under the GPL, and not the LGPL. Those modules have been marked with
.GPL.dll in their name. All relevant licensing information should also be accompanying each respective source code. Other
extra modules may carry other restrictions.

Please see relevant source headers for details.

The documentation sections contains references to Wikipedia and is thus entirely available under the Creative Commons
Attribution/Share-Alike License. All referenced sections include a hyperlink to the original article page. If you think you have
found something which has not been properly linked, please let me know so it can be corrected.

Overall framework architecture and style was greatly inspired by AForge.NET. In May 2015, this project has been merged
with the AForge.NET framework since public support for AForge.NET has ended. The original AForge.NET Framework is a
copyrighted work by Andrew Kirillov, altough developed and shared under the same LGPL license.

This library also contains routines adapted from Lutz Roeder's Mapack for .NET, LAPACK and Jama routines. Jama has
been released under the public domain. LAPACK has been released under a compatible 3-clause BSD license, listed below.
Original ArrayDataView code is copyright © 2004 Mihail Stefanov, licensed under the LGPL with permission of the original
author. Original SortableBindingList source code is copyright © 2008 Tim Van Wassenhove, licensed under the LGPL with
permission of the original author. Statistics module contains code for computing the Kolmogorov-Smirnov distribution based
on original code by Richard Simard, redistributed under the LGPL with permission of the original author. Imaging module
contains code for Gabor filter based on the original code by Max Bügler, redistributed under the LGPL with permission of the
original author.

The Augmented Lagrangian Solver implementation is based on the NLopt Numerical Optimization Library, copyright © 2008
Steven G. Johnson, distributed under the MIT license. Some image filters have been contributed by Diego Catalano,
distributed under the LGPL license and included with permission of the original author. Mathematics module includes the
Kinematic joint models by Rémy Dispagne, licensed under the LGPL with permission of the original author. The Haar Object
detector contains contributions from Darko Jurić, added with permission of the original author.
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The Accord.Vision module includes definitions for Haar Cascades created by Modesto Castrillon-Santana, distributed under
the LGPL with permission of the original author. The SURF interest points detector implementation is based on code by
Christopher Evans, licensed under the LGPL with permission of the original author. The FAST corners detector has been
created using a code generation tool created by Edward Rosten, distributed under a compatible 3-clause BSD license, listed
below. The Camshift tracker implementation is based on the FaceIt ActionScript Camshift tracker, copyright © 2009
Benjamin Jung, distributed under the MIT license, listed below. The Project Marilena is copyright © 2008 Masakazu Ohtsuka,
distributed under a compatible 2-clause BSD license, listed below. See actual sources for details.

Below are the licenses applying to specific sections of the code. Those are not applicable to the work as a whole (the
Framework), but to the specifics of each portion of the framework. See actual sources for details.

Circular Statistics Toolbox (Directional Statistics)
Copyright © Philipp Berens, 2006–2012, All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following
conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of
conditions and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of
conditions and the following disclaimer in the documentation and/or other materials
provided with the distribution

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY EXPRESS
OR IMPLIEDWARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIEDWARRANTIES OF MERCHANTABILITY
AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR
CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY
THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR
OTHERWISE) ARISING IN ANYWAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY
OF SUCH DAMAGE.

LIBLINEAR - A library for large linear classification
Copyright © 2007–2011 The LIBLINEAR Project. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following
conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of
conditions and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of
conditions and the following disclaimer in the documentation and/or other materials
provided with the distribution.

3. Neither name of copyright holders nor the names of its contributors may be used to
endorse or promote products derived from this software without specific prior written
permission.
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THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY EXPRESS
OR IMPLIEDWARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIEDWARRANTIES OF MERCHANTABILITY
AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE REGENTS OR
CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY
THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR
OTHERWISE) ARISING IN ANYWAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY
OF SUCH DAMAGE.

LibSVM & liblinear library for Support Vector Machines
Copyright © 2000–2014 Chih-Chung Chang and Chih-Jen Lin, All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following
conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of
conditions and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of
conditions and the following disclaimer in the documentation and/or other materials
provided with the distribution.

3. Neither name of copyright holders nor the names of its contributors may be used to
endorse or promote products derived from this software without specific prior written
permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY EXPRESS
OR IMPLIEDWARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIEDWARRANTIES OF MERCHANTABILITY
AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE REGENTS OR
CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY
THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR
OTHERWISE) ARISING IN ANYWAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY
OF SUCH DAMAGE.

LumenWorks.Framework.IO.CSV.CsvReader - A Fast CSV Reader
Copyright © Sebastien Lorion, 2005–2011, All rights reserved.

MIT license (http://en.wikipedia.org/wiki/MIT_License)

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated documentation
files (the "Software"), to deal in the Software without restriction, including without limitation the rights to use, copy, modify,
merge, publish, distribute, sublicense, and/or sell copies of the Software, and to permit persons to whom the Software is
furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in all copies or substantial portions of the Software.
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THE SOFTWARE IS PROVIDED "AS IS", WITHOUTWARRANTY OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING
BUT NOT LIMITED TO THEWARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND
NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM,
DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM,
OUT OF OR IN CONNECTIONWITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

MathExtension: Mathematical extensions and structures for the .NET framework
MIT License

Copyright © 2015 AJ Richardson

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated documentation
files (the "Software"), to deal in the Software without restriction, including without limitation the rights to use, copy, modify,
merge, publish, distribute, sublicense, and/or sell copies of the Software, and to permit persons to whom the Software is
furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in all copies or substantial portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUTWARRANTY OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING
BUT NOT LIMITED TO THEWARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND
NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM,
DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM,
OUT OF OR IN CONNECTIONWITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

Munkres algorithm - The Hungarian method for solving the assignment problem
MIT License

Copyright © 2000 Robert A. Pilgrim, Murray State University, Dept. of Computer Science & Information Systems,
Murray,Kentucky

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated documentation
files (the "Software"), to deal in the Software without restriction, including without limitation the rights to use, copy, modify,
merge, publish, distribute, sublicense, and/or sell copies of the Software, and to permit persons to whom the Software is
furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in all copies or substantial portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUTWARRANTY OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING
BUT NOT LIMITED TO THEWARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND
NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM,
DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM,
OUT OF OR IN CONNECTIONWITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

Partitioning around medoids and Voronoi iteration algorithm for the K-Medoids clustering:
algorithm implementation and unit tests
MIT License

Copyright © 2017 Ivan Pizhenko

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated documentation
files (the "Software"), to deal in the Software without restriction, including without limitation the rights to use, copy, modify,
merge, publish, distribute, sublicense, and/or sell copies of the Software, and to permit persons to whom the Software is
furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in all copies or substantial portions of the Software.
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THE SOFTWARE IS PROVIDED "AS IS", WITHOUTWARRANTY OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING
BUT NOT LIMITED TO THEWARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND
NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM,
DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM,
OUT OF OR IN CONNECTIONWITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.
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NLopt Numerical Optimization Library - Copyright © 2008–2014 Steven G. Johnson
Copyright © 2007–2011 Massachusetts Institute of Technology

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated documentation
files (the "Software"), to deal in the Software without restriction, including without limitation the rights to use, copy, modify,
merge, publish, distribute, sublicense, and/or sell copies of the Software, and to permit persons to whom the Software is
furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in all copies or substantial portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUTWARRANTY OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING
BUT NOT LIMITED TO THEWARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND
NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM,
DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM,
OUT OF OR IN CONNECTIONWITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

Peter Kovesi's Computer Vision functions - Copyright © 1995–2010 Peter Kovesi

Copyright © 1995–2010 Peter Kovesi, Centre for Exploration Targeting, School of Earth and
Environment, The University of Western Australia

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated documentation
files (the "Software"), to deal in the Software without restriction, including without limitation the rights to use, copy, modify,
merge, publish, distribute, sublicense, and/or sell copies of the Software, and to permit persons to whom the Software is
furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in all copies or substantial portions of the Software.

The software is provided "as is", without warranty of any kind, express or implied, including but not limited to the warranties of
merchantability, fitness for a particular purpose and noninfringement. In no event shall the authors or copyright holders be
liable for any claim, damages or other liability, whether in an action of contract, tort or otherwise, arising from, out of or in
connection with the software or the use or other dealings in the software.

Snowball: A language for stemming algorithms
Copyright © 2001, Dr Martin Porter, Copyright © 2004,2005, Richard Boulton, All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following
conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of
conditions and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of
conditions and the following disclaimer in the documentation and/or other materials
provided with the distribution.

3. Neither the name of the Snowball project nor the names of its contributors may be used
to endorse or promote products derived from this software without specific prior written
permission.
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THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY EXPRESS
OR IMPLIEDWARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIEDWARRANTIES OF MERCHANTABILITY
AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR
CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY
THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR
OTHERWISE) ARISING IN ANYWAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY
OF SUCH DAMAGE.

Statistical Quantiles: implementation and unit tests
MIT License

Copyright © 2017 Ivan Pizhenko

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated documentation
files (the "Software"), to deal in the Software without restriction, including without limitation the rights to use, copy, modify,
merge, publish, distribute, sublicense, and/or sell copies of the Software, and to permit persons to whom the Software is
furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in all copies or substantial portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUTWARRANTY OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING
BUT NOT LIMITED TO THEWARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND
NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM,
DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM,
OUT OF OR IN CONNECTIONWITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

The Cephes Math Library - Copyright © 1984–2000
Release 2.8 - June, 2000 Copyright 1984, 1987, 1988, 2000 by Stephen L. Moshier.

Some software in this archive may be from the book _Methods and Programs for Mathematical Functions_ (Prentice-Hall or
Simon & Schuster International, 1989) or from the Cephes Mathematical Library, a commercial product. In either event, it is
copyrighted by the author. What you see here may be used freely but it comes with no support or guarantee.

The two known misprints in the book are repaired here in the source listings for the gamma function and the incomplete beta
integral.

Stephen L. Moshier, moshier@na-net.ornl.gov.

The FaceIt Library - Copyright © 2009 Benjamin Jung
Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated documentation
files (the "Software"), to deal in the Software without restriction, including without limitation the rights to use, copy, modify,
merge, publish, distribute, sublicense, and/or sell copies of the Software, and to permit persons to whom the Software is
furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in all copies or substantial portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUTWARRANTY OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING
BUT NOT LIMITED TO THEWARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND
NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM,
DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM,
OUT OF OR IN CONNECTIONWITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.
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The FAST corners detector - Copyright © 2006–2010 Edward Rosten
Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following
conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of
conditions and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of
conditions and the following disclaimer in the documentation and/or other materials
provided with the distribution.

3. Neither the name of the University of Cambridge nor the names of its contributors may be
used to endorse or promote products derived from this software without specific prior
written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY EXPRESS
OR IMPLIEDWARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIEDWARRANTIES OF MERCHANTABILITY
AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR
CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY
THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR
OTHERWISE) ARISING IN ANYWAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY
OF SUCH DAMAGE.

The LAPACK Linear Algebra Package - Copyright © 1992–2010
Copyright © 1992–2010 The University of Tennessee and The University of Tennessee Research Foundation. All rights
reserved.

Copyright © 2000–2010 The University of California Berkeley. All rights reserved.

Copyright © 2006–2010 The University of Colorado Denver. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following
conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of
conditions and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of
conditions and the following disclaimer listed in this license in the documentation and/or
other materials provided with the distribution.

3. Neither the name of the copyright holders nor the names of its contributors may be used
to endorse or promote products derived from this software without specific prior written
permission.

The copyright holders provide no reassurances that the source code provided does not infringe any patent, copyright, or any
other intellectual property rights of third parties. The copyright holders disclaim any liability to any recipient for claims brought
against recipient by any third party for infringement of that parties intellectual property rights.
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THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY EXPRESS
OR IMPLIEDWARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIEDWARRANTIES OF MERCHANTABILITY
AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR
CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY
THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR
OTHERWISE) ARISING IN ANYWAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY
OF SUCH DAMAGE.

The Marilena Project - Copyright © 2008 Masakazu Ohtsuka
Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following
conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of
conditions and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of
conditions and the following disclaimer in the documentation and/or other materials
provided with the distribution.

This software is provided by the copyright holders and contributors "as is" and any express or implied warranties, including,
but not limited to, the implied warranties of merchantability and fitness for a particular purpose are disclaimed. In no event
shall the Intel Corporation or contributors be liable for any direct, indirect, incidental, special, exemplary, or consequential
damages (including, but not limited to, procurement of substitute goods or services; loss of use, data, or profits; or business
interruption) however caused and on any theory of liability, whether in contract, strict liability, or tort (including negligence or
otherwise) arising in any way out of the use of this software, even if advised of the possibility of such damage.

Autofac
MIT License

Copyright © 2014 Autofac Project

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated documentation
files (the "Software"), to deal in the Software without restriction, including without limitation the rights to use, copy, modify,
merge, publish, distribute, sublicense, and/or sell copies of the Software, and to permit persons to whom the Software is
furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in all copies or substantial portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUTWARRANTY OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING
BUT NOT LIMITED TO THEWARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND
NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM,
DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM,
OUT OF OR IN CONNECTIONWITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.
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AutoMapper
MIT License

Copyright © 2010 Jimmy Bogard

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated documentation
files (the "Software"), to deal in the Software without restriction, including without limitation the rights to use, copy, modify,
merge, publish, distribute, sublicense, and/or sell copies of the Software, and to permit persons to whom the Software is
furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in all copies or substantial portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUTWARRANTY OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING
BUT NOT LIMITED TO THEWARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND
NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM,
DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM,
OUT OF OR IN CONNECTIONWITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

Bio-Formats
Copyright © 2005–2018 Open Microscopy Environment, Board of Regents of the University of Wisconsin-Madison

l Glencoe Software, Inc.

l University of Dundee

BitMiracle.LibTiff.NET
Copyright © 2008–2019, Bit Miracle, All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following
conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of
conditions and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of
conditions and the following disclaimer in the documentation and/or other materials
provided with the distribution.

3. Neither the name of the Bit Miracle nor the names of its contributors may be used to
endorse or promote products derived from this software without specific prior written
permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY EXPRESS
OR IMPLIEDWARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIEDWARRANTIES OF MERCHANTABILITY
AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL BIT MIRACLE BE LIABLE FOR
ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT
NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR
BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT,
STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANYWAY OUT OF THE USE
OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
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NOTE: This software is based in part on the The Independent JPEG Group's JPEG software, http://www.ijg.org/, Copyright ©
1991–1998, Thomas G. Lane.

NOTE: This software is based in part on the LibTIFF - TIFF Library and Utilities http://www.remotesensing.org/libtiff/,
Copyright © 1988–1997 Sam Leffler

Copyright © 1991–1997 Silicon Graphics, Inc., Portions Copyright © 2006, ComponentAce, http://www.componentace.com,
All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following
conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of
conditions and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of
conditions and the following disclaimer in the documentation and/or other materials
provided with the distribution.

3. Neither the name of ComponentAce nor the names of its contributors may be used to
endorse or promote products derived from this software without specific prior written
permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY EXPRESS
OR IMPLIEDWARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIEDWARRANTIES OF MERCHANTABILITY
AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR
CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY
THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR
OTHERWISE) ARISING IN ANYWAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY
OF SUCH DAMAGE.

Boost
Boost Software License - Version 1.0 - August 17th, 2003

Permission is hereby granted, free of charge, to any person or organization obtaining a copy of the software and
accompanying documentation covered by this license (the "Software") to use, reproduce, display, distribute, execute, and
transmit the Software, and to prepare derivative works of the Software, and to permit third-parties to whom the Software is
furnished to do so, all subject to the following:

The copyright notices in the Software and this entire statement, including the above license grant, this restriction and the
following disclaimer, must be included in all copies of the Software, in whole or in part, and all derivative works of the
Software, unless such copies or derivative works are solely in the form of machine-executable object code generated by a
source language processor.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUTWARRANTY OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING
BUT NOT LIMITED TO THEWARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, TITLE
AND NON-INFRINGEMENT. IN NO EVENT SHALL THE COPYRIGHT HOLDERS OR ANYONE DISTRIBUTING THE
SOFTWARE BE LIABLE FOR ANY DAMAGES OR OTHER LIABILITY, WHETHER IN CONTRACT, TORT OR
OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTIONWITH THE SOFTWARE OR THE USE OR OTHER
DEALINGS IN THE SOFTWARE.
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Castle Core
Copyright (c) 2004-2019 Castle Project - http://www.castleproject.org/
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CefSharp
Copyright © 2010–2017 The CefSharp Authors. All rights reserved. Redistribution and use in source and binary forms, with or
without modification, are permitted provided that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions
and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of
conditions and the following disclaimer in the documentation and/or other materials provided
with the distribution.

3. Neither the name of Google Inc. nor the name Chromium Embedded Framework nor the
name CefSharp nor the names of its contributors may be used to endorse or promote
products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY EXPRESS
OR IMPLIEDWARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIEDWARRANTIES OF MERCHANTABILITY
AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR
CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY
THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR
OTHERWISE) ARISING IN ANYWAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY
OF SUCH DAMAGE.

Chromium
Copyright © 2015 The Chromium Authors. All rights reserved. Redistribution and use in source and binary forms, with or
without modification, are permitted provided that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions
and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of
conditions and the following disclaimer in the documentation and/or other materials provided
with the distribution.

3. Neither the name of Google Inc. nor the names of its contributors may be used to endorse or
promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY EXPRESS
OR IMPLIEDWARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIEDWARRANTIES OF MERCHANTABILITY
AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR
CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY
THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR
OTHERWISE) ARISING IN ANYWAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY
OF SUCH DAMAGE.
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Common Service Locator
Copyright © Microsoft 2008

CsvHelper
Copyright © 2009–2017 Josh Close and Contributors

DotNetZip Library
Copyright © 2006–2011 Dino Chiesa

Copyright © 2006, 2007, 2008, 2009 Dino Chiesa and Microsoft Corporation.

--------------------------------------------------------------

The managed ZLIB code included in Ionic.Zlib.dll and Ionic.Zip.dll is derived from jzlib.

jzlib ( https://github.com/ymnk/jzlib ) is provided under a BSD-style (3 clause)

Copyright © 2000,2001,2002,2003 ymnk, JCraft, Inc.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following
conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of
conditions and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of
conditions and the following disclaimer in the documentation and/or other materials
provided with the distribution.

3. The names of the authors may not be used to endorse or promote products derived from
this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED "AS IS" AND ANY EXPRESSED OR IMPLIEDWARRANTIES, INCLUDING, BUT NOT
LIMITED TO, THE IMPLIEDWARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
DISCLAIMED. IN NO EVENT SHALL JCRAFT, INC. OR ANY CONTRIBUTORS TO THIS SOFTWARE BE LIABLE FOR
ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT
NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR
BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT,
STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANYWAY OUT OF THE USE
OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

--------------------------------------------------------------

The jzlib library, itself, is a re-implementation of ZLIB v1.1.3 in pure Java.

zlib is provided under the zlib license:

Copyright © 1995–2004 Jean-loup Gailly and Mark Adler

The ZLIB software is provided 'as-is', without any express or implied warranty. In no event will the authors be held liable for
any damages arising from the use of this software.
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Permission is granted to anyone to use this software for any purpose, including commercial applications, and to alter it and
redistribute it freely, subject to the following restrictions:

1. The origin of this software must not be misrepresented; you must not claim that you wrote the original software. If you use
this software in a product, an acknowledgment in the product documentation would be appreciated but is not required.

2. Altered source versions must be plainly marked as such, and must not be misrepresented as being the original software.

3. This notice may not be removed or altered from any source distribution.

Jean-loup Gailly jloup@gzip.org

Mark Adler madler@alumni.caltech.edu

--------------------------------------------------------------

The managed BZIP2 code included in Ionic.BZip2.dll and Ionic.Zip.dll is modified code, based on Java code in the Apache
commons compress library.

Apache Commons Compress ( http://commons.apache.org/proper/commons-compress/ ) is provided under the Apache 2
license:

Apache Commons Compress

Copyright 2002–2014 The Apache Software Foundation

Licensed to the Apache Software Foundation (ASF) under one or more contributor license agreements. See the NOTICE file
distributed with this work for additional information regarding copyright ownership. The ASF licenses this file to you under the
Apache License, Version 2.0 (the "License"); you may not use this file except in compliance with the License. You may obtain
a copy of the License at

http://www.apache.org/licenses/LICENSE-2.0

Unless required by applicable law or agreed to in writing, software distributed under the License is distributed on an "AS IS"
BASIS, WITHOUTWARRANTIES OR CONDITIONS OF ANY KIND, either express or implied. See the License for the
specific language governing permissions and limitations under the License.

Many thanks to Julian Seward for the original C implementation of BZip2 ( http://www.bzip.org/).

FluentMigrator
Copyright - Sean Chambers 2008–2014

Fody
MIT License

Copyright (c) 2012 Simon Cropp and contributors

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated documentation
files (the "Software"), to deal in the Software without restriction, including without limitation the rights to use, copy, modify,
merge, publish, distribute, sublicense, and/or sell copies of the Software, and to permit persons to whom the Software is
furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in all copies or substantial portions of the Software.
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THE SOFTWARE IS PROVIDED "AS IS", WITHOUTWARRANTY OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING
BUT NOT LIMITED TO THEWARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND
NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM,
DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM,
OUT OF OR IN CONNECTIONWITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

Framework Microsoft SqlClient Data Provider
MIT License

Copyright (c) Microsoft Corporation

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated documentation
files (the "Software"), to deal in the Software without restriction, including without limitation the rights to use, copy, modify,
merge, publish, distribute, sublicense, and/or sell copies of the Software, and to permit persons to whom the Software is
furnished to do so, subject to the following conditions: The above copyright notice and this permission notice shall be
included in all copies or substantial portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUTWARRANTY OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING
BUT NOT LIMITED TO THEWARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND
NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM,
DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM,
OUT OF OR IN CONNECTIONWITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

GongSolutions.WPF.DragDrop 1.1.0.0
MIT License

Copyright © 2013–2019, Jan Karger, Steven Kirk. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following
conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of
conditions and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of
conditions and the following disclaimer in the documentation and/or other materials
provided with the distribution.

3. Neither the name of gong-wpf-dragdrop nor the names of its contributors may be used to
endorse or promote products derived from this software without specific prior written
permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY EXPRESS
OR IMPLIEDWARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIEDWARRANTIES OF MERCHANTABILITY
AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR
CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY
THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR
OTHERWISE) ARISING IN ANYWAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY
OF SUCH DAMAGE.
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GoogleAnalyticsTracker
Copyright © GoogleAnalyticsTracker 2012–2017
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gRPC
Apache License

Version 2.0, January 2004

http://www.apache.org/licenses/

TERMS AND CONDITIONS FOR USE, REPRODUCTION, AND DISTRIBUTION

1. Definitions.

"License" shall mean the terms and conditions for use, reproduction, and distribution as defined by Sections 1 through 9 of
this document.

"Licensor" shall mean the copyright owner or entity authorized by the copyright owner that is granting the License.

"Legal Entity" shall mean the union of the acting entity and all other entities that control, are controlled by, or are under
common control with that entity. For the purposes of this definition, "control" means (i) the power, direct or indirect, to cause
the direction or management of such entity, whether by contract or otherwise, or (ii) ownership of fifty percent (50%) or more
of the outstanding shares, or (iii) beneficial ownership of such entity.

"You" (or "Your") shall mean an individual or Legal Entity exercising permissions granted by this License.

"Source" form shall mean the preferred form for making modifications, including but not limited to software source code,
documentation source, and configuration files.

"Object" form shall mean any form resulting from mechanical transformation or translation of a Source form, including but not
limited to compiled object code, generated documentation, and conversions to other media types.

"Work" shall mean the work of authorship, whether in Source or Object form, made available under the License, as indicated
by a copyright notice that is included in or attached to the work (an example is provided in the Appendix below).

"Derivative Works" shall mean any work, whether in Source or Object form, that is based on (or derived from) the Work and
for which the editorial revisions, annotations, elaborations, or other modifications represent, as a whole, an original work of
authorship. For the purposes of this License, Derivative Works shall not include works that remain separable from, or merely
link (or bind by name) to the interfaces of, the Work and Derivative Works thereof.

"Contribution" shall mean any work of authorship, including the original version of the Work and any modifications or
additions to that Work or Derivative Works thereof, that is intentionally submitted to Licensor for inclusion in the Work by the
copyright owner or by an individual or Legal Entity authorized to submit on behalf of the copyright owner. For the purposes of
this definition, "submitted" means any form of electronic, verbal, or written communication sent to the Licensor or its
representatives, including but not limited to communication on electronic mailing lists, source code control systems, and
issue tracking systems that are managed by, or on behalf of, the Licensor for the purpose of discussing and improving the
Work, but excluding communication that is conspicuously marked or otherwise designated in writing by the copyright owner
as "Not a Contribution."

"Contributor" shall mean Licensor and any individual or Legal Entity on behalf of whom a Contribution has been received by
Licensor and subsequently incorporated within the Work.

2. Grant of Copyright License.

Subject to the terms and conditions of this License, each Contributor hereby grants to You a perpetual, worldwide, non-
exclusive, no-charge, royalty-free, irrevocable copyright license to reproduce, prepare Derivative Works of, publicly display,
publicly perform, sublicense, and distribute the Work and such Derivative Works in Source or Object form.
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3. Grant of Patent License. Subject to the terms and conditions of this License, each Contributor hereby grants to You a
perpetual, worldwide, non-exclusive, no-charge, royalty-free, irrevocable (except as stated in this section) patent license to
make, have made, use, offer to sell, sell, import, and otherwise transfer the Work, where such license applies only to those
patent claims licensable by such Contributor that are necessarily infringed by their Contribution(s) alone or by combination of
their Contribution(s) with the Work to which such Contribution(s) was submitted. If You institute patent litigation against any
entity (including a cross-claim or counterclaim in a lawsuit) alleging that the Work or a Contribution incorporated within the
Work constitutes direct or contributory patent infringement, then any patent licenses granted to You under this License for
that Work shall terminate as of the date such litigation is filed.

4. Redistribution.

You may reproduce and distribute copies of the Work or Derivative Works thereof in any medium, with or without
modifications, and in Source or Object form, provided that You meet the following conditions:

(a) You must give any other recipients of the Work or Derivative Works a copy of this License; and

(b) You must cause any modified files to carry prominent notices stating that You changed the files; and

(c) You must retain, in the Source form of any Derivative Works that You distribute, all copyright, patent, trademark, and
attribution notices from the Source form of the Work, excluding those notices that do not pertain to any part of the Derivative
Works; and

(d) If the Work includes a "NOTICE" text file as part of its distribution, then any Derivative Works that You distribute must
include a readable copy of the attribution notices contained within such NOTICE file, excluding those notices that do not
pertain to any part of the Derivative Works, in at least one of the following places: within a NOTICE text file distributed as part
of the Derivative Works; within the Source form or documentation, if provided along with the Derivative Works; or, within a
display generated by the Derivative Works, if and wherever such third-party notices normally appear. The contents of the
NOTICE file are for informational purposes only and do not modify the License. You may add Your own attribution notices
within Derivative Works that You distribute, alongside or as an addendum to the NOTICE text from the Work, provided that
such additional attribution notices cannot be construed as modifying the License. You may add Your own copyright
statement to Your modifications and may provide additional or different license terms and conditions for use, reproduction, or
distribution of Your modifications, or for any such Derivative Works as a whole, provided Your use, reproduction, and
distribution of the Work otherwise complies with the conditions stated in this License.

5. Submission of Contributions.

Unless You explicitly state otherwise, any Contribution intentionally submitted for inclusion in the Work by You to the
Licensor shall be under the terms and conditions of this License, without any additional terms or conditions. Notwithstanding
the above, nothing herein shall supersede or modify the terms of any separate license agreement you may have executed
with Licensor regarding such Contributions.

6. Trademarks.

This License does not grant permission to use the trade names, trademarks, service marks, or product names of the
Licensor, except as required for reasonable and customary use in describing the origin of the Work and reproducing the
content of the NOTICE file.

7. Disclaimer of Warranty.

Unless required by applicable law or agreed to in writing, Licensor provides the Work (and each Contributor provides its
Contributions) on an "AS IS" BASIS, WITHOUTWARRANTIES OR CONDITIONS OF ANY KIND, either express or implied,
including, without limitation, any warranties or conditions of TITLE, NON-INFRINGEMENT, MERCHANTABILITY, or
FITNESS FOR A PARTICULAR PURPOSE. You are solely responsible for determining the appropriateness of using or
redistributing the Work and assume any risks associated with Your exercise of permissions under this License.
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8. Limitation of Liability.

In no event and under no legal theory, whether in tort (including negligence), contract, or otherwise, unless required by
applicable law (such as deliberate and grossly negligent acts) or agreed to in writing, shall any Contributor be liable to You for
damages, including any direct, indirect, special, incidental, or consequential damages of any character arising as a result of
this License or out of the use or inability to use the Work (including but not limited to damages for loss of goodwill, work
stoppage, computer failure or malfunction, or any and all other commercial damages or losses), even if such Contributor has
been advised of the possibility of such damages.

9. Accepting Warranty or Additional Liability.

While redistributing the Work or Derivative Works thereof, You may choose to offer, and charge a fee for, acceptance of
support, warranty, indemnity, or other liability obligations and/or rights consistent with this License. However, in accepting
such obligations, You may act only on Your own behalf and on Your sole responsibility, not on behalf of any other
Contributor, and only if You agree to indemnify, defend, and hold each Contributor harmless for any liability incurred by, or
claims asserted against, such Contributor by reason of your accepting any such warranty or additional liability.

END OF TERMS AND CONDITIONS

APPENDIX: How to apply the Apache License to your work.

To apply the Apache License to your work, attach the following boilerplate notice, with the fields enclosed by brackets "[]"
replaced with your own identifying information. (Don't include the brackets!) The text should be enclosed in the appropriate
comment syntax for the file format. We also recommend that a file or class name and description of purpose be included on
the same "printed page" as the copyright notice for easier identification within third-party archives.

Copyright [yyyy] [name of copyright owner]

Licensed under the Apache License, Version 2.0 (the "License"); you may not use this file except in compliance with the
License.

You may obtain a copy of the License at http://www.apache.org/licenses/LICENSE-2.0

Unless required by applicable law or agreed to in writing, software distributed under the License is distributed on an "AS IS"
BASIS, WITHOUTWARRANTIES OR CONDITIONS OF ANY KIND, either express or implied.

See the License for the specific language governing permissions and limitations under the License.

-----------------------------------------------------------
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BSD 3-Clause License

Copyright 2016, Google Inc.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following
conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer
in the documentation and/or other materials provided with the distribution.

3. Neither the name of the copyright holder nor the names of its contributors may be used to endorse or promote products
derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY EXPRESS
OR IMPLIEDWARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIEDWARRANTIES OF MERCHANTABILITY
AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDER
OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY
THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR
OTHERWISE) ARISING IN ANYWAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY
OF SUCH DAMAGE.

-----------------------------------------------------------

Mozilla Public License, v. 2.0

This Source Code Form is subject to the terms of the Mozilla Public License, v. 2.0.

If a copy of the MPL was not distributed with this file, You can

obtain one at https://mozilla.org/MPL/2.0/.

Java(TM) Platform SE 8
Oracle Binary Code License Agreement for the Java SE Platform Products and JavaFX ORACLE AMERICA, INC.
("ORACLE"), FOR AND ON BEHALF OF ITSELF AND ITS SUBSIDIARIES AND AFFILIATES UNDER COMMON
CONTROL, IS WILLING TO LICENSE THE SOFTWARE TO YOU ONLY UPON THE CONDITION THAT YOU ACCEPT
ALL OF THE TERMS CONTAINED IN THIS BINARY CODE LICENSE AGREEMENT AND SUPPLEMENTAL LICENSE
TERMS (COLLECTIVELY "AGREEMENT"). PLEASE READ THE AGREEMENT CAREFULLY. BY SELECTING THE
"ACCEPT LICENSE AGREEMENT" (OR THE EQUIVALENT) BUTTON AND/OR BY USING THE SOFTWARE YOU
ACKNOWLEDGE THAT YOU HAVE READ THE TERMS AND AGREE TO THEM. IF YOU ARE AGREEING TO THESE
TERMS ON BEHALF OF A COMPANY OR OTHER LEGAL ENTITY, YOU REPRESENT THAT YOU HAVE THE LEGAL
AUTHORITY TO BIND THE LEGAL ENTITY TO THESE TERMS. IF YOU DO NOT HAVE SUCH AUTHORITY, OR IF YOU
DO NOTWISH TO BE BOUND BY THE TERMS, THEN SELECT THE "DECLINE LICENSE AGREEMENT" (OR THE
EQUIVALENT) BUTTON AND YOUMUST NOT USE THE SOFTWARE ON THIS SITE OR ANY OTHERMEDIA ON
WHICH THE SOFTWARE IS CONTAINED.
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DEFINITIONS. "Software" means the software identified above in binary form that you selected for download, install or use
(in the version You selected for download, install or use) from Oracle or its authorized licensees and/or those portions of such
software produced by jlink as output using a Program’s code, when such output is in unmodified form in combination, and for
sole use with, that Program, as well as any other machine readable materials (including, but not limited to, libraries, source
files, header files, and data files), any updates or error corrections provided by Oracle, and any user manuals, programming
guides and other documentation provided to you by Oracle under this Agreement. The Java Linker (jlink) is available with
Java 9 and later versions. "General Purpose Desktop Computers and Servers" means computers, including desktop and
laptop computers, or servers, used for general computing functions under end user control (such as but not specifically
limited to email, general purpose Internet browsing, and office suite productivity tools). The use of Software in systems and
solutions that provide dedicated functionality (other than as mentioned above) or designed for use in embedded or function-
specific software applications, for example but not limited to: Software embedded in or bundled with industrial control
systems, wireless mobile telephones, wireless handheld devices, kiosks, TV/STB, Blu-ray Disc devices, telematics and
network control switching equipment, printers and storage management systems, and other related systems are excluded
from this definition and not licensed under this Agreement. "Programs" means (a) Java technology applets and applications
intended to run on the Java Platform, Standard Edition platform on Java-enabled General Purpose Desktop Computers and
Servers; and (b) JavaFX technology applications intended to run on the JavaFX Runtime on JavaFX-enabled General
Purpose Desktop Computers and Servers. “Java SE LIUM” means the Licensing Information User Manual – Oracle Java SE
and Oracle Java Embedded Products Document accessible at http://www.oracle.com/java/technologies/java-se-doc.html.
“Commercial Features” means those features that are identified as such in the Java SE LIUM under the “Description of
Product Editions and Permitted Features” section.

LICENSE TO USE. Subject to the terms and conditions of this Agreement including, but not limited to, the Java Technology
Restrictions of the Supplemental License Terms, Oracle grants you a non-exclusive, non-transferable, limited license without
license fees to reproduce and use internally the Software complete and unmodified for the sole purpose of running Programs.
THE LICENSE SET FORTH IN THIS SECTION 2 DOES NOT EXTEND TO THE COMMERCIAL FEATURES. YOUR
RIGHTS AND OBLIGATIONS RELATED TO THE COMMERCIAL FEATURES ARE AS SET FORTH IN THE
SUPPLEMENTAL TERMS ALONGWITH ADDITIONAL LICENSES FOR DEVELOPERS AND PUBLISHERS.

RESTRICTIONS. Software is copyrighted. Title to Software and all associated intellectual property rights is retained by
Oracle and/or its licensors. Unless enforcement is prohibited by applicable law, you may not modify, decompile, or reverse
engineer Software. You acknowledge that the Software is developed for general use in a variety of information management
applications; it is not developed or intended for use in any inherently dangerous applications, including applications that may
create a risk of personal injury. If you use the Software in dangerous applications, then you shall be responsible to take all
appropriate fail-safe, backup, redundancy, and other measures to ensure its safe use. Oracle disclaims any express or
implied warranty of fitness for such uses. No right, title or interest in or to any trademark, service mark, logo or trade name of
Oracle or its licensors is granted under this Agreement. Additional restrictions for developers and/or publishers licenses are
set forth in the Supplemental License Terms.

DISCLAIMER OFWARRANTY. THE SOFTWARE IS PROVIDED "AS IS" WITHOUTWARRANTY OF ANY KIND. ORACLE
FURTHER DISCLAIMS ALLWARRANTIES, EXPRESS AND IMPLIED, INCLUDINGWITHOUT LIMITATION, ANY
IMPLIEDWARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE OR NONINFRINGEMENT.

LIMITATION OF LIABILITY. IN NO EVENT SHALL ORACLE BE LIABLE FOR ANY INDIRECT, INCIDENTAL, SPECIAL,
PUNITIVE OR CONSEQUENTIAL DAMAGES, OR DAMAGES FOR LOSS OF PROFITS, REVENUE, DATA OR DATA
USE, INCURRED BY YOU OR ANY THIRD PARTY, WHETHER IN AN ACTION IN CONTRACT OR TORT, EVEN IF
ORACLE HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. ORACLE'S ENTIRE LIABILITY FOR
DAMAGES HEREUNDER SHALL IN NO EVENT EXCEED ONE THOUSAND DOLLARS (U.S. $1,000).

TERMINATION. This Agreement is effective until terminated. You may terminate this Agreement at any time by destroying all
copies of Software. This Agreement will terminate immediately without notice from Oracle if you fail to comply with any
provision of this Agreement. Either party may terminate this Agreement immediately should any Software become, or in
either party's opinion be likely to become, the subject of a claim of infringement of any intellectual property right. Upon
termination, you must destroy all copies of Software.
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EXPORT REGULATIONS. You agree that U.S. export control laws and other applicable export and import laws govern your
use of the Software, including technical data; additional information can be found on Oracle's Global Trade Compliance web
site (http://www.oracle.com/us/products/export). You agree that neither the Software nor any direct product thereof will be
exported, directly, or indirectly, in violation of these laws, or will be used for any purpose prohibited by these laws including,
without limitation, nuclear, chemical, or biological weapons proliferation.

TRADEMARKS AND LOGOS. You acknowledge and agree as between you and Oracle that Oracle owns the ORACLE and
JAVA trademarks and all ORACLE- and JAVA-related trademarks, service marks, logos and other brand designations
("Oracle Marks"), and you agree to comply with the Third Party Usage Guidelines for Oracle Trademarks currently located at
http://www.oracle.com/legal/trademarks.html. Any use you make of the Oracle Marks inures to Oracle's benefit.

U.S. GOVERNMENT LICENSE RIGHTS. If Software is being acquired by or on behalf of the U.S. Government or by a U.S.
Government prime contractor or subcontractor (at any tier), then the Government's rights in Software and accompanying
documentation shall be only those set forth in this Agreement.

GOVERNING LAW. This agreement is governed by the substantive and procedural laws of California. You and Oracle agree
to submit to the exclusive jurisdiction of, and venue in, the courts of San Francisco, or Santa Clara counties in California in
any dispute arising out of or relating to this agreement.

SEVERABILITY. If any provision of this Agreement is held to be unenforceable, this Agreement will remain in effect with the
provision omitted, unless omission would frustrate the intent of the parties, in which case this Agreement will immediately
terminate.

INTEGRATION. This Agreement is the entire agreement between you and Oracle relating to its subject matter. It supersedes
all prior or contemporaneous oral or written communications, proposals, representations and warranties and prevails over
any conflicting or additional terms of any quote, order, acknowledgment, or other communication between the parties relating
to its subject matter during the term of this Agreement. No modification of this Agreement will be binding, unless in writing
and signed by an authorized representative of each party.

SUPPLEMENTAL LICENSE TERMS
These Supplemental License Terms add to or modify the terms of the Binary Code License Agreement. Capitalized terms not
defined in these Supplemental Terms shall have the same meanings ascribed to them in the Binary Code License
Agreement. These Supplemental Terms shall supersede any inconsistent or conflicting terms in the Binary Code License
Agreement, or in any license contained within the Software.

A. COMMERCIAL FEATURES. You may not use the Commercial Features for running Programs, Java applets or
applications in your internal business operations or for any commercial or production purpose, or for any purpose other than
as set forth in Sections B, C, D and E of these Supplemental Terms. If You want to use the Commercial Features for any
purpose other than as permitted in this Agreement, You must obtain a separate license from Oracle.

B. SOFTWARE INTERNAL USE FOR DEVELOPMENT LICENSE GRANT. Subject to the terms and conditions of this
Agreement and restrictions and exceptions set forth in the Java SE LIUM incorporated herein by reference, including, but not
limited to the Java Technology Restrictions of these Supplemental Terms, Oracle grants you a non-exclusive, non-
transferable, limited license without fees to reproduce internally and use internally the Software complete and unmodified for
the purpose of designing, developing, and testing your Programs.
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C. LICENSE TO DISTRIBUTE SOFTWARE. Subject to the terms and conditions of this Agreement and restrictions and
exceptions set forth in the Java SE LIUM, including, but not limited to the Java Technology Restrictions and Limitations on
Redistribution of these Supplemental Terms, Oracle grants you a non-exclusive, non-transferable, limited license without
fees to reproduce and distribute the Software, provided that (i) you distribute the Software complete and unmodified and only
bundled as part of, and for the sole purpose of running, your Programs, (ii) the Programs add significant and primary
functionality to the Software, (iii) you do not distribute additional software intended to replace any component(s) of the
Software, (iv) you do not remove or alter any proprietary legends or notices contained in the Software, (v) you only distribute
the Software subject to a license agreement that: (a) is a complete, unmodified reproduction of this Agreement; or (b)
protects Oracle's interests consistent with the terms contained in this Agreement and that includes the notice set forth in
Section H, and (vi) you agree to defend and indemnify Oracle and its licensors from and against any damages, costs,
liabilities, settlement amounts and/or expenses (including attorneys' fees) incurred in connection with any claim, lawsuit or
action by any third party that arises or results from the use or distribution of any and all Programs and/or Software. The
license set forth in this Section C does not extend to the Software identified in Section G.

D. LICENSE TO DISTRIBUTE REDISTRIBUTABLES. Subject to the terms and conditions of this Agreement and restrictions
and exceptions set forth in the Java SE LIUM, including but not limited to the Java Technology Restrictions and Limitations
on Redistribution of these Supplemental Terms, Oracle grants you a non-exclusive, non-transferable, limited license without
fees to reproduce and distribute those files specifically identified as redistributable in the Java SE LIUM ("Redistributables")
provided that: (i) you distribute the Redistributables complete and unmodified, and only bundled as part of Programs, (ii) the
Programs add significant and primary functionality to the Redistributables, (iii) you do not distribute additional software
intended to supersede any component(s) of the Redistributables (unless otherwise specified in the applicable Java SE
LIUM), (iv) you do not remove or alter any proprietary legends or notices contained in or on the Redistributables, (v) you only
distribute the Redistributables pursuant to a license agreement that: (a) is a complete, unmodified reproduction of this
Agreement; or (b) protects Oracle's interests consistent with the terms contained in the Agreement and includes the notice
set forth in Section H, (vi) you agree to defend and indemnify Oracle and its licensors from and against any damages, costs,
liabilities, settlement amounts and/or expenses (including attorneys' fees) incurred in connection with any claim, lawsuit or
action by any third party that arises or results from the use or distribution of any and all Programs and/or Software. The
license set forth in this Section D does not extend to the Software identified in Section G.

E. DISTRIBUTION BY PUBLISHERS. This section pertains to your distribution of the JavaTM SE Development Kit Software
("JDK") with your printed book or magazine (as those terms are commonly used in the industry) relating to Java technology
("Publication"). Subject to and conditioned upon your compliance with the restrictions and obligations contained in the
Agreement, Oracle hereby grants to you a non-exclusive, nontransferable limited right to reproduce complete and
unmodified copies of the JDK on electronic media (the "Media") for the sole purpose of inclusion and distribution with your
Publication(s), subject to the following terms: (i) You may not distribute the JDK on a stand-alone basis; it must be distributed
with your Publication(s); (ii) You are responsible for downloading the JDK from the applicable Oracle web site; (iii) You must
refer to the JDK as JavaTM SE Development Kit; (iv) The JDK must be reproduced in its entirety and without any modification
whatsoever (including with respect to all proprietary notices) and distributed with your Publication subject to a license
agreement that is a complete, unmodified reproduction of this Agreement; (v) The Media label shall include the following
information: “Copyright [YEAR], Oracle America, Inc. All rights reserved. Use is subject to license terms. ORACLE and JAVA
trademarks and all ORACLE- and JAVA-related trademarks, service marks, logos and other brand designations are
trademarks or registered trademarks of Oracle in the U.S. and other countries.” [YEAR] is the year of Oracle's release of the
Software; the year information can typically be found in the Software’s “About” box or screen. This information must be
placed on the Media label in such a manner as to only apply to the JDK; (vi) You must clearly identify the JDK as Oracle's
product on the Media holder or Media label, and you may not state or imply that Oracle is responsible for any third-party
software contained on the Media; (vii) You may not include any third party software on the Media which is intended to be a
replacement or substitute for the JDK; (viii) You agree to defend and indemnify Oracle and its licensors from and against any
damages, costs, liabilities, settlement amounts and/or expenses (including attorneys' fees) incurred in connection with any
claim, lawsuit or action by any third party that arises or results from the use or distribution of the JDK and/or the Publication; ;
and (ix) You shall provide Oracle with a written notice for each Publication; such notice shall include the following information:
(1) title of Publication, (2) author(s), (3) date of Publication, and (4) ISBN or ISSN numbers. Such notice shall be sent to
Oracle America, Inc., 500 Oracle Parkway, Redwood Shores, California 94065 U.S.A , Attention: General Counsel.
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F. JAVA TECHNOLOGY RESTRICTIONS. You may not create, modify, or change the behavior of, or authorize your
licensees to create, modify, or change the behavior of, classes, interfaces, or subpackages that are in any way identified as
"java", "javax", "sun", “oracle” or similar convention as specified by Oracle in any naming convention designation.

G. LIMITATIONS ON REDISTRIBUTION. You may not redistribute or otherwise transfer patches, bug fixes or updates made
available by Oracle through Oracle Premier Support, including those made available under Oracle's Java SE Support
program.

H. COMMERCIAL FEATURES NOTICE. For purpose of complying with Supplemental Term Section C.(v)(b) and D.(v)(b),
your license agreement shall include the following notice, where the notice is displayed in a manner that anyone using the
Software will see the notice:

Use of the Commercial Features for any commercial or production purpose requires a separate license from Oracle.
“Commercial Features” means those features that are identified as such in the Licensing Information User Manual – Oracle
Java SE and Oracle Java Embedded Products Document, accessible at http://www.oracle.com/java/technologies/java-se-
doc.html, under the “Description of Product Editions and Permitted Features” section.

I. SOURCE CODE. Software may contain source code that, unless expressly licensed for other purposes, is provided solely
for reference purposes pursuant to the terms of this Agreement. Source code may not be redistributed unless expressly
provided for in this Agreement.

J. THIRD PARTY CODE. Additional copyright notices and license terms applicable to portions of the Software are set forth in
the Java SE LIUM accessible at http://www.oracle.com/java/technologies/java-se-doc.html. In addition to any terms and
conditions of any third party opensource/freeware license identified in the Java SE LIUM, the disclaimer of warranty and
limitation of liability provisions in paragraphs 4 and 5 of the Binary Code License Agreement shall apply to all Software in this
distribution.

K. TERMINATION FOR INFRINGEMENT. Either party may terminate this Agreement immediately should any Software
become, or in either party's opinion be likely to become, the subject of a claim of infringement of any intellectual property
right.

L. INSTALLATION AND AUTO-UPDATE. The Software's installation and auto-update processes transmit a limited amount
of data to Oracle (or its service provider) about those specific processes to help Oracle understand and optimize them.
Oracle does not associate the data with personally identifiable information. You can find more information about the data
Oracle collects as a result of your Software download at http://www.oracle.com/java/technologies/java-se-doc.html.

For inquiries please contact: Oracle America, Inc., 500 Oracle Parkway,

Redwood Shores, California 94065, USA.

Last updated 21 September 2017

JsonSubTypes
MIT License

Permission is hereby granted, free of charge, to any person obtaining a copy of _____ (the "Software"), to deal in the
Software without restriction, including without limitation the rights to use, copy, modify, merge, publish, distribute, sublicense,
and/or sell copies of the Software, and to permit persons to whom the Software is furnished to do so, subject to the following
conditions:

The above copyright notice and this permission notice (including the next paragraph) shall be included in all copies or
substantial portions of the Software.
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THE SOFTWARE IS PROVIDED "AS IS", WITHOUTWARRANTY OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING
BUT NOT LIMITED TO THEWARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND
NONINFRINGEMENT. IN NO EVENT SHALL _____ BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY,
WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION
WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

LibJpeg
This software is based in part on the work of the Independent JPEG Group.

Copyright © 1991–2016, Thomas G. Lane, Guido Vollbeding.

LibTiff
Copyright © 1988–1997 Sam Leffler, Copyright © 1991–1997 Silicon Graphics, Inc.

Permission to use, copy, modify, distribute, and sell this software and its documentation for any purpose is hereby granted
without fee, provided that (i) the above copyright notices and this permission notice appear in all copies of the software and
related documentation, and (ii) the names of Sam Leffler and Silicon Graphics may not be used in any advertising or publicity
relating to the software without the specific, prior written permission of Sam Leffler and Silicon Graphics.

THE SOFTWARE IS PROVIDED "AS-IS" ANDWITHOUTWARRANTY OF ANY KIND, EXPRESS, IMPLIED OR
OTHERWISE, INCLUDINGWITHOUT LIMITATION, ANYWARRANTY OF MERCHANTABILITY OR FITNESS FOR A
PARTICULAR PURPOSE.

IN NO EVENT SHALL SAM LEFFLER OR SILICON GRAPHICS BE LIABLE FOR ANY SPECIAL, INCIDENTAL, INDIRECT
OR CONSEQUENTIAL DAMAGES OF ANY KIND, OR ANY DAMAGESWHATSOEVER RESULTING FROM LOSS OF
USE, DATA OR PROFITS, WHETHER OR NOT ADVISED OF THE POSSIBILITY OF DAMAGE, AND ON ANY THEORY
OF LIABILITY, ARISING OUT OF OR IN CONNECTIONWITH THE USE OR PERFORMANCE OF THIS SOFTWARE.

LibTiff.net
Copyright 2008–2011, Bit Miracle. All rights reserved.

This software is provided by the copyright holders and contributors “as is” and any express or implied warranties, including,
but not limited to, the implied warranties of merchantability and fitness for a particular purpose are disclaimed. In no event
shall Bit Miracle be liable for any direct, indirect, incidental, special, exemplary, or consequential damages (including, but not
limited to, procurement of substitute goods or services; loss of use, data, or profits; or business interruption) however caused
and on any theory of liability, whether in contract, strict liability, or tort (including negligence or otherwise) arising in any way
out of the use of this software, even if advised of the possibility of such damage.

log4net
Copyright 2004–2013 The Apache Software Foundation.
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LZ4 Library
Copyright (c) 2011-2020, Yann Collet

All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following
conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.

* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer
in the documentation and/or other materials provided with the distribution.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY EXPRESS
OR IMPLIEDWARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIEDWARRANTIES OF MERCHANTABILITY
AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDER
OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY
THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR
OTHERWISE) ARISING IN ANYWAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY
OF SUCH DAMAGE.

Math.NET Numerics
Copyright © 2002–2020 Math.NET

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated documentation
files (the "Software"), to deal in the Software without restriction, including without limitation the rights to use, copy, modify,
merge, publish, distribute, sublicense, and/or sell copies of the Software, and to permit persons to whom the Software is
furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in all copies or substantial portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUTWARRANTY OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING
BUT NOT LIMITED TO THEWARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND
NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM,
DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM,
OUT OF OR IN CONNECTIONWITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

Microsoft Enterprise Library for .NET
Copyright © Microsoft Corporation. All rights reserved.

Microsoft Entity Framework
©Microsoft Corporation. All rights reserved.
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Nito Libraries
MIT License

Permission is hereby granted, free of charge, to any person obtaining a copy of _____ (the "Software"), to deal in the
Software without restriction, including without limitation the rights to use, copy, modify, merge, publish, distribute, sublicense,
and/or sell copies of the Software, and to permit persons to whom the Software is furnished to do so, subject to the following
conditions:

The above copyright notice and this permission notice (including the next paragraph) shall be included in all copies or
substantial portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUTWARRANTY OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING
BUT NOT LIMITED TO THEWARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND
NONINFRINGEMENT. IN NO EVENT SHALL _____ BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY,
WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION
WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

NLog v3.2.0.0 (PrivateBuild)
Copyright © 2004–2020 Jaroslaw Kowalski <jaak@jkowalski.net>, Kim Christensen, Julian Verdurmen

All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following
conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of
conditions and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of
conditions and the following disclaimer in the documentation and/or other materials
provided with the distribution.

3. Neither the name of Jaroslaw Kowalski nor the names of its contributors may be used to
endorse or promote products derived from this software without specific prior written
permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY EXPRESS
OR IMPLIEDWARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIEDWARRANTIES OF MERCHANTABILITY
AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR
CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY
THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR
OTHERWISE) ARISING IN ANYWAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY
OF SUCH DAMAGE.

OpenCvSharp3
BSD 3-Clause License

Copyright © 2019, shimat
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All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following
conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of
conditions and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of
conditions and the following disclaimer in the documentation and/or other materials
provided with the distribution.

3. Neither the name of the copyright holder nor the names of its contributors may be used to
endorse or promote products derived from this software without specific prior written
permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY EXPRESS
OR IMPLIEDWARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIEDWARRANTIES OF MERCHANTABILITY
AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDER
OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY
THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR
OTHERWISE) ARISING IN ANYWAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY
OF SUCH DAMAGE.

OxyPlot
MIT License

Copyright © 2014 OxyPlot contributors

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated documentation
files (the "Software"), to deal in the Software without restriction, including without limitation the rights to use, copy, modify,
merge, publish, distribute, sublicense, and/or sell copies of the Software, and to permit persons to whom the Software is
furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in all copies or substantial portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUTWARRANTY OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING
BUT NOT LIMITED TO THEWARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND
NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM,
DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM,
OUT OF OR IN CONNECTIONWITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

Polly
Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following
conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer
in the documentation and/or other materials provided with the distribution.
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3. _____ be used to endorse or promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY _____ "AS IS" AND ANY _____ OR IMPLIEDWARRANTIES, INCLUDING, BUT NOT
LIMITED TO, THE IMPLIEDWARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
DISCLAIMED. IN NO EVENT SHALL _____ BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL,
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION)
HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT
(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANYWAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF
ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Protocol Buffers .NET
The core Protocol Buffers technology is provided courtesy of Google. At the time of writing, this is released under the BSD
license.

Full details can be found here: http://code.google.com/p/protobuf/

This .NET implementation is Copyright 2008 Marc Gravell Licensed under the Apache License, Version 2.0 (the "License");
you may not use this file except in compliance with the License. You may obtain a copy of the License at
http://www.apache.org/licenses/LICENSE-2.0

Unless required by applicable law or agreed to in writing, software distributed under the License is distributed on an "AS IS"
BASIS, WITHOUTWARRANTIES OR CONDITIONS OF ANY KIND, either express or implied.

See the License for the specific language governing permissions and limitations under the License.

RBush.dll
MIT License

Copyright © 2017 viceroypenguin

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated documentation
files (the "Software"), to deal in the Software without restriction, including without limitation the rights to use, copy, modify,
merge, publish, distribute, sublicense, and/or sell copies of the Software, and to permit persons to whom the Software is
furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in all copies or substantial portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUTWARRANTY OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING
BUT NOT LIMITED TO THEWARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND
NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM,
DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM,
OUT OF OR IN CONNECTIONWITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

Reactive Extensions (Rx) for .NET
MIT License

Copyright © .NET Foundation and Contributors

All rights reserved.
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Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated documentation
files (the "Software"), to deal in the Software without restriction, including without limitation the rights to use, copy, modify,
merge, publish, distribute, sublicense, and/or sell copies of the Software, and to permit persons to whom the Software is
furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in all copies or substantial portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUTWARRANTY OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING
BUT NOT LIMITED TO THEWARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND
NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM,
DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM,
OUT OF OR IN CONNECTIONWITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

RestSharp
Apache License

Version 2.0, January 2004

http://www.apache.org/licenses/

TERMS AND CONDITIONS FOR USE, REPRODUCTION, AND DISTRIBUTION

1. Definitions.

"License" shall mean the terms and conditions for use, reproduction, and distribution as defined by Sections 1 through 9 of
this document.

"Licensor" shall mean the copyright owner or entity authorized by the copyright owner that is granting the License.

"Legal Entity" shall mean the union of the acting entity and all other entities that control, are controlled by, or are under
common control with that entity. For the purposes of this definition, "control" means (i) the power, direct or indirect, to cause
the direction or management of such entity, whether by contract or otherwise, or (ii) ownership of fifty percent (50%) or more
of the outstanding shares, or (iii) beneficial ownership of such entity.

"You" (or "Your") shall mean an individual or Legal Entity exercising permissions granted by this License.

"Source" form shall mean the preferred form for making modifications, including but not limited to software source code,
documentation source, and configuration files.

"Object" form shall mean any form resulting from mechanical transformation or translation of a Source form, including but not
limited to compiled object code, generated documentation, and conversions to other media types.

"Work" shall mean the work of authorship, whether in Source or Object form, made available under the License, as indicated
by a copyright notice that is included in or attached to the work (an example is provided in the Appendix below).

"Derivative Works" shall mean any work, whether in Source or Object form, that is based on (or derived from) the Work and
for which the editorial revisions, annotations, elaborations, or other modifications represent, as a whole, an original work of
authorship. For the purposes of this License, Derivative Works shall not include works that remain separable from, or merely
link (or bind by name) to the interfaces of, the Work and Derivative Works thereof.

"Contribution" shall mean any work of authorship, including the original version of the Work and any modifications or
additions to that Work or Derivative Works thereof, that is intentionally submitted to Licensor for inclusion in the Work by the
copyright owner or by an individual or Legal Entity authorized to submit on behalf of the copyright owner. For the purposes of
this definition, "submitted" means any form of electronic, verbal, or written communication sent to the Licensor or its
representatives, including but not limited to communication on electronic mailing lists, source code control systems, and
issue tracking systems that are managed by, or on behalf of, the Licensor for the purpose of discussing and improving the
Work, but excluding communication that is conspicuously marked or otherwise designated in writing by the copyright owner
as "Not a Contribution."
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"Contributor" shall mean Licensor and any individual or Legal Entity on behalf of whom a Contribution has been received by
Licensor and subsequently incorporated within the Work.
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2. Grant of Copyright License.

Subject to the terms and conditions of this License, each Contributor hereby grants to You a perpetual, worldwide, non-
exclusive, no-charge, royalty-free, irrevocable copyright license to reproduce, prepare Derivative Works of, publicly display,
publicly perform, sublicense, and distribute the Work and such Derivative Works in Source or Object form.

3. Grant of Patent License.

Subject to the terms and conditions of this License, each Contributor hereby grants to You a perpetual, worldwide, non-
exclusive, no-charge, royalty-free, irrevocable (except as stated in this section) patent license to make, have made, use, offer
to sell, sell, import, and otherwise transfer the Work, where such license applies only to those patent claims licensable by
such Contributor that are necessarily infringed by their Contribution(s) alone or by combination of their Contribution(s) with
the Work to which such Contribution(s) was submitted. If You institute patent litigation against any entity (including a cross-
claim or counterclaim in a lawsuit) alleging that the Work or a Contribution incorporated within the Work constitutes direct or
contributory patent infringement, then any patent licenses granted to You under this License for that Work shall terminate as
of the date such litigation is filed.

4. Redistribution.

You may reproduce and distribute copies of the Work or Derivative Works thereof in any medium, with or without
modifications, and in Source or Object form, provided that You meet the following conditions:

You must give any other recipients of the Work or Derivative Works a copy of this License; and

You must cause any modified files to carry prominent notices stating that You changed the files; and

You must retain, in the Source form of any Derivative Works that You distribute, all copyright, patent, trademark, and
attribution notices from the Source form of the Work, excluding those notices that do not pertain to any part of the Derivative
Works; and

If the Work includes a "NOTICE" text file as part of its distribution, then any Derivative Works that You distribute must include
a readable copy of the attribution notices contained within such NOTICE file, excluding those notices that do not pertain to
any part of the Derivative Works, in at least one of the following places: within a NOTICE text file distributed as part of the
Derivative Works; within the Source form or documentation, if provided along with the Derivative Works; or, within a display
generated by the Derivative Works, if and wherever such third-party notices normally appear. The contents of the NOTICE
file are for informational purposes only and do not modify the License. You may add Your own attribution notices within
Derivative Works that You distribute, alongside or as an addendum to the NOTICE text from the Work, provided that such
additional attribution notices cannot be construed as modifying the License.

You may add Your own copyright statement to Your modifications and may provide additional or different license terms and
conditions for use, reproduction, or distribution of Your modifications, or for any such Derivative Works as a whole, provided
Your use, reproduction, and distribution of the Work otherwise complies with the conditions stated in this License.

5. Submission of Contributions.

Unless You explicitly state otherwise, any Contribution intentionally submitted for inclusion in the Work by You to the
Licensor shall be under the terms and conditions of this License, without any additional terms or conditions. Notwithstanding
the above, nothing herein shall supersede or modify the terms of any separate license agreement you may have executed
with Licensor regarding such Contributions.

6. Trademarks.

This License does not grant permission to use the trade names, trademarks, service marks, or product names of the
Licensor, except as required for reasonable and customary use in describing the origin of the Work and reproducing the
content of the NOTICE file.
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7. Disclaimer of Warranty.

Unless required by applicable law or agreed to in writing, Licensor provides the Work (and each Contributor provides its
Contributions) on an "AS IS" BASIS, WITHOUTWARRANTIES OR CONDITIONS OF ANY KIND, either express or implied,
including, without limitation, any warranties or conditions of TITLE, NON-INFRINGEMENT, MERCHANTABILITY, or
FITNESS FOR A PARTICULAR PURPOSE. You are solely responsible for determining the appropriateness of using or
redistributing the Work and assume any risks associated with Your exercise of permissions under this License.

8. Limitation of Liability.

In no event and under no legal theory, whether in tort (including negligence), contract, or otherwise, unless required by
applicable law (such as deliberate and grossly negligent acts) or agreed to in writing, shall any Contributor be liable to You for
damages, including any direct, indirect, special, incidental, or consequential damages of any character arising as a result of
this License or out of the use or inability to use the Work (including but not limited to damages for loss of goodwill, work
stoppage, computer failure or malfunction, or any and all other commercial damages or losses), even if such Contributor has
been advised of the possibility of such damages.

9. Accepting Warranty or Additional Liability.

While redistributing the Work or Derivative Works thereof, You may choose to offer, and charge a fee for, acceptance of
support, warranty, indemnity, or other liability obligations and/or rights consistent with this License. However, in accepting
such obligations, You may act only on Your own behalf and on Your sole responsibility, not on behalf of any other
Contributor, and only if You agree to indemnify, defend, and hold each Contributor harmless for any liability incurred by, or
claims asserted against, such Contributor by reason of your accepting any such warranty or additional liability.

END OF TERMS AND CONDITIONS

Serilog
Apache License

Version 2.0, January 2004

http://www.apache.org/licenses/

TERMS AND CONDITIONS FOR USE, REPRODUCTION, AND DISTRIBUTION

1. Definitions.

"License" shall mean the terms and conditions for use, reproduction, and distribution as defined by Sections 1 through 9 of
this document. "Licensor" shall mean the copyright owner or entity authorized by the copyright owner that is granting the
License. "Legal Entity" shall mean the union of the acting entity and all other entities that control, are controlled by, or are
under common control with that entity. For the purposes of this definition, "control" means (i) the power, direct or indirect, to
cause the direction or management of such entity, whether by contract or otherwise, or (ii) ownership of fifty percent (50%) or
more of the outstanding shares, or (iii) beneficial ownership of such entity. "You" (or "Your") shall mean an individual or Legal
Entity exercising permissions granted by this License. "Source" form shall mean the preferred form for making modifications,
including but not limited to software source code, documentation source, and configuration files.

"Object" form shall mean any form resulting from mechanical transformation or translation of a Source form, including but not
limited to compiled object code, generated documentation, and conversions to other media types. "Work" shall mean the
work of authorship, whether in Source or Object form, made available under the License, as indicated by a copyright notice
that is included in or attached to the work (an example is provided in the Appendix below).
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"Derivative Works" shall mean any work, whether in Source or Object form, that is based on (or derived from) the Work and
for which the editorial revisions, annotations, elaborations, or other modifications represent, as a whole, an original work of
authorship. For the purposes of this License, Derivative Works shall not include works that remain separable from, or merely
link (or bind by name) to the interfaces of, the Work and Derivative Works thereof. "Contribution" shall mean any work of
authorship, including the original version of the Work and any modifications or additions to that Work or Derivative Works
thereof, that is intentionally submitted to Licensor for inclusion in the Work by the copyright owner or by an individual or Legal
Entity authorized to submit on behalf of the copyright owner. For the purposes of this definition, "submitted" means any form
of electronic, verbal, or written communication sent to the Licensor or its representatives, including but not limited to
communication on electronic mailing lists, source code control systems, and issue tracking systems that are managed by, or
on behalf of, the Licensor for the purpose of discussing and improving the Work, but excluding communication that is
conspicuously marked or otherwise designated in writing by the copyright owner as "Not a Contribution."

"Contributor" shall mean Licensor and any individual or Legal Entity on behalf of whom a Contribution has been received by
Licensor and subsequently incorporated within the Work.

2. Grant of Copyright License.

Subject to the terms and conditions of this License, each Contributor hereby grants to You a perpetual, worldwide, non-
exclusive, no-charge, royalty-free, irrevocable copyright license to reproduce, prepare Derivative Works of, publicly display,
publicly perform, sublicense, and distribute the Work and such Derivative Works in Source or Object form.

3. Grant of Patent License.

Subject to the terms and conditions of this License, each Contributor hereby grants to You a perpetual, worldwide, non-
exclusive, no-charge, royalty-free, irrevocable (except as stated in this section) patent license to make, have

made, use, offer to sell, sell, import, and otherwise transfer the Work, where such license applies only to those patent claims
licensable by such Contributor that are necessarily infringed by their Contribution(s) alone or by combination of their
Contribution(s) with the Work to which such Contribution(s) was submitted. If You institute patent litigation against any entity
(including a cross-claim or counterclaim in a lawsuit) alleging that the Work or a Contribution incorporated within the Work
constitutes direct or contributory patent infringement, then any patent licenses granted to You under this License for that
Work shall terminate as of the date such litigation is filed.

4. Redistribution.

You may reproduce and distribute copies of the Work or Derivative Works thereof in any medium, with or without
modifications, and in Source or Object form, provided that You meet the following conditions:

You must give any other recipients of the Work or Derivative Works a copy of this License; and You must cause any modified
files to carry prominent notices stating that You changed the files; and You must retain, in the Source form of any Derivative
Works that You distribute, all copyright, patent, trademark, and attribution notices from the Source form of the Work,
excluding those notices that do not pertain to any part of the Derivative Works; andIf the Work includes a "NOTICE" text file
as part of its distribution, then any Derivative Works that You distribute must include a readable copy of the attribution notices
contained within such NOTICE file, excluding those notices that do not pertain to any part of the Derivative Works, in at least
one of the following places: within a NOTICE text file distributed as part of the Derivative Works; within the Source form or
documentation, if provided along with the Derivative Works; or, within a display generated by the Derivative Works, if and
wherever such third-party notices normally appear. The contents of the NOTICE file are for informational purposes only and
do not modify the License. You may add Your own attribution notices within Derivative Works that You distribute, alongside
or as an addendum to the NOTICE text from the Work, provided that such additional attribution notices cannot be construed
as modifying the License. You may add Your own copyright statement to Your modifications and may provide additional or
different license terms and conditions for use, reproduction, or distribution of Your modifications, or for any such Derivative
Works as a whole, provided Your use, reproduction, and distribution of the Work otherwise complies with the conditions
stated in this License.
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5. Submission of Contributions.

Unless You explicitly state otherwise, any Contribution intentionally submitted for inclusion in the Work by You to the
Licensor shall be under the terms and conditions of this License, without any additional terms or conditions. Notwithstanding
the above, nothing herein shall supersede or modify the terms of any separate license agreement you may have executed
with Licensor regarding such Contributions.

6. Trademarks.

This License does not grant permission to use the trade names, trademarks, service marks, or product names of the
Licensor, except as required for reasonable and customary use in describing the origin of the Work and reproducing the
content of the NOTICE file.

7. Disclaimer of Warranty.

Unless required by applicable law or agreed to in writing, Licensor provides the Work (and each Contributor provides its
Contributions) on an "AS IS" BASIS, WITHOUTWARRANTIES OR CONDITIONS OF ANY KIND, either express or implied,
including, without limitation, any warranties or conditions of TITLE, NON-INFRINGEMENT, MERCHANTABILITY, or
FITNESS FOR A PARTICULAR PURPOSE. You are solely responsible for determining the appropriateness of using or
redistributing the Work and assume any risks associated with Your exercise of permissions under this License.

8. Limitation of Liability.

In no event and under no legal theory, whether in tort (including negligence), contract, or otherwise, unless required by
applicable law (such as deliberate and grossly negligent acts) or agreed to in writing, shall any Contributor be liable to You for
damages, including any direct, indirect, special, incidental, or consequential damages of any character arising as a result of
this License or out of the use or inability to use the Work (including but not limited to damages for loss of goodwill, work
stoppage, computer failure or malfunction, or any and all other commercial damages or losses), even if such Contributor has
been advised of the possibility of such damages.

9. Accepting Warranty or Additional Liability.

While redistributing the Work or Derivative Works thereof, You may choose to offer, and charge a fee for, acceptance of
support, warranty, indemnity, or other liability obligations and/or rights consistent with this License. However, in accepting
such obligations, You may act only on Your own behalf and on Your sole responsibility, not on behalf of any other
Contributor, and only if You agree to indemnify, defend, and hold each Contributor harmless for any liability incurred by, or
claims asserted against, such Contributor by reason of your accepting any such warranty or additional liability.

END OF TERMS AND CONDITIONS

APPENDIX: How to apply the Apache License to your work

To apply the Apache License to your work, attach the following boilerplate notice, with the fields enclosed by brackets "[]"
replaced with your own identifying information. (Don't include the brackets!) The text should be enclosed in the appropriate
comment syntax for the file format. We also recommend that a file or class name and description of purpose be included on
the same "printed page" as the copyright notice for easier identification within third-party archives.

Copyright [yyyy] [name of copyright owner]

Licensed under the Apache License, Version 2.0 (the "License"); you may not use this file except in compliance with the
License. You may obtain a copy of the License at http://www.apache.org/licenses/LICENSE-2.0

Unless required by applicable law or agreed to in writing, software distributed under the License is distributed on an "AS IS"
BASIS, WITHOUTWARRANTIES OR CONDITIONS OF ANY KIND, either express or implied. See the License for the
specific language governing permissions and limitations under the License.
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SQLitePCLRaw
Apache License

Version 2.0, January 2004

http://www.apache.org/licenses/

TERMS AND CONDITIONS FOR USE, REPRODUCTION, AND DISTRIBUTION

1. Definitions.

"License" shall mean the terms and conditions for use, reproduction, and distribution as defined by Sections 1 through 9 of
this document.

"Licensor" shall mean the copyright owner or entity authorized by the copyright owner that is granting the License.

"Legal Entity" shall mean the union of the acting entity and all other entities that control, are controlled by, or are under
common control with that entity. For the purposes of this definition, "control" means (i) the power, direct or indirect, to cause
the direction or management of such entity, whether by contract or otherwise, or (ii) ownership of fifty percent (50%) or more
of the outstanding shares, or (iii) beneficial ownership of such entity. "You" (or "Your") shall mean an individual or Legal Entity
exercising permissions granted by this License.

"Source" form shall mean the preferred form for making modifications, including but not limited to software source code,
documentation source, and configuration files.

"Object" form shall mean any form resulting from mechanical transformation or translation of a Source form, including but not
limited to compiled object code, generated documentation, and conversions to other media types.

"Work" shall mean the work of authorship, whether in Source or Object form, made available under the License, as indicated
by a copyright notice that is included in or attached to the work (an example is provided in the Appendix below).

"Derivative Works" shall mean any work, whether in Source or Object form, that is based on (or derived from) the Work and
for which the editorial revisions, annotations, elaborations, or other modifications represent, as a whole, an original work of
authorship. For the purposes of this License, Derivative Works shall not include works that remain separable from, or merely
link (or bind by name) to the interfaces of, the Work and Derivative Works thereof.

"Contribution" shall mean any work of authorship, including the original version of the Work and any modifications or
additions to that Work or Derivative Works thereof, that is intentionally submitted to Licensor for inclusion in the Work by the
copyright owner or by an individual or Legal Entity authorized to submit on behalf of the copyright owner. For the purposes of
this definition, "submitted" means any form of electronic, verbal, or written communication sent to the Licensor or its
representatives, including but not limited to communication on electronic mailing lists, source code control systems, and
issue tracking systems that are managed by, or on behalf of, the Licensor for the purpose of discussing and improving the
Work, but excluding communication that is conspicuously marked or otherwise designated in writing by the copyright owner
as "Not a Contribution."

"Contributor" shall mean Licensor and any individual or Legal Entity on behalf of whom a Contribution has been received by
Licensor and subsequently incorporated within the Work.

2. Grant of Copyright License. Subject to the terms and conditions of this License, each Contributor hereby grants to You a
perpetual, worldwide, non-exclusive, no-charge, royalty-free, irrevocable copyright license to reproduce, prepare Derivative
Works of, publicly display, publicly perform, sublicense, and distribute the Work and such Derivative Works in Source or
Object form.
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3. Grant of Patent License. Subject to the terms and conditions of this License, each Contributor hereby grants to You a
perpetual, worldwide, non-exclusive, no-charge, royalty-free, irrevocable (except as stated in this section) patent license to
make, have made, use, offer to sell, sell, import, and otherwise transfer the Work, where such license applies only to those
patent claims licensable by such Contributor that are necessarily infringed by their Contribution(s) alone or by combination of
their Contribution(s) with the Work to which such Contribution(s) was submitted. If You institute patent litigation against any
entity (including a cross-claim or counterclaim in a lawsuit) alleging that the Work or a Contribution incorporated within the
Work constitutes direct or contributory patent infringement, then any patent licenses granted to You under this License for
that Work shall terminate as of the date such litigation is filed.

4. Redistribution. You may reproduce and distribute copies of the Work or Derivative Works thereof in any medium, with or
without modifications, and in Source or Object form, provided that You meet the following conditions:

(a) You must give any other recipients of the Work or Derivative Works a copy of this License; and

(b) You must cause any modified files to carry prominent notices stating that You changed the files; and

(c) You must retain, in the Source form of any Derivative Works that You distribute, all copyright, patent, trademark, and
attribution notices from the Source form of the Work, excluding those notices that do not pertain to any part of the Derivative
Works; and

(d) If the Work includes a "NOTICE" text file as part of its distribution, then any Derivative Works that You distribute must
include a readable copy of the attribution notices contained within such NOTICE file, excluding those notices that do not
pertain to any part of the Derivative Works, in at least one of the following places: within a NOTICE text file distributed as part
of the Derivative Works; within the Source form or documentation, if provided along with the Derivative Works; or, within a
display generated by the Derivative Works, if and wherever such third-party notices normally appear. The contents of the
NOTICE file are for informational purposes only and do not modify the License. You may add Your own attribution notices
within Derivative Works that You distribute, alongside or as an addendum to the NOTICE text from the Work, provided that
such additional attribution notices cannot be construed as modifying the License.

You may add Your own copyright statement to Your modifications and may provide additional or different license terms and
conditions for use, reproduction, or distribution of Your modifications, or for any such Derivative Works as a whole, provided
Your use, reproduction, and distribution of the Work otherwise complies with the conditions stated in this License.

5. Submission of Contributions. Unless You explicitly state otherwise, any Contribution intentionally submitted for inclusion in
the Work by You to the Licensor shall be under the terms and conditions of this License, without any additional terms or
conditions. Notwithstanding the above, nothing herein shall supersede or modify the terms of any separate license
agreement you may have executed with Licensor regarding such Contributions.

6. Trademarks. This License does not grant permission to use the trade names, trademarks, service marks, or product
names of the Licensor, except as required for reasonable and customary use in describing the origin of the Work and
reproducing the content of the NOTICE file.

7. Disclaimer of Warranty. Unless required by applicable law or agreed to in writing, Licensor provides the Work (and each
Contributor provides its Contributions) on an "AS IS" BASIS, WITHOUTWARRANTIES OR CONDITIONS OF ANY KIND,
either express or implied, including, without limitation, any warranties or conditions of TITLE, NON-INFRINGEMENT,
MERCHANTABILITY, or FITNESS FOR A PARTICULAR PURPOSE. You are solely responsible for determining the
appropriateness of using or redistributing the Work and assume any risks associated with Your exercise of permissions
under this License.

8. Limitation of Liability. In no event and under no legal theory, whether in tort (including negligence), contract, or otherwise,
unless required by applicable law (such as deliberate and grossly negligent acts) or agreed to in writing, shall any Contributor
be liable to You for damages, including any direct, indirect, special, incidental, or consequential damages of any character
arising as a result of this License or out of the use or inability to use the Work (including but not limited to damages for loss of
goodwill, work stoppage, computer failure or malfunction, or any and all other commercial damages or losses), even if such
Contributor has been advised of the possibility of such damages.
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9. Accepting Warranty or Additional Liability. While redistributing the Work or Derivative Works thereof, You may choose to
offer, and charge a fee for, acceptance of support, warranty, indemnity, or other liability obligations and/or rights consistent
with this License. However, in accepting such obligations, You may act only on Your own behalf and on Your sole
responsibility, not on behalf of any other Contributor, and only if You agree to indemnify, defend, and hold each Contributor
harmless for any liability incurred by, or claims asserted against, such Contributor by reason of your accepting any such
warranty or additional liability.

END OF TERMS AND CONDITIONS

APPENDIX: How to apply the Apache License to your work.

To apply the Apache License to your work, attach the following boilerplate notice, with the fields enclosed by brackets "[]"
replaced with your own identifying information. (Don't include the brackets!) The text should be enclosed in the appropriate
comment syntax for the file format. We also recommend that a file or class name and description of purpose be included on
the same "printed page" as the copyright notice for easier identification within third-party archives.

Copyright [yyyy] [name of copyright owner]

Licensed under the Apache License, Version 2.0 (the "License"); you may not use this file except in compliance with the
License.

You may obtain a copy of the License at http://www.apache.org/licenses/LICENSE-2.0

Unless required by applicable law or agreed to in writing, software distributed under the License is distributed on an "AS IS"
BASIS, WITHOUTWARRANTIES OR CONDITIONS OF ANY KIND, either express or implied.

See the License for the specific language governing permissions and limitations under the License.

SystemWrapper
Copyright © 2008 Jared Barneck, Portions Copyright © 2014-2018 Jozef Izso

VCL Styles InnoSetup plugin
Copyright © Rodrigo Ruz

YamlDotNet
Copyright (c) 2008, 2009, 2010, 2011, 2012, 2013, 2014 Antoine Aubry and contributors Permission is hereby granted, free
of charge, to any person obtaining a copy of this software and associated documentation files (the "Software"), to deal in the
Software without restriction, including without limitation the rights to use, copy, modify, merge, publish, distribute, sublicense,
and/or sell copies of the Software, and to permit persons to whom the Software is furnished to do so, subject to the following
conditions:

The above copyright notice and this permission notice shall be included in all copies or substantial portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUTWARRANTY OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING
BUT NOT LIMITED TO THEWARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND
NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM,
DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM,
OUT OF OR IN CONNECTIONWITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.
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ZedGraph Library
GNU LESSER GENERAL PUBLIC LICENSE, Version 2.1, February 1999, Copyright © 1991, 1999 Free Software
Foundation, Inc., 51 Franklin Street, Fifth Floor, Boston, MA 02110–1301 USA

Everyone is permitted to copy and distribute verbatim copies of this license document, but changing it is not allowed.

[This is the first released version of the Lesser GPL. It also counts as the successor of the GNU Library Public License,
version 2, hence the version number 2.1.]

Preamble
The licenses for most software are designed to take away your freedom to share and change it. By contrast, the GNU
General Public Licenses are intended to guarantee your freedom to share and change free software--to make sure the
software is free for all its users.

This license, the Lesser General Public License, applies to some specially designated software packages--typically libraries-
-of the Free Software Foundation and other authors who decide to use it. You can use it too, but we suggest you first think
carefully about whether this license or the ordinary General Public License is the better strategy to use in any particular case,
based on the explanations below.

When we speak of free software, we are referring to freedom of use, not price. Our General Public Licenses are designed to
make sure that you have the freedom to distribute copies of free software (and charge for this service if you wish); that you
receive source code or can get it if you want it; that you can change the software and use pieces of it in new free programs;
and that you are informed that you can do these things.

To protect your rights, we need to make restrictions that forbid distributors to deny you these rights or to ask you to surrender
these rights. These restrictions translate to certain responsibilities for you if you distribute copies of the library or if you modify
it.

For example, if you distribute copies of the library, whether gratis or for a fee, you must give the recipients all the rights that
we gave you. You must make sure that they, too, receive or can get the source code. If you link other code with the library,
you must provide complete object files to the recipients, so that they can relink them with the library after making changes to
the library and recompiling it. And you must show them these terms so they know their rights.

We protect your rights with a two-step method: (1) we copyright the library, and (2) we offer you this license, which gives you
legal permission to copy, distribute and/or modify the library.

To protect each distributor, we want to make it very clear that there is no warranty for the free library. Also, if the library is
modified by someone else and passed on, the recipients should know that what they have is not the original version, so that
the original author's reputation will not be affected by problems that might be introduced by others.

Finally, software patents pose a constant threat to the existence of any free program. We wish to make sure that a company
cannot effectively restrict the users of a free program by obtaining a restrictive license from a patent holder. Therefore, we
insist that any patent license obtained for a version of the library must be consistent with the full freedom of use specified in
this license.

Most GNU software, including some libraries, is covered by the ordinary GNU General Public License. This license, the GNU
Lesser General Public License, applies to certain designated libraries, and is quite different from the ordinary General Public
License. We use this license for certain libraries in order to permit linking those libraries into non-free programs.

When a program is linked with a library, whether statically or using a shared library, the combination of the two is legally
speaking a combined work, a derivative of the original library. The ordinary General Public License therefore permits such
linking only if the entire combination fits its criteria of freedom. The Lesser General Public License permits more lax criteria
for linking other code with the library.
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We call this license the "Lesser" General Public License because it does Less to protect the user's freedom than the ordinary
General Public License. It also provides other free software developers Less of an advantage over competing non-free
programs. These disadvantages are the reason we use the ordinary General Public License for many libraries. However, the
Lesser license provides advantages in certain special circumstances.

For example, on rare occasions, there may be a special need to encourage the widest possible use of a certain library, so
that it becomes a de-facto standard. To achieve this, non-free programs must be allowed to use the library. A more frequent
case is that a free library does the same job as widely used non-free libraries. In this case, there is little to gain by limiting the
free library to free software only, so we use the Lesser General Public License.

In other cases, permission to use a particular library in non-free programs enables a greater number of people to use a large
body of free software. For example, permission to use the GNU C Library in non-free programs enables many more people to
use the whole GNU operating system, as well as its variant, the GNU/Linux operating system.

Although the Lesser General Public License is Less protective of the users' freedom, it does ensure that the user of a
program that is linked with the Library has the freedom and the wherewithal to run that program using a modified version of
the Library.

The precise terms and conditions for copying, distribution and modification follow. Pay close attention to the difference
between a "work based on the library" and a "work that uses the library". The former contains code derived from the library,
whereas the latter must be combined with the library in order to run.

GNU LESSER GENERAL PUBLIC LICENSE

TERMS AND CONDITIONS FOR COPYING, DISTRIBUTION ANDMODIFICATION

0. This License Agreement applies to any software library or other program which contains a notice placed by the copyright
holder or other authorized party saying it may be distributed under the terms of this Lesser General Public License (also
called "this License"). Each licensee is addressed as "you".

A "library" means a collection of software functions and/or data prepared so as to be conveniently linked with application
programs (which use some of those functions and data) to form executables.

The "Library", below, refers to any such software library or work which has been distributed under these terms. A "work based
on the Library" means either the Library or any derivative work under copyright law: that is to say, a work containing the
Library or a portion of it, either verbatim or with modifications and/or translated straightforwardly into another language.
(Hereinafter, translation is included without limitation in the term "modification".)

"Source code" for a work means the preferred form of the work for making modifications to it. For a library, complete source
code means all the source code for all modules it contains, plus any associated interface definition files, plus the scripts used
to control compilation and installation of the library.

Activities other than copying, distribution and modification are not covered by this License; they are outside its scope. The act
of running a program using the Library is not restricted, and output from such a program is covered only if its contents
constitute a work based on the Library (independent of the use of the Library in a tool for writing it). Whether that is true
depends on what the Library does and what the program that uses the Library does.

1. You may copy and distribute verbatim copies of the Library's complete source code as you receive it, in any medium,
provided that you conspicuously and appropriately publish on each copy an appropriate copyright notice and disclaimer of
warranty; keep intact all the notices that refer to this License and to the absence of any warranty; and distribute a copy of this
License along with the Library.

You may charge a fee for the physical act of transferring a copy, and you may at your option offer warranty protection in
exchange for a fee.

2. You may modify your copy or copies of the Library or any portion of it, thus forming a work based on the Library, and copy
and distribute such modifications or work under the terms of Section 1 above, provided that you also meet all of these
conditions:

a) The modified work must itself be a software library.
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b) You must cause the files modified to carry prominent notices stating that you changed the files and the date of any change.

c) You must cause the whole of the work to be licensed at no charge to all third parties under the terms of this License.

d) If a facility in the modified Library refers to a function or a table of data to be supplied by an application program that uses
the facility, other than as an argument passed when the facility is invoked, then you must make a good faith effort to ensure
that, in the event an application does not supply such function or table, the facility still operates, and performs whatever part
of its purpose remains meaningful.

(For example, a function in a library to compute square roots has a purpose that is entirely well-defined independent of the
application. Therefore, Subsection 2d requires that any application-supplied function or table used by this function must be
optional: if the application does not supply it, the square root function must still compute square roots.)

These requirements apply to the modified work as a whole. If identifiable sections of that work are not derived from the
Library, and can be reasonably considered independent and separate works in themselves, then this License, and its terms,
do not apply to those sections when you distribute them as separate works. But when you distribute the same sections as
part of a whole which is a work based on the Library, the distribution of the whole must be on the terms of this License, whose
permissions for other licensees extend to the entire whole, and thus to each and every part regardless of who wrote it.

Thus, it is not the intent of this section to claim rights or contest your rights to work written entirely by you; rather, the intent is
to exercise the right to control the distribution of derivative or collective works based on the Library.

In addition, mere aggregation of another work not based on the Library with the Library (or with a work based on the Library)
on a volume of a storage or distribution medium does not bring the other work under the scope of this License.

3. You may opt to apply the terms of the ordinary GNU General Public License instead of this License to a given copy of the
Library. To do this, you must alter all the notices that refer to this License, so that they refer to the ordinary GNU General
Public License, version 2, instead of to this License. (If a newer version than version 2 of the ordinary GNU General Public
License has appeared, then you can specify that version instead if you wish.) Do not make any other change in these notices.

Once this change is made in a given copy, it is irreversible for that copy, so the ordinary GNU General Public License applies
to all subsequent copies and derivative works made from that copy.

This option is useful when you wish to copy part of the code of the Library into a program that is not a library.

4. You may copy and distribute the Library (or a portion or derivative of it, under Section 2) in object code or executable form
under the terms of Sections 1 and 2 above provided that you accompany it with the complete corresponding machine-
readable source code, which must be distributed under the terms of Sections 1 and 2 above on a medium customarily used
for software interchange.

If distribution of object code is made by offering access to copy from a designated place, then offering equivalent access to
copy the source code from the same place satisfies the requirement to distribute the source code, even though third parties
are not compelled to copy the source along with the object code.

5. A program that contains no derivative of any portion of the Library, but is designed to work with the Library by being
compiled or linked with it, is called a "work that uses the Library". Such a work, in isolation, is not a derivative work of the
Library, and therefore falls outside the scope of this License.

However, linking a "work that uses the Library" with the Library creates an executable that is a derivative of the Library
(because it contains portions of the Library), rather than a "work that uses the library". The executable is therefore covered by
this License. Section 6 states terms for distribution of such executables.

When a "work that uses the Library" uses material from a header file that is part of the Library, the object code for the work
may be a derivative work of the Library even though the source code is not. Whether this is true is especially significant if the
work can be linked without the Library, or if the work is itself a library. The threshold for this to be true is not precisely defined
by law.
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If such an object file uses only numerical parameters, data structure layouts and accessors, and small macros and small
inline functions (ten lines or less in length), then the use of the object file is unrestricted, regardless of whether it is legally a
derivative work. (Executables containing this object code plus portions of the Library will still fall under Section 6.)

Otherwise, if the work is a derivative of the Library, you may distribute the object code for the work under the terms of Section
6. Any executables containing that work also fall under Section 6, whether or not they are linked directly with the Library itself.

6. As an exception to the Sections above, you may also combine or link a "work that uses the Library" with the Library to
produce a work containing portions of the Library, and distribute that work under terms of your choice, provided that the terms
permit modification of the work for the customer's own use and reverse engineering for debugging such modifications.

You must give prominent notice with each copy of the work that the Library is used in it and that the Library and its use are
covered by this License. You must supply a copy of this License. If the work during execution displays copyright notices, you
must include the copyright notice for the Library among them, as well as a reference directing the user to the copy of this
License. Also, you must do one of these things:

a) Accompany the work with the complete corresponding machine-readable source code for the Library including whatever
changes were used in the work (which must be distributed under Sections 1 and 2 above); and, if the work is an executable
linked with the Library, with the complete machine-readable "work that uses the Library", as object code and/or source code,
so that the user can modify the Library and then relink to produce a modified executable containing the modified Library. (It is
understood that the user who changes the contents of definitions files in the Library will not necessarily be able to recompile
the application to use the modified definitions.)

b) Use a suitable shared library mechanism for linking with the Library. A suitable mechanism is one that (1) uses at run time
a copy of the library already present on the user's computer system, rather than copying library functions into the executable,
and (2) will operate properly with a modified version of the library, if the user installs one, as long as the modified version is
interface-compatible with the version that the work was made with.

c) Accompany the work with a written offer, valid for at least three years, to give the same user the materials specified in
Subsection 6a, above, for a charge no more than the cost of performing this distribution.

d) If distribution of the work is made by offering access to copy from a designated place, offer equivalent access to copy the
above specified materials from the same place.

e) Verify that the user has already received a copy of these materials or that you have already sent this user a copy.

For an executable, the required form of the "work that uses the Library" must include any data and utility programs needed for
reproducing the executable from it. However, as a special exception, the materials to be distributed need not include
anything that is normally distributed (in either source or binary form) with the major components (compiler, kernel, and so on)
of the operating system on which the executable runs, unless that component itself accompanies the executable.

It may happen that this requirement contradicts the license restrictions of other proprietary libraries that do not normally
accompany the operating system. Such a contradiction means you cannot use both them and the Library together in an
executable that you distribute.

7. You may place library facilities that are a work based on the Library side-by-side in a single library together with other
library facilities not covered by this License, and distribute such a combined library, provided that the separate distribution of
the work based on the Library and of the other library facilities is otherwise permitted, and provided that you do these two
things:

a) Accompany the combined library with a copy of the same work based on the Library, uncombined with any other library
facilities. This must be distributed under the terms of the Sections above.

b) Give prominent notice with the combined library of the fact that part of it is a work based on the Library, and explaining
where to find the accompanying uncombined form of the same work.
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8. You may not copy, modify, sublicense, link with, or distribute the Library except as expressly provided under this License.
Any attempt otherwise to copy, modify, sublicense, link with, or distribute the Library is void, and will automatically terminate
your rights under this License. However, parties who have received copies, or rights, from you under this License will not
have their licenses terminated so long as such parties remain in full compliance.

9. You are not required to accept this License, since you have not signed it. However, nothing else grants you permission to
modify or distribute the Library or its derivative works. These actions are prohibited by law if you do not accept this License.
Therefore, by modifying or distributing the Library (or any work based on the Library), you indicate your acceptance of this
License to do so, and all its terms and conditions for copying, distributing or modifying the Library or works based on it.

10. Each time you redistribute the Library (or any work based on the Library), the recipient automatically receives a license
from the original licensor to copy, distribute, link with or modify the Library subject to these terms and conditions. You may not
impose any further restrictions on the recipients' exercise of the rights granted herein. You are not responsible for enforcing
compliance by third parties with this License.

11. If, as a consequence of a court judgment or allegation of patent infringement or for any other reason (not limited to patent
issues), conditions are imposed on you (whether by court order, agreement or otherwise) that contradict the conditions of this
License, they do not excuse you from the conditions of this License. If you cannot distribute so as to satisfy simultaneously
your obligations under this License and any other pertinent obligations, then as a consequence you may not distribute the
Library at all. For example, if a patent license would not permit royalty-free redistribution of the Library by all those who
receive copies directly or indirectly through you, then the only way you could satisfy both it and this License would be to
refrain entirely from distribution of the Library.

If any portion of this section is held invalid or unenforceable under any particular circumstance, the balance of the section is
intended to apply, and the section as a whole is intended to apply in other circumstances.

It is not the purpose of this section to induce you to infringe any patents or other property right claims or to contest validity of
any such claims; this section has the sole purpose of protecting the integrity of the free software distribution system which is
implemented by public license practices. Many people have made generous contributions to the wide range of software
distributed through that system in reliance on consistent application of that system; it is up to the author/donor to decide if he
or she is willing to distribute software through any other system and a licensee cannot impose that choice.

This section is intended to make thoroughly clear what is believed to be a consequence of the rest of this License.

12. If the distribution and/or use of the Library is restricted in certain countries either by patents or by copyrighted interfaces,
the original copyright holder who places the Library under this License may add an explicit geographical distribution limitation
excluding those countries, so that distribution is permitted only in or among countries not thus excluded. In such case, this
License incorporates the limitation as if written in the body of this License.

13. The Free Software Foundation may publish revised and/or new versions of the Lesser General Public License from time
to time. Such new versions will be similar in spirit to the present version, but may differ in detail to address new problems or
concerns.

Each version is given a distinguishing version number. If the Library specifies a version number of this License which applies
to it and "any later version", you have the option of following the terms and conditions either of that version or of any later
version published by the Free Software Foundation. If the Library does not specify a license version number, you may
choose any version ever published by the Free Software Foundation.

14. If you wish to incorporate parts of the Library into other free programs whose distribution conditions are incompatible with
these, write to the author to ask for permission. For software which is copyrighted by the Free Software Foundation, write to
the Free Software Foundation; we sometimes make exceptions for this. Our decision will be guided by the two goals of
preserving the free status of all derivatives of our free software and of promoting the sharing and reuse of software generally.

NOWARRANTY
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15. BECAUSE THE LIBRARY IS LICENSED FREE OF CHARGE, THERE IS NOWARRANTY FOR THE LIBRARY, TO THE
EXTENT PERMITTED BY APPLICABLE LAW. EXCEPTWHEN OTHERWISE STATED INWRITING THE COPYRIGHT
HOLDERS AND/OR OTHER PARTIES PROVIDE THE LIBRARY "AS IS" WITHOUTWARRANTY OF ANY KIND, EITHER
EXPRESSED OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIEDWARRANTIES OF MERCHANTABILITY
AND FITNESS FOR A PARTICULAR PURPOSE. THE ENTIRE RISK AS TO THE QUALITY AND PERFORMANCE OF
THE LIBRARY IS WITH YOU. SHOULD THE LIBRARY PROVE DEFECTIVE, YOU ASSUME THE COST OF ALL
NECESSARY SERVICING, REPAIR OR CORRECTION.

16. IN NO EVENT UNLESS REQUIRED BY APPLICABLE LAWOR AGREED TO INWRITINGWILL ANY COPYRIGHT
HOLDER, OR ANY OTHER PARTYWHOMAYMODIFY AND/OR REDISTRIBUTE THE LIBRARY AS PERMITTED
ABOVE, BE LIABLE TO YOU FOR DAMAGES, INCLUDING ANY GENERAL, SPECIAL, INCIDENTAL OR
CONSEQUENTIAL DAMAGES ARISING OUT OF THE USE OR INABILITY TO USE THE LIBRARY (INCLUDING BUT NOT
LIMITED TO LOSS OF DATA OR DATA BEING RENDERED INACCURATE OR LOSSES SUSTAINED BY YOU OR THIRD
PARTIES OR A FAILURE OF THE LIBRARY TO OPERATEWITH ANY OTHER SOFTWARE), EVEN IF SUCH HOLDER
OR OTHER PARTY HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

END OF TERMS AND CONDITIONS

Zstandard
BSD License

For Zstandard software

Copyright (c) 2016-present, Facebook, Inc. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following
conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.

* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer
in the documentation and/or other materials provided with the distribution.

* Neither the name Facebook nor the names of its contributors may be used to endorse or promote products derived from this
software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY EXPRESS
OR IMPLIEDWARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIEDWARRANTIES OF MERCHANTABILITY
AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDER
OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY
THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR
OTHERWISE) ARISING IN ANYWAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY
OF SUCH DAMAGE.
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ZstdNet
BSD License

For ZstdNet software

Copyright (c) 2016-present, SKB Kontur. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following
conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.

* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer
in the documentation and/or other materials provided with the distribution.

* Neither the name SKB Kontur nor the names of its contributors may be used to endorse or promote products derived from
this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY EXPRESS
OR IMPLIEDWARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIEDWARRANTIES OF MERCHANTABILITY
AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDER
OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY
THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR
OTHERWISE) ARISING IN ANYWAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY
OF SUCH DAMAGE.
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